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1 BioStar 2 Overview

BioStar 2 is a web-based access control management system which is OS-independent and can be used
anywhere.
BioStar 2 expands its versatility even further with its support for access control and time & attendance

module, API, Mobile App, and Device SDK solutions.

License

Versions

Access Control

Max. Device 1,000
Max. Slave per Master (RS- . . .
31 (Up to 8 Fingerprint Devices)
485)
RS-485 Protocol OSDP Supported
Device Multi-Door Control Supported
Device Admin Level All / User / Config
Auto Reconnection to Server Direct & Server mode
USB Enrollment Device BioMini, BioMini Plus 2, DUALi DE-620
Daylight Saving Time Supported
Max. Card per User 8
Max. Fingerprint per User 10
Auto User Sync to Device Supported
Access-on-Card Supported
User Secure Credential Supported
iCLASS Seos Card Supported
Long-term Idle Users
Supported
Management
Custom Fields Supported
Max. Access Level 2,048 (Depends on the device)
Max. Access Group 2,048 (Depends on the device)
Max. Access Group per User 16
Max. Access Level per Access
128
Access Group
Control Max. Door per Access Level 128
Auto Access Group Sync to
. Supported
Device
Access Group Report by
Supported
Door/User/Elevator
Elevator Max. Floor per Elevator 192
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Max. Floor Level 2,048
(Floor Dual Auth Supported
Management) Anti-passback Zone Supported
Fire Alarm Zone Supported
Max. Zones 100
Max. Device per Zone 1,000 Global, 32 Local
Anti-passback Door APB, Global, Local
Fire Alarm Global, Local
Zone Scheduled Unlock/Lock Supported (Local)
Intrusion Alarm Supported (Local)
Interlock Supported (Local)
Muster Supported (Global)
Occupancy Limit Supported (Global)
Dashboard Supported
Server Matching Supported
Audit Trail Supported
Advanced Video Log Supported
Local API Server Supported

. . Supported (User, Door, Monitoring,
BioStar 2 Mobile App
Alarm)

Mobile Access Supported

Time Attendance

Number of Shifts Unlimited

Number of Schedules Unlimited

Number of User per Schedule Unlimited

Shift Type Fixed, Flexible, Floating
Time Card Supported

Number of Leave per User Unlimited

Calendar View Supported

Note

= Check the License for features that your license supports.

License

You can use more features by registering the activation key after purchasing the BioStar 2 license.
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For more information on license activation, refer to License.

License for Access Control

Items Starter Basic Standard Advance Professio Enterprls
(Free) nal

Unlim Unlim Unlim Unlim Unlim Unlim
User ited ited ited ited ited ited
Max.
) 1,000 1,000 1,000 1,000 1,000 1,000
Device
Max.
5 20 50 100 300 1,000
Door
Supp Supp Supp Supp
Zone - -
orted orted orted orted
Acces Elevator - - - Supp Supp Supp
S orted orted orted
Contr Graphic - - - Supp Supp Supp
ol Map orted orted orted
Server - - - Supp Supp Supp
Matchin orted orted orted
g
Cloud - - Supp Supp Supp Supp
orted orted orted orted
Active - - - Supp Supp Supp
Director orted orted orted
y

Note

= If there is an AC Standard license already in use, it is replaced by an Advance license.

License for Time Attendance

Starter
Items Standard Advanced Professional
(Free)

Number of Users 1,000 Unlimited

Note

= |f there is an Time Attendance license already in use, it is replaced by an Professional license.

License for Video
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Video Log - Supported

License for Visitor

Visitor Management - Supported

Versions

BioStar 2.9.4

New and improved features

General = |Improved Administrator menu Ul on the DEVICE detail page

Y = Added Template on Mobile feature
ser
= Supports Custom Smart Card Layout

Supports BioStaion 2a
Device . . ;
= Supports U&Z Wireless Door Lock connection to CoreStation

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.7.1 or later
= FaceStation 2: 1.5.3 or later
= CoreStation: 1.6.1 or later
= BioEntry P2: 1.4.4 or later
= BioEntry R2: 1.4.1 or later
= BioLite N2: 1.6.0 or later
= XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.7.1 or later
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= Facelite: 1.3.4 or later

= XPass 2: 1.3.2 or later

= FaceStation F2: 2.1.4 or later
= X-Station 2: 1.2.2 or later

= OM-120: 1.2.1 or later

= Secure I/0 2: 1.3.1 or later

= DM-20: 1.2.2 or later

= IM-120: 1.0.0 or later

= BioStation 3: 1.1.1 or later

BioStar 2.9.3

New and improved features

Category Functionality

= Added REPORT feature related to access control events
General = Updated German, French, Romanian, Russian, Polish, Czech, Greek, and

Italian resource files

Devi = Supports keypad Backlight of XPass D2
evice
= Supports QR code authentication in BioStation 3

= Added CARD PRINTER feature
Setting = Added SYSTEM BACKUP and RESTORE feature
= Stabilization of 'Specific Devices' Automatic User Synchronization option

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.7.1 or later
= FaceStation 2: 1.5.3 or later
= CoreStation: 1.6.1 or later
= BioEntry P2: 1.4.4 or later
= BioEntry R2: 1.4.1 or later
= BioLite N2: 1.5.0 or later
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= XPass D2: 1.3.2 or later

= XPass D2 (Rev 2): 1.7.1 or later
= Facelite: 1.3.4 or later

= XPass 2: 1.3.2 or later

= FaceStation F2: 2.1.3 or later
= X-Station 2: 1.2.2 or later

=  OM-120: 1.2.1 or later

= Secure I/0 2: 1.3.1 or later

= DM-20: 1.2.2 or later

= [M-120: 1.0.0 or later

= BioStation 3: 1.1.0 or later

BioStar 2.9.2

New and improved features

Setting = Improved security of login password vulnerabilities for brute-force attack

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.7.1 or later
= FaceStation 2: 1.5.3 or later
= CoreStation: 1.5.3 or later
= BioEntry P2: 1.4.4 or later
= BioEntry R2: 1.4.1 or later
= BiolLite N2: 1.5.0 or later
» XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.7.0 or later
= Facelite: 1.3.4 or later
» XPass 2: 1.3.2 or later
= FaceStation F2: 2.1.2 or later
= X-Station 2: 1.2.0 or later
= OM-120: 1.2.1 or later
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= Secure I/0 2: 1.3.1 or later
= DM-20: 1.2.2 or later
= IM-120: 1.0.0 or later
= BioStation 3: 1.0.2 or later

BioStar 2.9.1

New and improved features

= |[mproved main screen
General . . . .

= Added features to activate licenses to use specific features of the device
User = |mproved security and usability when downloading CSV files
Device = Support 31 party OSDP devices as a reader for CoreStation

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.7.1 or later
= FaceStation 2: 1.5.3 or later
= CoreStation: 1.5.3 or later
= BioEntry P2: 1.4.4 or later
= BioEntry R2: 1.4.1 or later
= Biolite N2: 1.5.0 or later
= XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.7.0 or later
= Facelite: 1.3.4 or later
= XPass 2: 1.3.2 or later
= FaceStation F2: 2.1.2 or later
= X-Station 2: 1.2.0 or later
= OM-120: 1.2.1 or later
= Secure I/0 2: 1.3.1 or later
= DM-20: 1.2.2 or later
= [M-120: 1.0.0 or later
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= BioStation 3: 1.0.2 or later

BioStar 2.9.0

New and improved features

Category Functionality

General = Adopted Improved Visual Face Algorithm

= Added Visual Face Import
User = Added Visual Face Migration
= Added User Configuration Partial Update

= Supports BioStation 3 (BS3-DB, BS3-APWB)

= When a sync error occurs because of exceeding the maximum number of
Device
users or credentials in the device, the error message explains the reason

for the sync error.

Compatible firmware
= BioLite Net: 2.3.5 or later

BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later

» XPass: 2.4.4 or later

=  XPass S2: 2.4.4 or later

= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.7.0 or later
= FaceStation 2: 1.5.2 or later
= CoreStation: 1.5.2 or later

= BioEntry P2: 1.4.3 or later

= BioEntry R2: 1.4.1 or later

= BioLite N2: 1.5.0 or later

= XPass D2: 1.3.2 or later

= XPass D2 (Rev 2): 1.6.0 or later
= Facelite: 1.3.2 or later

= XPass 2: 1.3.1 or later

= FaceStation F2: 2.0.3 or later
= X-Station 2: 1.1.3 or later

= OM-120: 1.2.1 or later

= Secure I/0 2: 1.3.1 or later
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= DM-20: 1.2.2 or later
= [M-120: 1.0.0 or later

BioStar 2.8.17

New and improved features

= Supports setting the storage period of punch logs
Time & Attendance PP 9 gep p g

= Improved security vulnerabilities

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
» XPass S2: 2.4.4 or later
= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.6.3 or later
= FaceStation 2: 1.5.1 or later
= CoreStation: 1.5.2 or later
= BioEntry P2: 1.4.3 or later
= BioEntry R2: 1.4.1 or later
= BioLite N2: 1.4.1 or later
= XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.6.0 or later
= Facelite: 1.3.2 or later
= XPass 2: 1.2.4 or later
= FaceStation F2: 2.0.3 or later
= X-Station 2: 1.1.3 or later
= OM-120: 1.2.1 or later
= Secure I/0 2: 1.3.1 or later
= DM-20: 1.2.2 or later
= IM-120: 1.0.0 or later

BioStar 2.8.16
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New and improved features

= Added visual face to the dashboard

= Added setting.config file initialization logic

General = Added procedure to accept to collection and use of the privacy when
using cloud

= Updated German and French resource files

= |mproved the visual face mobile enrollment usability

- Improved the user interface of Visual Face Mobile Enrollment page

- Added footer to email sending the visual face mobile enrollment link
User = Added Error_Description column to user list file that failed CSV import
= Added Hide Face Credential Preview Image option

= Added the Use QR as card option

= |Improved USB Device Agent security vulnerabilities
Device = Supports setting the byte order for smart cards

= Allows connecting X-Station 2 as a slave device of CoreStation

= Added relay deactivation option for exit button input
Door
= Added 'All Devices' option to dual authentication setting to door

Zone = |mproved occupancy limit zone monitoring page

= Separated the log related to door unlock
Monitoring - Door Unlocked (Exit Button)
- Door Unlocked (By Operator)

Video = Improved security vulnerabilities

= Added option to delete unassigned card
Settin
g = Support to log in to BioStar 2 with Active Directory account

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.1 or later
= BioStation A2: 1.9.1 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.6.3 or later
= FaceStation 2: 1.5.1 or later

10
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= CoreStation: 1.5.2 or later

= BioEntry P2: 1.4.3 or later

= BioEntry R2: 1.4.1 or later

= Biolite N2: 1.4.1 or later

= XPass D2: 1.3.2 or later

= XPass D2 (Rev 2): 1.6.0 or later
= Facelite: 1.3.2 or later

= XPass 2: 1.2.4 or later

= FaceStation F2: 1.1.4 or later
= X-Station 2: 1.1.3 or later

= OM-120: 1.2.1 or later

= Secure I/0 2: 1.3.1 or later

= DM-20: 1.2.2 or later

= [M-120: 1.0.0 or later

BioStar 2.8.15

New and improved features

General = Applied Log4j 2 v2.17.1

Setting = Stabilization of features for automatic user synchronization

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
» XPass S2: 2.4.4 or later
= BioStation 2: 1.10.0 or later
= BioStation A2: 1.9.0 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.6.3 or later
= FaceStation 2: 1.5.1 or later
= CoreStation: 1.5.2 or later
= BioEntry P2: 1.4.3 or later
= BioEntry R2: 1.4.1 or later
= BioLite N2: 1.4.1 or later
= XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.5.0 or later

11
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= Facelite: 1.3.1 or later

= XPass 2: 1.2.4 or later

= FaceStation F2: 1.1.2 or later
= X-Station 2: 1.1.2 or later

= OM-120: 1.2.1 or later

= Secure I/0 2: 1.3.1 or later

= DM-20: 1.2.2 or later

= IM-120: 1.0.0 or later

BioStar 2.8.14

New and improved features

= Supports OpenJDK

= Applied Log4j 2 v2.16.0

= Improved security vulnerabilities
= Updated APIs in Swagger

General
= Improved the server performance
= Improved the performance of processing data on the database
= 26 hit Wiegand card option support for BioStar 1.x to BioStar 2.x
Migration Tool
User = Supports PIN enroliment via CSV Import

= Supports Input Module (IM-120)
Device = Supports 1:N security level setting for CoreStation
= Improved the speed of connecting devices

Door = Changed the default value of held open setting
Access Control = Improved the speed of linking access groups

o = Improved event log processing performance
Monitoring

= Improved the speed of accessing the monitoring menu

Setting = Stabilization of features for automatic user synchronization

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.0 or later

12
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= BioStation A2: 1.9.0 or later
= BioStation L2: 1.6.1 or later

= BioEntry W2: 1.6.3 or later

= FaceStation 2: 1.5.0 or later
= CoreStation: 1.5.2 or later

= BioEntry P2: 1.4.2 or later

= BioEntry R2: 1.4.1 or later

= Biolite N2: 1.4.1 or later

= XPass D2: 1.3.2 or later

= XPass D2 (Rev 2): 1.5.0 or later
= Facelite: 1.3.0 or later

=  XPass 2: 1.2.4 or later

= FaceStation F2: 1.1.2 or later
= X-Station 2: 1.1.0 or later

=  OM-120: 1.2.0 or later

= Secure I/0 2: 1.3.0 or later

= DM-20: 1.2.1 or later

= [M-120: 1.0.0 or later

BioStar 2.8.13

New and improved features

= Created the T&A report inquiry API

= Supports private SSL certificates with a passphrase
Time & Attendance = Changed the TLS default version to 1.2

= Updated T&A APIs in Swagger

= Improved of the T&A report inquiry performance

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.0 or later
= BioStation A2: 1.9.0 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.6.3 or later
= FaceStation 2: 1.5.0 or later

13
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= CoreStation: 1.5.1 or later

= BioEntry P2: 1.4.1 or later

= BioEntry R2: 1.4.1 or later

= Biolite N2: 1.4.0 or later

= XPass D2: 1.3.2 or later

= XPass D2 (Rev 2): 1.5.0 or later
= Facelite: 1.3.0 or later

=  XPass 2: 1.2.3 or later

= FaceStation F2: 1.1.1 or later
= X-Station 2: 1.1.0 or later

=  OM-120: 1.2.0 or later

= Secure I/O 2: 1.3.0 or later

= DM-20: 1.2.1 or later

BioStar 2.8.12

New and improved features

Category Functionality

Device = Supports X-Station 2 Fingerprint model (XS2-ODPB, XS2-OAPB)

14

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.10.0 or later
= BioStation A2: 1.9.0 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.6.3 or later
= FaceStation 2: 1.5.0 or later
= CoreStation: 1.5.1 or later
= BioEntry P2: 1.4.1 or later
= BioEntry R2: 1.4.1 or later
= Biolite N2: 1.4.0 or later
= XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.5.0 or later
= Facelite: 1.3.0 or later
=  XPass 2: 1.2.3 or later
= FaceStation F2: 1.1.1 or later
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= X-Station 2: 1.0.3 or later
= OM-120: 1.2.0 or later

= Secure I/0 2: 1.3.0 or later
= DM-20: 1.2.1 or later

BioStar 2.8.11

New and improved features

= Updated APIs in Swagger
General .

= Updated a Japanese resource file

= Supports a new credential
User

- QR/Barcode

Device = Supports X-Station 2 (XS2-QDPB, XS2-QAPB, XS2-DPB, XS2-APB)
Zone = Supports Occupancy Limit Zone
Setting = Separated email settings of both Visual Face Mobile Enroliment and QR

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.9.0 or later
= BioStation A2: 1.8.0 or later
= BioStation L2: 1.6.1 or later
= BioEntry W2: 1.6.3 or later
= FaceStation 2: 1.4.2 or later
= CoreStation: 1.5.1 or later
= BioEntry P2: 1.4.1 or later
= BioEntry R2: 1.4.1 or later
= Biolite N2: 1.3.2 or later
» XPass D2: 1.3.2 or later
= XPass D2 (Rev 2): 1.5.0 or later
= Facelite: 1.2.0 or later
» XPass 2: 1.2.3 or later
= FaceStation F2: 1.0.5 or later
= X-Station 2: 1.0.1 or later
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= OM-120: 1.2.0 or later
= Secure I/0 2: 1.3.0 or later
= DM-20: 1.2.1 or later

BioStar 2.8.10

New and improved features

= Supplementation of New Local API
General ]
= Updated a German resource file

= Supports a drag & drop method when registering Visual Face with
‘Upload Image'

= Provides guidance on success or failure of Visual Face Mobile Enroliment

= Supports new Date File Export/Import

User

= Added minimum threshold temperature setting function on the thermal
] camera

Device )
= Supports Intelligent Slave

= Screen saver option support for FaceStation 2, FaceStation F2

Setting = Improved Email Settings

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» XPass: 2.4.4 or later
=  XPass S2: 2.4.4 or later
= BioStation 2: 1.9.0 or later
= BioStation A2: 1.8.0 or later
= BioStation L2: 1.6.0 or later
= BioEntry W2: 1.6.2 or later
= FaceStation 2: 1.4.0 or later
= CoreStation: 1.4.1 or later
= BioEntry P2: 1.4.0 or later
= BioEntry R2: 1.4.0 or later
= BioLite N2: 1.3.2 or later
= XPass D2: 1.3.1 or later
= XPass D2 (Rev 2): 1.4.2 or later
= Facelite: 1.2.0 or later
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XPass 2: 1.2.2 or later
FaceStation F2: 1.0.2 or later
OM-120: 1.2.0 or later
Secure 1/0 2: 1.3.0 or later
DM-20: 1.2.0 or later

BioStar 2.8.9

New and improved features

Category Functionality

General = Updated some language resource files
= Displays user information on the Mobile Access Cards
User = Provides a guide on the screen when registering Visual Face on the
mobile device
Time & Attendance = |mproves server synchronization structure
= Stabilization of features for Mobile Access
Setting - Supports Dynamic site
- Improves a user interface

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.9.0 or later
BioStation A2: 1.8.0 or later
BioStation L2: 1.6.0 or later
BioEntry W2: 1.6.1 or later
FaceStation 2: 1.4.0 or later
CoreStation: 1.4.1 or later
BioEntry P2: 1.4.0 or later
BioEntry R2: 1.4.0 or later
BioLite N2: 1.3.2 or later
XPass D2: 1.3.1 or later
XPass D2 (Rev 2): 1.4.2 or later
Facelite: 1.2.0 or later
XPass 2: 1.2.2 or later
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= FaceStation F2: 1.0.1 or later
= OM-120: 1.2.0 or later

= Secure I/0 2: 1.3.0 or later

= DM-20: 1.2.0 or later

BioStar 2.8.8

New and improved features

= BioStar 2 performance improvements
General )
= Supplementation of New Local API
User = Supports batch registration of Visual Face using CSV import
Device = Stabilization of features for thermal camera
Monitoring = Supports thermal report
Time & Attendance = Fixed bugs of some features in the TIME ATTENDANCE menu
) = Email contents improvements
Setting o . ) . o .
= Stabilization of 'Specific Devices' Automatic User Synchronization option

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» XPass: 2.4.4 or later
=  XPass S2: 2.4.4 or later
= BioStation 2: 1.9.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.6.0 or later
= BioEntry W2: 1.6.0 or later
= FaceStation 2: 1.4.0 or later
= CoreStation: 1.4.1 or later
= BioEntry P2: 1.4.0 or later
= BioEntry R2: 1.4.0 or later
= BioLite N2: 1.3.2 or later
= XPass D2: 1.3.1 or later
= XPass D2 (Rev 2): 1.4.2 or later
= Facelite: 1.1.0 or later
= XPass 2: 1.2.2 or later
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= FaceStation F2: 1.0.0 or later
= OM-120: 1.2.0 or later

= Secure I/0 2: 1.3.0 or later

= DM-20: 1.2.0 or later

BioStar 2.8.6

New and improved features

= Supports server matching on FaceStation 2

. = Supports thermal camera on face authentication devices
Device

= Support FaceStation F2
= Support BioEntry W2 (Rev 2)

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.6.0 or later
= BioEntry W2: 1.5.0 or later
= FaceStation 2: 1.3.1 or later
= CoreStation: 1.4.0 or later
= BioEntry P2: 1.4.0 or later
= BioEntry R2: 1.4.0 or later
= BiolLite N2: 1.3.1 or later
= XPass D2: 1.3.1 or later
= XPass D2 (Rev 2): 1.4.1 or later
= Facelite: 1.1.0 or later
= XPass 2: 1.2.1 or later
=  OM-120: 1.2.0 or later
= Secure I/0 2: 1.3.0 or later
= DM-20: 1.2.0 or later

BioStar 2.8.5
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New and improved features

Functionality

= Supports Wiegand devices

Time & Attendance = Improved the Individual Report usability

= Supports users to update TA reports

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.1 or later
BioStation L2: 1.6.0 or later
BioEntry W2: 1.5.0 or later
FaceStation 2: 1.3.1 or later
CoreStation: 1.4.0 or later
BioEntry P2: 1.4.0 or later
BioEntry R2: 1.4.0 or later
BioLite N2: 1.3.1 or later
XPass D2: 1.3.1 or later
XPass D2 (Rev 2): 1.4.1 or later
Facelite: 1.1.0 or later
XPass 2: 1.2.1 or later
OM-120: 1.2.0 or later
Secure 1/0 2: 1.3.0 or later
DM-20: 1.2.0 or later

BioStar 2.8.4

New and improved features

Category Functionality

General

= Supplementation of New Local API
= Improvement of backup and recovery logic for Web-App, CGI server
system.conf

= Exclusion of TLS V1.1 for improved security
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Category Functionality

= [mproved Thrift communication logic log

= Improved security vulnerabilities on Redis

U = [mproved the logic for issuing mobile access cards
ser
= Improved the logic for issuing mobile access cards using the CSV

Setting = Stabilization of features for mobile access cards

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
= BioEntry W2: 1.5.0 or later
= FaceStation 2: 1.3.1 or later
= CoreStation: 1.4.0 or later
= BioEntry P2: 1.4.0 or later
= BioEntry R2: 1.4.0 or later
= Biolite N2: 1.3.1 or later
» XPass D2: 1.3.1 or later
= XPass D2 (Rev 2): 1.4.1 or later
= Facelite: 1.1.0 or later
= XPass 2: 1.2.1 or later
=  OM-120: 1.2.0 or later
= Secure I/0 2: 1.3.0 or later
= DM-20: 1.2.0 or later

BioStar 2.8.3

New and improved features

General = Updated language resource files

Devi = Supports FaceStation 2 and FacelLite as a slave of CoreStation
evice
= Supports Mobile Access on BioLite N2
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Category Functionality

Elevator

Setting

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.1 or later
BioStation L2: 1.5.1 or later
BioEntry W2: 1.4.1 or later
FaceStation 2: 1.3.1 or later
CoreStation: 1.4.0 or later
BioEntry P2: 1.4.0 or later
BioEntry R2: 1.4.0 or later
BioLite N2: 1.3.0 or later
XPass D2: 1.3.0 or later

XPass D2 (Rev 2): 1.4.0 or later

FacelLite: 1.1.0 or later
XPass 2: 1.2.1 or later
OM-120: 1.1.0 or later
Secure 1/0 2: 1.3.0 or later
DM-20: 1.2.0 or later

BioStar 2.8.2

New and

General

improved features

= Fixed local file inclusion (LFI) vulnerability

22

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

= |mproved the scheduled unlock zone function to support elevator

= Supports Zone in the Admin Item Settings of the custom level

Functionality
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= XPass S2: 2.4.4 or later

= BioStation 2: 1.8.0 or later

= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.1 or later
= CoreStation: 1.3.1 or later

= BioEntry P2: 1.3.1 or later

= BioEntry R2: 1.4.0 or later

= BioLite N2: 1.2.0 or later

= XPass D2: 1.3.0 or later

= XPass D2 (Rev 2): 1.4.0 or later
= Facelite: 1.1.0 or later

= XPass 2: 1.2.0 or later

=  OM-120: 1.1.0 or later

= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later

BioStar 2.8.1

New and improved features

Category Functionality

General = Supports MS SQL Server 2019

Time & Attendance = Move the 'In/Out Only and 'All Punches' options in the Individual Report

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
» XPass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.1 or later
= CoreStation: 1.3.1 or later
= BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.4.0 or later
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= BiolLite N2: 1.2.0 or later

= XPass D2: 1.3.0 or later

= XPass D2 (Rev 2): 1.4.0 or later
= Facelite: 1.1.0 or later

» XPass 2: 1.2.0 or later

= OM-120: 1.1.0 or later

= Secure I/0 2: 1.2.4 or later

= DM-20: 1.1.5 or later

BioStar 2.8.0

New and improved features

General = DB encryption to enhance security on personal information

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
» XPass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.0 or later
= CoreStation: 1.3.1 or later
= BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.3.1 or later
= BiolLite N2: 1.2.0 or later
= XPass D2: 1.2.0 or later
= XPass D2 (Rev 2): 1.4.0 or later
= Facelite: 1.1.0 or later
= XPass 2: 1.1.0 or later
=  OM-120: 1.1.0 or later
= Secure I/0 2: 1.2.4 or later
= DM-20: 1.1.5 or later
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BioStar 2.7.14

New and improved features

= Supports Windows Authentication for MS SQL database server
connections

= Supports MS SQL Server 2017

= Added the Floor Control API to BioStar 2 APl Documents

General

Device = Support XPass D2(Rev 2)

= Enhancement in Mobile Access usage
Settin
g = Stabilization of 'Specific Devices' Automatic User Synchronization option

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.0 or later
= CoreStation: 1.3.1 or later
= BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.3.1 or later
= BiolLite N2: 1.2.0 or later
= XPass D2: 1.2.0 or later
= Facelite: 1.1.0 or later
= XPass 2: 1.1.0 or later
=  OM-120: 1.1.0 or later
= Secure I/0 2: 1.2.4 or later
= DM-20: 1.1.5 or later

BioStar 2.7.12

New and improved features
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Category Functionality

Time & Attendance = Support to generate TA reports simultaneously on multiple clients

Setting

= Added the new Suprema Mobile Access

= Stabilized 'Specific Devices' Automatic User Synchronization option

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.0 or later
BioStation L2: 1.5.1 or later
BioEntry W2: 1.4.1 or later
FaceStation 2: 1.3.0 or later
CoreStation: 1.3.1 or later
BioEntry P2: 1.3.1 or later
BioEntry R2: 1.3.1 or later
BioLite N2: 1.2.0 or later
XPass D2: 1.2.0 or later
FacelLite: 1.1.0 or later
XPass 2: 1.1.0 or later
OM-120: 1.1.0 or later
Secure I/0 2: 1.2.4 or later
DM-20: 1.1.5 or later

BioStar 2.7.11

New and improved features

Category Functionality

General = |mproved dashboard usability
User = Added User IP item to User Information
Devi = Supports the alert sound for 'Input(Event Name Change)' in the <Trigger &
evice
Action>
o = Supports the sorting of lists for the User ID and User Group column of the
Monitoring
<Muster Status> page
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Setting

Functionality

= Enhances the system security
= Added 'Specific Devices(Only devices belonging to the access group)’

option to <Automatic User Synchronization>

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.0 or later
BioStation L2: 1.5.1 or later
BioEntry W2: 1.4.1 or later
FaceStation 2: 1.3.0 or later
CoreStation: 1.3.0 or later
BioEntry P2: 1.3.1 or later
BioEntry R2: 1.3.1 or later
BioLite N2: 1.2.0 or later
XPass D2: 1.2.0 or later
Facelite: 1.1.0 or later
XPass 2: 1.1.0 or later
OM-120: 1.1.0 or later
Secure I/0 2: 1.2.4 or later
DM-20: 1.1.5 or later

BioStar 2.7.10

New and improved features

= Support FacelLite

Device

= Support XPass 2

= Improve the Custom Level

= Support to use the custom user field in the T&A report
Time & Attendance = Supports the sorting for entire data in the T&A report

= Added option to select 'First in & Last Out' or 'All in/Out Punches' to search

conditions of the individual report
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Category Functionality

Visitor

= Support to the USB fingerprint scanner connection (BioMini, BioMini Plus,
BioMini Plus 2)

Setting

= Update the resource files of Japanese, Arabic, and Spanish

= Add Automatic backup function for Setting.conf file

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.0 or later
BioStation L2: 1.5.0 or later
BioEntry W2: 1.4.0 or later
FaceStation 2: 1.3.0 or later
CoreStation: 1.3.0 or later
BioEntry P2: 1.3.0 or later
BioEntry R2: 1.3.0 or later
BioLite N2: 1.2.0 or later
XPass D2: 1.2.0 or later
Facelite: 1.1.0 or later
XPass 2: 1.0.1 or later
OM-120: 1.1.0 or later
Secure I/0 2: 1.2.4 or later
DM-20: 1.1.5 or later

BioStar 2.7.8

New and improved features

= Supports multiple use function of controllers in CoreStation
= Supports options for selection by card type

Device = Supports the fingerprint/face duplicate check

= Supports Anti-Tailgating

= Supports setting options for Wiegand authentication result output
Door = Supports Anti-Tailgating
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Category Functionality

Visitor

= Supports to search option for visitors using fingerprints

Setting

= Supports user group synchronization in Active Directory
= Supports Anti-Tailgating

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.7.1 or later
BioStation A2: 1.6.0 or later
BioStation L2: 1.5.0 or later
BioEntry W2: 1.4.0 or later
FaceStation 2: 1.2.1 or later
CoreStation: 1.3.0 or later
BioEntry P2: 1.3.0 or later
BioEntry R2: 1.3.0 or later
BioLite N2: 1.1.0 or later
XPass D2: 1.2.0 or later
FacelLite: 1.0.0 or later
XPass 2: 1.0.0 or later
OM-120: 1.1.0 or later
Secure I/0 2: 1.2.4 or later
DM-20: 1.1.4 or later

BioStar 2.7.7

New and improved features

General = Change the license policy
Visitor = Add the VISITOR menu
Setting = Add the settings for visitor management

Compatible firmware

BioLite Net: 2.3.5 or later
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= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later

= XPass: 2.4.4 or later

= XPass S2: 2.4.4 or later

= BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later

= BioEntry R2: 1.2.0 or later

= BiolLite N2: 1.1.0 or later

= XPass D2: 1.1.0 or later

=  OM-120: 1.1.0 or later

= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.6

New and improved features

Category Functionality

General = Add BioStar 1.x to BioStar 2.x Migration Tool

Monitoring Support to the Clear APB for each user

= Add the event items to IMAGE LOG menu

Setti = Add the encryption option to Active Directory menu
ettin

g = Supports that the administrator can change the port 9000 in FastCGI of

Port menu

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
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= FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later

= BioEntry P2: 1.2.0 or later

= BioEntry R2: 1.2.0 or later

= BiolLite N2: 1.1.0 or later

= XPass D2: 1.1.0 or later

=  OM-120: 1.1.0 or later

= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.5

New and improved features

Category Functionality

User = Support to the list sorting for group and status column

= Support to the list sorting for RS-485 column
Device = Remove the unsupported AoC events
= Added an Ambient Brightness option to the FaceStation 2 slave device

Door = Support to the list sorting for group column

Video = Remove the unsupported AoC events

= Add the Active Directory menu
Setting = Supports that the administrator can change the port 9000 in setting.conf

= Remove the unsupported AoC events

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
» XPass S2: 2.4.4 or later
= BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
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= BioLite N2: 1.1.0 or later

= XPass D2: 1.1.0 or later

=  OM-120: 1.1.0 or later

= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.4

New and improved features

Category Functionality

= Support for Quick Enroliment for FaceStation 2

Device )
(FaceStation 2 FW V1.2.2 or later)
= Limits the use of passwords that contain the same string, consecutive
string, and login ID
Setting = Limits reuse of the same password

= Support to Spanish and Arabic

= Expanding the number of custom levels to unlimited

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» XPass: 2.4.4 or later
=  XPass S2: 2.4.4 or later
= BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
= BioLite N2: 1.1.0 or later
= XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
= Secure I/0 2: 1.2.4 or later
= DM-20: 1.1.4 or later
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BioStar 2.7.3

New and improved features

= Increase the number of administrators that can be added per device
Device = Change the way new settings are applied when adding administrators
using batch edit of devices

Setting = Support for reconnection of devices configured as a port forwarding

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
» XPass S2: 2.4.4 or later
= BioStation 2: 1.7.0 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.0 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
= BioLite N2: 1.1.0 or later
= XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
= Secure I/0 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.2

New and improved features

Category Functionality

= Support to Live Video View on Graphic Map
Monitoring = Support to viewing Anti-passback Zone and Fire Alarm Zone on Graphic
Map

i = Supports <Allowed a day before/after time> setting for working 24 hours
Time & Attendance
or longer
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Category Functionality

= Add the Security menu

=« Change Password Level options

Setting = Support to the setting for Maximum Password Age and Maximum
Password Change Limit

= Support to the setting options for password failures at login

= Support to the Storage Path Settings for image logs

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.7.0 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.0 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
= BioLite N2: 1.1.0 or later
= XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
= Secure I/0 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.1

New and improved features

Device = Support to Input(Event Name Change) in Trigger & Action
= Support to the OM-120 Relay time setting value from 1 second
User = Support for deleting users stored on the device
o = Provides the log about whether a user has been updated on the device or
Monitoring
the server
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Category Functionality

= Supports synchronization of all devices connected to the server when
Setti users update the device

etting
= Adds root password verification procedures during installation and

upgrade

Compatible firmware
= Biolite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.7.0 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.0 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
= BiolLite N2: 1.1.0 or later
= XPass D2: 1.1.0 or later
=  OM-120: 1.1.0 or later
= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.0

New and improved features

Category Functionality

= Support to the number of users, fingerprints, faces, and cards in

Device ) ]

Manage Users in Device
Access Control = Support for a larger number of access groups and access groups
Monitoring = Support to Graphic Map

= Support to Working alarm time report

= Improve the process for generating the time card
= Support to the separator option in CSV export

= Support to Floating shift

Time & Attendance
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Category Functionality

= Support to Fixed option in Meal deduction and Break Time
= Support to Weekend days setting option in Schedule Template

Setting

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.7.0 or later
BioStation A2: 1.6.0 or later
BioStation L2: 1.4.0 or later
BioEntry W2: 1.3.0 or later
FaceStation 2: 1.2.0 or later
CoreStation: 1.2.0 or later
BioEntry P2: 1.2.0 or later
BioEntry R2: 1.2.0 or later
BioLite N2: 1.1.0 or later
XPass D2: 1.1.0 or later
OM-120: 1.1.0 or later
Secure I/0 2: 1.2.4 or later
DM-20: 1.1.4 or later

BioStar 2.6.4

New and improved features

Setting
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Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
XPass: 2.4.4 or later
XPass S2: 2.4.4 or later

= Support to Custom Account Level in T&A
= Support to AES encryption type for DESFire card
= Support to DESFire Advanced option

Functionality

= Support to set the same action for different triggers
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= BioStation 2: 1.6.2 or later
= BioStation A2: 1.5.1 or later
= BioStation L2: 1.3.2 or later
= BioEntry W2: 1.2.3 or later
= FaceStation 2: 1.1.1 or later
= CoreStation: 1.1.2 or later
= BioEntry P2: 1.1.2 or later

= BioEntry R2: 1.1.1 or later

= BiolLite N2: 1.0.2 or later

= XPass D2: 1.0.2 or later

= OM-120: 1.0.0 or later

= Secure I/0 2: 1.2.1 or later
= DM-20: 1.1.2 or later

BioStar 2.6.3

New and improved features

Category Functionality

Setting = Support Admin Item Settings when configuring Custom Account Level

Compatible firmware
= BiolLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.3 or later
= BioEntry W: 2.3.3 or later
= XPass: 2.4.4 or later
= XPass S2: 2.4.4 or later
= BioStation 2: 1.6.1 or later
= BioStation A2: 1.5.1 or later
= BioStation L2: 1.3.1 or later
= BioEntry W2: 1.2.1 or later
= FaceStation 2: 1.1.1 or later
= CoreStation: 1.1.1 or later
= BioEntry P2: 1.1.1 or later
= BioEntry R2: 1.1.0 or later
= Biolite N2: 1.0.2 or later
= XPass D2: 1.0.1 or later
= OM-120: 1.0.0 or later
= Secure I/0 2: 1.2.1 or later
= DM-20: 1.1.2 or later
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BioStar 2.6.2

New and improved features

User = Support the user information export/import by using the external
storage (USB)

Video = Support the real-time video monitoring

Monitoring = Support the event log import by using the external storage (USB)

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.3 or later
BioEntry W: 2.3.3 or later
XPass: 2.4.4 or later

XPass S2: 2.4.4 or later
BioStation 2: 1.6.1 or later
BioStation A2: 1.5.1 or later
BioStation L2: 1.3.1 or later
BioEntry W2: 1.2.1 or later
FaceStation 2: 1.1.1 or later
CoreStation: 1.1.1 or later
BioEntry P2: 1.1.1 or later
BioEntry R2: 1.1.0 or later
BioLite N2: 1.0.2 or later
XPass D2: 1.0.1 or later
OM-120: 1.0.0 or later
Secure I/0 2: 1.2.1 or later
DM-20: 1.1.2 or later

BioStar 2.6.0

New and improved features

General

Functionality

= Support the Daylight Saving Time(DST)

= Support the database encryption key management
= Support the system ports setting

= Support the system logs management

38



1 BioStar 2 Overview

Firmware upgrade notifications supported
Change the license policy

User & Card

Support for the auto-Increase User IDs

Support the iICLASS Seos card setting

Support the hexadecimal values for the primary and secondary site keys
on the smart card

Wiegand card search supported from the Unassigned card menu
Support for automatic deletion of user information when issuing an AoC
card

Wiegand Legacy Mode Support

Blacklist card deletion support

Device

Support BioLite N2

Support XPass D2

Support BioMini Plus 2

Support the user information and log deletion when a tamper event
occurs (secure tamper)

Device reset excluding network settings

Wiegand In/Out Support

Zone

Support the interlock zone
Support the muster zone

Video

Support MS SQL for Video log
Support the video file storage management

Monitoring

Add door column to event log list

Compatible firmware

BioLite Net: 2.3.3 or later
BioEntry Plus: 2.3.3 or later
BioEntry W: 2.3.3 or later
XPass: 2.4.3 or later

XPass S2: 2.4.3 or later
BioStation 2: 1.6.0 or later
BioStation A2: 1.5.0 or later
BioStation L2: 1.3.0 or later
BioEntry W2: 1.2.0 or later
FaceStation 2: 1.1.0 or later
CoreStation: 1.1.0 or later
BioEntry P2: 1.1.0 or later
BioEntry R2: 1.1.0 or later
BioLite N2: 1.0.0 or later
XPass D2: 1.0.0 or later
OM-120: 1.0.0 or later
Secure I/0 2: 1.2.1 or later
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= DM-20: 1.1.2 or later

BioStar 2.5.0

New and improved features

Category Functionality

= Setting https as the default communication protocol
= Oracle Database not supported

General

= Supports CoreStation

= Supports BioEntry P2

Device = Supports BioEntry R2

= Supports the enroliment of a fingerprint from the slave device(BioLite
Net does not support this feature)

Zone = Supports Intrusion Alarm zone (Local)

= Event Log, Real-time Log: T&A Key column added
Monitoring = Event Log: Supports the period setting
= Supports video log

= Supports NVRs (ACTi, Dahua, Hikvision)
= Supports IP cameras

Video

= Alert: Network disconnection detection alert added

Settin
g = Supports Audit Trail

Compatible firmware
= BioLite Net: 2.3.3 or later
= BioEntry Plus: 2.3.3 or later
= BioEntry W: 2.3.3 or later
= XPass: 2.4.3 or later
= XPass S2: 2.4.3 or later
= BioStation 2: 1.5.0 or later
= BioStation A2: 1.4.0 or later
= BioStation L2: 1.2.3 or later
= BioEntry W2: 1.1.4 or later
= FaceStation 2: 1.0.3 or later
= CoreStation: 1.0.0 or later
= BioEntry P2: 1.0.0 or later
= BioEntry R2: 1.0.0 or later
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BioStar 2.4.1

New and improved features

General

Supports Mobile Card (NFC, BLE)

Device

Supports FaceStation 2

Time & Attendance

Enhanced UI/UX

Merge the time card with T&A report

Display of daily T&A records

Time rate setting is excluded from the time code for leave management.
Break time is displayed on the time slot when fixed work is used.

It is possible to set the Min. Duration and Punch in Time Limit when
flexible work is used.

Setting

Supports Face Group Matching

Compatible firmware

= BioLite Net: 2.4.0 or later

= BioEntry Plus: 2.4.0 or later
= BioEntry W: 2.4.0 or later

= XPass: 2.4.1 or later

= XPass S2: 2.4.0 or later

= BioStation 2: 1.4.0 or later

= BioStation A2: 1.3.0 or later
= BioStation L2: 1.2.2 or later
= BioEntry W2: 1.1.2 or later
= FaceStation 2: 1.0.0 or later

BioStar 2.4.0

New and improved features

Supports elevator management

General )
= Supporting Oracle Database 11g, 12c
= Supports OM-120
Device = Supports card USB device (DUALi DE-620)

Supports secure communication between BioStar 2 and a device

Time & Attendance

Supports time & attendance report PDF export
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= Change of detailed custom permission setting
Setting = Supports user ID type setting (numbers/alphanumeric characters)
= Supports dd/mm/yyyy date format

Compatible firmware
= BioLite Net: 2.4.0 or later
= BioEntry Plus: 2.4.0 or later
= BioEntry W: 2.4.0 or later
= XPass: 2.4.0 or later
= XPass S2: 2.4.0 or later
= BioStation 2: 1.4.0 or later
= BioStation A2: 1.3.0 or later
= BioStation L2: 1.2.2 or later
= BioEntry W2: 1.1.2 or later

BioStar 2.3.0

New and improved features

= Supporting a low-resolution monitor
= Improvement in list page move

General

User = Improvement importing/exporting CSV files

= Supporting BioStation A2 video phone (SIP based)
Device = Supporting the batch editing the device manager
= Supporting an additional information display of a device firmware

Door = Supporting an automatic door setting

= Supporting Wiegand card's facility code setting

= Supporting the batch editing the Wiegand card data format

= Supporting BioStar 2 alert sound's upload and setting (.wav, .mp3)
= Supporting the custom account level (up to 32)

Setting

Compatible firmware
= BioLite Net: 2.3.0 or later
= BioEntry Plus: 2.3.0 or later
= BioEntry W: 2.3.0 or later
= XPass: 2.3.0 or later
= XPass S2: 2.3.0 or later
= BioStation 2: 1.3.0 or later
= BioStation A2: 1.2.0 or later
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= BioStation L2: 1.1.0 or later
= BioEntry W2: 1.0.0 or later

BioStar 2.2.2

New and improved features

= BioEntry W2 support

Compatible firmware
= Biolite Net: 2.2.3 or later
= BioEntry Plus: 2.2.3 or later
= BioEntry W: 2.2.3 or later
= XPass: 2.2.3 or later
» XPass S2: 2.2.3 or later
= BioStation 2: 1.3.0 or later
= BioStation A2: 1.1.0 or later
= BioStation L2: 1.0.0 or later
= BioEntry W2: 1.0.0 or later

BioStar 2.2.1

New and improved features
= BioStation L2 support
= Long-term idle user management
= Access control privilege management per user
= Automatic database backup
= Enrollment device management

= Custom user fields

Compatible firmware
= Biolite Net: 2.2.3 or later
= BioEntry Plus: 2.2.3 or later
= BioEntry W: 2.2.3 or later
= XPass: 2.2.3 or later
= XPass S2: 2.2.3 or later
= BioStation 2: 1.3.0 or later
= BioStation A2: 1.1.0 or later
= BioStation L2: 1.0.0 or later



1 BioStar 2 Overview

BioStar 2.2.0

New and improved features
= BioStation A2 support
= Access On Card
= Secure Credential Card
= Global Anti-passback zone
= Image Log

Compatible firmware
= BiolLite Net: 2.2.3 or later
= BioEntry Plus: 2.2.3 or later
= BioEntry W: 2.2.3 or later
» XPass: 2.2.3 or later
= XPass S2: 2.2.3 or later
= BioStation 2: 1.2.0 or later
= BioStation A2: 1.0.0 or later

BioStar 2.1.0

New and improved features
= BioStar API
= DM-20 support
= Global Anti-passback zone / Local Fire Alarm zone / Local Anti-passback zone
= More secure login password
= License management
= BioStar 2 Cloud support
= BioStar 2 Mobile support

= Zone status monitoring

Compatible firmware
= BioLite Net: 2.0.4 or later
= BioEntry Plus: 2.0.4 or later
= BioEntry W: 2.0.4 or later
= XPass: 2.0.4 or later
= XPass S2: 2.0.4 or later
= BioStation 2: 1.0.1 or later
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BioStar 2.0.1

New and improved features
= BioStation 2 support
= Wireless LAN configuration
= T&A configuration
= Interphone configuration
= Display and sound configuration
= CSV import and export
= Multi-language resource support
= Memory optimization of BioStar 2 server

Compatible firmware
= BiolLite Net: 2.0.0 or later
= BioEntry Plus: 2.0.0 or later
= BioEntry W: 2.0.0 or later
= XPass: 2.0.0 or later
= XPass S2: 2.0.0 or later

Before using BioStar 2 to implement an access control system, the BioStar 2 server must be installed on
the administrator PC.
The BioStar 2 server receives event logs, user information, etc. from connected devices and stores

them.

BioStar 2 can be installed easily. Before installation, please check the Minimum System Requirements.
The BioStar 2 installation file can be found on the Suprema’'s home page(https://

WWW.supremainc.com).

Minimum System Requirements

Installing BioStar 2

Minimum System Requirements

Total
Environment ota 110 50 51 to 100 101 to 1,000
Devices
Svstern Windows 7(SP1 or higher), Windows 8, Windows 8.1, Windows 10,
¥ . Windows 11, Windows Server 2008 R2(SP2 or higher), Windows
requirement (O] . :
(Server) Server 2012, Windows Server 2012 R2, Windows Server 2016,
Windows Server 2019, Windows Server 2022
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2 Installation

= Windows virtual environments on Mac Boot Camp are not
supported.
Datab MariaDB 10.1.10, MS SQL Server 2012 SP3, MS SQL Server 2014
t:
atabas | spo, Ms SQL Server 2016 SP1, MS SQL Server 2017, MS SQL
e
Server 2019
CPU 2 GHz Dual Core 4 GHz Quad Core 4 GHz 16 Core
RAM 8 GB 16 GB 32GB
SSD 512 GB 1TB 1TB
CPU 1 GHz 1 GHz 1 GHz
RAM 4 GB 4 GB 4 GB
System Google Chrome version 75 or higher
requirement
(Client) Web Note
Browser
= To use the Report menu, use a web browser with Google
Chrome version 93 or higher.

BioStar 2 Video Extension

CPU 4 GHz Quad Core 4 GHz Quad Core
RAM 8 GB 16 GB
HDD 27TB 4TB

Note

= For the best performance, use only the 64-bit operating system.

= BioStar 2 is optimized for Google Chrome.

= To use the Video menu, use the 64bits MariaDB or MS SQL database.

= BioStar 2 supports Windows 7, but Microsoft's technical support for Windows 7 has ended. Be
aware of the OS selection when installing the system.

= If you are using Windows 8.1 or Windows Server 2012 R2, install the KB2919355 update by
referring to the following web page.
https://support.microsoft.com/en-us/help/2919355/windows-rt-8-1--windows-8-1--and-
windows-server-2012-r2-update-april-2

= If MS SQL Server and BioStar 2 are installed on different PCs, you should install the Native
Client on a PC with BioStar 2 installed.

https://www.microsoft.com/en-us/download/details.aspx?id=50402
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= Oracle Database is no longer supported. For details, please contact the Suprema Technical
Support.

Installing BioStar 2

BioStar 2 supports a 32-bit operating system and a 64-bit operating system. Check the system type of

your PC where BioStar 2 is to be installed and carry out its installation accordingly.

Note

= Installation files for 32-bit operating systems are not provided from BioStar 2.9.2.

= Do not install BioStar 2 on a PC where BioStar 1 is installed. This may cause performance
problems.

= If BioStar 2.3.0 is installed on top of a BioStar 2.2.1 or 2.2.2 installation, all information stored
in the SQLite database is migrated to a new MariaDB database.

= Upgrading directly from the existing version to the latest version is possible from BioStar 2.6.0
or higher. If the installed version is lower than 2.6.0, installing all versions in a correct

sequence until reaching version v2.6.0 is essential.

2 221>23>24>241>25.0>2.6.4> Latest Version
2.2
2.2.1 2.3>24>24.1>25.0>2.6.4> Latest Version
2.2.2
2.3 2.4>24.1>25.0> 2.6.4 > Latest Version
2.4 2.4.1 > 2.5.0 > 2.6.4 > Latest Version
2.5 .
2.6.4 > Latest Version
2.6
2.6.4 or higher Latest Version

= If you are using Windows 8.1 or Windows Server 2012 R2, install the KB2919355 update by
referring to the following web page.
https://support.microsoft.com/en-us/help/2919355/windows-rt-8-1--windows-8-1--and-
windows-server-2012-r2-update-april-2

= If you are using MS SQL 2012 Express, install the Service Pack 3 by referring to the following
web page.
https://www.microsoft.com/en-us/download/details.aspx?id=49996

= If you are using MS SQL 2014 Express, install the Service Pack 2 by referring to the following
web page.
https://www.microsoft.com/en-us/download/details.aspx?id=53168

= If MS SQL Server and BioStar 2 are installed on different PCs, you should install the Native
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Client on a PC with BioStar 2 installed.
https://www.microsoft.com/en-us/download/details.aspx?id=50402

If you are using MS SQL Server, set the Collation option of the server and each table to ClI
(Case-insensitive).

When backing up a database from an older version of BioStar 2, disable all services and
procedures. Furthermore, if you do not back up and restore the AC database and the TA
database together, you will not be able to use the TA database.

If you want to back up the database of BioStar 2, be sure to also back up the enckey in the

W Program FilesW BioStar 2 (x64)W util folder and the system.conf and setting.conf file in the
W Program FilesW BioStar 2(x64) folder. Otherwise, the database will be unavailable.

The default values for the ports used by BioStar 2 are as follows. If another program occupies
the same port, BioStar 2 may not work properly.

Port

* HTTP Port Available + HTTPS Port

* Web-socket Port Available + APl Port
* Database Port Available * T&AHTTP Port
* T&A HTTPS Port * T&A Cloud Port

* FastCGI Port Available * Unified Gateway HTTP Port

AIRAIRAIEAIEA TR
S

* Unified Gateway Available + Report HTTP port

HTTPS Port

SRR IBAIEAISEATRA A

* Report HTTPS port Available

If you use a database configured by the user directly, check the following items before installing BioStar
2.

= MariaDB
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= Open the my.cnf file and then change some configurations under

[mysqld] as shown below.

character-set-server=utf8
collation-server=utf8_unicode_ci
max_connections = 600

= Open the my.cnf file and then add some configurations under [mysqld]

as shown below.

log_bin_trust function_creators = 1
group_concat_max_len = 102400

= Access MariaDB with the root permission and execute the following

command.

> GRANT SUPER ON. TO user_id@'localhost' IDENTIFIED BY "passwo
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= MS SQL Server

Note

> GRANT SUPER ON. TO user_id@'%' IDENTIFIED BY "password";

All database and tables should set the Collation as Cl(case-insensitive).

Setting the port

a)

b)

Run SQL Server Configuration Manager and set TCP/IP Protocol
for Protocols for SQLEXPRESS to the desired port number.

Restart SQL Server Services to apply the settings.

Creating the user and database

Log in to the sa account using SQL Server Authentication in SQL
Server Management Studio.

Right-click on Security and click New Login.

Enter the desired name in the Login Name field and select SQL Server
Authentication.

Enter the desired password in the Password and Confirm password
field, and then uncheck the Enforce password policy.

Click OK to save the settings.

Right-click on Database and click New Database.

Enter the desired name in the Database Name field.

Enter the login name in the Owner field. Use the login name set in step
C).

In the Database Files section, we recommend that set the Initial Size
(MB) to 3000 and set the Autogrowth/Maxsize to By 10 MB,
Unlimited.

Setting the Windows Authentication database

1. Presetting

If you ar

e using Microsoft Windows Active Directory, complete the presets as

below before setting up the Windows Authentication database.

a)

Log in to SQL Server Management Studio with an administrator
account.

Right-click on Security and click New Login.

Select Windows Authentication and click Search.

In the Select a user or group window, click Location, then select the
Active Directory path and click OK.

Enter the user name in the object name field, then click Check Names
> OK.
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f) Click Server Roles in the Select a page.

g) Select sysadmin and click OK.

h) Click User Mapping in the Select a page.

i) Select ac, master, ta, ve and set the Default Schema to dbo.
j) Click OK to save the settings.

2. Settings to use MS SQL Windows Authentication with Active Directory
account
a) Run services.msc and log in as a domain user by selecting Specify
account in the MSSQL DB's Properties > Logon.
b) Add port 1433 as an exception to your Windows firewall.
¢) Create an empty ac, ta, ve database in MS SQL with sysadmin
authentication.
d) Enable Windows Authentication for domain users in MS SQL and assign
all permissions except sysadmin to the ac, ta, ve databases.
e) Connect all services except Local Computer in services.msc.
f) Set the domain user as an administrator on the local service computer.
g) ODBC connection to MSSQL.

3. Setting the database

a) Run SQL Server Configuration Manager and click Client Protocol
under SQL Native Client Configuration.

b) Select TCP/IP and check the default port.

¢) Click Protocols for SQLEXPRESS under SQL Server Network
Configuration.

d) Make sure that the ODBC port is set to the same as the default port in
TCP/IP.

e) Loginto SQL Server Management Studio by an administrator
account.

f) Click Security> Logins and then double-click NT AUTHORITY
W SYSTEM.

g) Click Server Roles in the Select a page.

h) Select public, sysadmin, and then click OK.

i) Click User Mapping in the Select a page.

j) Select the ac, master, ta, and ve databases and click OK to save.

1) Double-click the downloaded setup program. (ex. 'BioStar 2 Setup.x.x.X.xxx.exe")
2) Select a language and click OK.
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3)

4)

5)

Select Setup Language b4
m Select the language to use during the installation:
English Lo

=

To continue the installation, select | accept the agreement and click Next.

— - -

k% Setup - BioStar 2(x64 _

License Agreement
Please read the following important information before continuing.

agreement before continuing with the installation.

Software End User License Agreement ~

SUPREMA INC.

|

1

|

I

I Please read the following License Agreement. You must accept the terms of this
i

]

|

[

[ SOFTWARE LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE INSTALLING OR USING THE SOFTWARE OR ANY ACCOMPANYING v

i @ I accept the agreement
(7)1 do not accept the agreement

Enter the password for admin account and click Next. The password set in this step will be used

when you log in to BioStar 2.

&4 Setup - BioStar 2(x64) — >

Admin User
Enter the password for admin user,

Lsername : admin

Password : | |

Confirm password : | |

1. It must contain between & and 16 characters.

2. It can contain only English letters, numbers from 0 to 9,
and certain special characters (e.q. !, §, #, %).

3. It must contain at least one alphabet character and at least one number.,

\Warning
-Admin user password must be managed carefully not to be forgotten,

Install the database to be used in BioStar 2. You can install a new MariaDB or connect it to the

already-installed MariaDB. Installing BioStar 2 for the first time, please select Express Installation
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and click Next.

k4 Setup - BioStar 2(x64) — X

Database installation type
Select a database type for BioStar 2. You can either install a new database or
connect the existing database.

® Express installation:
Use this option for quick installation with the built-in MariaDB server.

The installer will automatically install the MariaDE database server
and create the database.

(") Custom installation

Use this option to create database schema on an existing database

on a database server (MariaDB [ MSSQL) on the local or remote server.,
Make sure that the database and user account are created and configured
before starting the installation.

6) If Express Installation has been selected from Database Installation Type, enter the database
managers account password and click Next. If Custom Installation has been selected from
Database Installation Type, enter the detailed information on the already-configured database
and click Next.

&4 Setup - BioStar 2(x64) - d

Express Installation
Enter the password for database root account.

Username : root

Password : | |

Confirm password : | |

1. It must contain between & and 16 characters.
2. It can contain only English letters, numbers from 0 to 9,
and certain special characters (e.q. !, §, #, %).
3. Enter the existing root account password when upgrading the server.

Warning
-Root account password must be manaaed carefully not to be forgotten.
-Root account password is also used as the initial AC, TA, Video DB passwords.
-When the password is lost, it will not be able to make a version upgrade

and DB backup/recovery.
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k% Setup - BioStar 2(x64) — >
-
Custom installation
If you choose database type, you must enter the Root privilege account 4
information,
DE Type : Maria DB ~

sever?: [ | veosname: [ ]
severport: || veusemame: [ |
\Warning
AC Password : l:l -All database and tables should set
the Collation as Cl{case-insensitive).

TA Password : I:l Generate the database tables

Note

= BioStar 2 supports the following databases.
- MariaDB 10.1.10
- MS SQL Server 2012 SP3
- MS SQL Server 2014 SP2
- MS SQL Server 2016 SP1
- MS SQL Server 2017
- MS SQL Server 2019
« If the database table creation fails when MS SQL Server is set as the Database Type, you can
create the table by executing the script in C:W Program FilesW BioStar 2 (x64)W dbscript
W mssq|l folder.
= When installing with custom settings, AC DB name, TA DB name, and VE DB name cannot

be set the same.

7) Click Next after setting a path for BioStar 2 to be installed.
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&4 Setup - BioStar 2(x64) - d

Select Destination Location
Where should BioStar 2{x64) be installed?

Setup will install Biostar 2(x64) into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

C: WProgram FilesWBioStar 2(x64) Browse...

Atleast 352.8 MB of free disk space is required.

8) Click Next after setting a path for the encryption key to be stored.
L& Setup - BioStar 2(x64) - X

Encrypt Key Storage Directory
Select the location to store the encrpyt key

'Select a folder to store the encrypt key and dick ‘Next'

To continue, click Next, If you would like to select a different folder, click Browse.
Browse, .

Warning
Select the path where the encrypt key file will be stored,
Please do not alter the file once the location is set,

< Back Canceal

Note

= You can set a path for the encryption key to be stored. However, if the encryption key file is
modified or moved after selecting the path, a system error may occur.
= If you delete BioStar 2, the encryption key files will be deleted.

9) Read the instructions on the responsibility for protecting personal information stored in the
database and click Next to continue the installation.
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k% Setup - BioStar 2(x64) —

Responsibility for protecting personal information

Please be aware the system administrator has the responsibility to comply with the
applicable laws of each country when using personal information, biometric data
or any other stored material. To protect the data stored in the database, itis
recommended to use the Encrypt Personal Data on Database option,

10) Enter the port number and click Next.

k% Setup - BioStar 2(x64) —

Port Setting
Port Setting Enter a valid port number,

HTTPS Port for Web Server

Enter the desired port number between 10 and 65534,
The default port number is 443,

Availability: Ok

Device Port for Communication

Enter the desired port number between 10 and 65534,
The default port number is 51212,

51212 | Awailability: OK

Cancel

Note

= When you install BioStar 2 on a PC where BioStar 1 is installed, the device port (51212) is not

available. In this case, we recommend that uninstall BioStar 1.

9) Select a component of BioStar 2 and click Next. If you select USB Device Agent, a USB-Agent and
a driver for using BioMini, BloMini Plus 2, and DUALI DE-620 will be installed together.
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&4 Setup - BioStar 2(x64) - d

Select Components
Which components should be installed?

Select the companents you want to install; dear the components you do not want to
install, Clidk Next when you are ready to continue.

Full installation w

BinStar 2 4,002.7 MB
4,002.7 MB

USE Device Agent

Current selection requires at least 4,087.9 ME of disk space.

10) If ready to install, click Install.

&4 Setup - BioStar 2(x64) - d

Ready to Install
Setup is now ready to begin installing BioStar 2(x54) on your computer.,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:%Program FilesWBioStar 2(x54)

Setup type:
Full installation

Selected components:
BioStar 2
Server
USE Device Agent

< Back Install Cancel

11) Select whether to install additional program and click Finish. Follow on screen instructions to
complete.
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&4 Setup - BioStar 2(x64)

Completing the BioStar 2(x64)
Setup Wizard

Setup has finished installing BioStar 2(x64) on your computer,
The application may be launched by selecting the installed
shortcuts.

Click Finish to exit Setup.

Note

= The USB Device Agent Certificate provided can be applied to a local network only.

=  When another program uses port 443, BioStar-Setting program will be launched automatically
and then you can change the port number. For more information, see Changing port of
BioStar 2.

= For more information on Database setting changes, see Changing database of BioStar 2.

BioStar 2 is a web-based system which can be accessed from anywhere as long as you remember your

login ID and password.

1) Run your web browser.
= We recommend that you use Google Chrome 75 or later.

2) Run BioStar 2.
= If running from the PC installed with BioStar 2, enter 'https://127.0.0.1" in the address input

field of the web browser.
= If BioStar 2 is installed on another PC, enter 'https://BioStar 2 server IP address' in the address

input field of the web browser.
= Do not use the 'Localhost' to access the BioStar 2.

Note

= BioStar 2 uses port 443. If port 443 is used by a program, quit the program and try again. If
the program cannot be closed, run 'Biostar Setting' to change the port number. For more
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information, see Changing port of BioStar 2.

3) Log in with the administrator account. The administrator account ID is admin’and when you log in

for the first time, Not secure warning will be displayed in the address bar.

A Not secure | b#pE://127.0.0.1/%/login

4) To use HTTPS properly, register the IP address of the PC where BioStar 2 is installed. Click
Download HTTPS certification install program.

BioStar 2

Meed help?

Download HTTPS certification install program

5) Unzip the downloaded file and run cert-register.exe file. Enrollment Certification window will

appears.

6) Enter the IP address of the PC where BioStar 2 is installed and click Enrollment.

' N
Enrollment Certification

Server Address :

Cancel

7) Check the security warning message and click Yes.

8) When you restart the web browser and enter the registered IP address, Secure will appear on the

address bar of the web browser.

8 Sccure | https)//LEUHE 28/ #/login
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Changing server status of BioStar 2

You can check the status of the BioStar 2 server and stop or start the server.

1) Click im Start > BioStar 2 > BioStar Setting.

|& BioStar Setting

— Service Status

Test Connection |

Video IbiosL—dr_\fe Ibios'.—drveuser

IThe Core Web Server service has been started. I Running Stop
—
R —
IThe BioStar 2 service has been started. I Running Stap
——
IThe Ta&A& Web Server service has been started. I Running Stop
—rt
IThe Video License is not activated. I Running Stop
——
IThe Report Server service has been started I Running Stop
—rt
—Web Server Configuration
P’ HTTPS Port I“"'3
—Unified Gateway
Port |50EI2 IThe Unified Gateway has been stopped. Stopped Start
—Database Server Configuration
DB Type |Maria DB
Host |12?.n.u.1 Port |3312
Database Name Database User Database Password
AC IbiDEL?I’E_aC IbiusL—drE_ac_user FEEEEEEE
TA Ibinsi.?r_tna IbiosL—drtnauser Fmmm
B

2) Click Stop button of the server you want to stop.
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— Service Status

The Core Web Server service has been started. Running Sto
p

L]

——

IThe BioStar 2 service has been started. I Running Sto
p

—

——

IThe Ta&A Web Server service has been started. I Running Stop

—rt

IThe Video License is not activated. I Stopped Start

L]

—rt

IThe Report Server service has been started I Running Stop

—r——

3) Click Start button to restart the server.
—Service Status

IThe Core Web Server service has been stopped. I Stopped Start

—rt

IThe BioStar 2 service has been started. I Running Sto
p

L]

——

TeA The T&A Web Server service has been started Runnin

= I y . I g Stop

——

IThe Video License is not activated. I Stopped Start

—rt

IThe Report Server service has been started I Running Stop

—rt

Note

= If the time setting on the BioStar 2 server has changed, stop and restart the Core Web
Server. Otherwise, BioStar 2 may not work properly.

Changing port of BioStar 2

You can change the port used by BioStar 2. If BioStar 2 cannot use port 443, run BioStar Setting to
change the port.

Note

= If you use MS SQL as a database, when changes the port in BioStar 2, you must also change
the port manually in the database. Otherwise, BioStar 2 may be disconnected from the
database and may not work properly.

Changing with BioStar Setting (HTTPS port)

1) Click = Start > BioStar 2 > BioStar Setting.
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|y BioStar Setting

—Service Status
IThe Core Web Server service has been started. I Running Stop
—
—t—
The BioStar 2 service has been started. Running Stoy
— p
—t—
m . :
! IThe T&A Web Server service has been started. I Running Stop
—t—
IThe Video License is not activated. I Running Stop
—
—t—
IThe Report Server service has been started I Running Stop
—t—
—Web Server Configuration
P HTTPS Port | #43
~ Unified Gateway
Part |5002 IThe Unified Gateway has been stopped. I Stopped Start
—Database Server Configuration
DB Type  |Maria DB
Host [127.0.0.1 Port [2312
Database Name Database User Database Password
AC Ibinst:lrz_ac IbiasGrE_ac_user FEEE
TA Ibinsl]r_tna Ibiusmrtnauser F
Video Ibiasmr_ve Ibiusﬁweuser ERARRES
Test Connection | Save |
2) Click the Stop button for all BioStar 2 services. HTTPS Port is activated.
3) Enter the port number in HTTPS port field.
—Service Status
The Core Web Server service has been stopped. Stopped Start
—
—t—
IThe BioStar 2 service has been stopped. I Stopped Start
=t
IThe T&A Web Server service has been stopped. I Stopped Start
——
IThe Video License is not activated. I Stopped Start
—t—
IThe Report Server service has been stopped. I Stopped Start
L]
=t

~Web Server Configuration

HTTPS port | 443
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4) Click the Start button for all BioStar 2 services.
5) Run BioStar 2. If using port 450, enter 'IP address:450".

Changing with BioStar 2 for all port

Note

= The items may vary depending on the type of license that is activated.

1) Log in to BioStar 2 and click on the port. All ports in use in BioStar 2 are
displayed.

Port

* HTTP Port * HTTPS Port

* Web-socket Port * APIPort
+ Database Port + TBAHTTP Port
+ T&A HTTPS Port + T&A Cloud Port

+ FastCGl Port + Unified Gateway HTTP Port

AR IBATRAIRAIEAY
> r = oz E 3

* Unified Gateway
HTTPS Port

* Report HTTP port

ASRAYRAYEAIRA A TBAS
E x r = r E 3

* Report HTTPS port

2) Click the # of the port to change and enter the desired value.
3) Click Apply to save the settings.

Unified Gateway Setting

You can change the execution port of BioStar 2 to the Unified Gateway.
Unified Gateway allows efficient processing of requests to the BioStar 2 server through the reverse proxy
method, improves security vulnerabilities in iframes, and minimizes SSL certificate errors.

Note

= When installing or upgrading BioStar 2, the Unified Gateway is Inactive, and the default
port values are as follows.
- Unified Gateway HTTPS Port: 5002
- Unified Gateway HTTP Port: 5000

Setting up Unified Gateway in BioStar Setting

1) Click i Start > BioStar 2 > BioStar Setting.
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&y BioStar Setting
—Service Status
IThe Core Web Server service has been started. I Running Stop
—_——
—h
IThe BioStar 2 service has been started. I Running Stop
—_—— i
—h
IThe T&A Web Server service has been started. I Running Stop
—h
IThe Video License is not activated. I Running Stop
—_——
—h
IThe Report Server service has been started I Running Stop
—h—
—Web Server Configuration
P HTTPS Port | #43
~ Unified Gateway
Part |5002 IThe Unified Gateway has been stopped. I Stopped Start
—Database Server Configuration
DB Type |Maria DB
Host |12?.u.n.1 Port |3312
Database Mame Database User Database Password
AC IbinstarE_ac IbiastarE_ac_user FEEE
TA Ibin;tar_tna Ibiustartnauser FEmmm—
Video Ibiastar_ve Ibiustarveuser F
Test Connection | Save |

2) Click the Start button in the Unified Gateway section. Unified Gateway

becomes active.

Note

= Activating Unified Gateway will restart the server.
= If the portis in use, a pop-up message will appear. Enter a different port
number and activate it again.

3) If the HTTPS connection, the HTTPS Port field changes to 5002 and the
Unified Gateway's Port field changes to 443.
To change the port, click Stop to stop Unified Gateway and then change it.
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Web Server Configuration

/g HTTPS port | 2002

Unified Gateway

Port ‘443 ‘The Unified Gateway has been started. Running Stop

Setting up Unified Gateway in BioStar 2

1) Click Settings > Security.
2) Activate Unified Gateway in Unified Gateway Setting.

Unified Gateway Setting

* Unified Gateway Active

Note

= When you activate Unified Gateway, the server restarts and
automatically directed to the login page.

= If the portis in use, a pop-up message will appear. Enter a different port
number and activate it again.

Changing database of BioStar 2

You can change the database settings of BioStar 2.

1) Click i Start > BioStar 2 > BioStar Setting.
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&y BioStar Setting

— Service Status
IThe Core Web Server service has been started. I Running Stop
—
——
IThe BioStar 2 service has been started. I Running Stop
—rt
m i il il
- IThe Ta&A Web Server service has been started. I Running Stap
——
IThe Video License is not activated. I Running Stop
—rt
IThe Report Server service has been started I Running Stop
—rt
—Web Server Configuration
/( HTTPS Port I““3
—Unified Gateway
Port IEUUE IThe Unified Gateway has been stopped. Stopped Start
—Database Server Configuration
DB Type IMaria DB
Host [127.0.0.1 Port [3312
Database Name Database User Database Password
AC Ibiu:usL?r2_ac Ibiosﬁrz_ac_user FEmmmE
TA Ibinsiar_tna Ibius’l]rtnauser R
Video IbiusL—dr_\.fe Ibiusﬁweuser FR
Test Connection | Save |

DB Type

Host

AC

TA

Video

—Database Server Configuration

2) Click the Stop button for all BioStar 2 services. Database Server Configuration is activated.

|Maria DB

|12?.u.0.1

Database Name

Port |3312

Database User

Database Password

IbiosGrz_ac Ibios’mrz_ac_user FEFFHETFE
Ibiostar_tna Ibit}sGrtnauser g
EmEmmE R R R

I biostar_ve

Test Connection

IbiosGrveuser

| Save
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3) Edit the necessary fields. If you are not sure about the each information, contact your system
administrator.

4) Click Test Connection to check if the database has been set properly.

5) Click Save to save the settings.

BioStar 2 provides web-based services and various functions concerning access control.

Access groups configured in BioStar 2 refer to access privileges. An access group can be configured
using a combination of user, access level and door (device) information.

Below is a step-by-step guide on how to use BioStar 2.

Q Step 1. Register Activation Key

You can use more features by registering the activation key after purchasing the BioStar 2 license.

Related Information

Q Step 2. Adding Devices

Add devices to connect to BioStar 2. You can set up an authentication mode for each device type or
assign an administrator to each device.

You can also configure actions to be performed according to various events (authentication failure,
duress fingerprint authentication, Anti-passback violation, etc.) occurring in the device.

(® Related Information

Q Step 3. Adding and Configuring Doors

Add the information on the doors installed with devices. You can configure relay, Anti-passback, dual
authentication, alarm, etc.

(® Related Information
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Q Step 4. Configuring Access Levels

You can create an access level by combining door and schedule information. Multiple doors and

schedules can be registered to a single access level.

® Related Information

Q Step 5. Configuring Access Groups

You can create an access group by combining access level (doors and schedules) and user information.

Multiple access levels and users can be registered to a single access group.

® Related Information

Q Step 6. Adding Users

Add the information to use for access control such as user information, fingerprints, etc. User
information can be registered directly on the device or on the PC running BioStar 2. You can also fetch
the user information registered within the device to BioStar 2 or transfer the user information registered
within BioStar to the device.

(® Related Information

Q Step 7. Zone Configuration

You can configure anti-passback and fire alarm zone. The fire alarm can be set to local zone and global
zone. Only available when purchasing a standard license.

Related Information
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Zone Status

Q Step 8. Viewing Logs

You can view event logs, device status, door status and alert history, or just view the real-time log

information.

® Related Information
Event Log
Real-time Log
Device Status
Door Status

Alert History

The DASHBOARD gives you an overview of the major event status, usage status, notice, alarms, etc.

Dashboard
Overview Week Month Year
23 March 2022 ~ 29 March 2022
10
8
-
1 6 / \
4
2
.
23 24 25 26 27 28 29
Usaue Notice
BB - what's new with BioStar 2.8.15
2 4
uur vuu-l Face Fnca Finwpnm caru Device Door Zone mus Group
371000 21000 0/1000
Missed Alarm
3 2022/03/24 08:40 Facelite 547832712 (192.168.12.166) Device Disconnection Detected
2022/03/24 08:35 Facelite 547832712 (192.168.12.166) Device Disconnection Detected

1 Alert Event Status by Period < Notice
z Usage Status £ Alert List

2 Missed Alarm
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Note

= You can set what to display in "Alert Event Status by Period" in the Setting > Alert.

= 15 alarms that have been missed in the last 1 month displayed in ‘Missed Alarm' in the latest
order.

= You can view the list of monitored alerts and write notes by clicking the alert list icon.

Alert List X

| View History | \EHZ\ \Ilﬂ \I||I| ‘ 50 rows w ‘

Date evice s a

|
=]
]
[ ]
=
El

2016/07/25 10:59 BioLiteNet 538101276 RS-485 disconnected

2016/07/25 10:58 BioStation 2 546832590 (192.168.16.108) kyle Access denied (Invalid access group)

O odnf

2016/07/25 10:55 BioStation A2 541531008 (192.168.16.20... Tamper on

Related Information

Alert History

You can use the DEVICE menu to add, delete or edit registered devices, fetch the user information
registered within the device to the server or upgrade the firmware.

Adding and Managing Device Groups

Basic Search and Registration

Advanced Search and Registration

Wiegand Device Search and Registration

Slave Device Search and Registration

Registering and replacing 3rd party OSDP devices on CoreStation
Managing Users Registered with Devices

Upgrading Firmware

Editing Device Settings and Information



6 Device

1|
o[l

i

Basic Search

- 2 3 :
—:/ATDevices X 1A Slliovs |7||:\
Qv e =

All Devices

E BioStation L2 542501048 {

546832506 BioStation 2 546832506 All Devices BioStation 2 Hormal

g CoreStation 40 123400068
542501048 BioStation L2 542501048 ( All Devices BioStation L2 192.168.14.125 Normal

. BioStation 2 546832506
123400068 CoreStation 40 123400068 (... ~ All Devices corestationd0 [ 192.168.14.124  Normal
Viaiting Device

USB Device

Function Button (Delete Data & Sync
Device, Print, Column Setting)

o

Advanced Search ¢ Device List

Page Navigation Buttons and Number of List Rows i Device and Group List
Registered Device Search ¢ Expand Button

Note

Registered devices can be searched by Device ID, Name, Device Address.
Only BioMini can be connected as USB device.

When you select a device on the list, you can use the following functions.
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Reconnect: Reconnects the selected device. This function is available when only one device
is selected.

Sync Device: Synchronizes the user and access control information from BioStar 2 with the
registered devices. The synchronization will occur based on the information on the server
database, and the users that exist on the devices only will be deleted. Click Manage Users in
Device to retrieve users from the device to the BioStar server.

Delete Data & Sync Device: You can delete user related data including users, access
groups and schedules on the device and transfer the data on the server to the device. On the

device list page, select the target devices, click the Function button (| *** ) and choose the
Delete Data & Sync Device.

Batch Edit: Edits the information on multiple devices at once. This function is available only
when multiple devices are selected.

Manage Users in Device: Uploads the user information registered with the device to BioStar
2 or deletes it.

Firmware Upgrade: Easily upgrades the firmware of the device.

Delete Device: Deletes the selected device from the list. You cannot delete a device that is
set as a door or a zone.
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Adding and Managing Device Groups

You can register device groups for easy management of multiple devices. Name your device groups

according to installation locations of the devices for greater convenience.

= Adding Device Groups

1) Click DEVICE.
2) Right-click on All Devices and click Add Device Group.

All Devices

Add Device Group

3) Enter a name.

Note

= Device groups may be created in up to 8 levels.

= Up to 48 characters may be entered for a device group name.

= Renaming Device Groups

1) Click DEVICE.
2) Right-click on the name of a group you wish to rename and click Rename

Device Group.

All Devices

16F

Add Device Group
276 (1!

Rename Device Group

01268

Delete Device Group

Walling Uevice

3) Enter a name.

Note

= Up to 48 characters may be entered for a device group name.

= Deleting Device Groups
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1) Click DEVICE.
2) Right-click on the name of a group you wish to delete and click Delete Device
Group.

All Devices

16F

Add Device Group
276 (1!
Rename Device Group

01268
Delete Device Group

ing vevice

Note

= Deleting a group deletes all devices included in the group.

Basic Search and Registration

You can automatically search for devices connected to BioStar 2 and register them. Before searching for
devices, check whether they are correctly connected. When adding multiple devices at once, it will be
more convenient to know the location, ID and IP address information of each device in advance.

1) Click DEVICE > SEARCH DEVICE.
2) All available devices are shown. When the user ID type is mismatch with BioStar 2, the user ID type
of the device will be automatically changed according to BioStar 2.

Search Device X

Found 7 device(s). 2 device(s) have invalid IP addresses. o m

/[ Dayloe Name Group (m:;g::e) IP Address Status Secyire Mode

[] 541531041 BioStation A2 541531041 (. rd All Devices BioStation A2 ] 192.168.16.179 0K Connectable.

[[] 546832590 BioStation 2 546832590 (19.. # All Devices w BioStation2 [ 192.168.16.196 oK Connectable.

[[] 546832437 BioStation 2 546832437 (19.. rd All Devices BioStation 2 192.168.16.193 0K Connectable.

[[] 541531014 BioStation A2 541531014 (.. 4 All Devices w Biostation A2 [[] 192.168.16.160 0K Connectable.

[] 539308121 BioEntryPlus 539308121 (1 V4 All Devices w BioEntryPlus ] 192.168.16.239 OK Connectable.
544108056 E’{ggf‘fgﬂg_g;g;%"“ All Devices sioentyw2 [ 19216816238 o, N o Connectable.
542501008 ?{gg_‘?g;’_q é_-22§r]1)2501008 All Devices BioStation L2 192.168.16.231 (192_1'2’?_1_23] Connectable.

| SetIP | | Add ‘ [ Close ]

3) To view newly found devices only, click ¥ and then click Show New Devices Only.
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4)

5)

6)

)
8)

Search Option

Show Mew Devices Only

« Timeout(sec) | 3 |

Note

= To hide devices which do not respond within a set period of time, click £¥ and then enter a
duration in Timeout(sec).

= If the devices you are looking for are not shown on the list, click Search to search for the
devices again.

You may change the Name and Group of a device found to anything you like. If the IP address of
the device cannot be used or otherwise needs to be changed, click Set IP to change it.
To use a dynamic IP address, select Use DHCP. To manually enter the IP Address, Subnet Mask
and Gateway, deselect the option. To enter the BioStar 2 network information, select Device —
Server Connection and enter the Server Address and Server Port.
Set IP X
Device ID Device Type S
547838254 BioStation 3 « IP Address 197.168.12.180
+ Subnet Mask 255.255.255.0
+ Gateway 192.168.12.1
+ Device Port 51211
Device » Server Connection
+ Server Address | 192.168.1.1 |
« Server Port | si22 | |
. -
To save the IP settings, click Apply.
To register the configured device, click Add.
Select the registered device, and click Sync Device.
Note

= If you add a new device, the key of the device changed to the value of the data encryption key
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on the server. All user data on the device will be deleted when the key is changed.

= If you want to delete user related data including users, access groups and schedules on the
device and transfer the data on the server to the device, click the Delete Data & Sync
Device. On the device list page, select the target devices, click the Function button (Eb and
choose the Delete Data & Sync Device.

= After registering a device, you can edit its details by referring to Editing Device Settings and
Information.

= To register all waiting devices in the Waiting Device group, right-click on the group name
and click Add All Waiting Devices. To register each device, right-click on the device name
and click Add Waiting Device.

= If a different user ID type is set for BioStar 2 and a device, change the device setting
according to the user ID setting of BioStar 2.

= If the user ID type of BioStar 2 is set with alphanumeric characters, some devices may not be
used and/or limitations may occur. For more details, refer to Server.

Advanced Search and Registration
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You can register a device by specifying its IP address and port number.

1) Click DEVICE > ADVANCED SEARCH.

2) Enter the IP address and port number of a device to search.

3) Click Search to view the list of devices found. If the device you are looking for is not shown on the
list, click Search to search again.

Advanced Search *

538101276 BioLiteMNet 538101276 (192.168.1. BE 23 BioLiteMet 192.168.16.230

-

4) Select a group to add the found device to and click Add.
5) Select the registered device, and click Sync Device.

Note

= After registering a device, you can edit its details by referring to Editing Device Settings and
Information.
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Wiegand Device Search and Registration

You can easily add Wiegand devices connected to master/slave devices.

1) Click DEVICE.

2) Right-click on the name of a master/slave device to search for Wiegand devices and click Add
Wiegand Device.

3) The list of Wiegand devices connected to the master/slave device is shown.

Add Wiegand Device X

¥-Station 2 50490303 (192.168.120.9) has 1 Wiegand Device(s) that are not registered.

0 Wiegand Reader 0 (1124232127) ,

B -

4) Select the device to add, and click Add.

Slave Device Search and Registration

You can easily expand your access control system network by adding slave devices to existing master
devices. Master devices and slave devices can be connected together via RS-485. Besides regular

devices, additional devices such as Secure I/0 can be connected.

1) Click DEVICE.

2) Right-click on the name of a master device to search for slave devices and click Search Slave
Device.

3) The list of slave devices connected to the master device is shown. If the devices you are looking for
are not shown on the list, click Search to search for the devices again.
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Search Slave Device x

D 538101268 BioLiteNet 538101268 BioLiteNet

BioLiteNet 538101276 (192.168.16.230) has 1 slave Device(s).

Cancel

4) Select a group to register the device to and click Add.

Note

= If the fingerprint authentication device is the master device, the face authentication device
cannot be added as a slave device.

= If the face authentication device is the master device and a different slave device has been
added already, a face authentication device cannot be added as a slave device.

= When you connect the face authentication device as a slave device while the face
authentication device is the master device, only one face authentication device can be added
as a slave device.

= When the face authentication device is the master device and another face authentication
device is connected to it as a slave device, you can connect one additional Secure I/0 2 and
DM-20 each.

=  The maximum number of slave devices available to connect varies according to the
authentication method, number of users, and number of devices. Also note that the number of

slave devices affects the authentication speed.

Registering and replacing 3rd party OSDP devices on CoreStation
Registering 3rd party OSDP Reader
Add 3™ party OSDP reader to a registered CoreStation.
1) Click DEVICE.

2) Right-click on the name of a CoreStation and click Add OSDP Device.
3) The Select OSDP Device Type window appears. Select OSDP Reader.
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Select OSDP Device Type X

CoreStation 40 544777007 (192.168.40.197)
{(®) 0SDP Reader ()

() ospP Antenna ()

4) A list of ports appears. Among the ports whose Port Status is Available,
select the port to add the OSDP reader.

Add OSDP Device X

CoreStation 40 542071868 (192.168.12.164)

RS485 Port 0 Available

RS485 Port 1

Occupied by Suprema Slave

RS485 Port 2 Available

RS485 Port 3
HOST RS485 Available

Available

Note

= Connect up to 2 units per port on CoreStation, for a total of 8 units.

5) Set the Information, Network (RS-485), and Authentication.
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<+ Add New OSDP Device

Information

*+ Name

- Port

* Vendor Code

0SDP Reader (1108280240) + OSDP Device Type
+ Serial Number
* Product Name

* Hardware Version

« Firmware Version * Locked

Network (RS-485)

+ 0SDP ID

Authentication

« Auth Mode

* Full Access

']
A
-

(D visable + Auth Timeout sec
() Disable Auith Timeout { ] 5

[ ] Cancel

Informat
ion

= Name: Enter a device name. If not entered, it will be assigned
automatically.

= Status: Set the reader status. If set to Inactive, CoreStation
will not communicate with the OSDP reader.

Network
(RS-
485)

= OSDP ID: Enter the address of the OSDP reader. Enter a
number between 0 and 126.

= Secure Communication: Communication between
CoreStation and OSDP readers can be protected with an SCB
key.
When Secure Communication is set to Use, CoreStation
sends the SCB key to the OSDP reader. OSDP readers can use
this SCB key to send and receive data to and from CoreStation
through a secure channel.

Authenti
cation

= Auth Mode: You can configure the authentication modes of
the OSDP reader. BioStar 2 can use combinations of card and
PIN as authentication modes.

Note

= Click + Add and create an authentication mode by
dragging and dropping available options. Select a
schedule and click OK to register the authentication
mode. If no desired schedule is available, click + Add
Schedule to create it.

= For more information on configuring schedules, see
Schedule.

= Full Access: You can grant full access to users registered
within the OSDP reader without setting any access groups.
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= Auth Timeout: When using a combination of multiple
credentials in Auth Mode, the system waits for this length of
time to authenticate the second credential.
Set a timeout period for authenticating the second credential
after authenticating the first credential. If the second
credential is not input within this time, the authentication fails.

6) Click OK to register the configured OSDP reader.

Note

= Set the LED/Buzzer behavior of the connected OSDP reader. For detailed
configuring of the OSDP Device LED/Buzzer, refer to OSDP Device LED/

Buzzer.

Replacing 3rd party OSDP devices
Replace the OSDP device registered to CoreStation with another device.

1) Click DEVICE.
2) Among the OSDP devices registered to CoreStation, right-click on the name of
the OSDP device to be replaced and click Replace OSDP Device.

All Devices
ﬁ CoreStation 40 542071868 (

B 0SDP Device (1000074
-

g, OSDF Device |
Eﬂ Xpass D2 8658  peactivate 0SDP Device

[I X-Station 2 50509 Replace OS0P Device

[I X-Station 2 50509 Delete Device

3) Click Continue after reading the warning pop-up message, Replace OSDP

device process will proceed.
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80

When you replace or default the OSDP device, this sets the SCE
key that is set in the controller into the OSDP device. Continue?

Note

= OSDP device replacement may fail if the OSDP device is disconnected or if
the SCB key is already set. Check the connection status of the device and
the SCB key, then try again.

Registering U&Z Wireless Door Lock

Add the U&Z Wireless Door Lock to a registered CoreStation.

Note

= A separate Device License is required to register and use the U&Z
Wireless Door Lock. For more information, refer to Device License.

= U&Z Wireless Door Lock is available for CoreStation v1.7.1 or later and
BioStar 2 v2.9.4 or later.

= To connect the U&Z Wireless Door Lock, the wireless antenna module
must be connected to the CoreStation. Only one wireless antenna module
can be connected.

= The maximum number of U&Z Wireless Door Locks that can be connected
to one CoreStation is 8.

= Replacement of U&Z Wireless Door Lock is not supported in BioStar 2.

1) Click DEVICE.
2) Right-click on the name of a CoreStation and click Add OSDP Device.
3) The Select OSDP Device Type window appears. Select OSDP Antenna.
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Select OSDP Device Type X

CoreStation 40 544777007 (192.168.40.197)
() 0SDP Reader ()

(®) 0sDP Antenna ()

4) A list of ports appears. Among the ports whose Port Status is Available,

select the port to add the OSDP antenna.

Add OSDP Device X

CoreStation 40 542071868 (192.168.12.164)

RS485 Port 0 Available

RS485 Port 1

Occupied by Suprema Slave

RS485 Port 2 Available

RS485 Port 3
HOST RS485 Available

5) Set the Information, Network (RS-485), and click Apply.

Available

|« Add New OSDP Device

Information
+ Name 0SDP Antenna (1000000872) + OSDP Device Type 0SDP Antenna
* Port HOST RS485 * Serial Number
+ Device ID 1000000872 * Product Name
* Vendor Code * Hardware Version
+ Firmware Version
- Status @ active
Network (RS-485)
* 0SDPID 0 * Secure Communication| | Use

6) Right-click the added OSDP antenna and click Auto Add Wireless Door Lock.
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All Devices

0z0F) OSDP Antenna

Waiting Device

ﬁ CoreStation 40 544777007

7) Tag the provided SERVICEKEY card on the U&Z Wireless Door Lock.

8) The OSDP antenna connects to the wireless door lock

(® Related Information

U&Z Wireless Door Lock

Managing Users Registered with Devices

You can see the number of users, fingerprints, faces, and cards stored in the device.

You can compare the user information stored in the device with the user information registered in

BioStar 2, transfer the information to BioStar 2 or delete the information.

Note

= The Manage Users in Device function is available only when one device is selected.

1) Click DEVICE.

2) Select a device and click Manage Users in Device. A comparison of the user information

registered within the device and the user information registered within BioStar 2 is displayed.
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Manage Users in Device X

BioStation A2 541531008 (192.168.14.223)

& ez )[4 [ sorows » |
Q54 fipe @0 A i All Users | | Different Users | Upload | | Delete |
|
|:| 50 0 ] Device Default Mew User
D 49 0 0 Device Default Mew User
|:| 48 0 0 Device Default Mew User
|:| 47 0 0 Device Default Mew User
|:| 46 0 0 Device Default Mew User
D 45 0 0 Device Default Mew User
D 44 0 0 Device Default Mew User
[ ] 43 0 0 Device Default New User
Close

= Same: The user's information is the same as the information registered within BioStar 2.
= Different: The user's information is different from the information registered with BioStar 2.

= New User: The user has not been registered with BioStar 2.

3) After selecting user information, click Delete to delete it or click Upload to upload it to BioStar 2.
When you click Upload, if BioStar 2 contains user information of the same ID, it can be updated

with the information in the device.

Note

= After registering a device, you can edit its details by referring to Editing Device Settings and
Information.

= When you delete user information, it is only deleted from the device and the information in
BioStar 2 remains intact.

Upgrading Firmware

You can easily upgrade the firmware on any device connected to BioStar 2 without any additional
connection or action.
Copy the firmware files that you have downloaded to the following folder. If the folder does not exist,
you need to create it.

= 32-Bit Operating Systems: C:W Program FilesW BioStar 2% firmware
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= 64-Bit Operating Systems: C:W Program FilesW BioStar 2(x64)W firmware

1) Click DEVICE.
2) Select a device and click Firmware Upgrade. Multiple devices of the same type can be batch

upgraded.

Firmware Upgrade X

BioStation 2 546832590 (192.168.16.108)

Firmware Version

BioStation 2 (BS2-OMPW) 1.3.0 [2016/07/07 16:31]

BioStation 2 (BS2-OMPW) 1.2.0 [2016/02/04 17:43]

‘ Close

S

3) Click the firmware version to start the upgrade.

Note

= ltis possible to upgrade a number of devices with the same RS-485 mode simultaneously. For
example, a number of master devices can be upgraded simultaneously and a number of slave
devices can be upgraded simultaneously as well.

= ltis possible to upgrade a number of master devices or slave devices that have no master
device simultaneously.

= Itis not possible to upgrade a number of slave devices which is connected to the same

master device simultaneously.

(® Related Information

Information

Editing Device Settings and Information

You can edit detailed information of registered devices. For more information on registering devices,
see Basic Search and Registration or Advanced Search and Registration.
The details shown may vary depending on the RS-485 connection type or the device type.

1) Click DEVICE.
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2) Click a device on the device list to edit.

3) Edit the fields by referring to Information, Network, Authentication, Advanced Settings, Thermal &
Mask, SIP Intercom, RTSP, DM-20, OM-120, CoreStation and Wiegand Device.

4) To edit information of multiple devices, select multiple devices and click Batch Edit.

Device Batch Edit X

Devices (3)

+ OSDP Device Status

+ Use DHCP

+ Full Access

+ Time Zone

+ Daylight Saving Time

+ Suprema Smart Card Layout

+ Custom Smart Card

+ Custom Smart Card Layout

+ Subnet Mask

+ Gateway

+ Matching Timeout

+ Device Port

+ Connection Mode

+ Server Address

+ Server Port

+ RS5485

SIS SIS IS IS IS TSI SIS IS8 ]S

Active

Use DHCP

Full Access

J

Disabled Classic/Plus

(

Device » Server Connection

DESFire, DESFire EV1/EVZ/EV3

7 sec

Apply

5) Click # of the field you want to edit and edit the information.
6) After editing all information, click Apply.

Note

= The fields displayed for Batch Edit may vary depending on the device type selected.

= If you select both master devices and slave devices and click Batch Edit, only some of the

Authentication and Display/Sound fields can be edited.
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Information

You can enter or edit the name and the group of a device. If a new firmware version is available, you

can upgrade to it.

1) Edit all fields of the Information tab.

Information

1 —[ * Name

2 —[ + Device ID

3 —[ * Firmware Version

4 —[ * Kernel Version

5 —[ * Restore to default
5} —[ * Time Zone

7 4[ * Daylight Saving Time

System

14 4[ * Display Date

CoreStation 40 123400068 (192.168.14.124) * Group All Devices = ]— 8
- Device Type ]7 9
# Firmware Upgrade * Product Name ]7 10
* Hardware Version ]— I
All Without Network * Locked ! ]— 12
(UTC) W. Europe Standard Time, London, Lis... ¥ Time Synchronization with Server ]— 13
Get Time et Tim ]7 16

o Jom—Jogin

1 Name Enter a device name.
2 Device ID View the device ID.
Firmware . . ' .
3 ) Click Upgrade to install a new firmware version.
Version
Ki I
4 ernfa View the kernel version.
Version
Reset the settings of the device.
5 Restore to
default = All: Reset all settings.
= Without Network: Reset all settings excluding the network settings.
6 Time Zone Set the time zone of the device.
7 Daylight Apply the daylight saving time to the device. To add a new daylight saving
Saving Time | time rule, see Daylight Saving Time.
Change the device group. For more information on adding device groups,
8 Group ) ) .
see Adding and Managing Device Groups.
9 Device Type | View the device type.
Product .
10 View the model name.
Name

86



6 Device

o [rm  Jowowen

Hardware . .
11 } View the hardware version.
Version
12 Locked Unlock button will be available when the device is disabled via Trigger &
Action.
Time
13 Synchroniza | Select the option to synchronize the time information of the device with the
tion with server.
Server
Date and click B 1o manually set the date and time. If the Time Synchronization
14 Time with Server option is selected, the date and time cannot be selected
manually.
15 Get Time Click the button to fetch the time set in the device.
16 Set Time Click the button to apply the time set in BioStar 2 to the device.

2) Click Apply to save the settings.

Note

= Make sure to set the correct date and time as they are recorded in the Event Log and the

Real-time Log.

Network

You can configure various connection settings such as TCP/IP and RS-485, etc.

Note

= Editable fields vary depending on the device type.

1) Edit all fields of the Network tab.
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Network

TCR/IP
[ Use DHCP
* IP Address

+ Gateway

WLAN

+ Operation Mode
« Authorization Type

* Authorization Key

r Server

Serial

+ RS485

Intelligent Slave

+ Exception Code

+ Output Info

TCP/IP

*+ Subnet Mask

+ Device Port 51211

+ 8SID

+ Encryption Type

+ Server Port

Default - + Baud Rate 115200

Enabled

Exception Code Value

Max 8 bytes

®) CardID User ID + 0SDPID 126

N

You can configure the TCP/IP connection settings of the device.

= Use DHCP: Select this option to allow the device to use a dynamic IP
address. If this option is selected, network settings cannot be entered.

= IP Address, Subnet Mask, Gateway: Enter network settings of the
device.

= Device Port: Enter a port to be used by the device.

= DNS Server Address: Enter a DNS server address.

Note

= The devices and the firmware versions where a DNS server address
can be entered are as follows.
- BioStation L2 FW 1.0.0 or later
- BioStation A2 FW 1.0.0 or later
- BioStation 2 FW 1.2.0 or later
- BioLite Net FW 2.2.0 or later
- BioEntry Plus FW 2.2.0 or later
- BioEntry W FW 2.2.0 or later
- XPass FW 2.2.0 or later
- XPass S2 FW 2.2.0 or later
- FaceStation 2 FW 1.0.0 or later




6 Device

o T o

- BioLite N2 FW 1.0.0 or later

- Facelite FW 1.0.0 or later

- XPass 2 FW 1.0.0 or later

- FaceStation F2 FW 1.0.0 or later
- X-Station 2 FW 1.0.0 or later

- BioStation 3 FW 1.0.0 or later

2 WLAN

Turns on or off the wireless LAN. You can also configure the wireless LAN
related settings from the device menu. For the detailed information, refer to
the device's user guide.

Note

= Only for BioStation 2, BioStation A2, FaceStation 2 and BioStation 3.

3 Server

You can enter connection settings to use in the server mode.

= Device — Server Connection: Select this option to configure the
BioStar 2 settings for connecting to the devices. If this option is selected,
BioStar 2 server network settings can be entered.

= Server Address: Enter the IP address or domain name of the BioStar 2
server.

= Server Port: Enter the port number of the BioStar 2 server.

Note

= The devices and the firmware versions where a domain address can
be entered for the server address are as follows.
- BioStation L2 FW 1.0.0 or later
- BioStation A2 FW 1.0.0 or later
- BioStation 2 FW 1.2.0 or later
- BioEntry W2 FW 1.0.0 or later
- BioEntry P2 FW 1.0.0 or later
- FaceStation 2 FW 1.0.0 or later
- BioLite N2 FW 1.0.0 or later
- BioLite Net FW 2.2.0 or later
- BioEntry Plus FW 2.2.0 or later
- BioEntry W FW 2.2.0 or later
- XPass FW 2.2.0 or later
- XPass S2 FW 2.2.0 or later
- XPass 2 FW 1.0.0 or later
- X-Station 2 FW 1.0.0 or later
- BioStation 3 FW 1.0.0 or later

4 Serial

You can configure the connection mode and baud rate of devices connected
over RS-485.
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= RS-485: Set a RS-485 mode.
= Baud Rate: Set a baud rate of the RS-485 connection.

When a user performs fingerprint authentication with a Suprema device
connected to a third-party controller, the authentication result is transmitted
as OSDP card data to perform multiple 1:1 or 1:N matching.

= Exception Code: When using intelligent slaves, exception codes in
decimal or hexadecimal can be sent to aggregate accurate logs in
exceptional situations such as authentication failures. Decimal numbers
can be entered from O to 18446744073709551615, and hexadecimal
numbers can be entered from 0 to FFFFFFFFFFFFFFFF or hexadecimal
characters.

= Qutput Info: You can output the card ID or user ID when authentication
is successfully done.

= OSDP ID: Enter the OSDP address of the device. You can enter a number

from O to 126.
Intelligent

Slave Note

= Intelligent slave is activated only when the RS-485 option for Serial
is set as Default.
= The devices and firmware versions that support Intelligent Slave are
as follows.
- BioEntry W2 FW 1.6.3 or later
- BioStation L2 FW 1.6.1 or later
- BioEntry P2 FW 1.4.1 or later
- XPass 2 FW 1.2.3 or later
- X-Station 2 FW 1.1.0 or later
- BioLite N2 FW 1.4.1 or later
- FaceStation F2 FW 1.1.2 or later
- BioStation 3 FW 1.0.0 or later
= The data size of the Exception Code can be entered up to 8 bytes.

2) Click Apply to save the settings.

Authentication

You can configure the user authentication settings of the device.

Note

= Editable fields vary depending on the device type.
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1) Edit all fields of the Authentication tab.

Authentication

Auth Mode

2 4[ + Full Access (I visable
3 4[ « Server Matching (P mactive

r Face

- Fingerprint

1:N Security Level Normal

Sensor Sen

Template Format
View Image ;) Disabled
Advanced Enroliment (@) Enabled

Duplicate Check ( Enabled

1:N Security Level
Motion Sensor

Enhanced fake face enroliment block

Face Detect Setting

Operation Mode

(]

Normal

Medium

Disabled

% D

~e

Maximum Head Pose Angle

Detection Distance

Wide Search

@) Fusion Matching Mode

+ Fake Detection

Normal

®) Secure

More Secure

Most Secure

Always

Always

Always

+ Add

Ea

rd |

¥
Auth Timeout [ ] 10 sec
Face Detection Level ) Not Use
Sean Timeout ® ) 0se
1:N Fast Mode Auto
Matching Timeout [ ] 5 sec
Sensor Mode Auto On
Fingerprint LFD ‘ Not Use

Enroliment Time

Ambient Brightness Normal

Quick Enrollment

Duplicate Check

@) nadle
@) Enabled

@0 sec
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QR/Barcode

* Use QR/Barcode @ enavies * Use QR as Card (I visabied
through Camera -

+ Camera Timeout () 43ec * Motion Sensor Medium -

* Use QR/Barcode [ @R
through Scanner h

+ Scanner Timeout @ -

r Card Type

+ CSN Card @ ) cnabled
B emas100 Mifare/Felica
+ Byte Order MsB ¥

+ Format Type \) Norma

+ Wiegand Card (I isableg

+ Suprema Smart Card (@) Enabled
* MIFARE
4 Ciassic/Plus & DESFire, DESFire EV1/EV2/EV3
* ICLASS

SR/SE SEOS

* Suprema Smart Card None -
Layout

+ Suprema Smart Card MSB v
Output Byte Order

+ Custom Smart Card (@[ ) Enabled
* MIFARE

Classic/Plus DESFire, DESFire EV1/EVE/EV3

*+ Custom Smart Card None v
Layout

* Custom Smart Card MsB v
Byte Order

@) Enavled

* CSN Mobile
NFC BLE

+ Template on Mobile (@ ) Enavled

NFC BLE

+ ToM Enroliment Visual Face ()

+ ToM Output Byte MSB b4
Order

escription

You can configure the authentication modes of the device. BioStar 2 can use
any combinations of fingerprint, ID, card, PIN and face as authentication
modes.

CREZE.

1 Auth Mode = Click + Add and create an authentication mode by dragging and dropping
available options. Select a schedule and click OK to register the
authentication mode. If no desired schedule is available, click + Add
Schedule to create it.

= For more information on configuring schedules, see Schedules.

You can grant full access to users registered within the device without
setting any access groups.

2 Full Access
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Server
Matching

It is possible to set server matching. When Active is set, the authentication
is carried out using the user information stored in the PC where BioStar 2 is
installed, and when Inactive is set, the authentication is carried out using
the user information stored in the device. When using server matching, the
server matching of BioStar 2 should be also activated. For more information,
refer to Server.

Note

= The devices and the firmware versions where server matching can
be used are as follows.
- CoreStation FW 1.0.0 or later
- BioEntry P2 FW 1.0.0 or later
- BioEntry W2 FW 1.0.0 or later
- BioStation L2 FW 1.0.0 or later
- BioStation A2 FW 1.0.0 or later
- BioStation 2 FW 1.2.0 or later
- BioLite Net FW 2.2.0 or later
- BioEntry Plus FW 2.2.0 or later
- BioEntry W FW 2.2.0 or later
- XPass FW 2.2.0 or later
- XPass S2 FW 2.2.0 or later
- BioLite N2 FW 1.0.0 or later
- XPass D2 FW 1.0.0 or later
- XPass 2 FW 1.0.0 or later
- FaceStation 2 FW 1.4.0 or later
- FaceStation F2 FW 1.0.0 or later
- X-Station 2 FW 1.0.0 or later
- BioStation 3 FW 1.0.0 or later
= Server Matching is not available for FacelLite.
= Server Matching of Visual Face is not available for FaceStation
F2 and BioStation 3.

Auth
Timeout

When using a combination of multiple credentials in Auth Mode, the system
waits for this length of time to authenticate the second credential.

Set a timeout period for authenticating the second credential after
authenticating the first credential. If the second credential is not
authenticated within this time, the authentication fails.

Face
Detection

You can set an algorithm step for recognizing a face with a camera built in a
device when a user tries to authenticate.

If it is set to Normal, it can detect a face at an arm’ length. If it is set to
High, it can detect a face at a shorter distance. If it is set to Not Use, it
cannot use the face detection function.

Note
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= Only for BioStation A2 and X-Station 2.

You can configure the detail settings concerning fingerprint authentication.

= 1:N Security Level: You can set a security level to use for fingerprint
authentication. The higher the security level is set, the false rejection rate
(FRR) gets higher, but the false acceptance rate (FAR) gets lower.

= Scan Timeout: You can set a fingerprint scan timeout period. If the
fingerprint is not scanned within the set time, the authentication fails.

= Sensor Sensitivity: You can set a sensitivity level of the fingerprint
recognition sensor. Set the sensor sensitivity higher if you wish to use a
higher sensor sensitivity level and obtain more detailed fingerprint
information.

= 1:NFast Mode: You can set the fingerprint authentication speed. Select
Auto to have the authentication speed configured according to the total
amount of fingerprint templates registered within the device.

= Template Format: You can view the fingerprint template format.

= Matching Timeout: You can set the matching timeout period. If the
authentication is not completed within the set time, the authentication
fails.

= View Image: Displays the image of the fingerprint on the screen during
the authentication process.

= Sensor Mode: If the option is set to Auto On, the sensor will
automatically go on when it detects a finger. If the option is set to Always
On, the sensor will always be on.

= Advanced Enroliment: Checks the quality of the scanned fingerprint to
avoid the poor quality fingerprint template enrollment. The user will be
alerted when the quality of the fingerprint scanned is low and given
enrollment instructions.

6 Fingerprint

= Fingerprint LFD: It is possible to set the live fingerprint detection level. If
the live fingerprint detection level is higher, the false rejection rate on
actual human fingerprints will increase.

= Duplicate Check: You can check for duplicates when registering
fingerprints.

Note

= Editable fields vary depending on the device type.

= View Image is available only for BioStation 2, BioStation A2,
BioStation L2, BioLite N2, FaceStation F2 (FSF2-ODB) and X-Station
2 (XS2-ODPB, XS2-OAPB).

= Fngerprint LFD is available only for BioStation A2, BioStation L2,
BioEntry W2, BioLite N2, FaceStation F2 (FSF2-ODB) and X-Station 2
(XS2-0ODPB, XS2-OAPB).

7 Face You can configure the detail settings concerning face authentication.
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1:N Security Level: You can set a security level to use for face
authentication. The higher the security level is set, the false rejection rate
(FRR) gets higher, but the false acceptance rate (FAR) gets lower.
Enrollment Time: If a face is not registered during the set time when
registering a user's face, the face registration will be canceled.

Motion Sensor: Set the sensitivity for detecting motion near the device.
Ambient Brightness: Sense the brightness near the device and adjust
the intensity of IR LED.

Enhanced fake face enrollment block: It is possible to set the
Enhanced fake face enrollment block. If the live face detection level is
higher, the false rejection rate on actual faces will increase.

Light Brightness: Adjust the brightness level of IR LED manually. Select
Normal or High to change the level or select Not Use to turn off the light.
Quick Enrollment: Set whether or not to use a Quick Enrollment. When
you set this option to Enabled, the face registration procedure is setto 1
step. If you set the option to Disabled, it is set to 3 steps. To register
high-quality face templates, disable Quick Enroliment.

Face Detect Setting: Set the environment for recognizing the user's
face during face authentication.

- Maximum Head Pose Angle: Set maximum angle of head rotation.

- Detection Distance: Set the minimum and maximum detection
distance.

- Wide Search: Set to ON, search for a face in the entire camera image.
Operation Mode: Set the operation mode of the device when the face is
authenticated.

- Fusion Matching Mode: Use both visual and infrared cameras to
increase the face authentication accuracy.

- Fast Matching Mode: The device authenticates users who pass an
access point without a pause within the authentication distance.

Fake Detection: The device prevents user authentication using fake
faces, such as photos. It is available when Operation Mode is set to
Fusion Matching Mode.

Duplicate Check: You can check for duplicates when registering faces.

Note

= Editable fields vary depending on the device type.

= Ambient Brightness, Enhanced fake face enrollment block
and Quick Enroliment is available only for FaceStation 2 and
FacelLite.

= Light Brightness is only available on FaceStation F2 firmware
version 1.1.0 or later.

= Face Detect Setting and Operation Mode are available only for
FaceStation F2 and BioStation 3.
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You can configure the detail settings concerning QR/Barcode authentication.

» Use QR/Barcode through Camera: Set whether to use QR/Barcode
authentication through the device's camera.

= Camera Timeout: You can set the camera's QR/barcode scan timeout
period. If the QR/Barcode is not scanned within the set time, the
authentication fails.

= Use QR as Card: Allows authentication with a QR code of the same data
as the issued CSN card or Wiegand card.

= Motion Sensor: Set the sensor sensitivity of the camera for starting
scanning.

= Use QR/Barcode through Scanner: Set whether to use QR/Barcode
authentication through the device's scanner.

= Scanner Timeout: You can set a QR/Barcode scan timeout period. If the

8 QR/Barcode QR/Barcode is not scanned within the set time, the authentication fails.

Note

= Using Use QR/Barcode through Camera requires a separate
device license. For more information, refer to Device License.

= The devices that can use Use QR/Barcode through Camera,
Camera Timeout, Use QR as Card, and Motion Sensor are as
follows.
- X-Station 2 (XS2-ODPB, XS2-OAPB, XS2-DPB, XS2-APB) firmware
1.2.0 or higher
- BioStation 3 (BS3-DB, BS3-APWB) firmware 1.1.0 or higher

= The devices that can use Use QR/Barcode through Scanner,
and Scanner Timeout are as follows.
- X-Station 2 (XS2-QDPB, XS2-QAPB)

You can set the type of card used by the device.

Note

= The type of card supported by the device is displayed.

= CSNCard: You can select the CSN card and format type and set the byte

order.
9 Card Type

Note

= If Format Type is set to Nornal, the device will read the card serial
number (CSN). If the option is set to Wiegand, the device will read
the card serial number in a Wiegand format that the user has
defined.

= If Format Type is set to Wiegand, you can select the Wiegand
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format to be used in the device. To set a new Wiegand format, refer
to Wiegand.

= When Byte Order is set to MSB, the device reads a card ID from the
highest byte to the lowest byte. For example, the highest byte of the
card ID 0x12345678 is 0x12 and the device sequentially reads 0x12,
0x34, 0x56 and 0x78. When the option is set to LSB, the device
reads a card ID from the lowest byte to the highest byte.

= Wiegand Card: You can select a Wiegand card type and set the Wiegand
format.

Note

= You can select the Wiegand format to be used in the device. To set
a new Wiegand format, refer to Wiegand.

= Suprema Smart Card: It is possible to select the Suprema smart card
layout to be used in the device and set the byte order. To set a new smart
card layout, refer to Smart / Mobile Card.

Note

= When Suprema Smart Card Output Byte Order is set to MSB,
the device reads a card ID from the highest byte to the lowest byte.
When the option is set to LSB, the device reads a card ID from the
lowest byte to the highest byte.

= Custom Smart Card: Select the type of Custom Smart Card issued by a
third party and set Custom Smart Card Layout and byte order. To set a
new smart card layout, refer to Smart / Mobile Card.

Note

= The devices and the firmware versions that can use the Custom
Smart Card are as follows.
- XPass D2 FW 1.7.1 or later

= When Custom Smart Card Byte Order is set to MSB, the device
reads a card ID from the highest byte to the lowest byte. When the
option is set to LSB, the device reads a card ID from the lowest byte
to the highest byte.

= CSN Mobile: Select the recognition method for the mobile card.
= Template on Mobile: Select the recognition method for Template on

Mobile, specify which biometrics the user will enroll directly on the device,
and set the byte order.
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Note

= The devices and the firmware versions that can use the Template on
Mobile are as follows.
- BioStation 3 FW 1.2.0 or later

= When ToM Output Byte Order is set to MSB, the device reads a
card ID from the highest byte to the lowest byte. When the option is
set to LSB, the device reads a card ID from the lowest byte to the
highest byte.

Note

= Changing the fingerprint template format makes all previously stored fingerprints unusable. Be
sure to select the correct template format before registering user fingerprints.

= If Full Access is set to Enable, the device cannot be added to an Access Level and Hoor
Level.

2) Click Apply to save the settings.

(® Related Information

Server

Advanced Settings

You can set the administrator, display/sound and trigger & action.

1) Click Advanced tab.
2) Edit the fields by referring to Administrator, T&A, Display/Sound, Trigger & Action, Image Log,
Wiegand, Secure Tamper, Analog Interphone and Camera.

3) Click Apply to save the settings.

Note

= Editable fields vary depending on the device type.
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Administrator

You can assign and manage administration rights of the devices.

Note

= You can add and manage up to 1,000 administrators. The number of administrators that can

be added depends on the device firmware version.

1) Click + Add and select a user.

Administrator

[ a | E selectan | | +add | | ¥ pelete

1T — | Name/ID Q
D 1{Administrator) v
h 4 4 1 /1| » ]
[ Ueer | = selectan | [ +ada | [ elete

2 [ | Name/ID Q
[0 2coke) v
B M|« 1 (71wl
7- Configuration | [ Select All | | + Add ‘ W Delete

3 [ | Name/ID Q
[1 atcioery v

M|« 1 (71wl

o on—Jowernn

1 The assigned administrators can use all menu functions such as adding and
Al editing users.
5 The assigned administrators can manage the user information but cannot
User change the display, sound, network and RS-485 settings of the device.
) ) The assigned administrators can change the display, sound, network and
3 Configuration . . ) .
RS-485 settings of the device but cannot manage the user information.
Note

»  Click W to delete the registered users.
= The administrator settings configured for each device do not affect the BioStar 2 privileges.
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T&A

You can change the device's name of the T&A event or configure the device's T&A Mode.

1) Edit the necessary fields.

T&A

1 4[ + T&A Mode By User v * T&A Required J\—\ Not Use ]7 2

* T&A Event .

Code 1 check in

Code 2 check out

Code 3 meal start

Code 4 meal end

o Trm—Jomorgon

You can configure the T&A event settings.

= Not Use: The user cannot record T&A events.

= By User: The user can manually select a T&A event before the
authentication.

= By Schedule: T&A event automatically changes according to the pre-
defined schedule. You can select the schedule under the T& A Event
option.

= Last Choice: The T&A event that the last user has selected remains
unchanged until you change the T&A event manually.

= Fixed: The user can use the fixed T&A event only. Configure the T&A
Mode to Fixed and select the event you want to use as fixed.

1 T&A Mode

The user will be forced to select a T&A event during the authentication
process. The T&A Mode option must be set to By User in order to use the
Require T&A option.

2 T&A
Required

You can set the name of T&A events or you can add schedules which will be
used when you set the T&A Mode as By Schedule.

= T&A Key: Lists the keys that you can use for T&A event selection. Choose

3 T&A Event one of the function keys that you want to edit.

= Label: You can change the name of the T&A event for the T&A key.

= Schedule: You can set a schedule for the By Schedule. The T&A mode
must be set to By Schedule in order to enable this option. For more
Information on configuring new schedules, see Schedules.

Note

100



6 Device

= For a device with no LCD screen, T&A Mode can set to Fixed or By Schedule. You can register
a fixed T&A event or a T&A event that changes according to the schedule.
Supported devices are BioEntry P2, BioEntry W2, BioEntry Plus, BioEntry W, XPass, XPass S2,
XPass D2 and XPass 2.

Display/Sound

You can edit display and sound settings of the device. You can configure LED or buzzer action for each

event.

Note

= Editable fields may vary depending on the device type.

1) Edit the necessary fields.

= BioEntry P2, BioEntry W2, BioLite Net, BioEntry Plus, BioEntry W, XPass, XPass S2,
XPass D2, XPass 2

Note

= Language, Menu Timeout, Backlight Timeout, Mgs. Timeout can only

be used by BioLite Net.
= Keypad Backlight is only available with XPass D2 hardware VO2M,

firmware 1.7.1 or higher.

Display/Sound

1 4[ + Language English Update Resource
2 4[ + Volume ON + Menu Timeout . 20 sec ]7 3
4 4[ Backlight Timeout @ 20 sec - Msg. Timeout [ ] ZUstc]i 5
* LED/Buzzer
Normal + LED Infinite ON
Locked BLUE 2000 msec 0 msec
RTC Error CYAN 2000 |msec 1] msec
Waiting Input OFF 0 msec | g msec
[ Waiting DHCP ~-
+ Buzzer Infinite OFF Counts
Scan Finger
OFF 0 msec ] msec Fade Out
Scan Card
OFF 0 msec 0 msec Fade Out
Auth Success
OFF 0 msec ] msec Fade Out
Auth Fail
Auth Duress

7 4[ Keypad Backlight on
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Sets the display language of the device.

1 Language | Click Update Resource to transfer a language resource file
to the device.
2 Volume Turns the sound on or off.
3 Menu Sets the timeout period for changing from the menu screen
Timeout to the standby screen.
4 Backlight Sets the timeout period for the display backlight to turn off
Timeout automatically.
5 Msg. Sets the timeout period for various messages to disappear
Timeout automatically.
6 LED/ Selects an event and set LED or buzzer actions for the event.
Buzzer
Turn the keypad backlight on or off.
Keypad . N .
7 Enabling the k klight illumin h k of th
Backlight abling the keypad backlight illuminates the back of the

keypad to facilitate key identification in dark environments.

= BjoStation 2, BioStation L2, BioLite N2, Facelite

e
e

4 4[ Theme
e
e

Display/Sound
+ Language

+ Device Volume

+ Msg. Timeout

+ Use Voice

« Background

+ Sound

30 v Update Resource

— [ ] 50%

+ Menu Timeout

T ) 20 ] 3

T T T T T 20se ] 5

Theme 1 -

S — T
(I visabled

Logo v

+ Backlight Timeout

Update

Add Clear

Start Find

Verify Successful Find

Verify Failed Find

Update

o homJomri

Sets the display language of the device.

1 Language | Click Update Resource to transfer a language resource file
to the device.
2 Device Controls the volume.
Volume
3 | Menu Sets the timeout for the menu screen.
Timeout
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4 Theme Changes the style of the device's home screen.

5 | Backlight | gets the timeout for the backlight.
Timeout

6 Msg. Sets the timeout period for various messages to disappear
Timeout automatically.

7 Use Voice

Enables voice guidance.

8 Backgroun
d

Sets the items to be displayed on the device's home screen.

= Logo: Displays the user’s uploaded image on the home
screen. You can upload an image by clicking Add.
= Notice: Displays messages typed by the administrator.

= Slide Show: Displays a slideshow of maximum 10 images.

You can upload an image by clicking Add.

Note

= Click Update to apply the configurations to the
device instantly.

= Clicking Update will not apply when you change the
type of the Background. Click Apply to save the
configuration.

= Notice and Slide Show are supported on BioStation
2.

9 Sound

Configures the sound effect for boot, authentication success,
and authentication failure events.
Click And and select a *.wav file(less than 500KB).

Note

= Click Update to apply the configurations to the
device in real-time.

== BjoStation 3, BioStation A2, FaceStation 2, FaceStation F2, X-Station 2
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Display/Sound

1 ———— + Language English

2 ————— + Device Volume

A + Intercom
Microphone Volume

6§ —— + Backlight Timeout

8 ———————{ + Screensaver Enabled
9 ———— + Use Voice (I Disabled
10 —————{ + Home Screen Normal

11 —————— + Sound Start

Verify Successful

Verify Failed

v

[ ] 13%
[ ] 0%
[ ) 20 sec

Choose File

Choose File

Choose File

Update Resource

« Intercom

Speaker Volume

+ Menu Timeout

+ Msg. Timeout

[ ] 21% ]—3
[ ] Always On ]—5
[ ] 20:ec]—7

Find
Find

Find

Update

Description

Sets the display language of the device.

1 | Language Click Update Resource to transfer a language resource
file to the device.
2 | Device Volume | Controls the devices default volume.
Intercom
3 | speaker Sets the speaker volume when using the Intercom function.
Volume
4 In.tercom Sets the microphone volume when using the Intercom
Microphone function.
Volume
5 | Menu Timeout | Sets the timeout for the menu screen.
6 | Backlight Sets the timeout for the backlight.
Timeout
) Sets the timeout period for various messages to disappear
7 | Msg. Timeout .
automatically.
Sets this option to use the screen saver feature. It reduces
unnecessary energy consumption by lowering the
brightness of the LCD screen when the device is not in use.
8 | Screensaver )
Note
= Screensaver is supported on FaceStation 2,
FaceStation F2, X-Station 2 and BioStation 3.
9 | Use Voice Enables voice guidance.
Sets the items to be displayed on the device's home screen.
1

Home Screen

= Normal: Displays the default image on the home screen.
= Logo: Displays the user’s uploaded image on the home
screen. You can upload an image by clicking Add.
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Description

= Notice: Displays messages typed by the administrator.

Note

= Click Update to apply the configurations to the
device instantly.

= Clicking Update will not apply when you change
the type of the Background. Click Apply to save
the configuration.

= When you set Logo for Home Screen and set
Slide Show Enabled, you can display a slideshow
of maximum 10 images on the home screen. You
can upload an image by clicking Add.

Sound

Configures the sound effect for boot, authentication
success, and authentication failure events.
Click Find and select a *.wav file(less than 500KB).

Note

= Click Update to apply the configurations to the
device in real-time.

Trigger & Action

You can configure triggers and actions for each situation. For instance, you can get all alarms to go off

when an authentication fails or disable the device when its RS-485 connection is lost. You can select an

event or you can configure the desired triggers and actions.

1) Click + Add and configure the settings.
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Add Trigger & Action X

Input(Event Name Change)

« Event List ®) Output - Port

None v
Alert Sound

. + signal Setting
Fail to save to the server DB Disable Device

Scheduled unlock zone ended (Elevator)

Scheduled unlock zone started (Elevator)

Muster zone alarm cleared

Muster zone alarm detected

Muster zone time limit violation

Occupancy Limit Violation (Network Failure)
Occupancy Limit Violation (Count Full)

Interlock zone Alarm Clear

o Trom—Joworgon

1 Trigger

You can select a pre-defined event or add a user defined trigger.

= Event: You can select a pre-defined event.

= Input: You can set a user defined trigger by selecting Port, Switch,
Duration (ms), and Schedule.

= Input(Event Name Change): You can set a user defined trigger by
selecting Port, Switch, Duration (ms), Schedule and Event Name.

Note

= If you set the trigger as an event, you can select only one event from
the event list.

= When configuring a user defined condition by selecting Input or
Input(Event Name Change), if no desired schedule is available,
click + Add Schedule to create it. For more information on
configuring schedules, see Schedules.

= When configuring a user defined condition by selecting Input(Event
Name Change), if no desired event name is available, click Add
Event Name to create it. When the event occurs, the event name is
displayed in the Event Log and Real-time Log.

= Up to 64 characters may be entered for the event name.

2 Action

You can select a pre-defined action or add a user defined action.

Note

= When configuring a user defined action by selecting Output, if no
desired signal is available, click + Add Signal to create it.

= If you set the trigger as Input(Event Name Change), you can set
the Action to None.
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Image Log

You can set an image log event and schedule to be used in the device.

Note

= Only for BioStation A2, FaceStation 2, FaceStation F2, X-Station 2 and BioStation 3.

1) Set Enabled for the image log. It is possible to set Preset from Setting > Image Log. For more

information, see Image Log.

2) Click + Add and set a desired event and schedule.

Image Log

+ Image Log (I/ Enabled

- Confeuaten m -

1:1 authentication succeeded

1:1 authentication failed

1:1 duress authentication succeeded

1:N authentication succeeded

1:N authentication failed

1:N duress authentication succeeded

Dual authentication succeeded

Dual authentication failed

Authentication failed

Access denied

Administrator menu entered

v

v

-

Always
Always
Always
Always
Always
Always
Always
Always
Always
Always

Always

v

it

v

t

-

4 4 4 4 4 4 4
o = = = = = = =€

4
il

Wiegand

You can define the Wiegand Input/Output.

1) Edit the necessary fields.

Wiegand

1 + Input/Output Input -
2 4‘: + Wiegand Input Format = Default -
3 + Output Mode (I Hormal Fail Code

« Pulse Width(ps)

+ Pulse Interval(ys)

= Output info

40

10000

®) Card ID

S —
=
User ID ]7 6

escription
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Input/ .
1 P You can select input/output mode.
Output
Wiegand . . . .
5 | E: You can set a format for Wiegand. For more information on setting a
npu .
P Wiegand format, see Card Format.
Format
You can set the Wiegand signal output mode. If it is set to Normal, a card
will be scanned in the set Wiegand format. If it is set to ByPass, CSN will be
3 Output sent regardless of Wiegand authentication. ByPass should be set when
Mode using the device without an entrance door control function.
If it is set to Normal mode, it is possible to set Fail Code, and select a value
to be transmitted when Wiegand card authentication fails.
4 Pulse Width | You can set the pulse width of the Wiegand signal.
Pulse . . .
5 You can set the pulse interval of the Wiegand signal.
Interval
. You can select the information output to the device when the user
6 Output info )
authenticates.

Secure Tamper

If a tamper event occurs on the device, you can set to delete the entire user information, the entire log,

and the security key stored on the device.

1) To use the secure tamper, set to On.

* Secure Tamper

Analog Interphone

On * All the users, logs, and encryption key in the device will be removed at the secure tamper event.

It is possible to set whether or not to use an analog interphone.

Note

Only for BioStation 2.

1) Click Use to use a connected intercom.
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Camera

It is possible to set the camera frequency. If you set the frequency incorrectly in the environment where
the fluorescent light is used, flickering on the image may occur.

Different camera frequencies are used depending on geographic location. 60 Hz is generally used in
U.S., and 50 Hz is used in all other areas.

For the camera frequency of a given area, contact a sales agent.

Note

= Only for BioStation A2.

1) Select the frequency.

Camera

« Power Line I'-requancy. 50Hz

Thermal & Mask

You can set the detailed settings of thermal camera and mask detection.
Thermal camera with Suprema face authentication devices measures temperature of users passing the
access point and limit the access of users with higher temperature than preset threshold. And the face

authentication devices can also detect masks and restrict access to users without masks.

Note

= Only FaceStation 2 and FaceStation F2 support thermal cameras.
= The supported thermal cameras are as follows.

- TCM10-FS2

- TCM10-FSF2
= Only FaceStation F2 and BioStation 3 support mask detection.

1) Edit the necessary items.
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Thermal & Mask =

Mask Configuration

Mask Detection

« Mask Detect Level

Thermal Camera
Thermal Camera Use Use (Deny access when exceeded threshol
« Celsius/Fahrenheit Celsius () + Threshold Temp. ('C)  Low | 32.0 - [ 380 High

+ Save Temp. Data ) Enabled + Temp. Fail Sound

« Show Infrared Image Enabled

- Camera Configuration Temp, Correction (-C)
Distance(cm) 100

Emissivity

Thermal & Mask Check Mode

+ Cheek Mode eck after authenticatior

N

You can set whether to use mask detection or not.

= Mask Detection: You can set whether to use mask detection or not. If

Mask you select Use (Deny access when failed to detect mask), it refuses
1 Configuratio authentication of users who are not wearing a mask and saves event logs.
n If you select Use (Allow access after leaving log when failed to

detect mask) users who are not wearing a mask can authenticate but
event logs still be saved.
= Mask Detect Level: You can set sensitivity for mask detection.

You can set options whether to use the thermal camera and edit the detailed
settings.

» Thermal Camera Use: You can set whether to use thermal camera or
not. If you select Use (Deny access when exceeded threshold
temperature), it refuses authentication of users with elevated
temperature than the preset threshold and saves event logs. If you select
Use (Allow access after leaving log when exceeded threshold
temperature), users with elevated temperature than the preset
threshold can authenticate but event logs still be saved.

Thermal = Celsius/Fahrenheit: Change the unit of temperature.

2 Camera = Threshold Temp. (? /? ): You can set the minimum and maximum

temperature values to limit the access. The access of users with a lower
or higher skin temperature than threshold temperature will be restricted
depending on the Thermal Camera Use settings. It can be set in the
range of 1 °C to 45 °C, and the Low value cannot be set higher than the
High value.

= Save Temp. Data: Save temperature data. When this mode is Enabled,
it saves both authentication and temperature logs. When this mode is
Disabled, it only saves authentication logs.

= Temp. Fail Sound: Set the alerts to trigger when the temperature is
higher than the preset threshold.

= Show Infrared Image: Display infrared imaging on the screen of the
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devices.

Camera Configuration: Configure the thermal camera settings for
accurate measurement.

- Temp. Correction (? ): Depending on the device usage environment,
the temperature can be calibrated to measure as high or low as a certain
value. For example, in an environment where the temperature value is
always measured high by 0.1? , set the temperature compensation value
to -0.1? .

- Distance(cm): Set up the distance between the user and device.

- Emissivity: Set up the emissivity to precisely measure the temperature
of the user.

- Dynamic ROI: If there are lights in the device field of view, you can set
the thermal camera to automatically measure the user's temperature
rather than that light.

- ROI X(%0), ROI Y (%26), ROl Width(%6), ROI Height(26): If you set
Dynamic ROI to Disabled, you can manually set the ROI(Region of
Interest). Set the temperature measurement area by adjusting the size
and position of ROL.

Note

= Low and High value settings of Threshold Temp. can be used from
the firmware version below.
- FaceStation 2 FW 1.4.2 or later
- FaceStation F2 FW 1.0.2 or later

= Itis recommended to maintain the default values of the camera
configuration settings for the best performance. The default values ?
for each option per device are as follows:

FaceStation
Items 5 FaceStation F2

Distance(cm) 100 100
Emissivity 0.98 0.98
ROI X (%) 47 30
ROI Y(%) 45 25
ROI Width(%6) 15 50
ROI Height(%) 10 55

Thermal &
3 Mask Check
Mode

Set the thermal & mask check mode depending on the desired usage.

= Check after authentication: Measure the temperature or detect the

mask after a successful authentication.

= Check before authentication: Authentication is performed after

checking whether the user is wearing a mask or measuring the
temperature. When using this mode, it does not attempt to authenticate
user’ identity if they does not wear masks or their temperature has been
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detected to be above the threshold.

= Check without authentication: The device may only be used to
determine whether a mask is worn or to measure temperature. In this
mode, regardless of authentication, all users wearing a mask or below the
reference temperature can enter.

2) Click Apply to save the settings.

SIP Intercom

You can set the detailed settings of SIP Intercom.

Note

= SIP Intercom is only supported on BioStation 3, FaceStation 2, BioStation A2.

= Editable fields vary depending on the device type.

2) Set Intercom to Use.

3) Fill SIP configurations to register the device to your SIP server.

112



6 Device

o Lo

Intercom

+ Intercom

-3 Not Use

71— + SIP Server Address

3 ——— « SIP Username
5 —— + Authorization ID

* Open Door Button
7 (OTMF)

8 ——{ + Outbound Proxy Senrer.i) Mot Use

9 + Outbound Proxy
Server Address

« Display Extension ¢ . Not Use
n Number

12—[ « Extension Number

Order

« SIP Server Port

+ Password

+ Registration Duration

(sec)

+ Outbound Proxy

Server Port

ar

SIP Server
1 Enter SIP server address.

Address

SIP Server
2 Enter SIP server port.

Port

Enter username of your SIP account.

3 SIP Note

Username

= SIP Username can only enter alphanumeric (case sensitive), and
special characters (+, -, @, .).
4 Password Enter password of your SIP account.
Enter authorization ID of your SIP account.

5 Authorizatio Note

nID

= Authorization ID can only enter alphanumeric (case sensitive),
and special characters (+, -, @, .).

Registration | Enter Registration Duration in seconds. The device(SIP endpoint) tries to
6 Duration(se register to the SIP server every set Registration Duration.

c)

113



6 Device

Note

= Registration Duration can be set between 60 to 600 secs.

Open Door
7 Button(DTM | Set a button to open the door on the phone.
F)
Outbound
8 Proxy If your SIP service has a separate (outbound) proxy server, set this to Use.
Server
Outbound
Pro
9 X Enter the outbound proxy server address.
Server
Address
Outbound
10 Proxy Enter the outbound proxy server port.
Server Port
If you mind the device displaying extension numbers on the screen, set this
to Not Use.
Display
11 Extension Note
Number
= If Display Name is not set, it will not be possible to distinguish
receivers.
Register extension numbers up to 128. Click Edit to add / edit
= Send to Top: Selected extension number moves to the top of the list.
= CSV Import: Import extension numbers from a CSV file.
= CSV Export: Export extension numbers to a CSV file.
= Add: Add an extension number
= Delete: Delete an extension number
. Extension = Reorder: Reorder extension numbers by drag and drop.
Number

Note

= Max. Number of Extension Numbers for FaceStation 2 and BioStation
A2 is up to 16.

= CSV file cannot contain more than maximum number of supported
extension numbers.

= Extension Number can only enter alphanumeric (case sensitive),
and special characters (+, -, @, .).

4) Click Apply to save the settings.
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RTSP
It is possible to set whether to use RTSP.

Note

= RTSP is only supported on BioStation 3.

1) SetRTSP to Use.
2) Enter the necessary fields.

RTSP

* RTSP @ use

17— + Address Copy + Pomt ]7 2
3—{=+mw + Password ]7 4

o [ Jowagen

RTSP address is fixed.
1 Address
= Copy: Easily copy the RTSP address.
2 Port Set RTSP port.
3 ID Set ID of your RTSP credential.
4 Password Set password of your RTSP credential.

3) Click Apply to save the settings.

DM-20

You can edit detailed settings of registered DM-20.

1) Click DEVICE.
2) Click a DM-20 on the device list to edit.
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Information
*+ Name DoorMedule20 200000013 + Device ID
1 * Device Type « Firmware Version Firmware Upgrade
+ Product Name
Advanced -
Supervised Input
« Configuration Ind ‘ e i ‘
2 1/ 0 ’i Supervised 2.2 - ‘
1 f_k Supervised 2.2 v ‘
4 f'_; Supervised 2.2« - ‘
5 @) supervised 2.2 - ‘

o om  Jowogn

You can modify the devices settings.

= Name: Enter a device name.

= Device ID: View the device ID.

= Device Type: View the device type.

= Frmware Version: Click Firmware Upgrade to install a newer firmware
version.

1 Information

= Product Name: View the model name.

You can modify the Supervised Input settings. The DM-20 can oversee the
2 Advanced On, Off, Open, and Short status of the device connected to the Supervised
Input port, and can set the terminating resistor as 1kQ, 2.2kQ, 4.7kQ, 10kR .

3) Click Apply to save the settings.

OM-120

You can edit detailed settings of registered OM-120.

1) Click DEVICE.
2) Click a OM-120 on the device list to edit.

Information

+ Name 0OM-120 12345678 + Device ID
+ Device Type + Firmware Version 4 Firmware Upgrade
+ Product Name + Kernel Version

+ Hardware Version
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You can modify the device’s settings.

= Name: Enter a device name.
= Device ID: View the device ID.

Information = Device Type: View the device type.

= Frmware Version: Click Firmware Upgrade to install a newer firmware version.
= Product Name: View the model name.

= Kernel Version: View the kernel version.

= Hardware Version: View the hardware version.

3)

IM-120

Click Apply to save the settings.

IM-120 provides instant relay behavior by connecting to BioStar 2 for detected inputs in real-time and it

operates a relay or saves logs for detected inputs while it is disconnected from the master device. You

can edit detailed settings of registered OM-120.

1
2)
3)

Click DEVICE.
Click a IM-120 on the device list to edit.
Edit the necessary items.

Information

Information

+ Device Type + Firmware Upgrade

+ Product Name

« Hardware Version

You can modify the device’ settings.

= Name: Enter a device name.

= Device ID: View the device ID.

Informati | = Device Type: View the device type.

on = Armware Version: Click Frmware Upgrade to install a newer
firmware version.

= Product Name: View the model name.

= Kernel Version: View the kernel version.

= Hardware Version: View the hardware version.
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Input

Input

You can enter the name of each input port and set the resistance
value, switch, and duration.

= Index: 12 inputs, 2 AUX inputs, and tamper supported by IM-
120 are displayed in the index column.

= Name: Enter a name for each input.

= Supervised Input Resister: You can set whether to use
supervised input or not and the resistance value. Supervised
input allows you to monitor the on, off, cut, and short status of
the device by detecting the voltage flowing through the device
circuit connected to that port. When Supervised Input
Resister is set to Unsupervised, the supervised input port is
used as a TTL input. 1kQ , 2.2kQ , 4.7kQ and 10kR can be set
for the resistance value.

Input

Note

= Set the resistance value the same as the resistor
connected to the input device.

= Switch: The Switch can be set to N/C or N/O.

= Duration(ms): You can set the minimum time for an input
signal to be considered valid when it occurs. Duration can only
be entered numbers from 50 to 65535.
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Linkage

Linkage

Relay 0 Relay 1

« Common + Common

RS-485 disconnected ¢ ‘ RS-485 disconnected @ orr ]
Tampe ® o ] Tamper ® orr |
o A Aux
Aux 0 Auxd [ on @) Aux 0 Aux0 I
" " ® oFr Aux Aux I
+ Input Input
nput 0 Input) I nput 0 nput0 ID
nput 1 nput! P orr § nput 1 nput P orr
put nput “on @ put2 o $ o
input 3 Input3 P o ] nput 3 nput3 ID
input 4 Inputs m m Input 4 nputd m m
input 5 Inputs I nput § nputs I
nput 6 Inputs ® orr § nput 6 nputs I
nput 7 nput? P or ) nput 7 nput? P orF }
nput 8 nputs ®orr nput 8 nputd 9o
nput 9 Inputo P orr ] nputa npurs I
Input 10 nput10 ® orr | input nput10 ID
nput 11 nputt 1 D orr J npu 11 nputt 1 ® orr )

You can set the action of relay for each input. You can set the
action of Relay O and Relay 1 respectively.

= Common
- RS-485 disconnected: You can set whether to trigger an
alarm when the connection with the master device is lost.
- Tamper: You can set whether to trigger an alarm when a

Linkage tamper occurs.

= AUX: You can set whether to trigger an alarm when an AUX
signal occurs. The AUX port can be used to connect a power
failure detector or a dry contact output from another device.

= Input: You can set whether to operate an alarm or a fault when
an input signal occurs. Fault (cut and short) is only activated
when the supervised input is enabled by selecting a resistance
value in the Supervised Input Resister.

4) Click Apply to save the settings.
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CoreStation

You can edit detailed settings of registered CoreStation.

1) Click DEVICE.
2) Click a CoreStation on the device list to edit..

3) Edit the necessary items.

Information

Information

+ Name CoreStation 40 542070627 (192.168.14.205) + Group All Devices
+ Device ID + Device Type
+ Firmware Version + Firmware Upgrade + Product Name
+ Kernel Version + Hardware Version
« Restore to default All Without Network * Locked
+ Time Zone (UTC) W. Europe Standard Time, London, Lis.. Time Synchronization with Server
+ Daylight Saving Time
System

* Display Date Get Time

= Name: Enter a device name.

= Device ID: View the device ID.

= Armware Version: Click Frmware Upgrade to install a newer
firmware version.

= Kernel Version: View the kernel version.

= Restore to default: Reset the settings of the device. Click All to
reset all settings. Click Without Network to reset all settings
excluding the network settings.

= Time Zone: Set the time zone of the device. You can set a
different standard time zone of the device from the time zone of
the BioStar 2 server.

= Daylight Saving Time: Apply the daylight saving time to the
device. To add a new daylight saving time rule, see Daylight
Saving Time.

= Group: Change the device group. For more information on adding
device groups, see Adding and Managing Device Groups.

= Device Type: View the device type.

= Product Name: View the model name.

= Hardware Version: View the hardware version.

» Locked: Unlock button will be available when the device is
disabled via Trigger & Action.

= Time Synchronization with Server: Select the option to
synchronize the time information of the device with the server.

Informati
on
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= Display Date: Click H to manually set the date and time. If the
Time Synchronization with Server option is selected, the date
and time cannot be selected manually.

= Get Time: Click the button to fetch the time set in the device.

= Set Time: Click the button to apply the time set in BioStar 2 to the
device.

System

Network

Network
TCP/IP
Use DHCP
* IP Address * Subnet Mask

* Gateway * Device Port 51211

Server

+ Server Address * Server Port

Serial

+ RS485 * Baud Rate

+ SCBKey
Host 115200

* SCB Key Confirm
o 115200

115200

1 115200 v |

115200

= Use DHCP: Select this option to allow the device to use a dynamic
IP address. If this option is selected, network settings cannot be
entered.

= IP Address, Subnet Mask, Gateway: To assign a fixed IP to

TCP/IP the device, enter the information of each network. Uncheck Use
DHCP and enter the information.

= Device Port: Enter a port to be used by the device. This port is
used for the communication between BioStar 2 and the device.

= DNS Server Address: Enter a DNS server address.

» Device — Server Connection: Select this option to configure
the BioStar 2 settings for connecting to the devices. If this option
is selected, BioStar 2 server network settings can be entered.

Server
= Server Address: Enter the IP address or domain name of the
BioStar 2 server.
= Server Port: Enter the port number of the BioStar 2 server.
. = RS-485: You can only use Master.
Serial

= Baud Rate: Set a baud rate of the RS-485 connection.
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= SCB Key: Set the SCB key of the device. This feature is active
only when there is no RS-485 device connected to the
CoreStation.

= SCB Key Confirm: Make sure it matches the SCB key you set.
This feature is active only when there is no RS-485 device
connected to the CoreStation.

Note

= The SCB Key can be entered up to 16 bytes.

Authentication

Authentication

+ Server Matching ( ) Inactive
Fingerprint
+ 1:N Security Level Norma v * TN Fast Mode Auto 4

+ Template Format

Card Type

- CSN Card @ ) Enabled

EM4100 Mifare/Felica
+ Format Type (B vorma + Byte Order MSB -

+ Mobile @) Enabied

NFC

= Server Matching: It is possible to set server matching. When
Active is set, the authentication is carried out using the user
information stored in the PC where BioStar 2 is installed, and
when Inactive is set, the authentication is carried out using the
user information stored in the device. When using server
matching, the server matching of BioStar 2 should be also
activated. For more information, refer to Server.

Authentic
ation

= 1:N Security Level: You can set a security level to use for
fingerprint or face authentication. The higher the security level is
set, the false rejection rate (FRR) gets higher, but the false
acceptance rate (FAR) gets lower.

Fingerpri | = 1:NFast Mode: You can set the fingerprint authentication speed.

nt Select Auto to have the authentication speed configured
according to the total amount of fingerprint templates registered
within the device.

» Template Format: You can view the fingerprint template
format.
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You can set the type of card used by the device.

Note

= The type of card supported by the device is displayed.

= CSNCard: You can select the CSN card and format type and set
the byte order.

Note

= If Format Type is set to Nornal, the device will read the

Card card serial number (CSN). If the option is set to Wiegand,
the device will read the card serial number in a Wiegand
format that the user has defined.

= If Format Type is set to Wiegand, you can select the
Wiegand format to be used in the device. To set a new
Wiegand format, refer to Wiegand.

= When Byte Order is set to MSB, the device reads a card ID
from the highest byte to the lowest byte. For example, the
highest byte of the card ID 0x12345678 is 0x12 and the
device sequentially reads 0x12, 0x34, 0x56 and 0x78. When
the option is set to LSB, the device reads a card ID from the
lowest byte to the highest byte.

Type

Mobile Card: You can set the type of mobile card.

Advanced

Advanced o

+ Tamper None - + Switch Type Normally Open

[ @)
L/
- AcC Fail None - + Switch Type @) wormally open

Trigger & Action
 conten “—- -

Wiegand
+ Input/Output + Pulse Width(ps) 40

+ Wiegand Input Format | Default v + Pulse Interval(ps) 10000

Supervised Input

I nput
[@ I
(I nput
I nput
[@ X
[@ NI
I mput

+ Secure Tamper \) off

123



6 Device

Advance
d

= Tamper: You can set the AUX port where the tamper is
connected.

= AC Fail: You can set the AUX port that monitors the power input
signal.

Trigger
& Action

= Configuration: You can set the operation of the device according
to a pre-defined alarm or signal input. For example, you can set
to output a signal set by the user or not to use the device when a
temper on signal occurs in CoreStation.

Add Trigger & Action X

® Event « Event List ) output - Port
Input Alert Sound

Input(Event Name Change) O Failto save to the server DB Disable Device

Wiegand

= In/Qut: You can only use input mode.

= Input Format: You can set a format for Wiegand. For more
information on setting a Wiegand format, see Card Format.

= Pulse Width: You can set the pulse width of the Wiegand signal.

= Pulse Interval: You can set the pulse interval of the Wiegand
signal.

Supervis
ed Input

You can set the supervised input port of CoreStation to be used as
TTL input port and set a resistance value to be used for supervised
input. 1kQ, 2.2kQ  4.7kQ and 10k® can be set for the resistance
value.

Secure
Tamper

If a tamper event occurs on the device, you can set to delete the
entire user information, the entire log, and the security key stored
on the device.

OSDP Reader LED/Buzzer
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OSDP Reader LED/Buzzer

* OSDP Reader LED/Buzzer

* Mode Blinking

oN ms OFF ms

OSDP Reader
LED/Buzzer

When an event occurs in all OSDP readers connected to
CoreStation, LED and buzzer operations can be set collectively.

Note

= If the OSDP reader connected to CoreStation does not
support LED and buzzer, it may not operate as set.

LED

Sets the LED operation when Waiting Input, Auth Success,

and Auth Fail events occur.

= Mode: Set the desired operation among OF, Constant,
and Blinking.

= Cycle: When Mode is set to Blinking, enter the number of
LED blinks. Check Infinite to continuously repeat the set
Mode.

= Color/Duration: When Mode is set to Blinking, select two
colors to blink at the set repeat count and enter Duration.
When Mode is set to Constant, select one color to indicates
and enter Duration.

Buzzer

Sets the buzzer operation when Waiting Input, Auth

Success, and Auth Fail events occur.

= Mode: Set the desired operation among OF, Constant,
and Beeping.

= Cycle: When Mode is set to Beeping, enter the number of
buzzer plays. Check Infinite to continuously repeat the set
Mode.

» Duration: When Mode is set to Beeping, enter the duration
for the buzzer to be plays at each set repeat count.
When Mode is set to Constant, enter the duration for the
buzzer to be plays.

4) Click Apply to save the settings.
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Wiegand Device

You can edit detailed information of registered Wiegand devices.

1) Click DEVICE.
2) Click a Wiegand device on the device list to edit.

Information

+ Name Wiegand Reader 1 (575624497) + Device ID

* Device Type * Locked

Authentication

* Operation Schedule Always * Full Access (_JD Disable

* Matching Timeout [ ] 5sec

Advanced -

Tamper

« Tamper Port Mone * Switch Type @0 ) Hormally Open

LED/Buzzer

* Green LED Port Mone * Buzzer Port None

[ O

You can modify the settings of the Wiegand device.

1 Information = Name: Enter a device name.
= Device ID: View the device ID.
= Device Type: View the device type.

Modify the Wiegand device s authentication settings.

= Operation Schedule: Configure the activating time for the device.

Authenticati = Full Access: Allows the user to authenticate anytime. This overrides the

on access group of the user on the master device.

= Matching Timeout: You can set the matching timeout period. If the
authentication is not completed within the set time, the authentication
fails.

Modify the Wiegand devices tamper switch and LED settings.

= Tamper Port: Select the input port where the Wiegand devices tamper
3 Advanced switch is connected.

= Switch Type: Select the tamper switch type for the tamper operation.

= Green LED Port: Select the control port for the green LED.

= Buzzer Port: Select the control port for the buzzer.
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3) Click Apply to save the settings.

U&Z Wireless Door Lock

You can set the Name, Status, and Authentication of registered wireless door lock.

1) Click DEVICE.

2) Click a wireless door lock on the device list to edit.

< | Door Lock (1408280273) 23 [« »

Information

* Vendor Code
+ Firmware Version
* Status

Authentication

+ Auth Mode

+ Full Access

Door Lock (1408280273) * Device Type
+ Serial Number
* Product Name
* Hardware Version

* Locked

L) active

']

=
A
-

(I visable

o Thom Jomogon

= Name: Enter a device name. If not entered, it will be assigned
automatically.

1 Information . . . .
» Status: Set the device status. If set to Inactive, CoreStation will not
communicate with the wireless door lock.
= Auth Mode: The wireless door lock can only use CSN card as an
authentication mode.
Note
o = Click + Add, then drag and drop the Card. Select a schedule and
2 Authenticati click OK to register the authentication mode. If no desired schedule
on

is available, click + Add Schedule to create it.
= For more information on configuring schedules, see Schedule.

= Full Access: Full access can be granted to users registered in the
CoreStation to which the wireless door lock is connected without setting
an access group.

3) Click Apply to save the settings.

You can use the DOOR menu to add the information on doors connected to devices.

You can configure relay, dual authentication, anti-passback, forced open and held open alarm settings of
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the device. The door information is then used as a component of the access levels.

Adding and Managing Door Groups
Add Door

Editing Doors

Z 3
w% S
All Doors 11 (o [] [ Sorows v =2
All Doors B '— 4

Gmp Entry Device Embmu Status
All Doors BioStation 2 546832590 (1. BioLiteNet 538101276
All Doors BioStation A2 541531008 .. Wiegand Reader 0 (16152

1 Add Door £ Door List
2 Page Navigation Buttons and Number of List Rows ¢ Door and Group List
¢ Registered Device Search i Expand Button

< Function Button (Print, Column Setting)

After selecting a door, you can perform the following actions.
= Delete Door: Deletes the selected door from the list.

Adding and Managing Door Groups
You can add groups for easy management of multiple doors. Name your door groups according to door
locations or office names for greater convenience.
= Adding Door Groups

1) Click DOOR.
2) Right-click on All Door Groups and click Add Door Group.

5 All Doors

| Add Door Group
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3) Enter a group name.

Note
Door groups may be created in up to 8 levels.
Up to 48 characters may be entered for a door group name.

= Renaming Door Groups

1) Click DOOR.
2) Right-click on the name of a group you wish to rename and click Rename Door
Group.
5 All Doors
16F-1

Add Door Group

3) Enter a name.

Note

Up to 48 characters may be entered for a door group name.

= Deleting Door Groups

1) Click DOOR.
2) Right-click on the name of a group you wish to delete and click Delete User
Group.
» All Doors
16F-1

Add Door Group
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Note

= Deleting a group deletes all doors in the group.

Adding Doors

You can configure the doors to use in your access control installation. You can select an entry device and
an exit device, configure Anti-passback settings for improved security, or configure alarms for each
door.

1) Click DOOR and click ADD DOOR.
2) Configure the settings by referring to Information, Configuration, Option, Anti PassBack and Alarm.
3) After editing all information, click Apply.

® Related Information
Basic Search and Registration
Slave Device Search and Registration

Adding and Managing Access Levels

Information

You can enter or edit the name, group and description of the door.

1) Edit all fields of the Information tab.

Information

1 —[ Name 17F-1 + Group All Door Groups - ]— 3
2 —[ Description

o om  Jowogn

1 Name Enter a door name.

Set a door group. For more information on adding door groups, see Adding

2 Grou
P and Managing Door Groups.

3 Description Enter a short description of the door.

2) Click Apply to save the settings.
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Configuration

You can configure various settings for the device, exit button, door sensor, etc.

1) Edit all fields of the Configuration tab.

Configuration

1 ————————— - Entry Device
2 ———————{ + poorRelay(»)
3 ———— - ExitButton

4 ————— -+ Door Sensor

BioEntry W2 544108030 (192.168.12.176) v + Exit Device Xpass D2 400000005 v | ————— 5
Relay 0 of BioEntry W2 544108030 (192.168 v
Input Port 0 of BioEntry W2 544108030 (192 v + Switch - Normally Open

+ Does not activate relay (_JJJ) OFF

Input Port 1 of BioEntry W2 544108030 (192 v + Switch Normally Open

« Use sensor when Entry OFF
Confirmed APB enabled \D

o Jom—Jogin

1 Entry device

Select a device to use for entry. You can select a device from the list of
registered devices. If no registered device is available, see Basic Search and
Registration, Advanced Search and Registration, Wiegand Device Search and
Registration, or Slave Device Search and Registration.

Note

= If U&Z Wireless Door Lock is selected for Entry Device, U&Z
Wireless Door Lock must also be selected for Exit Device.

2 Door relay

Select a relay to control the door lock.

Note

= If U&Z Wireless Door Lock is selected for Entry Device, the Door
Relay option does not appear.

3 Exit button

Select a port to use for the exit button.

= The Switch can be set to Normally Closed or Normally Open.
= Does not activate relay: You can set the door open request log to
occur but the relay not to operate when the exit button is pressed.

4 Door sensor

Select a port to check the door status.

= The Switch can be set to Normally Closed or Normally Open.

= Use sensor when Entry Confirmed APB enabled: You can set
whether to use the door sensor when using Entry Confirmed APB.

» If Door Sensor is set to None, the Alarm tab cannot be edited.

5 Exit device

Select a device to use at exit. An exit device can only be used when there is
a slave device connected. If there is no registered slave device, see Basic
Search and Registration, Advanced Search and Registration, Wiegand Device
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= If no exit device is selected, the Anti Pass Back tab cannot be edited.

2) Click Apply to save the settings.

Option

Note

CoreStation can not be set as either an entry device or an exit device.

Anti Passback

(® Related Information

You can configure additional options.

1) Edit all fields of the Option tab.

Option

Open

Dual Authentication

Anti-Tailgating

No device A

None

o JomJogin

Open

You can configure options concerning the opening of the door.

= Open Time: Set the duration for which the door will remain open after a
user authentication is completed. When the authentication is successful,
the relay will be activated for the set time. When this time elapses, the
relay no longer sends the signal to the door.

Note

= Open Time may vary depending on the type of
door lock used.
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o [rm  Jowowen

= Lock when door is closed: When the door sensor detects that the door
is closed, the door is locked. This option is not available if Use
Automatic Door is set to ON.

= Use Automatic Door: When using an automatic door as an entrance
door, a relay can operate regardless of the status of a door sensor. This
option is not available if Lock when door is closed is set to ON.

Dual
2 Authenticati
on

You can configure the door to open only when authenticating credentials of
two persons (an ordinary user and an administrator).

= Device: Select a device to use dual authentication. If No device is
selected, the dual authentication mode is disabled.

Note

= [f you want to use the Dual Authentication feature
on the device previously set as either the Entry
Device or the Exit Device in Occupancy Limit Zone,
click Zone > Occupancy Limit and set the device
as either the Entry Device or the Exit device again.
For more information, refer to Occupancy Limit

Zone.

= Schedule: Set a schedule to use dual authentication. If no desired
schedule is available, click + Add Schedule to create it. For more
information on configuring schedules, refer to Schedules.

= Approval Type: You can configure the administrator authentication
order. Setting to None will require two users to authenticate regardless to
the access group. Setting to Last will require an authentication by a user
belonging to an access group that has been set after a normal user
authentication.

= Authentication Group: You can configure a group to which the
administrator belongs.

= Authentication Timeout: Set a timeout period for authenticating the
second credential after the first credential has been authenticated. If the
second credential is not authenticated within the timeout period after the
first credential has been authenticated, the door will not open.

Anti-
Tailgating

You can configure the door to detect the tailgating.

= Sensor: You can select the sensor to detect tailgating.

2) Click Apply to save the settings.
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Anti-passback

You can use Anti-passback to manage the access history and enhance security.

Anti-passback can help prevent the users from using an access card to enter and then passing the card
over to another user. It can also prevent unauthorized persons who have entered by following users
with access privileges from getting out on their own. This feature is available when both an entry device
and an exit device are installed. If Exit Device is set to None, this feature is unavailable.

For more information on configuring exit devices, see Configuration.

Note

= A master device and a slave device should be connected via the RS-485 interface in order to
activate the Anti-passback section on the Door page.

1) Edit all fields of the Anti PassBack tab.

Anti PassBack

1 —[ Type Soft APB v + Reset Time 1440 min.]— 2

o Jom—Jorgin

Select an Anti-passback type.

= None: Select this option to disable the Anti-passback feature.

1 Type = Soft APB: Select this option to allow entry but set off an alarm or create
a log entry in BioStar 2 when Anti-passback is violated.

= Hard APB: Select this option to prohibit entry and set off an alarm or
create a log entry in BioStar 2 when Anti-passback is violated.

You can set a time period for resetting the Anti-passback feature. The
2 Reset Time maximum possible duration is 7 days (10080 min.). If set to 0, the feature is
not reset.

2) Click Apply to save the settings.

Alarm

You can configure an alarm to go off or the device to lock when the door is opened by force, held open

or an anti-passback violation occurs.

1) Edit all fields of the Alarm tab. To add an action, click + Add.
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Alarm
2 —[ Held Open Time . 10 sec

’ —[' e — -
¢ —[. B — -

o Jom—Jogin

1 Held Open You can configure alarm actions to be taken when the door is held open.
P Click + Add and select an action. Click OK to add the action.
Held Open ) . . :
2 - You can configure the maximum allowed time for the door to remain open.
ime
. q You can configure alarm actions to be taken when the door is opened by
orce
3 force.
Open . . . .
Click + Add and select an action. Click OK to add the action.
You can configure alarm actions to be taken when an Anti-passback violation
occurs.
4 Anti- Click + Add and select an action. Click OK to add the action.
passback
= An exit device must be registered before the Anti-passback setting can
be configured.
2) Click Apply to save the settings.

Editing Doors

You can edit an existing door or batch edit multiple doors.

1
2)
3)
4)

Click DOOR.
In the door list, click a door to edit.
Edit the details by referring to the instructions in Adding Doors .

To edit information on multiple doors, select multiple doors and click Batch Edit.
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Edit All X

Open

+ Open Time

3 sec

(¢ =e

=

4) Click # of the field you want to edit and edit the information.

5) After editing all information, click OK.

You can configure the elevator to control floors with the access control device and OM-120 by using the

ELEVATOR menu.

Adding and Managing Elevator Groups

Adding Elevators

Editing Elevatos

Note

= The ELEVATOR menu will appear when the Advanced or higher license is activated.

)
— .

2 3
oo/m oo |\|ﬂ

All Elevators - 13
7 —[E] All Elevators E”i 4
Flevator | B3 Name Group Controller Reader Module
& D Elevator 1 All Elevators BioStation A2 541531008 BioStation A2 5 0OM-120 12345
5
1 Add Elevator £ Elevator List
z Page Navigation Buttons and Number of List Rows ¢ Elevator and Group List

¢ Registered Elevator Search

' Expand Button

¢ Function Button (Print, Column Setting)

After selecting an elevator, you can perform the following actions.
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= Delete Elevator: Deletes the selected elevator from the list.

Adding and Managing Elevator Groups
You can add groups for easy management of multiple elevators. Name your elevator groups according to
elevator locations for greater convenience.
= Adding Elevator Groups

1) Click ELEVATOR.
2) Right-click on All Elevators and click Add Group.

5 All Elevators

Add Group

Jm
L,

3) Enter a group name.

Note

= Elevator groups may be created in up to 8 levels.
= Up to 48 characters may be entered for an elevator group name.
= Renaming Elevator Groups

1) Click ELEVATOR.

2) Right-click on the name of a group you wish to rename and click Rename

Group.
3 All Elevators
Parkview 1
Add Group

Rename Group

Dem@te Group

3) Enter a name.

Note

= Up to 48 characters may be entered for an elevator group name.

137



8 Elevator

= Deleting Elevator Groups

1) Click ELEVATOR.

2) Right-click on the name of a group you wish to delete and click Delete Group.

5 All Elevators

Parkview 1

Add Group

Rename Group

Deletefzroup

Note

= Deleting a group deletes all elevators in the group.

Adding Elevators

You can configure the elevators to use for the floor control.

1) Click ELEVATOR and click ADD ELEVATOR.
2) Configure the settings by referring to Information, Detail, Option, and Alarm.
3) After editing all information, click Apply.

® Related Information
Basic Search and Registration
Slave Device Search and Registration

Adding and Managing Access Levels

Information

You can enter or edit the name, group and description of the elevator.

1) Edit all fields of the Information tab.
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Information

1 4[ Name Elevator 1 + Group All Elevators - ]7 3
2 —[ Description
“ Item Description
1 Name Enter an elevator name.

Set an elevator group. For more information on adding door groups, see

2 Grou
P Adding and Managing Elevator Groups.

3 Description Enter a short description of the elevator.

2) Click Apply to save the settings.

Detail

You can select a device to connect to the elevator and floor information.

Note

= BioEntry Plus, BioEntry W, BioLite Net are not available as a controller.

1) Edit all fields of the Detail tab.
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Detail

Configuration

1 4[ + Controller BioStation A2 541531008 (192.168... + Reader BioStation A2 541531008 (192.168... v ]— 2
3 4‘: * Module OM-120 12345678 v

Floor

4 4[ + Total Number of Floors| 12 Apply + Auto-mapping O Autofmappmg]i 5

* Floor Settings Floor Name Device Relay Number
Elevator 1 - 1 0M-120 12345678 Relay 0 of OM-120 12345678 De.. « v
Elevator 1 - 2 0M-120 12345678 Relay 1 of OM-120 12345678 De.. « v
Elevator 1 - 3 0M-120 12345678 Relay 2 of OM-120 12345678 De.. « v
Elevator 1 - 4 0M-120 12345678 Relay 3 of OM-120 12345678 De.. « v
Elevator 1 - 5 0M-120 12345678 Relay 4 of OM-120 12345678 De.. « v
6 Elevator 1 - 6 0M-120 12345678 Relay 5 of OM-120 12345678 De.. « v
Elevator 1 - 7 0M-120 12345678 Relay 6 of OM-120 12345678 De.. « v
Elevator 1 - 8 0M-120 12345678 Relay 7 of OM-120 12345678 De.. « v
Elevator 1 -9 0M-120 12345678 Relay 8 of OM-120 12345678 De.. « v
Elevator 1 - 10 0M-120 12345678 Relay 9 of OM-120 12345678 De.. « v
Elevator 1 - 11 0M-120 12345678 Relay 10 of OM-120 12345678 D.. v
Elevator 1 - 12 0M-120 12345678 Relay 11 of OM-120 12345678 D.. v

Select a device that controls the elevator access permission.

Note

1 Controller

= Only a master device can be selected.
= You can select it from the list of registered devices. If there is no
registered device, refer to Basic Search and Registration.

Select a device you intend to use for authentication.

Note

2 R r . . .
eade = You can select a device among the master device, slave device, and

Wiegand device.
= You can select up to 4 readers.
= OM-120 cannot be set as the reader.

Select the device to control the elevator button relay.

3 Module Note

= Only OM-120, DM-20, IM-120, and SI02 can be selected.
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Enter the total number of floors that you can move using the elevator.
Total
4 Number of Note
Floors
= Up to 192 floors can be entered.
5 Auto- Select whether or not to use auto-mapping. If Auto-mapping is used,
mapping Relay Number is assigned in consecutive order.
Floor
6 ) You can set the floor name and the relay number to control the floor.
Settings

2) Click Apply to save the settings.

Option

You can configure additional options.

1) Edit all fields of the Option tab.

Option

Relay Control

+ Open Time

Dual Authentication

+ Reader

Tamper

+» Tamper Port

] 5 sec

None -

Mone -

o Trm—Jomorgon

You can configure options concerning the activating of the relay of the floor.

1 Relay = Open Time: Set the duration for which the floor button will remain
Control activate after a user authentication is completed. When the authentication
is successful, the relay will be activated for the set time. When this time
elapses, the relay no longer sends the signal to the relay of the floor.
You can configure the floor button to activate only when authenticating
Dual credentials of two persons (an ordinary user and an administrator).
2 Authenticati
on = Device: Select a device to use dual authentication. If No device is

selected, the dual authentication mode is disabled.
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Note

= If you want to use the Dual Authentication feature
on the device previously set as either the Entry
Device or the Exit Device in Occupancy Limit Zone,
click Zone > Occupancy Limit and set the device
as either the Entry Device or the Exit device again.
For more information, refer to Occupancy Limit

Zone.

» Schedule: Set a schedule to use dual authentication. If no desired
schedule is available, click + Add Schedule to create it. For more
information on configuring schedules, see Schedules.

= Approval Type: You can configure the administrator authentication
order. Setting to None will require two users to authenticate regardless to
the access group. Setting to Last will require an authentication by a user
belonging to an access group that has been set after a normal user
authentication.

= Authentication Group: You can configure a group to which the
administrator belongs.

= Authentication Timeout: Set a timeout period for authenticating the
second credential after the first credential has been authenticated. If the
second credential is not authenticated within the timeout period after the
first credential has been authenticated, the door will not open.

3 Tamper You can set a port to output the tamper signal.

2) Click Apply to save the settings.
Alarm

An action can be set to be performed when tamper input or a separate input signal is detected.

1) Edit all fields of the Alarm tab. To add an action, click + Add.

Alarm

1 —[ Configuration Trigger ‘ . ‘ +add | }— 2

1 Trigger Tamper input detection or separate input signal detection can be set.
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An action can be set to be performed according to the status set under

trigger.
The floor button of the elevator can be activated, and/or output of a specific
signal can be set.

2 Action

2) Click Apply to save the settings.

Editing Elevators

You can edit an existing elevator or batch edit multiple elevators.

1) Click ELEVATOR.

2) In the elevator list, click an elevator to edit.

3) Edit the details by referring to the instructions in Adding Elevators.

4) To edit information on multiple elevators, select multiple elevators and click Batch Edit.

5) Click .c,of the field you want to edit and edit the information.
6) After editing all information, click OK.

You can use the ACCESS CONTROL menu to create access levels by configuring doors and access
schedules and to configure access groups using access levels and user group information.

The configured access groups are then used as components of the access control.

Adding and Managing Access Levels
Adding and Managing Access Groups
Adding and Managing Floor Levels

Access Privilege Status

Note

= The Hoor Level tab and ADD ALOOR LEVEL button will appear when the Advanced or higher

license is activated.
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9 Access Control

- 3 4 5
i il / /access Group \[ 1 m [

W%J:——. (s
\ = \

° 4[ ow | o | G| s AG 12F - 12F 12F access

Ao 1eE AG 1F ~ 6F = 1F ~ 6F 1F ~ 6F access
s AGTF ~6F AG 7F ~ 11F - TF~11F 7F ~ 11F access

AG TF ~ 11F

7

1 Add Access Group ¢ Function Button (Print, Column Setting)

Access Group / Access Level / Floor

Add Access Level i .
Level List

NN

Access Groups / Access Level / Floor

¢ Add Floor Level ¢
Level Groups
Tab buttons for the Access Group,
< Page Navigation Buttons and Number of List Rows ¢ Access Level, Floor Level and Status
list pages
. i
E Registered Item Search c Expand Button

After selecting an access group or an access level, you can perform the following actions.
= Delete Access Group: Deletes the selected access group from the list.
= Delete Access Level: Deletes the selected access level from the list.
= Delete Hoor Level: Deletes the selected floor level from the list.

Adding and Managing Access Levels
You can configure a schedule during which users are allowed to access the door and add it to an access
level.
= Adding Access Level
1) Click ACCESS CONTROL > ADD ACCESS LEVEL.
2) Enter Name and Description for the access level.

3) Click + Add.
4) Click « to select a door and a schedule.
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+Add

Door 1 Always

Note

«  Click @, to search for an item.

= If no desired door is available, add it by referring to

= If no desired schedule is available, click + Add Schedule to create it. For
more information on configuring schedules, see

= You can add up to 128 access levels per access group.

= Click ] to delete an item.

5) Click Apply to save the settings.

= Editing Access Level
1) Click ACCESS CONTROL > Access Level tab.
2) Inthe access level list, select an access level to edit.
3) After editing the necessary fields, click Apply.
= Deleting Access Level
1) Click ACCESS CONTROL > Access Level tab.

2) Inthe access level list, select an access level to delete.
3) Click Delete Access Level.

Adding and Managing Access Groups

You can configure access privileges by using access levels and user group information.

= Adding Access Group

1) Click ACCESS CONTROL > ADD ACCESS GROUP.

2) Enter Name and Description for the access group.

3) Click + Add for each field.

4) Click + to select an access level, a floor level, a user group or a user.
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+ Name
+ Description

+ Access Rule

+ Add Floor | 1 + Add

Access Level
*Md “ ’Md

Note

= If no desired access level is available, click + Add Access Level to
create it. For more information on access levels, see Adding and

Managing Access Levels.
= If no desired floor level is available, click + Add Hoor Level to create it.

For more information on floor levels, see Adding and Managing Floor

Levels.

= Click ] to delete an item.

4) Click Apply to save the settings.

= Editing Access Group
1) Click ACCESS CONTROL > Access Group tab.

2) Inthe access group list, select an access group to edit.
3) After editing the necessary fields, click Apply.

= Deleting Access Group
1) Click ACCESS CONTROL > Access Group tab.

2) In the access group list, select an access group to delete.
3) Click Delete Access Group.

Adding and Managing Floor Levels

You can configure the floor access privileges by using elevators and floor information.
Note
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= The Hoor Level tab and ADD AHLOOR LEVEL button will appear when the AC standard
license is activated.

= Adding Floor Level

1) Click ACCESS CONTROL > ADD HLOOR LEVEL.

2) Enter Name and Description for the floor level.

3) Click + Add.

4) Click « to select an elevator, a floor name, and a schedule.

+ Name

+ Description
+Add

Elevator 1 Elevator 1-1+ Always

-

Note

= Click Q to search for an item.
= If no desired elevator is available, add it by referring to
= If no desired schedule is available, click + Add Schedule to create it. For

more information on configuring schedules, see

= Click ¥ to delete an item.

5) Click Apply to save the settings.

= Editing Floor Level
1) Click ACCESS CONTROL > Hoor Level tab.
2) Inthe floor level list, select a floor level to edit.
3) After editing the necessary fields, click Apply.
= Deleting Floor Level
1) Click ACCESS CONTROL > Hoor Level tab.

2) Inthe floor level list, select a floor level to delete.
3) Click Delete Access Level.

Access Group Status

On the Status page, you can view who has the right to access certain doors. You can use a filter or
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combine filters to narrow down the result. You can also export the result as a CSV file. There are two
types of the access privilege status view: by user and by door.

1) Click ACCESS CONTROL > Status.
2) Choose Door Permission by Door, Door Permission by User, Elevator permission by Hoor,
or Elevator Permission by User.

3) To view the result of a specific type only, click the T of a column and apply a filter.

2

Access Group by Door W a1 [ga[s]lw 50 rows
1 4[ Y Save Filter E]]— 3
[ Door Group Y Door T Schedule T User ID T User Name T UserGroup T UserLevel T
All Doors 16F Always 15 User 006 All Users None
All Doers 16F Always 556 User 26 All Users None
All Doors 16F Always 33 User 024 All Users None
4 All Doors 16F Always 30 User 021 All Users None
All Doors 16F Always 27 User 018 All Users None
All Doors 16F Always 24 User 015 All Users None
All Doors 16F Always 19 User 010 All Users None
All Doors 16F Always 1 Administrator All Users Administrator
All Doers 16F Always 99 kyle All Users None
m Item Description
1 Save Filter Saves the set filter.
Button
You can move a page or set the number of list rows to be displayed on one
page.
Page = | Go to the first page.
Navigation “: Go to the previous page
n
2 Buttons and : P page.
Number of « | 2 /2: Enter the page number to move to.
List Row
st Rows = " : Go to the next page.
= | " Go to the last page.
25 . .
%5 T 1 set the number of list rows to be displayed on one page.
Function
Buttons . . ) )
3 (Print, CSV You can print the list of logs or save it as a CSV file. Also, the column
Export, settings can be modified.
Column
Setting)
Access o
4 Privilege Shows the access privilege status of users.
Status List
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You can use the USER menu to add users to BioStar 2 or to devices and manage their information.
You can also add users' fingerprints, manage their authentication credentials such as cards and PINs and
use them in access control, or grant administrator privileges.

Adding and Managing User Groups
Adding User Information

Adding User Credentials

Enroll Card

Transferring User Information to Devices
Deleting User from Devices

Editing User Information

Managing Long-term Idle Users

Visual Face Migration

2 3 4
T /A veers N o
s (] v - ]
flbsers > m- D Name Email Group Access Group m & O stas

15F USER 0

1 Administrator - All Users - o 0 o 1]
7 16F USER 0

2 Simba - All Users - 0 0 1 0
17F USER 0
3 User 000 - All Users - [} 0 0 0

4 User 001 - All Users - 0 0 0 0

5 User 002 - All Users - 0 0 0 0

Function Button (Print, Column Setting,
CSV Export, CSV Import, Visual Face

1 Add User £ Import, Data File Export, Data File
Import, Send Visual Face Mobile
Enrollment Link, Visual Face Migration)

Tab buttons for the User and Long-term Idle User list

z € User List
pages

¢ Page Navigation Buttons and Number of List Rows 7 User Group

< Registered User Search ¢ Expand Button
Note

= Registered users can be searched by Name, Email.
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= For more information on Send Visual Face Mobile Enrollment Link, see

When you select a user, you can perform the following functions.
= Batch Edit: Batch edits the information on multiple users. This function is available only when

multiple users are selected.
= Transfer to Device: Transfers user information registered with BioStar 2 to devices.
= Delete User: Deletes the selected user from BioStar 2. User information registered in

devices is not deleted.

Adding and Managing User Groups

You can add groups for easy management of multiple users. Name your user groups according to users'

organizations for greater convenience.

= Adding User Groups

1) Click USER.
2) Right-click on All User Groups and click Add User Group.

5 All Users 3

Add User Group

3) Enter a group name.

Note

= User groups may be created in up to 8 levels.
= Up to 48 characters may be entered for a user group name.
= Renaming User Groups
1) Click USER.

2) Right-click on the name of a group you wish to rename and click Rename User

Group.

150



10 Users

5 All Users 3

User Group 1 2

Add User Group

ARename User Group

3) Enter a group name.

Note

= Up to 48 characters may be entered for a user group name.

= Deleting User Groups

1) Click USER.
2) Right-click on the name of a group you wish to delete and click Delete User
Group.
» All Users 3
User Group 1 2
Add User Group

Adding User Information

You can add photo, name, email, telephone, etc. of a user.
A fingerprint scanner is required for adding users' fingerprints. If a fingerprint scanner is already

connected to BioStar 2, you can use the scanner to add fingerprints.

1) Click USER > ADD USER.

2) Enteror select the necessary fields in the Information tab.

Note
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« Theinformation with ~ must be entered.

Information

+ Name + Email —— 10

o

= Department « Title _ 11

[

1 « 1D

IS

+ Telephone

- Group S« Status

o m e
« Access Group - :’7 14

[E—

+ Add Photo .
* Period 2001/01/01 00:00 | - 2030/12/31

16 4[ Print Card
- Operator Level User v

« Login ID

~

+ User IP

T T

w oo

« Password

Add the user's photo. Click + Add Photo to select the user's photo.
Note
1 Photo
= Only an image file can be uploaded.
= User's photo is required to display the user's image on the mobile
access card.
Enter the user's name.
2 Name Note
= |tis possible to enter up to 48 characters including special characters
=L@, #$%N&() = HL0E)
Enter the department the user belongs to.
Note
3 Department = Departmentis required to display the user's department on the mobile
access card.
= |tis possible to enter up to 64 characters including spaces or
underbars( ) only.
Enter a unique 1D to assign to the user.
Note
4 ID = When Number is set for User ID Type in Setting > Server, a number
between 1 and 4294967294 can be entered.
= When Alphanumeric is set for User ID Type in Setting > Server, a
combination of alphabetic characters and numbers can be entered.
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= Do not use spaces when entering ID.
= Numbers or Alphanumeric characters can be set for the user ID type.

For more details, refer to Server.

Group

Select a user group. If no desired user group is available, add it by referring to

Adding and Managing User Groups.

Period

Set an active period of the account.

Operator
Level

Set a BioStar operator privilege level.

= None: The user has no operator privilege.

« Administrator: The user can use all menus.

= User Operator: The user can only use the USER and PREFERENCE
menus.

= Monitoring Operator: The user can use the MONITORING and
PREFERENCE menus and only view the DASHBOARD, USER, DEVICE,
DOOR, ZONE and ACCESS CONTROL menus.

= Video Operator: The user can only use the VIDEO menu.

= T&A Operator: The user can only use the TIME ATTENDANCE menu and
only view the USER menu.

= User: The user can only view own information and T&A records.

Note

= Tosetanew user permission, refer to Adding Custom Account Level.
« If you have upgraded from BioStar 2.5.0 to BioStar 2.6.0 and you are

using custom account level for monitoring, set operator level again.

Login ID

Enter the login ID.

Note

= The login ID appears when you set the Operator Level.

Password

Enter the login password. You can change the password level by referring to

Security.

Note

= The password appears when you set the Operator Level.
= The Confirm Password will appear when you enter the password.

Enter the password again to confirm.

10

Email

Enter the email address.
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Note

= |f the mobile access messaging option set as Email, user's email
address is required when using the mobile access.
= User's email address is required when using Visual Face Mobile

Enrollment or Secure QR.

Enter the user's title.

Note

11 | Title
=« Title is required to display the user's title on the mobile access card.

= Itis possible to enter up to 64 characters including spaces or

underbars() only.

Enter the telephone number.
12 Telephone Note

= |f the mobile access messaging option set as Text Message, user's

telephone number is required when using the mobile access.

13 Status You can temporarily deactivate the user's account.
1 Access Setan access group. If no desired access group is available, add it by
Group referring to Adding and Managing Access Groups.

Enter the user IP. If you register user IP, you can strengthen the security by
allowing access only when the IP information registered in the account and

the IP information of the PC match.

Note

15 USER IP = The user IP can be entered in the format xxx.xxx.xxx.xxx. Each octet
can only be entered in numbers between 0 and 255.

= Users whose user IP is not registered can log in regardless of the IP
information of the PC.

= When using the cloud, the users can log in regardless of the IP

information of the PC.

It can be printed as a card template with user information. Refer to CARD

16 Print Card _ ,
PRINTER for details on how to use the card printer.

3) Enter or select the necessary fields in the Credential tab and click Apply. For more information on

adding credentials, see Adding User Credentials.
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Note

= You can refer to the User/Device Management on the to learn how to add custom user

fields for extra user information.

(® Related Information

Export/Import CSV

You can export/import user data in CSV files. This feature is useful when you create users in bulk or
when you transfer users to another 3 party systems.

Note

= [f a CSV file to import contains data for custom user fields and the fields do not exist on the
server, then the data for the fields will be ignored during the import process. You can refer to

the to learn how to add custom user fields.

= If you enter the user information in a language other than English or Korean, save the CSV file
in UTF-8 format.

= CSV Export

1) Select users from the user list you intend to save to a CSV file and click | *** .
2) Click CSV Export.
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Print

Column Setting

CSV Export

CSV Import

Visual Face Import

Data File Export

Data File Import

Send Visual Face Mobile Enrollment Link

Visual Face Migration

3) The CSV file will be downloaded automatically.

= CSV Import

1) Click '+ and then click CSV Import.

Print

Column Setting

CSV Export

CSV Import

Visual Face Import

Data File Export

Data File Import

Send Visual Face Mobile Enrollment Link

Visual Face Migration

2) Select the CSV file and then click Open.
3) Set Start import at row and then click Next.

CSV Import X

+ File Import | C:\fakepath\User_201607.. | Browse |

« Start import at row | 2 |

BN -
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4) The user data field of the CSV file and the user data field of BioStar 2 are
mapped and displayed automatically. When you click Remap, the fields of the

same name will be remapped.

CSV Import X

CSV Field User Data Field
user_id user_id hd
name name v
department department b
user_title user_title hd
phane phone -
email email v
user_group user_group hd |
start_datetime start_datetime hd
expiry_datetime expiry_datetime hd
csn csn A
mobile_start_dateti... mobile_start_datetime v
maobile_expiry_date.. mobile_expiry_datetime A

|~ =i

5) Click Next after selecting whether to maintain the user data of which user ID
has been already registered to BioStar 2 or overwrite with the CSV file

information.

Note

= You can issue Mobile Access Cards via CSV Import. When using Regular
site, 1 credit will be deducted per Mobile Access Card in the Airfob Portal
once CSV import is complete. Disable matching if you do not want to issue
Mobile Access Cards.

= If the same data as the Mobile Access Card issued to the user who is
already registered in BioStar 2 exists in the CSV file, data can be
maintained or overwritten, and the existing Mobile Access Card is
maintained.

= If there is data different from the mobile access card issued to the user
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who is already registered in BioStar 2 in the CSV file, the existing Mobile
Access Card is maintained if the data is retained, and if overwritten, a
new Mobile Access Card is issued to the user.

= When using a dynamic site, if you issue a mobile access card to a user
using CSV import, mobile_start_datetime and
mobile_expiry_datetime fields must be entered.

= You cannot issue BioStar 2 QR via CSV import.

= You can enroll user's visual face via CSV Import. For more information,
see

= You can enroll user's PIN via CSV Import. For more information, see

6) If an error occurs during the import of CSV file information, you can upload it
again after checking only the erroneous CSV data.

Note

= |f there are additional columns in the CSV file other than the basic user

columns, BioStar 2 will fail to import the CSV file.

Export/Import User Information

You can store the data file on external storage (USB) and import to BioStar 2 or device. Up to 500,000

users can be moved from server to device or from device to device.

Note

= The exported data file from devices using older firmware version cannot be imported into
BioStar 2. Make sure always use the latest version of firmware.

= If you use BioStar 2.8.10 or later, data exported from the previous version of BioStar 2 cannot
be imported.

= If you use BioStar 2 latest version, it is impossible to read data from a device using an older
firmware version. Upgrade the devices firmware to a compatible version. Compatible devices
and firmware versions are as follows.
- BioStation 2 FW 1.9.0 or later
- BioStation A2 FW 1.8.0 or later
- FaceStation 2 FW 1.4.0 or later
- FaceStation F2 FW 2.0.0 or later
- X-Station 2 FW 1.0.0 or later
- BioStation 3 FW 1.0.0 or later

= If the fingerprint template format is different, the data file cannot be imported. For example,

the data file exported from a device which uses the Suprema fingerprint template format
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cannot be imported into a device which uses the ISO fingerprint template format.

= When importing user data with visual faces enrolled from FaceStation F2, the existing data
will be retained if there are already visual face data enrolled on BioStar 2 via Upload Image or
a mobile device.

= Data File Export

1) Select users from the user list you intend to export to a data file and click [le=a],
2) Click Data File Export.

Print

Column Setting

CSV Export

CSV Import

Visual Face Import

Data File Export

Data File Import

Send Vizsual Face Mobile Enrollment Link

Visual Face Migration

3) Select a device type to apply the exported data file. Only devices with USB port
is displayed.

Data File Export X

Please select a device type to apply the exported data file. (Default: BioStation 2)
(®) BioStation 2 (Applicable to v1.9.0 or higher)
) BioStation A2 (Applicable to v1.8.0 or higher)
) FaceStation 2 (Applicable to v1.4.0 or higher)
) FaceStation F2 (Applicable o v2.0.0 or higher)
) X-Station 2 (Applicable to v1.0.0 or higher)
") BioStation 3 (Applicable to v1.0.0 or higher)

) BioStation 2a (Applicable to v1.0.0 or higher)

-
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4) The data file is automatically downloaded.

Note

= The exported data file includes the profile photo, user ID, name, period,
access group, PIN, auth mode, credentials (face, fingerprint, card, mobile
access card, visual face, BioStar 2 QR, QR/Barcode), 1:1 security level.

= Be sure that the device is selected correctly. Otherwise, the device cannot
recognize the data file.

— Data Fie Import

1) Click L*** ! and then click Data File Import.

Print

Column Setting
CSV Export

CSV Import

Visual Face Import
Data File Export
Data File Import

Send Visual Face Mobile Enrollment Link

Visual Face Migration

2) Select the desired file (*.tgz) and then click Open.

3) A success message will appear on the screen when import successfully.

Adding User Credentials

You can add various user credentials such as PINs, fingerprints and cards.

Adding PIN
Auth Mode
Enroll Fingerprint
Enroll Face

Enroll Visual Face
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Adding PIN

Add a PIN.

1) Select the PIN option and enter a PIN to use.

PIN asee + Confirm PIN

2) For confirmation, enter the PIN again in Confirm PIN.
3) Click Apply to save the settings.

= Register by CSV Import

You can enroll user's PIN by importing CSV file.

1) Add the pin column to the CSV file to be imported.

2) Enter the user's PIN on the pin column and save the file.

3) Import CSV file that added PINs into BioStar 2 by referring to

Note

= Enrolled PIN data cannot be exported to a CSV file.

Auth Mode

You can configure an authentication mode for each user.
Select Device Default to allow the user to authenticate using the modes configured in ,

or select Private Mode to assign a unique authentication mode to each user.

1) Set Auth Mode to Private Mode.
2) Click + Add and configure the settings.
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Add New Auth Mode X

1 ——t—{ + Extended Auth Mode (_J) Not Use

#Extended Auth Mode is only supported by FaceStation F2 and BioStation 3.

[+ Auth Mode

e ELELE

Biometrics Card

N -

o JomJorgin

Set whether to use Extended Auth Mode. When Extended Auth Mode is set to
Use, the auth mode can be combined including both face and fingerprint.
1 Extended )
Auth Mode Note
= Extended Auth Mode is only supported by FaceStation F2 and
BioStation 3.
2 Auth Mode Drag and drop authentication methods to use.

3) Click Apply to add the authentication mode.

Note

= If Exclude Device Default Authentication Mode is set, only the personal authentication
mode set in BioStar 2 can be used. If Include Device Default Authentication Mode is set,
both the authentication mode set in the device and the personal authentication mode set in

BioStar 2 can be used.

+ Auth Mode (/ Private Mode

+ Add

@ L ,v

(/ Include Device Default Authentication Mode
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Enroll Fingerprint

You can add the user's fingerprints if the device supports fingerprint authentication. Fingerprints can be

scanned using a finger scanner or at the installation location.

Note

= Make sure that the user's finger is clean and dry.
= Do not add fingers with wounds or faint fingerprints.

1) Click + FAngerprint and configure the settings.

Enroll Fingerprint X

1 4[. Device BioLiteNet 538101276 (192.168.16.213) w
2 —- Quality [ [ ] o
3 4[|:| View Image

Enroll Fingerprint

4 4[ + Add Scan ———— 9

Delete EE— 1

5 validate I

Duress ]——— A

N o
Mo |em  Joesopion

1 Device Select a device to enroll the fingerprint with.
’ Quality Select a fingerprint enroliment quality level. Any fingerprint which does not
meet the quality requirement will not be enrolled.
3 View Image | Select this option to view the original image when a fingerprint is scanned.
Enroll . ) . ) .
4 ) ) Click + Add to add a fingerprint. Up to 10 fingerprints can be added.
Fingerprint
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This section shows the analysis of the fingerprint enrolled.
-
Fingerprint e e i ing
5 | P ;i- i ¥ e ":-. =
mage 2elTa St
i T | 7 s
4 P£ 1 o ¥ F‘:
4 iy, L4 q* 5
Select this option to add the fingerprint as a duress fingerprint. When
6 Duress threatened by someone to open the door, the user can authenticate using
this fingerprint to send an alarm signal to BioStar 2.
. It is possible to check if the fingerprint has been enrolled already or not
7 Validate P i ) gerp y
when using the server matching.
8 Delete Deletes the selected fingerprint.
9 Scan Click Scan and then place a finger on the fingerprint scanner or the device
sensor.

2) Click Enroll to enroll the fingerprint.

3) Setthe 1:1 Security Level and click Apply.

Note

= Fingerprints used for regular access should not be registered as duress fingerprints.

= The View Image option shows the fingerprint image but does not store it on BioStar.

= If the fingerprint authentication rate is low, delete the existing fingerprint information and add

a new fingerprint.

= Use an adequate security level. If 1:1 Security Levelis too high, the fingerprint

authentication rate may be too low or the false rejection rate (FRR) may be too high.

= For best fingerprint scanning quality, make sure to cover the entire surface of the fingerprint

sensor with the finger. We recommend using the index finger or the middle finger.

Enroll Face

You can add the user's faces if the device supports face authentication.
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Note

= When registering a face, maintain a distance of 40cm to 80cm between the device and the

face.

= Be careful not to change the facial expression. (smiling face, drawn face, wink, etc.)

= If you do not follow the instructions on the screen, the face registration may take longer or

may fail.

= Be careful not to cover the eyes or eyebrows.

= Do not wear hats, masks, sunglasses or eyeglasses.

= Be careful not to display two faces on the screen. Register one person at a time.

= Itis recommended for a user wearing glasses to register both faces with and without glasses.

1) Click + Face and configure the settings.

Enroll Face x

1 4[. Device

Mone -

2 4[. Face Pose Variation . 4

Enroll Face

3 4[ 1st Scan - 7

+ Add Delete .

Use as Profile Image 5

. o

o JomJorgin

1 Device Select a device to enroll the face with.
Face Pose Set the sensitivity for the position, angle, and distance of a face when
2 Variation registering the face. Set the sensitivity high if you wish to obtain a detailed
face template.
3 Enroll Face Click + Add to add a face. Up to 5 faces can be added.
4 Face Image | View the registered face.
5 Use as Select the registered face you wish to use as your profile image.
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Profile
Image
6 Delete Deletes the selected face.
7 Scan Click Scan and then follow the instructions on the device screen to scan.

2) Click Enroll to enroll the face.
3) Setthe 1:1 Security Level and click Apply.

Note

= If the face authentication rate is low, delete the existing face information and add a new face.
= Use an adequate security level. If 1:1 Security Level is too high, the authentication rate may

be too low or the false rejection rate (FRR) may be too high.

Enroll Visual Face

Visual Face is a credential that captures the user's face with a visual camera. It is different from face
information captured with an infrared camera and is only available on devices that support Visual Face.
Visual Face can also be registered non-face-to-face using a user's mobile device.

Note

= The devices that can use Visual Face are as follows.
- FaceStation F2, BioStation 3
= Cautions for enrolling a visual face
- When enrolling a face on the device, maintain a distance of 60-100 cm between the device
and the face.
- When enrolling a face on the device, stand still and enroll the face by staring at the screen.
- When enrolling a face on the device or the mobile device, if the user does not follow the
instructions on the screen, the face enrollment may take longer or fail.
- Do not change the user's face expression.
- Do not enroll a face while the user is wearing masks, hats, or eye patches.
- Do not enroll a face with the user raising their head or bowing.
- Do not wear thick makeup.
- Users should not enroll their faces with their eyes closed.
- Make sure that both of user's shoulders correctly appear on the screen.
- Be careful not to display two faces on the screen. Enroll one person at a time.

= Register by Device
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You can enroll a visual face by FaceStation F2 and BioStation 3.
1) Click + Visual Face and configure the settings.

Enroll Visual Face X

1 4[- Device FaceStation F2 547836011 (192.168.12.179) v

Enroll Visual Face

2 4[ + Add Scan 4

Upload Image —————— 5

Delete G

Use as Profile Image —————— 7

Drop image here

= -
o L om oo

1 Device Select a device to enroll the visual face with.
Enroll ) ) .
. Click + Add to add a visual face. Up to 2 visual faces can be
2 Visual
added.
Face
Visual . .
3 Face View the scanned or uploaded image. You can also upload
image files by dragging and dropping.
Image
4 Scan Click Scan and then follow the instructions on the device
screen to scan.
Upload the image to use as a visual face.
5 Upload Note
Image
= Supported image file size is up to 10MB.
= Supported image file formats are JPG, JPEG and PNG.
6 Delete Deletes the selected visual face.
Use as . . .
) Select the registered face you wish to use as your profile
7 Profile )
image.
Image

2) Click Enroll to enroll the visual face.
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= Register by CSV Import

You can enroll user's visual face by importing CSV.

1) Click USER.

2) Select users from the user list you intend to enroll visual faces.

3) Export the selected list to a CSV file by referring to CSV Export.

4) Enter the file name of visual face image, including the extension in visual face
column (face_image_filel, face_image_file2) of CSV file, and then save it.

5) Import CSV file that added visual faces into BioStar 2 by referring to Import CSV.

6) Click Browse, select the path where visual face images are stored, then click
Upload.

CSV Import X

+ Face Image Directory

Please select a directory Browse

Success 0

Fail 0

Note

= Itis recommended to use the same path for the CSV file and visual face
image files to be loaded.

= Supported image file size is up to 10MB.

= Supported image file formats are JPG, JPEG and PNG.

7) Click Next to complete the CSV import. If an error occurs during the import of
CSV file information, you can upload it again after checking only the erroneous
CSV data.

= Register by Visual Face Import
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You can enroll user’ visual face by importing face image files that match user ID.
1) Click Visual Face Import.

All Users Wil <P s I o B sorows v :}

# Batch Edit [ Transfer To Device W Delete User .

Print

Access Group.

Golumn Setting

. CSV Export
[ Administrator - All Users
CSV Import
2 USER1 abe@suprema.co kr All Users i
Visual Face Import
3 USER2 def@suprema co kr All Users - Data File Export
Data File Import
O USER3 ghi@suprema.co kr All Users
Send Visual Face Mobile Enrollment Link
Visual Face Migration

2) Click Browse, select the directory where face image files are stored, then click
Upload.

Visual Face Import X

« Face Image Directory

Please select a directory Browse

[ « New Visual Face Import

1 @ Import image files whose name matches user ID

Import image files whose name matches user 1D
+ Add new user by using file name as user ID

[ «+ When a user already has visual face

2 ® | preserve
overwrite
3 — [] use as Profile Image

0%

Success 0

Fail 0

Description

= Import image files whose name matches user ID:

New Visual The image is imported only when the user ID registered in
1| Face BioStar 2 and the file name match, and files that do not
Import match are ignored.

= Import image files whose name matches user ID +
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Description

Add new user by using file name as user ID: If the file
name matches the user ID registered in BioStar 2, the
image is imported, and if there is a file name that does not
match, a new user is added using the file name as the user
ID and the Visual Face is enrolled.

When a = preserve: Maintains the already enrolled users visual
’ user face.
already has | = overwrite: Overwrites the newly imported visual face
visual face over the existing visual face.
Use as . L . .
3 | Profile Check this option if you want to use an imported visual face

as a user's profile image.
Image

3) Click Start to complete the Visual Face Import. If an error occurs during
image file import, BioStar 2 will return a list of image files failed to import, you
can check which face image files are not suitable.

Note
= Supported image file size is up to 10MB.

= Supported image file formats are JPG, JPEG and PNG.

= Only one visual face can be imported per user ID.

= Register by Mobile Device

You can send the visible face mobile enroliment link to users via email. Users can
access the link from their mobile device and enroll their visual face directly.

1) Select users from the user list you intend to enroll the visual face and click | *** ..

All Users [« [ [ ] | sorows v | [ |

# Batch Edit (3 Transfer To Device W Delete User s

Print

Access Group.

Column Setting

X CSV Export
1 Administrator - All Users

CSV Import
2 USER1 abe@suprema.co kr All Users
- Visual Face Import
3 USERZ def@suprema.co kr All Users - Data File Export

Data File Import

o[ma@mod

4 USER3 ghi@suprema.co.kr All Users

Send Visual Face Mobile Enroliment Link

Visual Face Migration

2) Select Send Visual Face Mobile Enrollment Link and then click Yes. The
visual face enrollment link will be sent to the email of the selected user. When

the user completes the upload, the visual face is enrolled in the user

170



10 Users

information.

Note

= Complete the email settings including SMTP settings before using Visual
Face Mobile Enrollment. Refer to the for more information.

= You can check whether the email was successfully sent or not in the audit
trail. See the for more information.

» If the user receiving the visual face mobile enrollment link uses an external
email application, the language of the email application must be set to the
language of their country. If the language does not support Unicode, the text
in the email may be broken.

=  When the user clicks on Visual Face Mobile Enrollment link, the Visual

Face Enrollment Service is executed as follows.

Follow the instructions on the screen to enroll the visual face.

BioStar 2

Visual Face Registration

BioStar 2

BioStar 2 Visual Face Registration is required to send limited personal data on
individuals to facilitate the service being provided for the operator. This
U 0 information is collected by cach operator for the purpose of providing templates
for biometric authentication to users. All data sent is required and managed by
the operator eollecting the data for this purpose and the manufacturer does not
collect any data separately.

Personal information to be sent and managed by operator

from current webpage

Visual Face Registration

Cancel

© 2020 SUPREMAINC. ALL RIGHTS RESERVED.

Please take a picture by following the guide below.
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Enrol

BioStar 2

Visual Face Registration

BioStar 2

Visual Face Registration

m Photo

NG/IPG only (Less then SMB)

Your visual face has been
successfully enrolled.

Caneel

= Supported image file size is up to 10MB.

= Supported image file formats are JPG, JPEG and PNG.

= Visual Face Enroliment link sent will expire after 24 hours.

= Once the Visual Face Mobile Enrollment process is successful after
uploading a face picture, an enrollment success message appears on the
screen. If enrollment fails, a failure message and reason are displayed,
and the user can retry the Visual Face Enrollment again using a different

face picture.

| Card

You can assign access cards to users or manage the existing cards.

For the types of card supported by the device, refer to the device manual.

Registering CSN Card
Registering Wiegand Card

Registering Smart / Mobile Cards

[Card Enrollment using the USB Agent]

EM X X X

MIFARE O X 0]

172



10 Users

Card Type

(0] X (0]

DESFire
FeliCa 0 X X
HID Prox X X X
HID iCLASS X X X

Registering CSN Card

You can register the CSN cards.

1) Click + Card.
2) Select CSN for Card Type.

Enroll Card X

« Card Type CSN b4
« Registration Register by Card Reader -
Option
+ Device BioStation 2 546832590 (192.168.16.108) v
Information
« Card ID Read Card
Cancel

3) Select a desired Registration Option.
= Register by Card Reader
You can register a card by scanning the card information with the device connected
to BioStar 2.
a) Select Register by Card Reader for Registration Option.
b) Select the device to scan a card.
¢) Click Read Card and scan a card with the device.

== Assign Card

You can assign a registered card to a user.
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a) Select Assign Card for Registration Option.
b) Click the card to be assigned from the list or search for the card.

= Enter Manually
You can register a card by entering a card number directly.
a) Select Enter Manually for Registration Option.

b) Click Use User ID or enter directly.

4) Click Enroll to register a card.

(® Related Information

Card Usage Status

Card Format

Registering Wiegand Card

You can register the Wiegand cards.

1) Click + Card.
2) Select Wiegand for Card Type.

Enroll Card X

« Card Type | Wiegand - |

« Card Data | 26 bit SIA Standard-H10301 v |
Format

« Registration | Register by Card Reader - |
Option

« Device | BioStation 2 546832590 (192.168.16.108) - |

Information

« Facility Code | || Read card

« Card ID 1 | |

‘ Enroll ‘ [ Cancel ]

3) Seta Card Data Format. If no desired card data format is available, see Wiegand to set a
Wiegand format.
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4) Select a desired Registration Option.

= Register by Card Reader
You can register a card by scanning the card information with the device connected
to BioStar 2.
a) Select Register by Card Reader for Registration Option.
b) Select the device to scan a card. The available devices will be displayed on the

top of device list, if no device is available, see CSN Card Format of

c) Click Read Card and scan a card with the device.

= Assign Card
You can assign a registered card to a user.

a) Select Assign Card for Registration Option.

b) Select the card to be assigned from the list.

Note

= Only the cards with the set Card Data Format will be displayed on the
list.

== Enter Manually
You can register a card by entering a card number directly.
a) Select Enter Manually for Registration Option.

b) Enter the Facility Code or Card ID 1.

4) Click Enroll to register a card.

® Related Information

Registering Smart / Mobile Cards

It is possible to enroll the Access on card, Secure credential card or Custom smart card.

Note

= To set the mobile card, set Active for Mobile Card Enrollment on the User/Device
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Management tab of Setting > SERVER.
= Toissue a smart card or a mobile card, the correct card type must be set. For detailed
contents regarding the card type, refer to Smart / Mobile Card.

1) Click + Card.

Enroll Card X

- CardType | Smart Card v |+ Device | BioStation A2 541531008 (192.1.. v |
+ Card Layout Mobile Card + Smart Card | Secure Credential Card - |
Format Type
— Information
+ Card ID 12 | + PIN
« Fingerprint
1st Finger 2st Finger
Duress Duress

s | e R

1) Select Smart Card for Card Type.

2) Select a device where the smart card can be used. To set the smart card layout, refer to Card
Type on Authentication.
3) SetCard Layout Format. It is possible to set the card layout from Smart Card.
4) Select Smart Card Type.
= Access On Card: Allows you to save user information (Card ID, PIN, Access Group, Period,
and fingerprint templates, Private Auth Mode) on the card.
= Secure Credential Card: Allows you to save user information (Card ID, PIN, and fingerprint
templates) on the card. To use user information stored in BioStar 2, server matching must be
activated.
= Custom Smart Card: You can enroll smart cards issued by third parties. Proceed with
registration based on the selected Registration Option.
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Note

= The devices and the firmware versions that can use the Custom Smart Card are as

follows.
- XPass D2 FW 1.7.1 or later
= To set a new smart card layout, refer to

5) Select the fingerprint template to be enrolled on the card.
6) Clicking Issue Mobile Card or Write Smart Card will enroll the card.

Note

= If a mobile card has been issued, it can be used only after the issued card is activated through
the BioStar 2 Mobile app.

= Itis possible to set card ID for the Secure credential card directly.

= The information stored in BioStar 2 is used for the user information to be stored in the smart
card. If the new user information is not stored, incorrect user information may be stored in
the smart card. Also, if the changed user information is not synchronized with the device, the

device may not be able to carry out authentication.

(® Related Information

Read/Format Smart Cards

It is possible to format the smart card and record information again.

1) Click + Card.
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Enroll Card X

+ Card Type | Read card v |+ Device | BioStation 3 50998977 (1. v |
+ Suprema Smart Card + Custom Smart Card
Layout Format Layout Format

+ Smart Card Type

— Information
+ Card ID + PIN
+ Access Group + Period
+ Fingerprint
1st Finger 2st Finger
Duress Duress
+ Private Auth Mode
Mo applicable data

e .

2) Select Read Card for Card Type.
3) Select a device which can read the smart card. The list of devices only appears when the smart

card layout is set. For setting, refer to Card ID Format on Authentication.
4) Select Smart Card Type.
5) Click Read Card.
6) Check the card information and click Format Card.

® Related Information

Card Usage Status

Card Format
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Enroll Mobile Access Card

You can assign the mobile access to users when using the mobile access in conjunction with Suprema
Airfob Portal.

Mobile Access Card supports registration either of each user individually or of multiple users at once via
CSV Import.

Depending on the issuance method of Mobile Access Card set in the Airfob Portal, the user's email or
phone number should be entered.

Note

= For more information about using Suprema Airfob Portal and Mobile Access, see

Enroll CSN Mobile Card

Issue CSN mobile access cards to users.

Note

= For more information about using Suprema Airfob Portal and Mobile Access, see

1) Click + Mobile.
2) Select the Card Type as CSN Mobile.
3) Select a desired Registration Option.

== Assign Card

Unassigned CSN Mobile cards registered in BioStar 2 can be assigned to users.
a) Select Assign Card for Registration Option.
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Enroll Mobile Access Card X

+ Card Type | CSN Mobile v |
+ Registration | Assign Card - |
Option - /

x ]@ (=) ) B0 [ sorows v |

9 CSN Mobile Unassigned
22 CSN Mobile Unassigned
— Information
+ Photo C) Mot Use
+ Department () Marketing
s Title () Manager
— Period
+ Expiry Period | +1 Day || +7 Days || +30 Days | | +1 Year |
« Period | 2020/11/26 || 15:53 | ~ | 2020/11/27 || 15:53 |H

B -

b) Click the card to be assigned from the list or search for the card.

c) After setting Information and Period, click Enroll.

Note

= If the user's photo, department, and title are set in User Information, the
corresponding information can be displayed on the user's mobile access
card. Activate the items to be displayed on the mobile access card.

= The Expiry Period is only active when using the site type Dynamic. You
can set the user's mobile access card expiry period and usage period.

== Enter Manually
CSN Mobile cards can be registered with a card ID entered manually or a random

card ID.
a) Select Enter Manually for Registration Option.
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Enroll Mobile Access Card X

«+ Card Type CSN Mobile v

+ Registration Enter Manually -
Option

Card ID

+ Card ID Use User ID

+ Input Type C) Use random card 1D

Information

. Photo (3P notuse

+ Department C' Marketing

«+ Title C' Manager

Period

+ Expiry Period +1 Day +7 Days +30 Days +1 Year

+ Period 2020/11/26 15:53 ~ 2020/11/27 15:53  |HH

-

b) If Input Type is set as Use random card ID, a card ID is automatically
generated. Click Use User ID to use the user ID as the card ID.
If Input Type is set at Enter manually, a card ID can be entered manually.

c) After setting Information and Period, click Enroll.

Note

= Itis recommended to set Input Type to Use random card ID to prevent
duplicate card ID generation.

= If the user's photo, department, and title are set in User Information, the
corresponding information can be displayed on the user's mobile access
card. Activate the items to be displayed on the mobile access card.

= The Expiry Period is only active when using the site type Dynamic. You
can set the user's mobile access card expiry period and usage period.

4) Click Enroll to register a mobile access card.

Note

= If the activation code sent to you via email or text message is lost or deleted, you can reissue
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the activation code by clicking Resend. However, Mobile Access Cards activated in the Airfob

Portal cannot be reissued.

CSN Mabile Mabile Access Card D: 1231231244123 Resend Block | W

® Related Information

Enroll Template on Mobile

Template on Mobile is a Mobile Access card in which the user's biometric templates can be stored so
you can still use biometric authentication although your biometric information is not stored in BioStar 2
server, Airfob Portal, or device.

Template on Mobile can be useful in an environment where you want to use biometrics as a
credential, but can't store biometric information on servers or devices due to privacy concerns.

Because the issuance of Templates on Mobile and the enroliment of biometric templates are separate
processes, users can enroll visual faces directly from a Template on Mobile support device without

facing an administrator.

Note

= The devices and firmware versions that support Template on Mobile are as follows.
- BioStation 3 FW 1.2.0 or later
= For more information about using Suprema Airfob Portal and Mobile Access, see

= Mobile access cards can only use either the CSN Mobile card or Template on Mobile.

= Only one Template on Mobile can be issued per user.

1) Click + Mobile.
2) Select the Card Type as Template on Mobile.
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Enroll Mobile Access Card X

+ Card Type

+ Smart Card Type

Card Information

« Card ID

+ Access Group

+ Private Auth
Mode

Information

+ Photo

+ Department

« Title

Period

+ Expiry Peried

+ Period

Template on Mobile

Access On Card

+ PIN
+ Period
+ Add
C) Not Use
(P notuse
C) Not Use
+1 Day +7 Days +30 Days +1 Year
2023/09/05 i8:20 | ~ 2023/09/06
T

18:20

3) Select a desired Smart Card Type.

Access On Card: Allows you to save user information (Card ID, PIN, Access Group, Period,
Private Auth Mode) on the card.
Secure Credential Card: Allows you to save user information (Card ID, PIN) on the card. To

use user information stored in BioStar 2, server matching must be activated.

4) After setting Information and Period, click Enroll.

Note

If the user's photo, department, and title are set in User Information, the corresponding
information can be displayed on the user's mobile access card. Activate the items to be

displayed on the mobile access card.

The Expiry Period is only active when using the site type Dynamic. You can set the user's

mobile access card expiry period and usage period.

An issuance mail will be sent to the enrolled user's mail. To use it, need to install the Airfob
Pass application via the link in the mail, and then issue the Template on Mobile on the

smartphone.
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5) Tag the issued smartphone to the device and follow the on-screen instructions to enroll visual face
on Template on Mobile.

Note

= Template on Mobile authentication method

First, tag your smartphone to the device, then follow the instructions to authenticate your
face.

(® Related Information

Enroll QR/Barcode

You can use QR/Barcodes as a means of authentication.

Note

= The devices that can use Use QR/Barcode through Scanner are as follows.
- X-Station 2 (XS2-QDPB, XS2-QAPB)
= The devices that can use Use QR/Barcode through Camera are as follows.
- X-Station 2 (XS2-ODPB, XS2-OAPB, XS2-DPB, XS2-APB) firmware 1.2.0 or higher
- BioStation 3 (BS3-DB, BS3-APWB) firmware 1.1.0 or higher
- Using Use QR/Barcode through Camera requires a separate device license. For more
information, refer to

1) Click + Qr/Barcode.
2) Select the QrR/Barcode Type.

= BioStar 2 QR

You can directly issue a QR code that contains an encrypted PIN on BioStar 2.
A QR code will be sent via email registered in user information.
Note

= Complete the email settings including SMTP settings before using
BioStar 2 QR. Refer to the for more information.

= Toissue a BioStar 2 QR, the user's email address must be registered in
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user information.

a) Select BioStar 2 QR in the QrR/Barcode Type.
Enroll QR/Barcode X

* QR/Barcode Type | BioStar 2 QR

— Information
« Card ID 167462115154950 |
+ Input Type C) se random card ID
* BioStar 2 QR includes a PIN which is encrypted.

N -

b) Set details of a card to be issued in Information section. When setting the

Input Type option to Use random card ID, a card ID is automatically
generated. When setting the Input Type option to Enter manually, you need

to enter a user ID manually.

Note

It is recommended to set Input Type to Use random card ID to

prevent duplicate card ID generation.

QR/Barcode

You can register users with QR/Barcodes issued from 3" party systems.

a) Select QR/Barcode in the QR/Barcode Type.
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Enroll QR/Barcode X

+ QR/Barcode Type | QR/Barcode -
+ Registration Enter Manually v
Option
Information
+ Card ID
Cancel

b) Select Enter Manually in the Registration Option.
¢) Enter an existing QR/Barcode ID manually.

Note

= You can enter a card ID up to 32 characters including alphabets,

numbers, or special characters.

3) Click Enroll to register a QR/Barcode.

1:1 Security Level

1:1 Security Level can set a separate security level for the user regardless of the biometric 1:N
Security Level set in the device.
If there are users who frequently fail authentication because the device's 1:N Security Level is set too

high, authentication failures can be mitigated by setting the 1:1 Security Level low.

1) Setthe 1:1 Security Level.

+ 1:1 Security Level . | Device Default

2) Click Apply to save the settings.

Note

= If Auth Mode starts with biometric, 1:1 Security Level cannot be applied because the
entered user is not known, and Auth Mode starts with Card or ID only 1:1 Security Level

is applied because user identification is possible.
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= Use an adequate security level. If 1:1 Security Levelis too high, the fingerprint
authentication rate may be too low or the false rejection rate (FRR) may be too high.

Biometric Credential Sync

You can resend biometric credentials to devices.

Note

= If Automatic User Synchronization is set to Not Used in Setting > Server > User/
Device Management, Sync is not available.

1) Click Sync.

Type ‘Card Data Format ‘Summary

Visual Face - 1 sync | # §

Transferring User Information to Devices

You can transfer user information registered with BioStar 2 to devices.

1) Select a user to transfer and click Transfer to Device.
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Transfer To Device X

Users (3)
+ Device List
[] All Devices
[] 16F
|:| i BioLiteNet 538101276 (192.168.16.230)

|:| Overwrite users with different information

Transfer ‘ | Cancel

2) Select the Overwrite users with different information option to overwrite duplicate user
information.

3) Select devices to transfer the information to. Click Q to search for a device.
4) Click Transfer to transfer the user information.

® Related Information

Managing Users Registered with Devices

Deleting User from Devices

You can delete users from each device registered in BioStar 2.

1) Select a user to delete from the device and click Delete From Device.
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Delete From Device X

Users (3)
* Device List

All Devices

14F

hdl E ioStation L2 542501048 (192.168.14.125

m

= -

Note

= The Delete From Device button is activated only when the Automatic User
Synchronization is set as Not Used. You can refer to the User/Device Management for

more detailed information on the Automatic User Synchronization.

2) Select devices to delete the users. Click Q to search for a device.

3) Click Delete to delete users.

Note
When you delete a user, it is only deleted from the device and the user in BioStar 2 remains

intact.

Editing User Information

You can edit an existing user or batch edit multiple users.

1) Inthe user list, click a user to edit.
2) Edit the details by referring to the instructions in Adding User Information, Adding User Credentials

and Enroll Card.
3) To batch edit information of multiple users, select multiple users and click Batch Edit.
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Batch Edit X

Users (19)
+ Group
Active

+ Status

+ Period

+ Access Group

SN N NN

+ Operator Level

Cancel

4) Click # of a field to edit its information.
5) Click OK to save the changes.

Note

= You cannot modify the Operator Level of "Administrator".

Managing Long-term ldle Users

You can view, edit and delete the users who do not have access events for the recent months.

You can use a filter or combine filters to narrow down the result and export it as a CSV file.

1) Click Status tab.

2) Set the idle period. You can choose from one month to six months.

3) You can narrow down the result by setting the filters on the headers of the result table.
4) Click Delete User after selecting multiple users if you want to delete the multiple users.

Note

= Only users with the operator level of Administrator or User Operator can use the Delete
User menu. You can refer to the Adding User Information for more detailed information on

the operator level.

Visual Face Migration

Migrate all the visual faces from the previous version to the improved visual face algorithm.
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1) Click USER.

2) Click |+ and then select the Visual Face Migration.

3) Click Continue after reading the warning pop-up message, Visual Face Migration process goes

4) When Visual Face Migration is complete, a result popup appears. You can check the total number

5)

On the ZONE page, you can add anti-passback, fire alarm, schedule lock and schedule unlock zones, and

All Users (e 0o ) D Jon ()00 ) | sorows v | a - |

Access Group

|:| 1 Administrator - All Users
|:| 2 USER1 abc@suprema.co_kr All Users
I:‘ 3 USER2 def@suprema.co.kr All Users
|:| 4 USER3 ghi@suprema.co.kr All Users

Print

Column Setiing

CSV Export

CSV Impert

Visual Face Import

Data File Export

Data File Import

Send Visual Face Mobile Enrollment Link

Visual Face Migration

on.

of Visual Face enrolled in BioStar 2, and the nhumber of migrations succeeded visual faces and the

migration failed visual faces.

Visual Face Migration X

"\ S SBSWwhaaaat

+ Migration Result

Total Visual Faces(Users) 2(2)

Success(Users) 2(2)

Failure(Users) 0(0)
Close ]

If a migration error case occurs, the list of users who have failed migration will be provided as a

CSV file. You can delete the visual faces that have failed migration at once by clicking Delete.

configure the settings.
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Anti-passback Zone
Fire Alarm Zone
Schedule Lock Zone
Scheduled Unlock Zone
Intrusion Alarm Zone
Interlock Zone

Muster Zone

Occupancy Limit Zone

Note

=  The ZONE menu will appear when the Advanced or higher license is activated.

! 4[ Anti-passback

2 3

7 _[ M Anti-passback E]]i 4
fresm - Name Exit Devices Active/Inactive Status
Scheduled Lock

[] ape1 BioEntry W2 544117812 (192... Xpass D2 400000005 Active Normal

Scheduled Unlock

6
Intrusion Alarm
Interlock 5
Muster
Occupancy Limit

1 Add Zone £ Zone List
2 Page Navigation Buttons and Number of List Rows ¢ Zone Type

-

¢ Registered Zone Search

< Function Button (Column Setting)

7 Expand Button

Anti-passback Zone

Anti-passback zone provides an enhanced function than the door based anti-passback feature.

1) Click ZONE and click ADD ZONE.
2) Click Anti-passback and click Apply.
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Information

—

* Name

Configuration

Alarm

-

* Mode

+ Anti-passback Type

« Entry Confirmed APB

- Entry Devices

+ Network
Failure Action

*+ Action

APB Bypass

—

o Trm—Jomorgon

- Bypass Group

Information

APB 1 * Type

Global « Active/Inactive
Soft APB + Reset Time 1440 min.
Follows door configuratio

+ Exit Devices Xpass D2 400000005

+Add

Modify the information of the anti-passback zone.

= Name: Enter an anti-passback name.
= Type: View the zone type.

Configuratio
n

Modify the zone settings of the anti-passback.

= Mode: Itis possible to set either Local or Global for the range of zone
application. If Local is set, the zone can be set only with the entry devices
and devices connected with RS-485, and if Global is set, the zone can be
set with all devices enrolled in BioStar 2.

= Active/Inactive: You can disable the anti-passback zone. Select Active
to enable it.

= Anti-passback Type: Select an Anti-passback type.

= Reset Time: You can set a time period so that all anti-passback violations
can be deleted. This allows the user to be granted access after the time
period. The maximum possible duration is 7 days (10080 minutes). If set
to O, anti-passpack violations will not be deleted and the users who have
previously violated the anti-passback rule will not be granted access.

= Entry Confirmed APB: You can set the range to apply the anti-passback.
If Entry Confirmed APB is set to ON, the anti-passback is applied
according to the actual operation of the door that the entry and exit device
are configured. If this option is set to OFF, the rule is applied according to
the user's authentication regardless of the door operation. When set to
Follows door configuration, the anti-passback rule is applied according
to the setting of the Use sensor when Entry Confirmed APB enabled
option of the door.

= Entry Devices: Select a device to use for entry. You can select a device

193



11 Zone

o [rm  Jowowen

from the list of added devices. If no registered device is available, see
Basic Search and Registration, Advanced Search and Registration,
Wiegand Device Search and Registration, or Slave Device Search and
Registration.

= EXit Devices: Select a device to use at exit. You can select a device from
the list of added devices. If there is no registered slave device, see Basic
Search and Registration, Advanced Search and Registration, Wiegand
Device Search and Registration, or Slave Device Search and Registration.

= Network Failure Action: It is possible to set the door operation in case
the communication between BioStar 2 and the device where anti-passback
is set has been lost. Setting is available when Global is set for Mode.
When Open by auth is set, the door opens when the user has been
authenticated normally. When Open by auth & record APB log is set,
an anti-passback violation alarm occurs and the door opens. When Door
locked & record APB log is set, an anti-passback violation alarm occurs
and the door does not open.

3 Alarm Choose the operation to be triggered when an APB violation occurs.

Select an access level. Users who have the access level will not be restricted

4 APB Bypass .
by the anti-passback rule.

3) Click Apply to save the settings.

Related Information

Anti-passback

Fire Alarm Zone

Configure the fire alarm zone.

1) Click ZONE and click ADD ZONE.
2) Click Fire Alarm and click Apply.

194



11 Zone

Information

1 4': + Name

Configuration

* Mode
+ Door

+ Device / Input

Alarm

3 + Action

o JomJogin

1 Information

+ Type

s . i 1 1
‘\) Local Active/Inactive @) Active
Door 1 - + Elevator

+ Add

-t

Input Port 0 of BioStation 2 546832590 (192.168.16.196) .. + L/ Normally Open 100 =

Modify the information of the fire alarm zone.

= Name: Enter a fire alarm zone name.
= Type: View the zone type.

Configuratio
n

Modify the zone settings of the fire alarm zone.

= Mode: You can set fire alarm in two different modes. Local mode will
allow the master device and slave devices that are connected via RS-485
to be selected. Global mode will allow selection of all devices added to
BioStar 2.

= Active/Inactive: Disable the fire alarm zone. Select Active to enable
it.

= Door: Select the door(s) to include in the fire alarm zone.

= Elevator: Select the elevators to include in the fire alarm zone. You can
select multiple elevators.

= Device/ Input: Click + Add and configure the device to set off the fire
alarm signal.

Note

= When Local is set for Mode, either Door or Elevator can be set as
the fire zone.

= When CGlobal is set for Mode, both Door and Elevator can be set
as the fire zone at the same time.

3 Alarm

Choose the operation to be triggered when a fire alarm signal occurs.

3) Click Apply to save the settings.
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Scheduled Lock Zone

You can configure the scheduled lock zone. The scheduled lock zone keeps the door locked based on the

schedule that has been set.

Note

= The scheduled lock zone only supports local mode.

1) Click ZONE and click ADD ZONE.
2) Click Scheduled Lock and click Apply.

[ Information

+ Name

[ Configuration

+ Door

[ Alarm

+ Action

[ Scheduled Lock Bypass

+ Active/Inactive

- Bypass Group

+ Type

é [ Active + Door Lock Type [ L) Exit Allowed

Door 1 v + Schedule -

Not Use v

o Trm—Jomorgon

Information

Modify the information of the scheduled lock zone.

= Name: Enter a scheduled lock zone name.
= Type: View the zone type.

Configuratio
n

Modify the zone settings of the scheduled lock.

= Active/Inactive: Disable the scheduled lock zone. Select Active to
enable it.

= Lock Type: You can configure the zone to lock only the entering device,
or to lock both entering and exiting device.

= Door: Select the door(s) to include in the scheduled lock zone.

= Schedule: Select a schedule. If no desired schedule is available, click +
Add Schedule to create it.
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Note

= You can configure a scheduled lock zone by selecting multiple doors
in local mode.

3 Alarm

Choose the operation to be triggered when a scheduled lock signal occurs.

Scheduled
Lock Bypass

Select an access level. Users who have the access level will not be restricted
by the scheduled lock rule.

3) Click Apply to save the settings.

Scheduled Unlock Zone

You can configure the scheduled unlock zone. The scheduled unlock zone keeps the door open based on

the schedule that has been set.

Note

= The scheduled unlock zone only supports local mode.

1) Click ZONE and click ADD ZONE.
2) Click Scheduled Unlock and click Apply.

[ Information

+ Name

[ Configuration

+ Door

+ Active/Inactive

+ Door/Elevator

+ Access Group

« Type

@ ) Active + Started by @) Active
User Authentication

P poor + Schedule =

[ Scheduled Unlock Authentication

Not Use v

o JomJogin

Modify the information of the scheduled unlock zone.
1 Information
= Name: Enter a scheduled unlock zone name.
= Type: View the zone type.
5 Configuratio | Modify the zone settings of the scheduled unlock.
n
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= Active/Inactive: Disable the scheduled unlock zone. Select Active to
enable it.

= Started by User Authentication: When set as Active, the user who
belongs to the access group must authenticate in the configured schedule
to start a schedule unlock.

= Door/Elevator: You can set doors or elevators as schedule unlock zones.

= Schedule: Select a schedule. If no desired schedule is available, click +
Add Schedule to create it.

= Door: If you select Door, the door list is activated. Select the door(s) to
include in the scheduled unlock zone.

= Elevator: If you select Elevator, the elevator list is activated. Select the
elevators to include in the scheduled unlock zone. You can select multiple
elevators.

= Hoor: You can select the floor of the selected elevator.

Note

= You can configure a scheduled unlock zone by selecting multiple
doors in local mode.

= If you select an elevator that has already been configured with a
different scheduled unlock zone, you cannot set the same floor.

Scheduled
Unlock
Authenticati
on

You can select the access group where the user belongs who can start a
scheduled unlock.

3) Click Apply to save the settings.

Intrusion Alarm Zone

When intrusion alarm zone is used, you can detect trespassing of an unauthorized user to a designated

zone without permission.

1) Click ZONE and click ADD ZONE.
2) Click Intrusion Alarm and click Apply.
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[ Information

+ Name - Type

[ Configuration

7 — + Mode Local « Active/lnactive G Active

+ Deor 14F Door 01 v * The sensor of this door can be used as detecting intrusion

[ Arm/ Disarm Setting

« Delay Time Arm 0 =1 Disarm 0 =1

A _ - e il .
;3 — |
Device

+ Arm/Disarm Setting

(Device) Door Emtry / Exit Arm Type Input Type

+ Arm/Disarm Setting
I(Inuml . Davics / Input Amm Type Summary

[ Intrusion Setting

* Detect Intrusion

[ Alarm

+Add

b
|
:

+ Configuration

Modify the information of the intrusion alarm zone.

1 Information ] ]
= Name: Enter an intrusion alarm zone name.

= Type: View the zone type.

You can change the general settings of an intrusion alarm zone.

= Mode: You can check the application range of the zone. Only Local mode

Configuratio is supported for intrusion alarm zone, and the zone can be set only with

n devices connected to the entry device and RS-485.

= Active/Inactive: You can disable the intrusion alarm zone. Select
Active to enable it.

= Door: Select the doors to include in the intrusion alarm zone.

You can add an authentication setting for arm and disarm.

= Delay Time: You can set the delay time to arm or disarm. Arm is the
delay time from the authentication to the arm, and Disarm is the delay
time from the intrusion detection to the alarm occurs.

Arm / = Access Card: You can add a card with permission to arm or disarm. You

3 Disarm can register up to 128 access cards.

Setting = Access Group: You can add an access group with permission to arm or
disarm. You can register up to 128 access groups.

= Arm/Disarm Setting: You can set the arming and disarming by device
or input signal. Click + Add and set each item.

Add arming and disarming by device
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Click Device to select a device to control the intrusion alarm zone among
the entry and exit devices of the door, and select Arm Type.

Card, Key, and Card or Key can be selected for the Input type. Only
Card is available as the input type for a device with no LCD screen.

Add Arm/Disarm Setting (Device) X

+ Device

BioStation L2 542501048 (192.168.14.125) hd
+ Arm Type

Arm / Disarm A
+ Input Type

Card or Key -

-

Add arming and disarming by input signal

Click Device to select the device that controls the intrusion alarm zone.
Click Port and select an input port of the selected device.

Select Arm Type and set the switch type and the signal duration.
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Add Arm/Disarm Setting (Input) X

Setting
+ Device + Switch
™

| BioStation L2 542501048 ... v | @) normally open
+ Port + Duration{ms)

| Input Port 0 v | 100 =
+ Arm Type

| Arm / Disarm v |

| -

Note

= It is activated only when Door is set from Configuration.

You can set the intrusion detection signal. When you click + Add and set as
. shown in the screen below, the device recognizes the detection of intrusion if
Intrusion

4 Settin N/O sensor connected to input port O of BioStation L2 sends a signal for
g 100(ms).
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Add Intrusion Setting X

+ Device « Switch
™
| BioStation L2 542501048 ... v | @) rormally open
+ Port + Duration{ms)
| Input Port 0 v | | 100 =

. -

Note

= It is activated only when Door is set from Configuration.

Set the alarm action to carry out when a specific event occurs at the
intrusion alarm zone.

5 Alarm )
Note

= lItis activated only when Door is set from Configuration.

3) Click Apply to save the settings.

Interlock Zone

Interlock zone monitors the status of two or more doors by door sensor and relay state to control that
one door cannot be opened or close if other doors are open or unlocked. You can also disable access if
a user stays within the zone.
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Note

= Aninterlock zone can be configured with up to 4 doors.

= Aninterlock zone can only set the doors with the devices connected to the CoreStation.

= A device set as an interlock zone cannot be set to another zone.

= A door set as an interlock zone cannot be set to another zone other than the fire alarm zone.

1) Click ZONE and click ADD ZONE.
2) Click Interlock and click Apply.

3) Edit the necessary items.

[ Information

* Name

[ Configuration

2 — | * Mode

* Door

[ Option

* Action

[ Alarm

* Action

- Type

Local + Active/Inactive @) Active

Door 2 v * Door sensor must be set to use.

+Add

o Jom—Jorgin

Modify the information of the interlock zone.
1 Information )
= Name: Enter an interlock zone name.
= Type: View the zone type.
You can change the general settings of an interlock zone.
= Mode: You can check the application range of the zone. Only Local mode
i . is supported for interlock zone, and the zone can be set only with devices
Configuratio _
2 N connected to the CoreStation and RS-485.
= Active/Inactive: You can disable the interlock zone. Select Active to
enable it.
= Door: Select the doors to include in the interlock zone. You must select at
least two doors that are the door sensor is connected.
If a user stays in the zone, this option can prevent others from entering the
zone.
3 Option
Note
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= [tis activated only when Door is set from Configuration.

Alarm

Set the alarm action to carry out when a specific event occurs at the
interlock zone.

Note

= It is activated only when Door is set from Configuration.

4) Click Apply to save the settings.

Muster Zone

The muster zone is used as a place where users gather when an emergency occurs. It can also be used

for the purpose of monitoring the number of users and list of users in a specific area, or for notifying the

manager of alarms and alerts when a user stays in a specific area for a long time.

1) Click ZONE and click ADD ZONE.
2) Click Muster and click Apply.

3) Edit the necessary items.

[ Information

* Name

Configuration

* Mode

* Entry Devices

* Access Group

Alarm

* Action

* Type

Global * Active/Inactive ’—\ Active
BioLiteNet 538101276 v = Exit Devices BioStation 2 546832506 v

AG1 - * Max Time Limit 0 min.

“:“-‘Mld

o Thom Jomogon

Modify the information of the muster zone.

1 Information
= Name: Enter a muster zone name.
= Type: View the zone type.
You can change the general settings of a muster zone.
5 Configuratio | = Mode: You can check the application range of the zone. Only Global mode
n is supported for muster zone, and the zone can be set with all devices

added to BioStar 2.
= Active/Inactive: You can disable the muster zone. Select Active to
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enable it.

= Entry Devices: Select a device to use for entry. You can select a device
from the list of added devices. If no registered device is available, see
Basic Search and Registration, Advanced Search and Registration,
Wiegand Device Search and Registration, or Slave Device Search and
Registration.

= EXit Devices: Select a device to use at exit. You can select a device from
the list of added devices. If there is no registered slave device, see Basic
Search and Registration, Advanced Search and Registration, Wiegand
Device Search and Registration, or Slave Device Search and Registration.

= Access Group: Set the access group to which the user who will be
staying in the muster zone. Up to 16 access groups can be set.

= Max Time Limit: Set the maximum amount of time that user can stay in
the zone. It can be set up to 4320 minutes, and an alarm occurs when the
user stays in the muster zone exceeding the specified time.

Set the alarm action to carry out when a specific event occurs at the muster
zone.

3 Alarm Note

= It is activated only when Entry Devices and Exit Devices is set
from Configuration.

4) Click Apply to save the settings.

Occupancy Limit Zone

You can manage and control the population density of certain areas with Occupancy Limit Zone to
prevent overcrowding. You can also monitor the occupancy limit zone status or set an alert to get

notified when the zone has reached capacity.

Note

= Up to 100 occupancy limit zones can be added.

= Devices and firmware versions that are compatible with the occupancy limit zone features are
as follows:
- FaceStation F2 firmware version 1.1.0 or later
- FaceStation 2 firmware version 1.5.0 or later

1) Click ZONE and click ADD ZONE.

2) Click Occupancy Limit and click Apply.

3) Edit the necessary items.
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Information
1 —[ - Name oz - Type

Configuration

* Mode Global + Active/inactive Aetive
Entry Davices FSF2-0DB 547836011 - Exit Davices FaceStation 2 542189526 (192.168.12.169) v
Limit 50 » Auto Count Reset JP Hot use

+ Count Alert Use * Network Failure Allow Entry and Exit
Action

- Alert1 40

. Alert2 5 -

Count Bypass

3 —[ « Bypass Group Not Use v

o Jom—Jogin

Modify the information of the occupancy limit zone.

= Name: Enter an occupancy limit zone name.

= Type: View the zone type.
1 Information

Note

= Name can be up to 48 characters in length and cannot be set to the
same name as other zones.

Modify the settings of the occupancy limit zone.

= Mode: Check the application range of the zone. It only supports Global
mode for the occupancy limit zone.

= Active/Inactive: Deactivate the occupancy limit zone. If the zone is
deactivated, both Count that refers to the number of users in the zone and
Count Bypass settings will be initialized. Select Active to enable it.

= Entry Devices: Select a device to use for entry. You can select a device
from the list of added devices. If no registered device is available, see
Basic Search and Registration or Advanced Search and Registration.

= Exit Devices: Select a device to use at exit. You can select a device from

Configuratio the list of added devices. If there is no registered slave device, see Basic

n Search and Registration or Advanced Search and Registration.

= Limit: Enter the number of users who will be restricted from entering the
zone. If the number of users in the zone reaches the limit, entry will be
restricted. You can enter a number from 0 to 10,000, and if it is set to O,
people can enter the zone without limit.

= Auto Count Reset: Set the time to automatically initialize Count. The
Count will be initialized at the time you set every day.

= Count Alert: Set an alert to an administrator or set to save event logs
before Count reaches the occupancy limit. When Count Alert is activated,

+

the input field for Alert 1 appears. Click the to set Alert 2.
= Network Failure Action: Set whether to allow users to enter or leave
when a network error occurs in the device set in the zone. If you set it to
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Allow Entry and Exit, it stops entry restrictions when the device loses
network connection, and people can enter the zone even if Count in the
zone exceeds the occupancy limit.

Note

A device cannot be assigned to the entry device and exit device

simultaneously.

= You can set entry devices and exit devices up to 128 in total.

= A device using Dual Authentication cannot be set as the entry or
exit device.

= Set the time of Auto Count Reset based on UTC in the country
where the zone is located. For example, if the time is set to 00:00 in
UTC+9, the count is automatically reset at 01:00 in UTC+10.

= You can set up two alerts for Count Alert and only enter numbers

smaller than the Limit value. The values of both alerts must be

different.

Set Count Bypass by selecting bypass groups to allow users in the group to
enter the zone at any time without affecting the number of Count. The
Bypass Count column displays the number of people from Count Bypass in
the zone list.

3 Count )
Bypass Note

= Itis not able to use the Count Bypass feature when you set Thermal
& Mask Check Mode as Check without authentication while
using the device with a thermal camera.

= Up to 16 bypass groups can be added.

4) Click Apply to save the settings.

The list of the registered occupancy limit zones will be display and it shows the current status of zones.

3

G Reset Count © Activate

Occupancy Limit T

2
1 —[ [ Selectall © Deactivate ¥ Delete ]7 7
Status =

imit. &
8
O Occupancy Limit Zone 1 5} L] Normal o [+ /10 0 Normal 3 View &

1 Select All Select all occupancy limit zones in the list.
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Initialize both Count and Bypass Count settings. After initialization, user's
2 Reset Count | entry and exit logs will be deleted, and Count may be inaccurate depending
on the network status.
You can move a page or set the number of list rows to be displayed on one
page.
Page 5 he f
Navigation . : Go to the first page.
3 Buttons and = | *: Go to the previous page.
Number of « |2 /2 Enter the page number to move to.
List Rows = [ " : Go to the next page.
= | "I Go to the last page.
» | P77 - Set the number of list rows to be displayed on one page.
4 Activate Activate the deactivated zone.
. Deactivate the occupancy limit zone. If the zone is deactivated, both Count
5 Deactivate : ] o
and Bypass Count settings will be initialized.
6 Search Search the registered zone.
7 Delete Delete the zone.
The list of the registered occupancy limit zones will be display and it shows
the current status of zones.
= Name: View the zone name.
= Status: View the zone status.
- Normal: The number of users in the zone has not reached either preset
alerts or the occupancy limit, and more users can enter the zone.
- Count Alert: The number of users in the zone has reached alert 1 or
alert 2.
- Full: The number of users in the zone has reached the occupancy limit,
Occupancy and furtht_er _entr;_/ will be restricted. _
8 Limit Zone = Count/Limit: View the number of users currently in the zone and the
List occupancy limit. An administrator can directly modify the Count by clicking
the - or + buttons or by inputting a value after clicking the Count section.
= Bypass Count: View the number of users belonging to Count Bypass in
the zone.
= Device Status: View the network status of devices set in the zone.
- Normal: Networks work properly.
- Network Failure: A network error occurs in one or more devices.
= Full Screen: View the current status of the occupancy limit zone on the
full screen.
Note
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= If you have set Limit, you can enter up to 50,000. If you have not
set Limit, you can enter up to 999,999. (numeral character only)
You cannot enter a number above the maximum input value. If the
actual number of people in the zone is greater than the maximum
input value, the value exceeded will not be saved in the database.

You can use the MONITORING menu to view lists of access control events, device and door status, zone

status and the alert history.

You can see and control the status of the doors in real-time in the graphic if you add a graphic map.

List View

Graphic Map View

= Event Log

1 List View Graphic Map View
2>

Y Save Filter = Period | 4 | 1Day(s)(2020/10/12 00:00 ~ 2020/10/12 23:59) ¥ | b ]7 4

5
X af» 50 rows v

-k

= EventLog
I > . .
(® Real-time Log Date Door g Devicen T Device v userGroup T User v Event Y View
39 Live Video View
2020/10/12 150 547836011 FaceStation F2 5478 All Users 2(user 01) User update sueceeded (Bio.
Device Status
2020/10/12 15:0. 547836011 FaceStation F2 5478, All Users 1(Administrator) User update succeeded (Bio.
[ oor status
2020/10/12 14:5. 547836011 FaceStation F2 5478, All Users 1(Administrator) User update succeeded (Bio.
8
&> Wireless Door Lock Status
2020/10/12 14:5. 547836011 FaceStation F2 5478, BioStar connected
(@ Fioor Status
2020/10/12 14:3 547836011 FaceStation F2 5478 Tamper on
© zone status
2020/10/12 1433 547836011 Facestation F2 5478. DHCP connected
) Alert History e N
2020/10/12 14:3 547836011 FaceStation F2 5478 Device started
Y} Thermal Report
g ermal Repo 2020/10/12 14:3. 547836011 FaceStation F2 5478, Network connected

e

1 Tab buttons for List View and Graphic Map View

2 Expand Button

2 Save Filter Button

¢ Search period of Event Log

Page Navigation Buttons and Number
of List Rows

Function Button (Print, CSV Export,
Data File Import, Column Setting)

List of Selected Monitoring Items

Monitoring Categories

Note

= The Hoor Status, Zone Status and Graphic Map View will appear when the AC standard

license is activated.

= The Live Video Viewl menu will appear when the Video license is activated.
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List View

You can see lists of access control events, device and door status, zone status and the alert history.
You can also apply filters to the collected monitoring data and view specific types of monitoring

information.

Note

= The Hoor Status and Zone Status menu will appear when the AC standard license is
activated.
= The Live Video Viewl menu will appear when the Video license is activated.

Event Log

You can view all the logs of all past events. You can also apply various filters to sort the displayed data.

Note

= Make sure to check the time and date setting of the device. For more information on
configuring device time, see

= When the image log is set, you can view or store a stored image in its actual size.

= Use a separate storage media for the video log. Video logs might not be saved if the video
storage space is reduced by the external processing(such as copying files and creating files),

To change the path to save video logs, see

1) Click MONITORING > List View > Event Log.
2) To view log entries of a specific type only, click the Yof a column and apply a filter.
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3
= Event Log </ » || 50rows v
1 —[ Y Save Filter * Period 4 1 Day(s) (2018/12/12 00:00 ~ 2018/12/12 23:59) * | » ]7 2 @ }7 4
Date Door Y Devicein Y Device Y  userGroup Y user Y Event A
2018/12/12 13:36, 542501048 BioStation L2 542501... DHCP connected
2018/12/1213:36 542501048 BioStation L2 542501.. 1:N authentication failed (Fingerpr.
2018/12/1213:36 542501048 BioStation L2 542501.. Network connected
2018/12/12 13:36. 542501048 BioStation L2 542501 Network disconnected
5 2018/12/1213:36... 542501048 BioStation L2 542501. All Users 55(Simba) User deletion succeeded (BioStar)
2018/12/1213:28... 542501048 BioStation L2 542501... All Users 55(Simba) Access denied (Invalid access gro..
2018/12/12 09:47 542501048 BioStation L2 542501... All Users 55(Simba) User update succeeded (BioStar)
2018/12/12 09:47 542501048 BioStation L2 542501... All Users 55(Simba) User enrollment succeeded (Device)
2018/12/12 09:45 542501048 BioStation L2 542501... All Users 2(User01) User update succeeded (BioStar)
2018/12/12 09:45.. 542501048 BioStation L2 542501... All Users 1{Administra... User update succeeded (BioStar)
L |2018/12/12 09:42.. 538101276 BioLiteNet 538101276 Tamper on

escription

1 Save Filter Saves the set filter.
Button
2 Period You can set a desired period and sort event logs.
You can move a page or set the number of list rows to be displayed on one
Page page.
Navigation
3 Buttons and | . | |: Go to the first page.
Number of )
List Rows = [ *): Go to the previous page.
#910ws | get the number of list rows to be displayed on one page.
You can use the additional features with event logs.
) = Print the event log
Function )
Buttons = Export to CSV file
(Print, CSV = Import the data file
4 Export, Data | « Change the column setting
File Import,
Column :
Setting) Note
= For more information about importing a data file, see Import Event
Logs.
5 Event Log Shows the event log. When an image log exists, it is displayed as & and
you can view or store a captured image in its actual size in PC.

Note

= When Log Upload is set to Manual, the user can import the log manually by clicking Update

Log. For how to change log upload setting, refer to Server.
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Latest
All 1 + | » ] 50 rows

From To
Update Log [Z]

If Latest is set, the log saved after the date of the log saved last in BioStar 2 will be imported

from the device, and if All is set, all logs of the device will be imported to BioStar 2. You can
also set a date range within which to import logs.

Import Event Logs

You can view all the logs of all past events. You can also apply various filters to sort the displayed data.

Note

= The exported data file from devices using older firmware version cannot be imported into
BioStar 2. Make sure always use the latest version of firmware.

= Only data files exported from FacaStation F2, FaceStation 2, FaceLite, BioStation A2,
BioStation 2, X-Station 2 and BioStation 3 can be imported.

= Some information of event log may appear as a blank if a door, elevator, or zone is not set by
the BioStar 2.

1) Click .*** ! and then click Data File Import.

Print

CSV Export

Data{% e Import

Column Setting

2) Select the desired file (*.tgz) and then click Open.
3) A success message will appear on the screen when import successfully.

Real-time Log

You can view a log of various events in real time.

Note

= Make sure to check the time and date setting of the device. For more information on
configuring the device time, see

= The real-time log can only be viewed while the Real-time Log page is displayed. In other
words, when the administrator is viewing another page for changing device settings, etc., the
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real-time log cannot be viewed.
= If Log Upload is set to Manual in the Server, the real-time log cannot be viewed.
= When the image log is set, you can view or store a stored image in its actual size.

1) Click MONITORING > List View > Real-time Log.
2) To view log entries of a specific type only, click the T of a column and apply a filter.

2 3

® Real-time Log

2015/11/20 14:51:06 541530948 BioStation A2 5. Administrator Authentication failed @
5 2015/11/20 14:50:41 541530948 BioStation A2 5.. Administrator 1:1 authentication su... E]
2015/11/20 14:50:29 541530948 BioStation A2 5. Administrator 1:N authentication su @
2015/11/20 14:50:22 541530948 BioStation A2 5. Administrator Access denied (Captu... [Z]
m Item Description
1 Save Filter Saves the set filter.
Button
2 Start/Pause Pauses or starts real-time log collection.
Button
Clears the collected log information. To view the entire event log, see Event
3 Clear Button
Log.
Function
4 Buttons Changes the column setting of the log.
(Column
Setting)
Shows the event log. When an image log occurs, a notification will pop up on
5 Event Log the left side of the browser screen and you can view a captured image in its
actual size of store in PC. You can also press 2] to check.

Live Video View

You can see the screen of IP camera set in Video menu and event log set up in real time. In addition,
Open, Manual Unlock, Manual Lock, and Release functions are available for the door control function.

Note

= The Live Video Viewl menu will appear when the Video license is activated.
= For more information on registering the NVR and IP camera, see Video.
= IP cameras that do not support the live streaming feature are displayed as "Disconnected".
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=  PC-NVR does not support the live video view.

1) Click MONITORING > List View > Live Video View.

v Live Video View

AXIS (M3203)(door 1) v o e HIKVISION IPC-HFW14208(... ~ 2 B AXIS (M3203)(door 5) v e a =

AXIS (M3203)(door 2) v n o AXIS (M3203)(door3) v a o AXIS (M3203)(door4) v o o

2) Refer to the explanation below for how to operate the screen.

Select the IP camera to monitor. If there is no desired the IP camera, see
1 IP camera )
Video.
2 Open Open the door temporarily.
3 Manual Unlock the door manually.
Unlock
4 Manual Lock | Lock the door manually.
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5 Release Release the manual unlock or manual lock.
6 Large size The live view screen can be viewed in a large size.
view

Device Status

You can view various device status information such as the device status, alarm and last event.

1) Click MONITORING > List View > Device Status.

2) To view log entries of a specific type only, click the T of a column and apply a filter.

Device Status

BT -

3 [] BioLiteNet 538101268 Normal

|:| BioLiteNet 538101276 (19.. Normal

o [ Jowagen

1 Save Filter Saves the set filter.
Button
Function
2 Buttons Changes the column setting of the log.
(Column
Setting)
3 ) Shows the device status list.
Status List = Select a device and click Clear Alarm to clear the alarm.

Door Status

You can view various door status information such as the door status, relay status, alarm and last
event.

You can also apply various filters to sort the displayed data.

1) Click MONITORING > List View > Door Status.

2) To view log entries of a specific type only, click the T of a column and apply a filter.
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O Door Status
1 4[ Y Save Filter E]]i 2

door 2 Closed Normal Locked

o Trm—Jomorgon

1 Save Filter Saves the set filter.
Button
Function
2 Buttons Changes the column setting of the log.
(Column
Setting)
Shows the door status list.
The following operations are available for the selected door:
= Manual Lock: Click after selecting a door to lock the door manually. If you
set Manual Lock, the door will have remained inaccessible even if a user
authenticates.
= Manual Unlock: Click after selecting a door to unlock the door manually.
If you set Manual Unlock, the door will have remained accessible even if a
3 Status List .
user does not authenticate.
» Release: Release the manual lock or manual unlock set by the
administrator.
= Open: Click after selecting a door to open the door temporarily.
= Clear Alarm: Clear alarms of all doors. If an alarm is set in the Zone, the
alarm may be continuously output even if the door alarm is released. Click
Clear Alarmon Zone Status.
= Clear APB: Reset the anti-passback violation by selecting all or each user.
Note

Refer to below for the explanation on door events.

= Hre alarm unlocked: A state where the door designated as a fire alarm zone is unlocked
because a fire has broken out.

= Manual Lock: A state where the door is locked because the administrator has locked it
manually.

= Manual Unlock: A state where the door is unlocked and able to enter without an
authentication because the administrator has unlocked it manually.

= Schedule Locked: A state where the door is locked by the schedule that has been set.

= Schedule Unlocked: A state where the door is unlocked by the schedule that has been set.

= Normal: A state where a user can enter the door after an authentication.
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Wireless Door Lock Status

Check the battery status of the wireless door lock in use.

1) Click MONITORING > List View > Wireless Door Lock Status.
2) To view log entries of a specific type only, click the T of a column and apply a filter.

& Wireless Door Lock Status

1 ——[ Y Save Filter E]]— 2

3 Door Lock (1300000841) OSDP Antenna (1000000840) High battery leve

Door Lock (1300000842) OSDP Antenna (1000000840) High battery leve!

o [ Jowagen

1 Save Filter Saves the set filter.
Button
Function
2 Buttons Changes the column setting of the log.
(Column
Setting)
Check the battery status of the wireless door lock in use.
= High battery level: The battery level is sufficient.
= Low battery level/ Critical battery level: The battery level is low, it
is recommended to replace the battery for smooth operation.
3 Status List = Empty battery: The battery level is almost empty. Please replace the
battery.
Note
= In the Settings > ALERT menu, you can set alarms to occur at
Low battery level, Critical battery level, and Empty battery.

Floor Status

You can view various floor status information such as the floor status, relay status, alarm and last
event.

Note

= The Hoor Status menu will appear when the Advance or higher license is activated.
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1) Click MONITORING > List View > Hoor Status.

2) To view log entries of a specific type only, click the T of a column and apply a filter.

2

Floor Status W[« 1 > [ ] ] so0rows v

1 4[ Y Save Filter IZ] j’— 3

T FloorName Y  Floor Status Type Floor Relay

Elevator 1 Elevator 1-1 Normal Unlock

Elevator 1 Elevator 1 -2 Normal Locked

Elevator 1 Elevator1-3 Normal Locked

Elevator 1 Elevator 1 - 4 Normal Locked

|
u
U
d
a
d

Elevator 1 Elevator1-5 Normal Locked

o Thom Jomogon

1 Save Filter Saves the set filter.
Button
Function
2 Buttons Changes the column setting of the log.
(Column
Setting)
Shows the floor status list.
The following operations are available for the selected floor:
3 ) = Manual Lock: Click after selecting a floor to lock the floor manually.
Status List = Manual Unlock: Click after selecting a floor to unlock the floor manually.
= Release: Release the manual lock.
= Open: Click after selecting a floor to open the floor temporarily.
= Clear Alarm: Clears alarms of all floors.

Zone Status

View zone status information such as the zone active status, alarm status, and the last event that has
occurred.

Note

= The Zone Status menu will appear when the Standard or higher license is activated.
= To see the current status of Occupancy Limit Zone, click ZONE > Occupancy Limit.

1) Click MONITORING > List View > Zone Status.
2) To view log entries of a specific type only, click the T of a column and apply a filter.
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© Zone Status

1 4[ Y Save Filter

)

Y Active/Ina...

3 D Anti-passb... APB1

D Muster Muster 1

Active Mormal

Active Normal Muster Status

o Trom—Joworgon

1 Save Filter Saves the set filter.
Button
Function
2 Button Changes the column setting of the log.
(Column
Setting)
Shows the zone status list.
The following operations are available for the selected zone:
= Clear APB: Reset the anti-passback violation by selecting all or each user.
This can be only used when selecting an anti-passback zone.
= Clear Alarm: Release the anti-passbhack violation alarm when selecting an
anti-passback zone, and closes the door relays that has been opened by
the fire alarm when selecting a fire alarm zone.
3 Status List )
Note
= If a muster zone is set, you can check the user's status by clicking
the Muster Status.
<+ Muster 1 <) e ()00 | s0rows ~
InUsers 0, OutUsers 1, TotalUsers 2 Auto refresh at every minute E]
2 - All Users - 2018/03/01 12:48:27 Normal m

Alert History

You can view the history and status of various alerts. You can also apply various filters to sort the

displayed data.

1) Click MONITORING > List View > Alert History.

2) To view log entries of a specific type only, click the T of a column and apply a filter.
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2
@ Alert History W <) v e (o) o] | sorows ~
1 —[ Y Save Filter @ 3
Date T Device T User h Alarm T Ack. By Status
4
2016/07/20 09:16:45 BioLiteNet 5381012.. Tamper on Administrator 2016/07/20 09:16

escription

1 Save Filter Saves the set filter.
Button
You can move a page or set the number of list rows to be displayed on one
page.
[ ] M- i
Page : Go to the first page.
2 Indicator and | = [ *I: Go to the previous page.
Navigation « | 2 /2: Enter the page number to move to.
Buttons
= " Go to the next page.
» [ " Go to the last page.
« | 1% T - Set the number of list rows to be displayed on one page.
Function
Buttons
3 (Print, Prints the log or changes the column setting.
Column
Setting)
4 Shows the alert list.
Alert Histor . — . .
y Click ¥ to view the alert details.

Thermal Report

You can view the events including user's temperature information.

1) Click MONITORING > List View > Thermal Report.

2) To view log entries of a specific type only, click the T of a column and apply a filter.

4
2
{ Thermal Report x < s ) 50rows

1 —[ Y SaveFilter | = Period | « | 1Day(s)(2020/10/12 00:00 ~ 2020/10/1223:59) ¥ | b « Celsius/Fahrenheit () Celsius (‘C) ]7 3 B]ﬁ 5
Date User Group v User v Device T Telephone Email Temper_. Event v
5 2020110112 151655 AllUsers 2test) FaceStation F2 54735994 (192,168, 010-4444-4444 test@test.com 2930 Actess deried (Temp. not measured correctly)
202011012 15:16:51 A1l Users Z(test) FaceStation F2 547835994 (192.168._  010-dddd-4dda test@test.com 2930 Access denied (Temp. not measured correcty)
202011012 151648 Al Users 2tes) FaceStation F2 547835994 (192,168 010-4444-4444 testetestcom 2010 Access denied (Temp. not measured correctly)
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1 Save Filter Saves the set filter.
Button
2 Period You can set a desired period and sort thermal reports.
3 Celsius/ You can set the unit of temperature.
Fahrenheit
You can move a page or set the number of list rows to be displayed on one
Page page.
Navigation
4 Buttons and | , [« | Gg 1o the first page.
Number of )
List Rows = | *: Go to the previous page.
#910ws | get the number of list rows to be displayed on one page.
Function You can use the additional features with thermal reports.
Buttons
5 (Print, CSV = Print the event log
Export, .
Column = Export to CSV file
Setting) = Change the column setting
You can view the events including user's temperature information.
6 Reports Note
= You can sort the list in ascending or descending order by clicking on
the Date column.

(® Related Information

Thermal & Mask

Graphic Map View

If you add a graphic map, you can see and control the status of the doors in real-time in the graphic.
You can control the door and relay using the icons in the door status bar and see the alarm when an
event occurs at the door.

Adding and Managing Graphic Map Groups

Adding and Managing Graphic Maps

Note

= The Graphic Map View will appear when the AC standard license is activated.
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Adding and Managing Graphic Map Groups

You can register graphic map groups for easy management of multiple devices. Name your graphic map

groups according to door locations or office names for greater convenience.

= Adding Graphic Map Groups

1) Click MONITORING > Graphic Map View.
2) Right-click on All Graphic Maps and click Add Group.

All Graphic Mapg

Add Group

3) Enter a group name.

Note
= Graphic map groups may be created in up to 8 levels.

= Up to 48 characters may be entered for a graphic map group name.

Renaming Graphic Map Groups

1) Click MONITORING > Graphic Map View.
2) Right-click on the name of a group you wish to rename and click Rename

Group.

All Graphic Maps

Graphic Map Group 1

Add Group
Rename Group

Delete Group

3) Enter a group name.

Note

= Up to 48 characters may be entered for a graphic map group name.

Deleting Graphic Map Groups

1) Click MONITORING > Graphic Map View.
2) Right-click on the name of a group you wish to delete and click Delete Group.
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All Graphic Maps

Graphic Map Group 1

Add Group
Rename Group

Delete Group

Note

= You cannot delete a group if it contains a graphic map. To delete a

group, you must delete all graphic maps belonging to the group.

Adding and Managing Graphic Maps

If you add a graphic map, you can see and control the status of the doors in real-time in the graphic.

Adding Graphic Map

1) Click MONITORING > Graphic Map View.
2) Click ADD GRAPHIC MAP.

Configuration

* Name * Group
* Background Upload

* Door * Zone

3) Set the name and group of the graphic map.

4) Click Upload and select the background you want to use as the graphic map.

Note

All Graphic Maps

= The max size of the images that can be used as a background is 5MB.
= Supported image file formats are BMP, GIF, JPG, JPEG, PNG.

= If you back up the BioStar 2 database, the image file registered in the

graphic map may be deleted. If you want to continue using images

registered as a background even after database backup, back up the

image files.

5) Select the door you want to display on the graphic map from the Door. The

door status bar appears.
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Graphic .
1 M The uploaded background image appears.
ap
Door .
2 You can see the door status and temporarily open the door.
Status
Door
3 You can lock or unlock the door manually.
Relay
You can see the screen of the IP camera registered at the
door in real time.
Live
4 Video Note
View
= The Live Video View button is activated only when
the camera is registered at the door.
You can see or clear the alarm that has occurred on the
5 Alarm

door.

6) Select the zone you want to display on the graphic map from the Zone. The

Zone status bar appears.

You can see the type of zone.

224




12 Monitoring

Note

= The zones can be selected up to 100.

You can see or clear the alarm that has occurred on the
2 Alarm

zone.

7) Drag the door and zone status bar to the location of the door and zone in the
graphic map.

8) When setting is finished, click Apply.
Editing Graphic Map

1) Click MONITORING > Graphic Map View.
2) Click # in the graphic map that you want to edit.

All Graphic Maps
Office 01
14F Graphic Map 01 # i§

Office 02

3) After editing the information you want, click Apply.
Deleting Graphic Map

1) Click MONITORING > Graphic Map View.
2) Click ¥in the graphic map that you want to delete.

All Graphic Maps
Office 01
14F Graphic Map 01 # §

Office 02

3) Click Yes to delete the selected graphic map.
You can use the VIDEO menu to interlock an IP camera with an event of the door. You can set the IP

camera to record video or image logs when a set event occurs. Saved videos can be viewed in the
MONITORING menu.
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Note

The VIDEO menu will appear when the Video license is activated.

If you connect BioStar 2 using the Cloud, cannot access to the VIDEO and REPORT menus.
Set the Network Time Protocol (NTP) on a PC with BioStar 2 installed before using the Video
menu. Go to the Control Panel > Date and Time and then click Change setting on the
Internet Time to set up. Use time.windows.com for the server address.

If the network connection fails, video and image logs that occurred during that period may be

missing.
2
] All NVRs
s —° ﬁ]— 3
4
1 Add NVR < NVR and IP Camera List
2 Add IP Camera £ NVR and IP Camera Hierarchy
¢ Function Button (Column Setting) ¢ Expand Button
Adding NVRs

226

You can add NVR to save video logs or image logs.

Note

ACTi, Dahua, and Hikvision products can be added for NVR. Before adding NVR, check its
manufacturer.

Set the Network Time Protocol (NTP) to synchronize the time between the BioStar 2 server
and the NVR. Use time.windows.com for the server address.

PC-NVR does not support the live video view.

NVR types that support the live video view are as follows.

- Dahua: DH-NVR4416-16P, DH-NVR608-32-4K

- Hikvision: DS-7616NI-E2 / 16P, DS-7608NI-E2 / 8P
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1) Click VIDEO > Add New NVR.

2) Edit the necessary items.

Add New NVR X

Cancel ]

o Thom Jomogon

1 Name Enter the name of NVR.
Select the manufacturer of NVR. ACTi, Dahua and Hikvision products are
2 Manufacturer
supported.
3 IP Enter the IP address of NVR.
4 Port Enter the port of NVR.
Enter the account information (ID) to access NVR.
Note
5 ID
= Enter the default administrator account information for the ID. If you
enter the ID after creating a custom administrator account in NVR
setting, the function may not work properly.
6 Password Enter the account information (password) to access NVR.

3) Click Apply to save the changes.

Note

Contact the system administrator for the detailed information of NVR (IP, Port, ID,
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Password).

Adding IP Cameras

You can add an IP camera connected to NVR.

Note

= Before adding an IP camera, add NVR first. For more details, refer to Adding NVRs.
= Set the Network Time Protocol (NTP) to synchronize the time between the BioStar 2 server
and the IP camera. Use time.windows.com for the server address.

1) Click VIDEO > Add New Camera.
2) Select an added NVR from the list and click Next.

]

Select NVR

« NVR | NVR 1 hd |

= ) o ]

3) The list of cameras connected to NVR will appear. Select a camera to add and click + Add. To
select a different NVR, click Prev.

[ | Type P
HIKVISION IPC-HFW1420S 192.168.12.110
|:| AXIS (M3203) 192.168.12.63
|:| 112_Amcrest 192.168.12.112
|:| HikVion IP 84 192.168.12.84
Prev + Add ‘[ Cancel

4) After adding the camera, you can set the camera to record a video log according to an event
occurring at the door. For more details, refer to Editing IP Camera Settings.
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Editing IP Camera Settings

You can set the time interval to capture a video log or an image log and link the door and event type to

the IP camera.

1) Inthe camera list, click a camera to edit.

2) Edit the necessary items.

Information
11— m®
2 4[ * Name HIKVISION IPC-HFW142... * Channel ]7 E]
g—-p
5 4[ * Log Type Video b

Configuration

Video Log Setting
6 4[ * Start recording | 2 secs before an event * Endrecording | 3 secs after an event

Event

* Door v

. + Add
Event Sohedule ‘

o [ Jowagen

1 ID You can view the camera ID.

2 Name You can change the camera name.

3 Channel You can view the camera channel.

4 IP You can view the IP address of the camera.

You can set the log type to be captured by the camera.

= None: A video log or an image log is not captured.
= Video: A video log is captured.
5 Log Type = Image: An image log will captured.

Note

= You can set Video Log Setting or Image Log Setting according
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to the set Log Type.
= None is set for Log Type, you cannot set the Video Log Setting,
Image Log Setting, and Event.

You can set the time to capture a video log or an image log.

Note

= You can set Video Log Setting or Image Log Setting according
to the set Log Type.

When Log Type is set to Video

Video Log
6 Sett'ng / + Startrecording | 3 secs before an event + End recording | 3 secs after an event
Image Log
Setting When Log Type is set to Image
* Capture an image | 3 s | before an event
Note
= Recorded video/image logs does not mean the real-time log. It can
view after storing in in BioStar 2 database.
Select a pre-registered entrance door. Click + Add and set a desired event
and schedule.
Note
= Door should be set.
7 Event = Only one door can be set per camera.

= If there is no registered entrance door, register one by referring to
Adding Doors.

= If there is no desired schedule, click Setting > Schedule and
register a new schedule. For more details, refer to Schedule.

= You can delete an added event by clicking [ ]

3) Click Apply to save the changes.

You can set the time code, shift, and schedule and/or view time card or report by using the TIME
ATTENDACE menu.

Shift
Schedule

Report
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Set according to the following order when registering the schedule for the first time.

Step 1. Time code setting

You can set the attendance and leave time code, overtime time code, and the go out/outside work/
vacation time code. You can also set the time rate and assign and display a color to make it easily

recognizable.

(® Related information

Step 2. Shift setting

You can set the service rule on a daily basis (24 hours). The shift includes the time code setting, the
start time of day setting and the rounding rule.

(® Related information

Step 3. Schedule template setting

You can set the schedule template with the shift on a daily basis. You can also set the weekly and daily
schedule template.

(® Related information

Step 4. Overtime rule setting

This can be used conveniently when the overtime time code has not been added to the shift. Overtime
set in the service rule has a start time and an end time, but Overtime rule calculates the total time
exceeding the range of regular service time. Overtime rule can be used conveniently for managing
total daily, weekly and monthly overtime hours, and when Overtime rule is set, it applies instead of the
overtime time code added to the shift.
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(® Related information

Step 5. Schedule setting

You can set the period, user, overtime rule, and vacation schedule to apply to the schedule template set

in the previous step.

(® Related information

Shift

You can set the time code, time segment for time code, schedule template, and overtime rule. These

are the main components of T&A management.

Time Code

You can set the time code to be used for worktime calculation. It can be set for T&A records, time code
for overtime, and time code for vacation management.
You can assign and use a different time rate for each time code.

1) Click TIME ATTENDANCE > Shift > Time Code.
2) Click ADD TIME CODE and set each item.

1 4[ + Name

2 4[ + Description

3 4[ * Type Attendance management Qvertime management Leave management
4 4[ + Time Rate ® 1

s — + color El
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1 Name Enter the desired time code name.

2 Description Enter a brief description of the time code.

Set the time code type.

= Attendance management: You can set the time code to be used for the
T&A record.

= Overtime management: You can set the time code to be used for
overtime.

3 Type » Leave management: You can set the time code to be used for go out,

outside work, business trip and vacation.

Note

= If the time code currently used by shift, Type cannot be changed.
= If Type is set to Leave management, Time Rate cannot be set.

Set the time rate according to the time code. 1 is the default time rate. If 2

4 Time Rate is set, it is calculated with twice the hourly pay when the set time code is
applied.
5 Color Set a color to distinguish the time code.

3) To save settings, click Apply. To add a shift, click Apply & Next. To save the settings and add
another time code, click Apply & Add New.

(® Related information

Shift

Shift

You can create a shift by applying a different time code for each hour based on a 24 hour cycle. You can
select either a fixed working shift , flexible working shift or floating working shift and you can set the
start time of day and rounding rule.

1) Click TIME ATTENDANCE > Shift > Shift.
2) Click ADD SHIFT and set each item.
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1 ———* Name

2 4[ * Description

k] —[ Type ®) Fixed Flexible Floating
~ ~

4 —[ * Day start time 05 | 00 Allowed a day before/after time
v v

5 * First check-in & \) Mo

Last check-out

[+ Time segment
v
Next day
o 3 6 9 12 15 18 21
~ ~ ~ ~ -~ N
4]
Attendance man... ¥ 09 00 18 : 00 04 00
v v v v v v
* Grace [ use
[ * Rounding [] Punchin
7
Punch out
[+ Meal deduction 1 By Punch v
8
L * Meal deduction 2 Use
9 ——— + Break Time None v

Description
1 Name Enter the desired shift name.
Descript . _ .
2 ) P Enter a brief description of the shift.
ion
Set the shift type. The detailed setting varies according to the shift type.
= Fixed: You can set the fixed service to attend and leave at a fixed time.
3 | Type = Hexible: You can set the flexible service with no fixed attendance and leave
times.
= Hoating: You can set the floating service with no fixed attendance and leave
times. In this shift type, the shift is automatically applied according to the
attendance time.
ba Set the start time of day.
4 St:rt If you use Allowed a day before/after time, you can set Shift for work hours
Time exceeding 24 hours based on the Day start time set.
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Description

Note

= Allowed a day before/after time is activated only when you set the type
of Shift to Fixed.

When Yes is set, the first user authentication time is recorded as check-in time, and

First the last user authentication time is recorded as check-out time.
check-in
5 & Last Note
check-
out = If the Arst check-in & Last check-out is set to Yes, Break by Punch
should be set for recording the user’ break time.
When Fixed is selected for Type,
-~ -~
+ Day start time 05 00 [] Allowed a day before/after time
v v
il A
+ Time segment
Next day
N N -~ A ~ A~
Attendance man... ¥ 09 : 00 18 : 00 04 : 00
L4 L4 v v v v
+ Grace I:‘ Use
Tlme * Rounding [] Punchin
6 | segmen [ Punch out
t

* Meal deduction 1 By Punch v
* Meal deduction 2 Use

+ Break Time None v

Select the salary code set as T&A record and then set Start time, End time and
Min. Duration.

You can also set Grace, Rounding, Meal deduction and Break Time. When
setting is finished, click Add.

Note

= The Allowed a day The before/after time can be set up to 6 hours.

= You can only add one time code set as Attendance management to the
shift.

= For the time code set as Overtime management, you can only set Start
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Description

time, End time, Min. Duration, Rounding .

When Hexible is selected for Type,

-~ ~

- Working hours 08 - 00
per day

v v

- Options

* Time code Attendance man... ¥

* Punch in Time Limit [ | Use + Punch out Time Limit [ | Use

- Meal deduction 1 By Punch v

¢ Meal deduction 2 Use

* Rounding [] eunchin
[ Ppunch out

* Break Time None v

Set the working hours per day, and then select the time code.

You can also set Punch in Time limit, Punch out Time Limit, Meal deduction,
Rounding, Break Time.

Note

= If Flexible is selected for Type, the time code for overtime cannot be
added.

When Hoating is selected for Type,
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Description

. +Add
Segment Apply leave by this segment

+ Time segment

Next day
0 3 6 [l 12 5 18 2 2
Time code ‘Start time End time Min. Duration Action
A ~ A A A ES
Attendance man... ¥ 09 0o 18 oo 04 00
v v v v v v
~ ~
* Punchingrantedtime range | 5 . g
v A
~ ~
09 00
v v
+ Grace [ use

+ Rounding [ punehin

[] Punch out
+ Meal deduction 1 By Punch v
* Meal deduction 2 Use

*+ Break Time None v

Select the time code and set Start time, End time, Min. Duration, and Punch in
granted time range.
You can also set Grace, Rounding, Meal deduction, and Break time.

Note

= You can configure the shift by up to 5 time slots.

= If you use the floating shift, you must select Apply leave by this
segment when setting up a leave management. You can select Apply
leave by this segment from the time segment configured as shifts.

= For the time code set as Overtime management, you can only set Start
time, End time, Min. Duration, Rounding.

Roundin
g

You can set the time rounding rule. Unit is the time to round off to and Point is the
time to apply rounding off. For example, 10 minutes are set for Unit and 7 minutes
are set for Point, an event occurring at 8:05 is considered to have occurred at 8
and an event occurring at 8:08 is considered to have occurred at 8:10.

Select the item which you intend to use, and then set Unit and Point.

= Punch in: You can set the rounding rule to process the registered time when an
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N
(o] Description
attendance event is registered earlier/later than the set start time.
= Punch out: You can set the rounding rule to process the registered time when a
leave event is registered earlier/later than the set end time.
Note
= Rounding applies in preference to Grace.
You can set to deduct meal time from the shift.
= By Punch: You can set it to be deducted according to the record registered in the
device, without a fixed meal deduction time.
= Auto: You can set the meal deduction by setting Deduction time and Minimal
Meal hours before deduction.
8 deduct = Fixed: You can set the fixed meal deduction by setting Start time and End time.
on
1,2 Note
= You can deduct two meal times from the shift if you use Meal deduction
2.
= When using the meal deduction type as Auto or Fixed, Meal deduction 1
and Meal deduction 2 can be set only for the same type.
You can set the break time.
9 Break = By Punch: You can set it to be confirmed according to the record registered in
Time the device, without a fixed break time. If you select By Punch, you can set Max.
allowed break time.
= Fixed: You can set the fixed break time by setting Start time and End time.

3) To save settings, click Apply. To add a schedule template, click Apply & Next. To save the
settings and add another shift, click Apply & Add New.

® Related information

Schedule Template

Schedule Template

You can create a weekly and daily schedule by using the set shift.
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1) Click TIME ATTENDANCE > Shift > Schedule Template.
2) Click ADD SCHEDULE TEMPLATE and set each item.

1 4[ Name

2 4[ Description
33— 1ype

4 ——+ Weekend days

Daily Fixed 09:00~18:00 | 05:00 E

Weekly Daily Flexible Flexible 8hr Omin 05:00

sar ] sun |

* Please select one or consecutive two days.

o Trm—Jomorgen

1 Name Enter the desired schedule template name.
2 Description Enter a brief description of the schedule template.
3 Tvoe You can set either Weekly or Daily for the schedule template, and when
w Daily is selected, you can set the period to be used repeatedly.
Weekend
4 davs You can set the days of the week that you want to use as the weekend.
Y
5 Shift You can view the list of set service rules.
Set drag & drop for the set service rule. To apply all at once, click Copy All.
Note
6 Schedule
= To apply a shift that setting the Allowed a day before/after
time, Allowed a day before/after time cannot be set 24 hours
before Day start time on Shift the day before.

3) To save settings, click Apply. To add a schedule, click Apply & Next. To save the settings and

add another schedule template, click Apply & Add New.
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(® Related information

Rule

Overtime Rule

This can be used conveniently when the overtime time code has not been added to the shift. Overtime

set in the shift has a start time and an end time, but Rule calculates the total time exceeding the range

of regular working time. Rule can be used conveniently for managing total daily, weekly and monthly

overtime hours, and when Rule is set, it applies instead of the overtime time code added to the shift.

1) Click TIME ATTENDANCE > Shift > Rule.
2) Click ADD RULE and set each item.

1 4[ - Name
2 4[ - Description

[ - Overtime

Not Use
Daily overtime
Weekly overtime

Monthly overtime

Weekend overtime

Time Code None
~ ~

Day start time 05 00 First check-in & Last check-out
v v

Holiday overtime

Time Code None
~ ~

Day start time 05 00 First check-in & Last check-out
v v

o Thom Jomogon

1 Name Enter the desired overtime rule name.
2 Description Enter a brief description of the overtime rule.
Set the overtime rule.
3 Overtime Daily overtime, Weekly overtime, Monthly overtime rules can set the

overtime time code to be applied after the regular working time, and a
different overtime time code can be applied after a certain time. You can
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o [rm  Jowowen

also limit the overtime hours for an employee by setting the maximum
overtime hours.

When you set as follows, the 'Overtime management' time code applies from
5 PM to 11 PM if the normal working time is from 8 AM to 5 PM, and the
'‘Overtime management' time code applies from 11 PM to 2 AM. Also, the
maximum overtime hours for an employee for one day is limited to 9 hours,
and the daily payroll is calculated only using the record of providing work
until 2 AM.

Mot Use

Daily overtime

Apply| Overtime manag... v |after|@ hour(s) 0 minute(s)
Apply| Overtime manag... ¥ |after |6 hour(s) 0 minute(s) of [ Overtime management |
Max overtime (9 hour(s)

Weekly overtime

Monthly overtime
Note
= Total working time does not include break time or meal time.
For Weekend overtime and Holiday overtime rules, Time code and Day
start time can be set, and only First check-in & Last check-out can be

set.

Weekend overtime

Time Code None v
~ -

Day start time 05 : 00 First check-in & Last check-out
v v

Holiday overtime

Time Code None
~ ~

Day start time 05 | 00 First check-in & Last check-out
v v

3) To save settings, click Apply. To add a schedule, click Apply & Next. To save the settings and
add another rule, click Apply & Add New.
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(® Related information

Schedule

Schedule

You can create a service schedule by assigning the set schedule template, overtime rule, period, and
holiday to a user.
You can also add a temporary schedule or personal vacation to the created service schedule.

Note

= Before creating a schedule, check if the Time Code, Shift, Schedule Template, and Holiday
which you will use have been created correctly.
= Adding & deleting a schedule
You can create a service schedule for a registered user.

1) Click TIME ATTENDANCE > Schedule.
2) Click Add and set each item.

1 ———{ - Name
32— - peseription
53— - hule None
4 ——{ + Schedule template None v
5 —[ + Period 2017-03-17 ~ | 2017-03-17
6 —[ * Holiday None v
All Users EJ Go Go
15F USER 0 @
16F USER 0 Ad mi?i‘s)tramr
17F USER o [%Ig)
Usa(g )nuo
7 Us(e_‘rou}m
Us(eWrWO}OZ
Ui(swrzu}m
Us(e.‘raﬂ}ﬂﬂ
Us(e&o}os
Ui(swrsu}ﬂﬁ

Enter the desired schedule name.
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o Jon Jomem

2 Descriptio | gnter a brief description of the schedule.
n
Select the set overtime rule.
When the overtime rule is set, the overtime service salary
code set to the service rule will not apply. If you do not wish
use it, set None.
3 Rule
Note
= If there is no desired overtime rule, set one by
referring to the Overtime Rule.
Select the set schedule template.
4 Schedule Note
Template = If there is no desired schedule template, set one by
referring to the Schedule Template.
= Once schedule template is set, it cannot be changed.
Set the period to collect T&A events.
Note
5 | Period = Once the start date is set, it cannot be changed. The
end date can be changed, and when it is changed to
a date which is earlier than the set date, leave events
for the changed period will be deleted.
Select the set vacation schedule. If you do not wish use it,
set None.
6 Holiday Note
= [f there is no desired vacation schedule, add a
vacation schedule by referring to the Schedule.
7 User Add a user to apply the rule.

3) To save settings, click Apply.

4) To delete a schedule, select the schedule you wish to delete from the list, and

Note

then click Delete schedule.

The number of users included in the entire schedule cannot exceed the

maximum number of users for the T&A license you chose. To learn more

about the maximum number of users per license, refer to License.
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= Adding & deleting a temporary schedule

If you have already registered schedule. you can set a different service rule to a user

temporarily.

1) Select a user assigned to the schedule from the list and click a date on the

calendar.

‘v ] ADD SCHEDULE

, Schedule 1 > User 1

" Novembera0ts >

Schedule 1 4

2

1
09:00~18:00 Daily

Add Temporary Schedule

ministrator

Add Leave

erl
5 6|

yser2

;

User 3

)

User a4
5)

7

09:00~18:00 Daily

g 10

8

& 85 Sk

2) Select Add Temporary Schedule and set each item. To apply it to other users

equally, add a user by clicking Q.

[kyle] Temporary Schedule X

. Name | |

« shift | regular shift ~

+ Period 2016-12-01 ~ | 2016-12-01
+ Apply to Other User(s) Q,

-

3) When you click Apply, the shift for the set period will be changed.
4) To delete a temporary schedule, click the service schedule of the set temporary

schedule, and then click Yes.

= Adding & deleting a leave
You can add a user’ personal leave schedule.

1) Select a user assigned to the schedule from the list and click a date on the

calendar.
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] ADD SCHEDULE
‘7‘ Schedule 1 > User 1
shift | schedue = < November 2018 >
Schedule 1 I | 0 7
| ‘
Administrator
(1)
user 1
@ 7 5 5 7 ] 5 0
pger2
5
User 3
)
User 4
®

2) Select Add Leave and set each item. To apply it to other users equally, add a

user by clicking Q.

Edit Leave X

User 1(2)
2018-11-01(Thu)
Leave management Ad
Use Time O
IR | 2018-11-01 \ End Date | 2018-11-01
Leave Hours 1day(s)
Apply to Other User(s) Q,
Approver Comments

. -

3) When you click OK, the leave will be registered on the set period.
4) To delete a leave, click the registered leave and click Yes.

Note

= If there is no desired leave management Time code, add one by referring
to the Time Code.

Report
You can create a T&A report with T&A events of a user collected through the system, and edit or export
time records as a CSV file or a PDF file.
7 preset report filters can be used conveniently, or the administrator can set the filter manually.

+ Before Using the Multiingual Report

BioStar 2 supports Korean and English language. To use multilingual report, please
check the following.
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Font Setting
1. Go to [C:WProgram FilesW BioStar 2(x64)W taW distW setupW report_fonts].

2. Create a folder with the language name you want to use. Refer to the ISO 639-
1 standard for language name. For example, to use Spanish, create a folder
named "es".

3. Copy and paste the font file into the folder you created. Only one TrueType Font
is supported.

PDF View Setting

1. Click the link to install the PDF viewer on Google Chrome.

= Before Updating the Report

1)
2)

3)

BioStar 2 uses MariaDB as the default database. If you are using MS SQL database,
please check the following.

When using BioStar 2 with MS SQL database, your PC's memory usage will
accumulate each time you update the report if there are a large number of
registered users. Reset Max Server Memory for the MS SQL database.

1. Run Microsoft SQL Server Management Studio.
2. Right-click BioStar 2 database in Object Explorer and click Property.
3. Click Memory and then decrease the value of Max Server Memory.

Note

* For more information on MariaDB and MS SQL Server settings,
see

Click TIME ATTENDANCE > Report.

To use a preset filter list, select a desired filter type, set either User Group or User and click
Update Report.

To register a new filter, click ADD FILTER and set each item.


https://chrome.google.com/webstore/detail/pdf-viewer/oemmndcbldboiebfnladdacbdfmadadm
https://chrome.google.com/webstore/detail/pdf-viewer/oemmndcbldboiebfnladdacbdfmadadm
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Search Col

©N

* R

- U

— Filter Conditions

nditions

ame Daily Report

eport Type Daily Column Setting

ser Group All users Q * User

[ — Report Period

Save Filter

| Monthly (2018-11-01 ~2018-11-30) ¥ | »

Daily Repo
Date

2018/11/01

2018/11/01

2018/11/01

Update Report GSV Export PDF Export

rt JENENADE 50 rows ¥

Name User ID ‘shift Exception Regular hours Overtimehours ~ Total Work Ho...

Administrator 1 User Group 1 Daily Absence 0:00:00 0:00:00 0:00:00

User 1 2 User Group 1 Daily Absence 0:00:00 0:00:00 0:00:00

User2 3 User Group 1 Daily Absence 0:00:00 0:00:00 0:00:00

o Jom—Jogin

Filter
Conditions

Set a new T&A report.

= Name: Enter the desired report name.

= Report Type: Select the desired report type. Daily, Daily Summary,
Individual, Individual Summary, Leave, Exception, Edit History,
Working alarm time reports are available.

= Column Setting: Change or hide the order of columns in the report
table.

= Hlter: This function is enabled only when Leave or Exception is set for
Report Type, and detailed conditions for leave or exception records can
be selected.

= User Group / User: Select a user group or a user to create a report.

= Save Hilter: Save the set T&A report as the filter.

Report
Period

Set the period of report.

= Period: Set the period for creating a report to Daily, Weekly, Monthly,
or Custom.

= In/0ut Only: Select to output only the check-in and check-out logs of the
user to the report.

= All Punches: Select to output all punches of the user to the report.

Note

= In/0ut Only and All Punches are enabled only in

Individual Report.

= Update Report: Update the report table to the most recent information.
= CSV Export: Save the created report as a CSV file.
= PDF Export: Save the created report as a PDF file.

Report

View the created report.
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Adding the Working alarm time report

You can update the report for users who have reached their specified working

hours, or notify the administrator by email.

You can update the Working alarm time report weekly.

1) Click TIME ATTENDANCE > Report > Working alarm time Report.
2) Seteach item in Filter Conditions and Report Period and then click Update

Report.

3) Set Automated Email if you want to send an email notification to the

administrator for users who have reached their specified working hours.

Search Conditions

- — Filter

* Report Type

* Name Working alarm time Report

Working alarm time Column Setting

* Working alarm time 40

* User Group Q * User Q

[ — Report Period

* Period

Save Filter

{ Weekly ( 2018-10-29 ~ 2018-11-04)

Update Report SV Export PDF Export

Email

Email

* Day of Week (1] * Time

* Recipient

Description
Set a new T&A report.
Name: Enter the desired report name.
Report Type: Select the desired report type.
Filter Column Setting: Change or hide the order of columns in
1 Condition the report table.
s Working alarm time: Set the time to generate Working
alarm time report.
User Group / User: Select a user group or a user to
create a report.
Save Hilter: Save the set T&A report as the filter.
Set the period of report.
Report . . .
2 Period = Period: Set the period for creating a report.
erio
= Update Report: Update the report table to the most
recent information.
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n

= CSV Export: Save the created report as a CSV file.
= PDF Export: Save the created report as a PDF file.

You can notify about users who have reached their specified
working hours for the administrator by email.

= Email: Click to send an email to an administrator
automatically.

= Day of Week: You can set the days of the week to send
an email to administrators.

= Time: You can set the time to send an email to
administrators.

Automat | ® Recipient: You can add an administrator's email address

ed Email that receives the email.

Note

= You need to configure Hilter
Conditions and then save the
filter in order to set up
Automated Email.

= You can set the sender information

for automatically sent emails in L+

Editing T&A Records

You can modify T&A records by clicking the created report table.

Note

= In order to modify T&A records, a report must be created first. For details about the creation
of a report, refer to Report.
= The attendance and leave record of a user whose T&A schedule has not been registered

cannot be modified.

1) Click a row to modify the record from the created report table.
2) Modify a T&A record or add a leave according to the desired method.

= Modifying in the List
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+ Userl-2

1 ——{ - DateRange | « | paily (20181101 ~ 2018.1101) ¥ | > (w)—=

Attendance manage... - . Absence 0:00:00 0:00:00 ra

0:00:00 0:00:00 0:00:00 0:00:00 1 o 0:00:00

Daily 0:00:00

Regular By Time Rate Overtime By Time Rate Work time in Leave Non-work time in Leave

0:00:00 0:00:00 0:00:00

o LhomJomer

You can set the period for the T&A record to be displayed as
1 Period .
a list.
You can view the daily T&A record.
Note
= You can add, modify or delete a T&A record by
Daily T&A clicking In/Out time. Click # after clicking In/Out
2 record time to modify the registered T&A record. When you
click OK, changes will be saved.
= You can add a leave by clicking # Toadda leave,
the Time Code set as Leave management is
necessary. You can click ¥ of the added leave to
delete it.
T&A
3 record You can view T&A records according to the set period.
summary
View in
4 calendar You can view T&A records in a calendar.
button

= Modifying in the calendar
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|+ User1-2
1 [ E2EI [ vork Time ([e—-
2 { < November 2018 >
*‘ 2 3
Fo000 G000
'9:00:00 ( Daily) '9:00:00 ( Daily )
0:00:00 0:00:00
7 5 5 7] B 3 10
oo E0500 oo Foo00 G000
9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily) '9:00:00 ( Daily )
0:00:00 0:00:00 0:00:00 0:00:00 0:00:00
B
ol iH T} iE] o 7
oo E0500 oo Foo00 G000
9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily) '9:00:00 ( Daily )
0:00:00 0:00:00 0:00:00 0:00:00 0:00:00
3
73 i = 7 Fx] %
oo E0500 | Foo00 G000 )
9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily) '9:00:00 ( Daily )
0:00:00 0:00:00 0:00:00 0:00:00 0:00:00
7 F ]
oo E0500 oo Foo00 G000
9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily ) '9:00:00 ( Daily )
0:00:00 0:00:00 0:00:00 0:00:00 0:00:00
Summary Regular hours Overtime hours Break Time Over Break Time Meal Time Exception Leave Total Work Hours
Monthly 0:00:00 0:00:00 0:00:00 0:00:00 0:00:00 0 0:00:00
il
Overtime Rule Regular By Time Rate Overtime By Time Rate Work time in Leave Non-work time in Leave
0:00:00 000:00 0:00:00 0:00:00

You can click each event type to display or hide on the
calendar.

You can move to the previous or next month by clicking < or
2.

3 Daily T&A

You can view the daily T&A record.

Note

= You can add, modify or delete a T&A record by
clicking the work time (white). You can modify the

registered T&A record by clicking Y 4 , and when you

record

click OK, changes will be saved.
= You can add a leave by clicking the shift (gray). To

add a leave, the Time Code set as Leave
management is necessary. You can click W of the
added leave to delete it.

T&A

4 record You can view monthly the T&A record.
summary

5 View in list
button

You can view T&A records in a list.
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Setting

You can register a device used for T&A management or set the user list synchronization option.

1) Click TIME ATTENDANCE > %of .
2) Seteach item.

<+ Setting
[ Unregistered Devices + Register Registered Devices  Unregister £# Setting

2

FaceLite 547832712 (192.168.12.166) BioEntry W2 544108030 (192.168.12.176)

X-Station 2 547836813 (192.168.12.176)

[ Sender Information

Edit

[ Export
* Use|, Vv as afiled separation delimiter

r Punchlogs 7 Apply

* Punchlogs storage duration (I mactive | 0 day(s)

o Jom—Jorgin

This is the list of devices for which T&A management is available.

1 gg\rltiacgel:tered Select the desired device and click + Register to register the selected
device as a T&A management device.
This is the list of T&A management devices being used currently. To cancel
registration, select the desired device and click Unregister.
_ You can also change the T&A setting of a registered device by clicking
2 Reg_lstered Setting. For details, refer to the device's T&A.
Devices

T&A type is a setting to map the T&A Event Key and T&A event
type(Check In, Check Out, Break Start, Break End, Meal Time Start,
Meal Time End).
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o Trom—Joserpien

- T&A Mode Byuser v - T&A Required @ I

+ T&A Event
Code 1 MNone v

Code 2 HNone
Code 3 Hone

Code 4 Hone

|

Note

= Itis possible to edit the device's T&A settings only while the device
is connected.

3 Sender You can set the sender information to use when sending out notification
Information emails.
You can select the delimiter of the document when exporting T&A report to
4 Export
CSV export.
Punchlogs
5 storage You can set the period for storing the punch logs.
duration
Note

= When a registered device is deleted in DEVICE menu, the registered T&A management
device will be also deleted automatically.

You can manage the access of visitors by using the VISITOR menu.
You can also set up a PC where visitors can apply for a visit.

Applying to Visit

Managing Visitors

Note

= The VISITOR menu will appear when the Visitor license is activated.
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: 7{ ¢ 2019/07/08 > :'% » 2 ~ U- o 5 9 S }7 2

9
8 —[ + Add Visitor A Search Visitor « Filter Registered ]7 6 E]]— 5

1 Period and Number of Visitors by Status € Filter of Visitors by Status
z Page Navigation Buttons and Number of List Rows 7 List of Visitors by Status

¢ Search for Visitors in List of Selected ¢ Add Visitor Button

¢ List of Visitors Expired the Personal Data ¢ Search Visitor Button

£ Function Button (Column Setting)

Applying to Visit
Visitors can view and accept the terms and conditions or the privacy policy for access.

Visitors with a visit record can also apply for a visit by reusing previously registered information, such as

their name, telephone number, and fingerprint.

Note

= You can access the visit application page on the visiting PC. If there is not the shortcut of the

visit application page on the visiting PC, create the shortcut by referring to

Applying to First Visit
If you are visiting for the first time, apply for a visit on the visit application page.

Note

= You can access the visit application page on the visiting PC. If there is not the shortcut of the

visit application page on the visiting PC, create the shortcut by referring to
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If you visit the site for the first time, apply to visit on the visit application page.
1) Run the visit application page on the visiting PC.

If you have already visited, please fill in

\/\/e ‘ C O m e the information below.

First visit

2) Click Arst visit.
3) Check and accept the terms and conditions or the privacy policy for access and then click Next.
4) Enter or select the necessary fields.

Registration Information

Visitor

* Name « Telephone

Host

* Name * Telephone

Entry Information

* Zone -

* Period 2019/06/04 14:42 - 2019/06/05 14:42 E

Enter the visitor's information.

= Name: Enter the name.

« Telephone: Enter the telephone number.

1 Visitor .
Note
» If the Custom Visitor Field is set in the VISITOR setting, that fields are
activated.
= Up to 48 characters may be entered for a name.
Enter the host's information.
2 Host
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= Name: Enter the name.

= Telephone: Enter the telephone number.

Note

» Upto 48 characters may be entered for a name.

Set the zone and period to visit.

= Zone: Set the access group.

= Period: Set the period for visit.

3 Entry
Information )
Note
= Only access groups of sites assigned to visiting PC in VISITOR
setting are displayed.
5) Click Next.

6) Set the credentials.

Credential

B MRS -

2 - Card (I Mo request

1 Click + Fingerprint to use the fingerprint authentication.
Fingerprint
gerp And enroll the fingerprint.
) Set the card to Request to use the card authentication.
Card -
And get a card from the visitor operator.
7) Click Next.

8) To apply for a visit, click Register.

Related Information
Visitor

Applying to Visit Using Existing Info
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Applying to Visit Using Existing Info
Visitors with a visit record can also apply for a visit by reusing previously registered information, such as

their name, telephone number, and fingerprint.

== Search by name and telephone number

If you have visited the site, you can use your existing visit information again to

request a visit.
1) Run the visit application page on the visiting PC.

If you have already visited, please fill in

\/\/e | C O m e the information below.

g First visit
v

2) Enter the name and telephone number and then click Search.

3) Check and accept the terms and conditions or the privacy policy for access and
then click Next.

4) Check the Registration Information. If there are items that need to be
modified, modify each item by referring to Applying to first visit and click Next.

5) Check the Credential. If there are items that need to be modified, modify each
item by referring to Applying to first visit and click Next.

6) To apply for a visit, click Register.

Search by fingerprint

If you have a fingerprint registered in the site of visit, you can search the

fingerprint and apply for a visit using the existing visit information.

1) Run the visit application page on the visiting PC.
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If you have already visited, please fill in

\/\/e | C O m e the information below.

Q First visit
v

2) Click Search at the bottom of the fingerprint icon.
3) Scan your fingerprint to search the registered visitor.
4) If the visitor information is correct, click Yes.

Confirm X
Mame : Vero
Phone: 01000000007
Is it correct? Please check the

information.

5) Check and accept the terms and conditions or the privacy policy for access and
then click Next.
6) Check the Registration Information. If there are items that need to be

modified, modify each item by referring to Applying to first visit and click Next.
7) Check the Credential. If there are items that need to be modified, modify each
item by referring to Applying to first visit and click Next.
8) To apply for a visit, click Register.

Related Information
Visitor
Applying to First Visit
Managing Visitors

You can check the list of visitors and manage the check in and check out of them. You can also add,
delete, or modify visitor information.
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Managing Registered Visitors
Managing Check In Visitors
Managing Checked Out Visitors
Managing All Visitors

Deleting Personal Data Expired

Note

= The VISITOR menu will appear when the Visitor license is activated.

Managing Registered Visitors

You can approve a visit or edit the registration information. You can also add or delete visitors.

== Approve the Visit

You can approve a visit.

1) Click VISITOR.

2) Click a visitor in the Registered.

3) Check the information of the visitor and then click Check in.

Visitor

Host

Entry Information

Credential

+ Credential

Note

01000000003

Simba

01000000000

simba 01000000000 Choose

Access Group -

2019/06/04 10:00 | _ | 2019/06/05 10:00 | B

(I o request

+ Fingerprint r@

= If there are items that need to be modified, modify each item and click

Edit.
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4) Check the Registration Information and then click Approve to approve the
visit.
Registration Information

Privacy Policy

* Accept Terms Did not agree View terms

Visitor Information

* Name Shannon + Telephone 01000000003

Entry Information
* Access Group Access Group

+ Period

* Name Simba + Telephone 01000000000

Credential

+ Fingerprint + card Mo request

Note

= The Approve button is deactivated for visitors who did not agree to the
terms and conditions when applying for a visit. Click View terms to
provide the visitor with the terms and conditions and request the
agreement. If a visitor does not accept the terms and conditions, the
visitor will be restricted from visiting.

= If a card device is set on the visiting PC, the Approve and register
card button is activated. Click Approve and register card to approve

the visit and issue an access card.

Enroll Card X

+ Registration Register by Card Reader v
Option
Information

+ Facility Code Read Card

+ Card ID 1

Cancel

a) Select a desired Registration Option.

Register by Card Reader

You can register a card by scanning the card
information with the device connected to the visiting PC.
a) Select Register by Card Reader for
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Registration Option.
b) Click Read Card and scan a card with the device.

Enter Manually

You can register a card by entering a card number
directly.

a) Select Enter Manually for Registration Option.
b) Enter the Facility Code or Card ID 1.

b) Click Enroll to register a card.

Add Visitors

You can add visitors.
1) Click VISITOR.
2) Click + Add Visitor.

Visitor

Host

[ Credential

Entry Information

* Name

* Telephone

Not found

+ Access Group

- Period 2019/06/05 14:06 | . | 2019/06/06 14:06 | B

+ Credentil r—

[ Register 1 Cancel

Description

1 | visitor

Enter the visitor's information.

= Name: Enter the name.

= Telephone: Enter the telephone number.
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\[o] _—
Description

Note

= |f the Custom Visitor Field is setin the VISITOR
setting, that fields are activated.

= Up to 48 characters may be entered for a name.

Enter the host's information.

= Name: Enter the name.

= Telephone: Enter the telephone number.

2 Host Note

= Up to 48 characters may be entered for a name.
= When you enter the name or telephone number, a list
of users with information that matches is displayed.

Click Choose to set a user of that list to the host.

Set the zone and period to visit.

= Zone: Set the access group.

Entry = Period: Set the period for visit.
3 Informatio
n Note

= Only access groups of sites assigned to visiting PC
in VISITOR setting are displayed.

Set the credentials.

= Card: Set the card to Request to use the card

4 i L
Credential authentication.

= Credential: Click + Fingerprint to use the fingerprint

authentication. And enroll the fingerprint.

3) Click Register to complete adding visitors.

Delete Visitors

1) Click Visitor.

2) Click a visitor to delete in the Registered.
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< 2019/07/08 > 3 2 0 5 0

ALL PERIOD Registered Checked In Checked Out Total Personal Data

Expired
+Add Visitor A Search visitor * Filter | Registered v W Delete Visitor E]

B~ Name  Telephone HostNa. HostTelep. AccessGr.. Start Date ExpiryDate  Allowed period for credent  Checked In Checked Out  Update Date
Vero 010000000 Simba 010000000 Access Gro.. 2019/07/08 1 2019/07/091 2019/07/08 12:49 ~2020/... - - 2019/07/08 1
O psy 010000000.. Simba  010000000.. AccessGro.. 2019/07/081.. 2019/07/091.. 2019/07/0813:04 ~2020/.. - - 2019/07/08 1
[ sunyoung 010000000.. Simba  010000000.. AccessGro.. 2019/07/081.. 2019/07/0971. 2019/07/08 13:05~2020/.. - - 2019/07/08 1

3) Click Delete Visitor and then click Yes.

Note

= The Delete Visitor button is activated if you click || (check box).

= You can delete visitors only in the Registered.

® Related Information
Applying to Visit
Managing Check In Visitors
Managing Check Out Visitors

Visitor

Managing Check In Visitors

You can check which visitors have been checked in and edit the registration information of them. And

you can also let the visitors check out.

1) Click VISITOR.
2) Click a visitor in the Checked In.
3) Check the information of the visitor and then click Check Out.
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« Jacey

Visitor
+ Name Jacey
+ Telephone 01000000002
Host
* Name ‘ Simba |
+ Telephone | 01000000000 |
Name Telephone Choose
Simba 01000000000 | choose |
Entry Information
+ Access Group ‘ Access Group v |
* Period | 2019708704 || 10:00 | .| 2019708705 || 10:00 | B
Credential
+ Credential —_—
entia + Fingerprint IW | +Card |

s —

Note

= If there are items that need to be modified, modify each item and click Edit.
= You can let the visitors check out in the list. The Check Out button is activated if you click |
(check box).

(e )<} [l [v][] [ 50 rows ¥ H - ]@

< 2019/06/05 » o 4 1 4 9 2
ALL PERIOD Registered | @ Checked In ‘ @ Checked Out | 0 Total Personal Data
Expired

+ Add Visitor Search Visitor + Filter | Checked In - @ Ccheckout
Rl

~ *  Name  Telephone HostN.. HostTelep.. AccessGr..  Start Date Expiry Date  Allowed period for creden...  Checked In Checked Out  Update Date

Jacey 01000000. Simba 01000000... AccessGr.. 2019/06/041.. 2019/06/051... 2019/06/04 10:03 ~ 2020... 2019/06/041... - 2019/06/041.. EXPIRED

Managing Check Out Visitors

You can check which visitors have been checked out and register the visit again using that visitor's

registration information.

1) Click VISITOR.
2) Inthe Checked Out list, click the visitor to re-register.
3) Click Edit.
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4) If there are items that need to be modified, modify each item and click Register.

Managing All Visitors

Visitor
* Name vero
« Telephone 01000000001
Host
* Name | Simba |
* Telephone | 01000000000 |
Name Telephone Choose
Simba 01000000000 | choose |
Entry Information
* Access Group | Access Group v ‘
+ Period | 2019/08/04 || 16:53 | . | 201906705 || 16:53 B
Credential
+ Card O No request
+ Credential + Fingerprint m ‘
)
Type Card Data Format
Fingerprint I’ |
Register | Cancel

You can view all visitors that have been registered, checked in, and checked out for the set period. You

can also add visitors.

1) Click VISITOR.
2) Click Total.
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DD EES

& 2019/06/05 > 4 'l @ 4 ‘ 9 o 2
ALL PERIOD Registered ‘ @ Checked In ‘ Checked Out Total Personal Data
Expired

| +Add visttor

A Searchvisitor | - Filter | Al Visitors v | E]

| Telephone  Host N... Host Telep... AccessGr... Start Date Expiry Date Allowed period for creden... Checked In Checked Out Update Date
D Jacey 01000000... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051.. 2019/06/04 10:03 ~2020... 2019/06/041... - 2019/06/04 1...
D Chloe 01000000... Simba 01000000... AccessGr.. 2019/06/051.. 2019/06/061... 2019/06/05 16:00 ~ 2019. - - 2019/06/05 1...
D Julien 01011111...  Simba 01000000... Access Gr.. 2019/06/051... 2019/06/061... - - - 2019/06/051...
D Jacey 01000000... Simba 01000000... Access Gr.. 2019/06/051... 2019/06/061... - - = 2019/06/05 1...
D sY 01000000... Simba 01000000... AccessGr.. 2019/06/051.. 2019/06/061... - - - 2019/06/051...
D Shannon  01000000... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051... 2019/06/0513:48 ~ 2019... - 2019/06/05 1... 2019/06/051... m
D vero 01000000... Simba 01000000... Access Gr.. 2019/06/051... 2019/06/061... 2019/06/05 14:00 ~ 2019, - 2019/06/05 1... 2019/06/051.. m
D PSY 01000001... Simba 01000000... Access Gr.. 2019/06/041.. 2019/06/051.. 2019/06/04 17:05 ~ 2019, - 2019/06/05 1... 2019/06/051.. m
D Sunyoung 01000000... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051... 2019/06/0417:05~2019... - 2019/06/05 1... 2019/06/051... m

Note

= You can approve the visit and add visitors in Total. For more details, refer to Managing
Registered Visitors.

= You can manage the checked in or checked out visitors in Total. For more details, refer to
Managing Check In Visitors or Managing Check Out Visitors.

Deleting Personal Data Expired

You can delete the visitors that have the personal data expired.

Note

= Only users with the operator level of Administrator can view the list of visitors who have
expired. You can refer to the Adding User Information for more detailed information on the

operator level.

1) Click VISITOR.

2) Click Personal Data Expired. The visitors that have personal data expired is displayed.

[ 0] [ v Joa [» ][ » ]| sorows v |[ v ]@

< 2019/06/05 > ™ 4 2 1 2
ALL PERIOD Registered ‘ @ Checked In ‘ @ Checked Out ‘ otal Personal Data
Expired

| 0 searchvistor [ - Filter | Personal Data Expired v | | ¥ pelete personal data |E]

-

| +Add visttor

- Name Telephone  Host N... Host Telep... Access Gr... Start Date Expiry Date  Allowed period for creden... Checked In Checked Qut Update Date

psy 01000001... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051... 2019/06/04 17:05~2019... - = 2019/06/04 1.

[]  sunyoung 01000000.. Simba  01000000.. AccessGr.. 2019/06/041.. 2019/06/051.. 2019/06/0410:03 ~2019.. 2019/06/050.. 2019/06/050... 2019/06/050... (ALY

Note
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= For more information on configuring the period for the credential, see

3) Click || (check box) to select the visitors you want to delete.

4) Click Delete personal data and then click Yes.

In the REPORT menu, create and save user information or various events in BioStar 2 in the desired

format.
Automatically generate the desired reports periodically, and the generated reports can be exported or

printed as CSV or PDF.

Note
If you connect BioStar 2 using the Cloud, cannot access to the VIDEO and REPORT menus.

Generate Report

Reports are created in the desired format.
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Generate Report Schedule

Saved Reports

[User

Users Information

Users In Device

User Detail

User Photo Gallery
Users Without Credential

Private Auth Mode By User

All Cards
Unassigned Cards
Elacklist Cards

Expired Users

Number Of Credentials By User

Settings

Q

-Event

Inactive Users

Users To Be Expired Within X Days

Idle Users For The Last X Months

Custom Report

o Trm—Joworgon

Saved Click Save Report in the created report, it will be saved as a template
ave
1 ReDorts below this. This is useful when you need to create a report with the same
P conditions in the future.
2 User Create a report by selecting a template relevant to the user.
3 Event = Custom Report: Create a report by selecting desired Events, Periods,
Vi
and Filters (USERS, DOORS, DEVICES).

Automatic Report Schedule

Set a schedule to automatically generate custom reports created by setting the DYNAMIC period.
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Biostar 2 Admin Login is required to use Automatic Report Schedule. For more information, refer

to Biostar 2 Admin Login.

1) Click Add Schedule.
2) Edit the necessary items.

<+ Add Automatic Report Schedule

Information

+ Schedule Name

Report & Schedule

+ Report None 0

« Frequency None + Generate Time oo oo
Report Format

+ Output Type None

« Report Title

Show Title On Every Page

+ Header Show Header

+ Footer Page Number

« File Format None

L APP J‘ CANCEL

o Trom Jowoon

Set basic information of Automatic Report Schedule.
= Schedule Name: Enter the schedule name.

1 Information

Set the schedule to be automatically generated for each report.

= Report: Select a custom report to automatically generate. Only custom
reports set to DYNAMIC period will appear.

= Frequency: Set the frequency to automatically generate reports.

= Generate Time: Set the time to automatically generate reports.

Report &
Schedule

Set the format for each report.

= QOutput Type: Set the automatically generate method of reports.

= Report Title: Select Show Title On Every Page to display the report
Report name as the title on every page.

Format = Header: If Show Header is selected, the header is displayed when the
report is created. Select On Every Page to display the header on every
page.
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o Jrm  Jowowen

Note

= The header may vary depending on the reports.

= Footer: Set whether to display page numbers.
= Fle Format: Set the file format for exporting reports.

3) Click APPLY to save the settings.

Settings

1) Click REPORT > Settings.

2) Edit the necessary items.

Report

« Export report path [ ]

Biostar 2 Admin Login @

+ Biostar 2 Admin User ID + Password

[ APPL) J‘ CANCEL ‘

o [ Jowagen

= Export report path: Export the report to the saved path. If not entered,
it is created in "DocumentsW BioStar2" of the user's PC.

1 Report

Enter the login ID and password of the administrator account. Automatic

Report Schedule can be used after entering the administrator account

Biostar 2 information.

Admin Login | = Biostar 2 Admin User ID: Enter the login ID of the administrator
account.

= Password: Enter the password of the administrator account.

3) Click APPLY to save the settings.

You can use the Setting menu to configure user privileges, language, time, date, access card
management, server connection, doors, etc.
The modifiable items may differ depending on the user permission.

Account
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Preferences

Card

Card Format

Server

Trigger & Action
Schedules

Alert

HTTPS

Cloud

Image Log

USB Agent

Face Group Matching
Audit Trail

Video

Daylight Saving Time
Security

Active Directory

Visitor

Mobile Access

Email Setting

License

Card Printer

System Backup

Account

You can assign BioStar 2 operator account levels to registered users.

1) Click Settings > ACCOUNT.

2) Click an account type. Depending on the type of license activated, the account type may vary.

Administrator: The user can use all menus.
User Operator: The user can only use the USER and PREFERENCE menus.
Monitoring Operator: The user can use the MONITORING and PREFERENCE menus and

only view the DASHBOARD, USER, DEVICE, DOOR, ZONE and ACCESS CONTROL menus.

Video Operator: The user can only use the VIDEO menu.
T&A Operator: The user can only use the TIME ATTENDANCE menu and only view the

271



17 BioStar 2 Settings

USER menu.
= User: The user can only view own information and T&A records.
= Visitor Operator: The user can only use the VISITOR menu.

3) Click + Add and select a user or click Q to search for a user.

1 4| + Name
2 4[ + Description
3 ———{  Admin ltem Settings User Group Device Group Door Group Elevator Group Access Group Zone Type ‘Graphic Map Group.

All Users -
1 Dashboard N/A
2 User Enabled
3 Device Enabled
4 Door Enabled

5 Elevator Enabled

6 Zone Enabled

Access Control Enabled
8 Monitoring Enabled
9 Time & Attendance Enabled

10 Setting N/A

1(Administrator)

o Jom—Jorgin

1 Name Shows the account level name.
2 Description Show a brief description of the account level.
Admin Item ) L
3 . Show the group assigned the permission.
Settings
Admin Menu . L
4 . Shows the assigned privileges.
Settings
Shows the list of users assigned with the privileges. Click + Add to add a
5 Add User user.
« Click ¥ to delete the registered users.

4) Click Apply to save the settings.

Note

= If privileges have already been assigned while adding or editing users, the assigned users are
shown on the list.

= Unless a user with the privilege for Edit saves settings after changing the detailed settings of
each menu, the user with a Read privilege only can see the previous information yet to be
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modified.

® Related Information
Editing User Information

Adding Custom Account Level

Adding Custom Account Level

You can assign BioStar 2 operator privilege levels to registered users.

Note

= The Admin Menu Settings may vary depending on the type of license that is activated.

1) Click Settings > ACCOUNT.
2) Click ADD CUSTOM LEVEL.
3) Enter or select the necessary items. Depending on the type of license activated, the account type

may vary.

1 —[ + Name
2 —[ - Description
3 —— + Admin item Settings User Group Device Group Door Group Elevator Group Aocess Group Zone Type Graphic Map Group

All Users v All Devices w All Doors - All Elevators v All access g... v All zones v All Graphic v

1 Dashboard N/A ]

2 User Disabled |

3 Device Disabled | |

4 Door Disabled ] O
4 5 Elevator Disabled |

6 Zone Disabled I

7 Access Control Disabled | (|

8 Monitoring Disabled 1

9 Time & Attendance Disabled ]

10 Setting N/A ]

o [ Jowagen

1 Name Enter the desired account level name.

2 Description Enter a brief description of the account level.
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o [rm  Jowowen

Set the detailed permission for each item. You can select groups to assign
the edit and read permissions for each menu.

Admin Item Settings can be set for User Group, Device Group, Door
Group, Elevator Group, Access Group, Zone Type, Graphic Map Group
Admin Item and it can be set based on the already created group information.

Settings If there is no group you want, add a new group to that menu. For details
about the creation of a group, refer to Adding and Managing User Groups,
Adding and Managing Device Groups, Adding and Managing Door Groups,
Adding and Managing Elevator Groups, Adding and Managing Access Groups,
Adding and Managing Graphic Map Groups.

Set the edit and read permissions for the menu. A different permission can
be set according to each menu.

= Edit: The permission to add, edit, and delete the items of the menu.
= Read: The permission to read the items of the menu.

Admin Menu -
4 ) Note
Settings

=« If you assign the edit permission to each menu, Add Button will be
enabled. However, there is no Add Button in Dashboard and Setting
menu, so it is displayed as N/A. And Add button in Access Control
menu is only enabled when Access Group is set as All access

groups in Admin Item Settings and the edit permission is assigned.

You can add or view the users assigned with the privilege. If you want to add
5 Add User a user, click + Add to add a user.

« Click W to delete the registered users.

4) Click Apply to save the settings.

Note

= Refer to the following example for configuring Admin Item Settings and Admin Menu

Settings.

User Group 01w Device Grou... v Door Group .. v All Elevators AC Group v All zones v All Graphic .
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Preference

2 User Disabled
3 Device Disabled
4 Door Enabled
5 Elevator Disabled
6 Zone Disabled
Access Control Disabled

8 Monitoring Disabled
- User: You can see the user information in the 'User Group 01'. However, you cannot add a
new user or edit existing users.
- Device: You can see the device information in the ‘Device Group 01'. However, you cannot
add a new device or edit existing devices.
- Door: The setting of doors included in the 'Door Group 01' can be edited or deleted. You
can edit the device of the door included in 'Door Group 01'. You can also add a new door to
‘Door Group 01'.
- Elevator: You can see the setting of all the elevators. However, you cannot add a new
elevator or edit existing elevators.
- Zone: You do not have permission.
- Access Control: The setting of access groups included in the 'AC Group' can be deleted.
You can add or delete users and user groups to 'AC Group'.
- Monitoring: You can see the access control events of the devices included in '‘Device Group
01'. And you can see the device and door status zone status and the alert history. You can
also see a graphic map of 'All Graphic Maps'. However, you cannot control each status.
If the configuring for Admin Item Settings and Admin Menu Settings do not match, the
permission will not be assigned for that item. If you select the item of the menu by the
account to which this custom permission was assigned, the 'Permission Denied’' message is
displayed.
You can add an unlimited number of custom account levels.

You can change language, time zone, time/date format, and upload a sound file to be used as an alert.

1) Click Settings > PREFERENCE.
2) Edit the necessary fields.
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 Language / Time Zone

* Language

* Time Zone

« Daylight Saving Time

[ Date/Time

+ Date Format

[ sound

* Alert

English -

(UTC+9:00) Seoul, Tokyo, Osaka, Sapporo, Y... ¥

yyyy/mm/dd - + Time Format hh:mm -

Sound Name File Size File Format Play rhdd

Not found

o JomJogin

Language /
Time Zone

You can configure the BioStar 2 language and time zone settings.

» Language: Select a language to use.

= Time Zone: Select a time zone to use.

= Daylight Saving Time: Select the daylight saving time to apply to BioStar
2 server. If no registered daylight saving time, see Daylight Saving Time.

Date/Time
Format

You can configure the date and time format to use in BioStar 2.

= Date Format: Changes the date format.
= Time Format: Changes the time format.

Sound

You can upload a sound file to use in BioStar 2.

a) Click + Add.

+ Sound Name
+ File Size 0KB
+ File Format

+ Sound Name Browse

* Sound Files must be .wav or .mp3 format and a maxiumum of 10 MB.

B -

b) Click Browse to select a file.
c¢) Select .wav file or .mp3 file and then click Open.
d) Click Add to upload

Note

= Sound files must be .wav or .mp3 format.
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= A maximum file size is 10MB.

3) Click Apply to save the settings.

® Related Information

Alert

Card

You can view the card status, assigned users, blacklist, etc.

1) Click Setting > CARD. The list of registered cards is shown.

Card Type Card ID Status User ID User Name
CSN 1225051669057584 Assigned 2 User 1
CSN 4276710323 Unassigned
CSN 989777499 Unassigned
CSN 1217252008448048 Unassigned
CSN 1234938686252624 Unassigned
CSN 308871143 Unassigned

2) Click Unassigned Card, Activated Card or Blacklist Card to view the list of corresponding
cards.

Note

= If a card is blocked, the card information will appear in Blacklist Card list. To unblock the
card, select a card and click Unblock.

Changing Wiegand Card Data Format

You can change the Wiegand card data formats in use simultaneously.

Note

= The data format of the card already assigned to the user will be changed.
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1) Click Settings > CARD.

2) Click | *** I and then select Change All Wiegand Format.
3) Select a card data format to be changed from the list of Current and select a desired card data

format from the list of Changes to.

Change All Wiegand Format X

Choose a card data format to change a current card data format at once.
The card data format which is already used on BioStar 2 will be changed
simultaneously.

« Current ID#1-26 bit SIA Standard-H10301 v

« Changes to ID#2-HID 37 bit-H10302 \ 4

. -

4) Click Apply to change the card data format.

Card Format

It is possible to set the Wiegand type of the card or the website key and layout of the smart / mobile

card.

1) Click Settings > CARD FORMAT.
2) Configuring the settings by reffering to information, \Wiegand and Smart / Mobile Card.

Wiegand

You can configure the format for reading card data. The card data is processed in the set Wiegand
format.

Note

= The data format of the card already assigned to the user will be changed.

1) Click Settings > CARD FORMAT.
2) Click Wiegand.
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3) Click # from the list and then configure the settings.

Information

1 4[ MName
el 4[ Description
3 —— Total Bits =
[+ 1D Field S T aize +Add
4 Do = = 0 v
[+ parityBis Position Type Start Bit End Bit size 1A%
’ odd = = 0 L
o lwen omewen
1 Name Enter a Wiegand format name.
2 Description Enter a short description.
3 Total Bits Enter the total bit count.
4 Facility You can set whether or not to use a facility code. If you want to use a facility

Code Field code, click |_l(check box) and enter a start bit and end bit.

4 ID Field Enter a start bit and end bit of the ID to use. Click + Add to add an ID field.

Click + Add to add a parity bit.
Enter the position of the parity bit to use and the start and end bit.

5 Parity Bits )
Note

= You must enter the total bit to add a parity bit.

3) Click Apply to add the Wiegand format.

Note

= Pre-defined formats cannot be edited or deleted.

Smart / Mobile Card

It is possible to set the layout of smart cards such as MIFARE, iCLASS, DESFire, iCLASS Seos and
mobile.

Note

= To set the mobile card, set Active for Mobile Card Enrollment on the User/Device
Management tab of Setting > SERVER.
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1) Click Settings > CARD FORMAT.
2) Click ADD SMART CARD and configure the setting.

Smart Card Type

1 4[ + Smart Card Type

Information

i { e

MIFARE ICLASS

« Primary Key

+ Secondary Key

+ Start Block Index

Layout
+ Template Count

+ Use Face Template

+ Add New Smart Card

(_I suprema Smart Card

+ Secondary Key

v

DESFire / Mobile ICLASS Seos

Primary Key
Confirm New Primary Key
The key values made with 2.5v or before need 1o be

converted o HEX through the below before applying.

Convert to HEX

. Converting Result
Confirm New Secondary Key

+ Template Size 300

+ Face Template Size

o Thom Jomogon

Smart Card .
1 T Turn on the option to set up a custom smart card layout.
ype
2 Name Enter the name of the smart card.
It is possible to set whether or not to use the secondary website key. If
3 Secondary Active is set, you can set Secondary Key. When a secondary site key is
Key set, authentication is carried out using the secondary website key when the
basic site key of the card does not match.
It is possible to set the structure of smart cards such as MIFARE, iCLASS,
DESFire, iCLASS Seos and mobile.
Note
= Custom smart cards only support MIFARE and DESFire.
4 Smart Card The primary site key and the secondary site key support only HEX values. In
Setting the field on the right side of the screen, enter the key value and click

Convert to HEX. Use the converted value as your site key.

Note

= The Convert to HEX button can only be used when the Smart
Card Type is Suprema Smart Card.

280



17 BioStar 2 Settings

o [rm  Jowowen

= DESHre Advanced: You can use a DESFire card issued by a third-party.

Setting is available only for DESFire.

Note

= Touse DESFire Advanced, enter the information for App Master Key,
App Master Key Index, File Read Access Key, File Read Access Key
Index, File Write Access Key, File Write Access Key Index, App ID,
File ID, and Encryption Type correctly.

Primary Key: Key which encrypts the communication between the smart
key and the card reader.

Secondary Key: When a secondary key is set, authentication is carried
out using the secondary key when the primary key of the card does not
match. The Secondary Key can only be entered by activating the
Secondary Key at the top.

Start Block Index / Block Index: Select the start block where each
template will be saved. This block is the index of block where user
information will be saved. If the user already has the smart key, set
available block for saving. Setting is available only for MIFARE and iCLASS.

App ID: Set the application ID. This plays a role of directory which
includes file ID. Setting is available only for DESFire.

File ID: Set the file ID. Setting is available only for DESFire.

Encryption Type: It is possible to set the encryption type to DES/3DES or
AES. Setting is available only for DESFire.

ADF Address Value: ADF address where digital credential is stored and
only the iCLASS Seos card is available.

Skip Bytes: You can set the starting point for reading the card number.
Setting is available only for MIFARE and DESFire in Custom Smart Card
mode.

Data Size: (When the set Primary Key and Secondary Key are the
same as the set value of the card) You can set the data size of the card to
be read. Setting is available only for MIFARE and DESFire in Custom
Smart Card mode.

5 Layout

It is possible to change the layout where user information and fingerprint
information are recorded.

Template Count: Set the number of fingerprint templates to be included
in the layout.

Template Size: Set the number of bytes used by the fingerprint
template.

Use Face Template: Select whether to use the face template.

Face Template Size: Set the number of bytes used by the face template.
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Note

= Face templates are only available on FaceStation F2.

3) Click Apply to enroll a smart card setting.

Server

You can configure the BioStar 2 server information, user management, device management and

automatic upgrade settings.

1) Click Settings > SERVER and configure the settings.

General

- BioStar IP Address Any - - Log Uplosd
+ BioStar Port

+ Session Timeout 60 M + Web Server Protocol HITP (8) HITPS

You can configure the general information on BioStar 2.

= BioStar IP Address: Set the server IP address. Change the
setting to use a specific IP address.

= BioStar Port: Set the server port.

General = Session Timeout: Set a session timeout period. If there is no
activity on BioStar 2 for the set time after logging in, the session
is logged out automatically.

= Log Upload: Select an event log upload method. If real-time
communication with the server is difficult, set this to Manual.

= Web Server Protocol: Set a server communication protocol.

User/Device Management
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User/Device Management

+ Automatic User All Devices + Mobile Card Inactive
nnnnnnnnnnnnnn Enroliment

+ Fingerprint Suprema + User ID Type Number
Template Format

+ Enroliment Device +Add
Not found

+ Custom User Field + Add
Not found

* Delete personal & credential data when issuing an oG (_JJJ) mactive
+ AC event log storage duration 'J D inactive 200

+ Hide Face Credential Preview Image I inactive

You can configure the user synchronization and fingerprint
template format settings.

= Automatic User Synchronization: Change the user
information synchronization method.
- Select All Devices to have the user information automatically
synchronized with the server.
- When set to All Devices(Including user update from
device), user information on the server is synchronized with all
devices registered on the server. However, user information
modified on the device is not synchronized to the server, and
only user information added on the device is synchronized to the
server.
- Select Specific Devices(Only devices belonging to the
access group) to automatically synchronize only the devices

User/ belonging to the access group with the changes.

Device = Mobile Card Enrollment: Set to Enabled to use the mobile
Manage card.

ment = Fingerprint Template Format: Set the fingerprint template

format. Available options include SUPREMA, ISO and ANSI378.
If there are still user fingerprint template remaining in the
device, selecting a different format is not possible.

= User ID Type: Use of Number or Alphanumeric can be set for
user ID. When Alphanumeric is set for User ID Type, BioLite
Net, BioEntry Plus and BioEntry W cannot be used. In addition, all
users saved in XPass and XPass S2 will be deleted and all
settings except for the network will be initialized.

= Enroliment Device: You can designate certain devices that you
frequently use for fingerprint and card enroliment as an
enrollment device. Click the + Add and choose the devices.

= Custom User Feld: You can add custom user fields for extra
user information and these fields appear on the User page.
There are three types of custom user fields: Number Input
Box, Text Input Box and Combo Box. If you choose the
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Combo Box for a custom user field, you can add up to 20 items
with 32 characters each, and each item is separated by a
semicolon (;).

= Delete personal & credential data when issuing an AoC:
If you issue an AoC card which stores user's credentials on the
smart card, you can set BioStar 2 to delete user's data and
credential information automatically.

= AC event log storage duration: You can set the period for
storing the access control event logs.

= Hide Face Credential Preview Image: To protect users'
privacy, preview images can be hidden when enrolling face
credentials. If you enable this option, a preview will not be
provided when enrolling the user's face or visual face.

Note

= [f you select Automatic User Synchronization as
Specific Devices(Only devices belonging to the
access group), users stored in the device that do not
belong to the access group cannot be managed by the
server. If you use this option, go to DEVICE menu and
click Delete Data & Sync Device for each device to
proceed with the synchronization.

= Even if you select Automatic User Synchronization as
Specific Devices(Only devices belonging to the
access group), Access groups set up for special
purposes, such as the following, will be synchronized
regardless of the device's access group.
- Dual authentication access group set up in the Devices
and Elevators
- Bypass Group in the Anti-passback Zone
- Bypass Group in the Scheduled Lock Zone
- Scheduled Unlock Authentication Group in the Scheduled
Unlock Zone
- Arm/Disarm Group in the Intrusion Alarm Zone

= Even if you select Automatic User Synchronization as
Specific Devices(Only devices belonging to the
access group), Users set to device administrator will be
synchronized regardless of the access group.

= NFC card is supported with the below conditions.
- Mobile device OS: Android 5.0 Lollipop or later, Android
10 or earlier
- BioStar 2 Mobile 2.4.1 or later
- XPass S2: XPS2M-V2 FW 2.4 or later
- BioStation 2: BS2-OMPW, BS2-OIPW FW 1.4 or later, FW

284



17 BioStar 2 Settings

1.8 or earlier
- BioStation A2: BSA2-OMPW, BSA2-OIPW FW 1.3 or later,
FW 1.7.1 or earlier
- BioStation L2: BSL2-OM FW 1.2 or later
- BioEntry W2: BEW2-OAP, BEW2-ODP FW 1.1 or later, FW
1.5 or earlier
- FaceStation 2: FS2-D, FS2-AWB FW 1.3.1 or earlier
- BioLite N2: BLN2-ODB, BLN2-OAB, BLN2-PAB FW 1.2 or
earlier
- XPass D2: XPD2-MDB, XPD2-GDB, XPD2-GKDB FW 1.3 or
earlier
- Facelite: FL-DB FW 1.1 or earlier
- XPass 2: XP2-MDPB, XP2-GDPB, XP2-GKDPB FW 1.0 or
later
- BioEntry P2: BEP2-OD, BEP2-OA FW 1.0 or later
- BioEntry R2: BER2-OD FW v1.1.0 or later

= BLE card is supported with the below conditions.
- Mobile device OS: Android 5.0 Lollipop or later, Android
10 or earlier /i0S 9.0 or later
- BioStar 2 Mobile 2.4.1 or later
- FaceStation 2: FS2-AWB FW 1.3.1 or earlier
- BioLite N2: BLN2-ODB, BLN2-OAB, BLN2-PAB FW 1.2 or
earlier
- XPass D2: XPD2-MDB, XPD2-GDB, XPD2-GKDB FW 1.3 or
earlier
- Facelite: FL-DB FW 1.1 or earlier
- XPass 2: XP2-MDPB, XP2-GDPB, XP2-GKDPB FW 1.0 or
later

= You can use either Mobile card or Mobile Access. The
firmware does not support Mobile card or Mobile Access
simultaneously.

= When User ID Type is changed from Alphanumeric to
Number, all user information registered on BioStar 2
should be deleted.

= The devices and the firmware versions where the User ID
Type can be changed are as follows.
- CoreStation FW 1.0.0 or later
- FaceStaion 2 FW 1.0.0 or later
- Facelite FW 1.0.0 or later
- BioEntry W2 FW 1.1.0 or later
- BioStation L2 FW 1.2.0 or later
- BioStation A2 FW 1.3.0 or later
- BioStation 2 FW 1.4.0 or later
- BioLite N2 FW 1.0.0 or later
- BioEntry P2 FW 1.0.0 or later
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- BioEntry R2 FW 1.0.0 or later
- XPass 2 FW 1.0.0 or later
- XPass D2 FW 1.0.0 or later
- XPass FW 2.4.0 or later
- XPass S2 FW 2.4.0 or later
- X-Station 2 FW 1.0.0 or later
- BioStation 3 FW 1.0.0 or later
= If you change the value in the Order field, the position of
the custom field on the User page changes.
= For a number input field, a number from 0 to 4294962795
is allowed and characters are not allowed.

+ @x - Number Input Bo..
= For a text input field, up to 32 characters are allowed.

+ ex - Text Input Box

= For a combo box field, the items that have been set to the
field are displayed as item. If you want to configure a
combo box field as shown in the screenshot below, you
need to enter Option 1;0ption 2;0ption 3;0ption 4 in the

data field.
+ ex - Combo Box | Option 1 - ‘
None
Option 1
Option 2
Option 3
Option 4
Server Matching
Server Matching
* Use Server Matching ) Inactive . ;Aax. Sl’;nutll:naolés . /e
Fingerprint
« Fast Mode @) Active + Security Level [} 1/1,000,000
Fac:
+ Security Level [ ] Normal

You can configure server matching. If you use server matching, the
user’ fingerprint will be matched from BioStar 2, not the device.
Server The Server Matching will appear when the Advance or higher
Matching | license is activated.

= Use Server Matching: Activates/Deactivates server matching.
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= Max. Simultaneous Server Matching Count: You can
configure how many matchings can be done simultaneously.

= Fast Mode: You can configure the fingerprint matching speed.

= Security Level: You can configure the server matching’
security level for fingerprints and faces. The higher the security
level is set, the more the false rejection rate (FRR) can occur.

Note

= Max. Simultaneous Server Matching Count depends
on the PC's CPU performance.

System Log Level Settings

System Log Level Settings

+ System log storage duration 60 day(s) 0: Do not delete system logs * System log level e
nfo -

Not Use -
Info v
Info v
Hot Use v

Hot Use v

You can set the duration and log level of the system log to be
stored in the database. The system log storage period can be set
up to 120 days, and logs is not deleted when setting to O.

System
Log Level | System logs are managed according to pre-defined categories, and
Settings the log level is divided into Trace, Debug, Info, Warning, and Error.
The high level contains all lower level logs. For example, when set
to Trace, you can store the logs including Debug, Info, Warning,
and Error logs.

2) Click Apply to save the settings.

Note

= Please inquire your network administrator for any help necessary with the web server

protocol configuration.
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® Related Information

Real-time Log

Trigger & Action

You can set the device or BioStar to do a specific operation when a specific event has occurred at the

devices, doors and zones.

1) Click Settings > TRIGGER & ACTION.
2) Click ADD TRIGGER & ACTION and configure the settings.

2
1 4[‘ Name \[ + Schedule -

®) Device Door Zone Event Device BioStar Action

Supervised Input (Open
Q P put (Open) Q * output
All Devices Supervised Input (Short) All Devices None -
B sicstation 2 56832590 Tamper an W siosteton2ssceazsso 92 ||, o
a BioLiteNet 538101276 RS-485 disconnected i BioLiteNet 538101276 -
E BioStation A2 54153100 Device restarted E BioStation A2 541531008 (192

o JomJogin

1 Name Enter a name of the trigger & action.

Select a schedule.

Note
2 Schedule

= When configuring a user defined condition by selecting Input, if no
desired schedule is available, click + Add Schedule to create it.
= For more information on configuring schedules, see Schedules.
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Select a device/door/zone at which a specific event will be monitored.
Multiple devices/doors/zones can be selected. The devices/doors/zones work
independently even when they are disconnected from the BioStar server.
3 Device,
Door, Zone Note
= The Zone will appear when the Advance or higher license is
activated.
Set a triggering event. At least one event must be selected.
4 Triggering Note
Event
= Event lists may be activated differently depending on the options
selected in Device, Door, and Zone.
5 Device and Select a device which performs the action. You can select a device or BioStar
BioStar 2 2 to perform an action.
Set a signal to send when the selected triggering event occurs. You can also
set an email to which the log will be sent from BioStar 2.
6 Action
o Select BioStar and click 'ﬁ' to configure the email server information.
e To add an email address, click + Add and enter an email address. Click
OK to add the recipient.

3) Click Apply to save the settings.

Note

= For more information on email server information, contact your system administrator.

Schedules

You can add access schedules and holiday schedules.

= Adding New Schedule

1) Click Settings > SCHEDULE.
2) Click ADD SCHEDULE.
3) Enter the required information into the fields and set a schedule for each day of

the week.
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1T —— . Name
2 —. Deseription
3 —. Type ®) Weekly Daily
R
0 3 6 9 12 15 18 27 24
Sunday a4
Monday rE 4
Tuesday 2
Wednesday s, 2
Thursday s 2
Friday s 2
Saturday A
0 3 6 9 12 15 18 21 24

5 ——{ - Holiday Schedule

3

0 3 6 E) 12 15 18 n 24
7 4[ Hone =

o L om{omron—————————

+add

L3
-

1 Name Enter a name of the schedule.
Descripti .
2 P Enter a short description of the schedule.
on
3 Type For schedule type, select Weekly or Daily. When set to
Daily, Cycle and Start Date can be selected.
Click on time slots to set a desired schedule and click OK.
+ Schedule & Clear
Time Slot 1 : -
Time Slot 2 : -
Time Slot 3 : -
4 Time Time Slot 4 : ~
Slots
Time Slot 5 : -

B - |

= Up to 5 time slots can be configured for each day of the
week or each day.

= After setting a schedule, click 4#l to copy the time slots set
immediately above.

« Click # to edit the time slots. Click 2 to delete the set
time slots.
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5 Holiday Specify whether to apply a holiday schedule. When the option
Schedule | is selected, the detailed settings can be applied.
Holiday Click on time slots to set a desired schedule for holidays.
6 Time « Click # to edit the time slots. Click £ to delete the set
Slots time slots.
) Select pre-defined holidays.
Holiday . . .
7 : = Click + Add to add a pre-defined holiday.
Selection -
= Click W to delete a holiday.

4) Click Apply to add the holiday schedule.

+ Adding Holiday Schedule

Alert

You can set the alarm type and message to display when a specific event has occurred at the devices,
doors and zones. You can adjust settings so that BioStar 2 can play the uploaded sound file upon the

occurrence of alarms.

1) Click Settings > ALERT.

Device Disconr

Device

nection Detected

Device restarted

RTSP connected

RTSP disconnected

RS-485 disconnected

Tamper on

Supervised Input (Short)

Supervised Input (Open)

AGC Power Failure

Low battery level

Critical battery leve!

Empty battery

Door

Forced door opened

Held deor opened

Forced door open alarmed

Held door open alarmed

Elevator

Enable all floor relays

Thermal & Mask

b

s denied (Exceeded threshold temp.)

b

s denied (Temp. not measured correctly)

b

s denied (Mask not detected)

b

ccess granted (Soft temp. vielatien on check only)

b

s granted (Soft mask violation on check only)

Zone

Anti-passback zone alarm detected

Fire alarm zone alarm detected

Scneduled lock zone alarm detected

Occupancy Full Detected

Occupancy Availability Recovered

Exit Occurred While Occupancy Count Z

Occupancy Count Alert 1 Detected

Occupancy Count Alert 2 Detected

Authentication

1:1 authentication failed

111 duress authentication succeeded

1:N authentication failed

1:N duress authentication succeeded

Access denied (Invalid access group)

Access denied (Disabled user)

Access denied(Invalid period)

Access denied (Blacklist)

Access denied (Hard Anti-passback)

2d (Forced lock schedule)

ed (Soft anti-passback)
Fake Fingerprint Detected

Access Denied (Anti-tailgating)

2) Select event types to display on the screen.
3) Click

upon the occurrence of a corresponding event, select it from the list of Sound File and set the Play

and enter a message to display on the screen. If you have uploaded the sound file to play

Options. If there is no sound file to play, upload it with reference to the Sound of Preference.

2901



17 BioStar 2 Settings

Alert Message X

« Name | Alert Message |
+ Message |

4
« Sound File | alert v | i l-
« Play Options | Once L 4 |

B -

4) Click Apply to save the alert messages.

5) Click Apply to save the changes.

® Related Information

Preference

HTTPS

In order to connect BioStar 2 through HTTPS, it is necessary to register the IP address where BioStar 2
is installed and install the certificate. For correct network connection, install the certificate before using
BioStar 2.

Note

= BioStar 2.5.0 uses HTTPS as the default communication protocol.

1) Click Settings > HTTPS.
2) Click Cert. Download.
3) Unzip the downloaded file and run cert-register.exe file. Enrollment Certification window will

appears.

Server Address : I

Enrolment Cancel
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4) Enter the IP address of the PC where BioStar 2 is installed and click Enroliment.

5) Check the security warning message and click Yes.

6) When you restart the web browser and enter the registered IP address, Secure will appear on the

address bar of the web browser.

Cloud

You need to configure the cloud settings in order to access your BioStar 2 server remotely (outside of

the local network). Additionally, the cloud settings should be done in order to use the BioStar 2 Mobile

app.

Note

= The Cloud will available when the Standard or higher license is activated.

= If you use BioStar 2 Cloud, cannot connect to BioStar 2 through Internet Explorer or Edge.

= If you connect BioStar 2 using the Cloud, cannot access to the VIDEO and REPORT menus.

1) Click Settings > CLOUD.
2) Edit the necessary fields.

General

1 ———* Cloud Use
2 4[ Subdomain Name

Advanced

4 —[ Cloud Server Address
5 4[‘ Version

suprema biostar2.com * Administrator e-mail suprema@suprema.co.kr ]— 3

pi.blostar2.com * Port Used By Cloud 52000 s

o [ Jowagen

To use the cloud set it as Use. If you set it as Not Use, it will be unable to
access BioStar 2 using BioStar 2 Mobile.

1 Cloud Use Note

= If you set Cloud Use as Use, Password Level should be set as
Medium or Strong. For more information, see Server.

Enter the subdomain for usage. You can use the subdomain to access

5 Subdomain BioStar 2 using BioStar 2 Mobile.

Name The subdomain is a unique value for identification same as user ID, so use a

unique word such as company names.

3 Administrat Enter the cloud administrator email.
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or e-mail
Cloud
4 Server The Cloud server’s address. Normally set as default.
Address
5 Version The Cloud server's version. Normally set as default.
This is the port number the cloud uses. Normally set as default (52000).
If the cloud does not operate normally, modify the inbound and outbound
Port Used rules from the firewall setting on the PC where BioStar 2 is installed. For
6 By Cloud more information, contact the system administrator.
= Ports to be added to the inbound rule: BioStar 2 server port (Default
value: 80, user-specification), BioStar 2 cloud port (Default value: 52000,
user-specification)
= Ports to be added to the outbound rule: 4443, all ports used by ngrok

3) Click Apply to save the changes.

Note

= E-mail transfer may take up to 10 minutes.
= For the cloud, BioStar server must always be turned on. If the server loses more than one

week of connection, you must proceed with a re-register process via email.

Image Log

It is possible to set the default value which can be added when using the delete option of image log and

an image log from the device.

1) Click Settings > Image Log.
2) Edit the necessary fields.
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Preset

+ Configuration

Delete Option

+ Delete Option

Storage Path Settings

* Image Log File Path

User Profile Image Option

——- o

1:1 authentication succeeded v Always v i
1:1 authentication failed v Always v L
1:1 duress authentication succeeded v Always v ¥
1:N authentication succeeded v Always v w
1:N authentication failed v Always v v
1:N duress authentication succeeded ¥ Always v v
Dual authentication succeeded v Always v w
Dual authentication failed v Always v w
Authentication failed v Always v w
Access denied v Always - w
Access denied (Invalid access group) v Always v i
Administrator menu entered ¥ Always v ¥
None v

\imagelog\

+ Display user profile image when there is no image log for the events

It is possible to set the default setting to be used when adding an image log
to the device.
It is possible to add an event and schedule to delete by clicking + Add.
1 Preset )
Note
= If there is no desired schedule, set a desired condition by clicking +
Add Schedule.
It is possible to set the delete condition of image log.
= Delete Option: It is possible to set the condition to delete an image log.
9 Delete = Amount of Image Log: It is possible to set the unit of condition set at
Option Delete Option.
= Delete Cycle: It is possible to set the cycle to carry out the delete
condition of image log set from Delete Option and Amount of Image
Log.
Storage Set the path to save image log files.
3 Path )
Settings Note
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= The save path must be set to a directory that has already been
created.

If this option is on, the profile image registered for a user is displayed on
the Event Log and Real-time Log pages when there are user related
events. This option is particularly useful when you have devices that do not

User Profile have a built-in camera.

4 Image )

Option Note

= Even if the user profile image option is on, the image captured from
the device camera is displayed when there is an image log for the

event.

3) Click Apply to save the changes.

Note

= The default setting set from Setting > Image Log does not apply to the device. To add or
change an image log of the device, refer to Image Log.

USB Agent

If you want to use the USB Device when logging into BioStar 2 from a client PC, installing the USB Device

Agent is required.

Note

= If User Account Control is enabled in Windows, USB Agent cannot be run automatically.

Disable the User Account Control or run as administrator.

1) Click Settings > USB AGENT.
2) Download the file by clicking Download, and install it.

USB Device Agent

You must install the USB Device Agent before using USB device. Click the Download button and then install the USB Device Agent

Download

3) Select the byte order of USB card device.
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Byte Order of USB Card Device

Byte order is applied to CSN card type only.

+ Byte Order MSB -

4) Set the port that the USB Agent will use.

USB Agent Port

The USB Agent port number setting is to designate the port number to be communicated from the server, because the agent program runs at each client independently.

* USB Agent Port Number (8081

5) Click Apply to save the changes.

Face Group Matching

Face group matching is the function used to specify a matching group based on the user groups set in
BioStar 2 and authenticate users in that manner.

Note

= Up to 10 matching groups can be created.
= Each group can include up to 3,000 face templates.
= The total number of face templates in the matching group cannot exceed 5,000.

1) Click Settings > Face Group Matching.
2) Edit the necessary fields.

General

1 —[ Group Matching <L/ Use

2 —[ + Group Matching Device Settings + Add
4 FaceStation 2 4 (192.168.16.208) All Devices 192.168.16.208 ¥

[ Matching Group Settings Number of Faces + Add
1 - 15F 15F USER - 4 /3000 ¥
3 -
2 - 16F 16F USER - 473000 v
3 - 17F 17F USER - 1/ 3000 ¥

Set whether or not to use Group Matching.

Group
Matching Note
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= To disable the group matching while it is being used, all devices set
previously and the group settings must be deleted.
Group
Matching . . .
2 Devi Set a device to use the group matching. Only FaceStation 2 can be added.
evice
Settings
Click + Add and set Group Name and User Group.
Matching Note
3 Gro‘“_'p = Up to 10 matching groups can be created.
Settings = A number of user groups can be set for one matching group.
= If the number of face templates included in the user group exceeds
3,000, it cannot be set as a matching group.

3) Click Apply to save the changes.

Audit Trail

Audit trail tracks user access information as well as all the information changed in the system. You can

set a filter for each item for sorting.

1) Click Settings > Audit Trail.

2

— «+ | Audit Trail < 1 Je (o) n] | soroms
Last 1 Month
1 . -
= Last 3 Months Filter

« Operator L
* Datetime * User evel <P - Category  * Target + Action

Datetime User Operator Level [ Category Target Action Modification

2017/08/29 18:24:46 Admims:ramr[l] Adl\m\ns[ramm: 127.0.0.1 Custom Fi... Add

2017/08/29 18:24:46 Administrator(1) Administrator(1) 127.0.0.1 Server Set. Update

2017/08/29 17:45:14 Administrator(1) Administrator(1) 127.0.0.1 Zone APB1 Add

2017/08/29 15:37:16 ;y;tem 127.0.0.1 Device \l‘.'H'Tm]EDﬂDIH] Add

2017/08/29 13:10:04 Administrator{1) Administrator(1) 127.0.0.1 Door Door 2 Add

2017/08/29 13:09:44 Administrator(1) Administrator(1) 127.0.0.1 System Action Login

Description
1 Period You can set the previous 1 month or 3 months conveniently for the period.

You can set conditions for each filter item. Click Save Filter to save the

2 Filter i
filter.
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You can move a page or set the number of list rows to be displayed on one
page.

Page = | " : Go to the first page.
Navigation p .

3 Buttons and = | *): Go to the previous page.
Number of « | 2 /2: Enter the page number to move to.
List Rows = " : Go to the next page.

» | "I Go to the last page.
219%S T - set the number of list rows to be displayed on one page.

Function
Buttons

4 (CSV Export, | You can save the list of audit list as a CSV file or changes the column setting.
Column
Setting)

5 Audit List Shows the audit list.

Video

You can set the path to save video files and the storage duration.

Note

The VIDEO menu will appear when the Video license is activated.

Use a separate storage media for the video log. Video logs might not be saved if the video

storage space is reduced by the external processing(such as copying files and creating files),

1) Click Settings > Video.

2) Edit the necessary items.
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1 —[ * Video File Path D:\Program Files\BioStar 2(x64)\ve\records\
2 —[ * Video Recording space 20 GByte
settings

3 4[ + Racording space manag  When the recording space is full, (®) overwrite from the oldest file.
ement
stop recording.
* Recording Space Status
D:\ Total Recording Space Status D:\ Video Recording Space Status
Unalloc ated
Space
Video

Alloc ated
Space

LD Allocated
4 See s
* Video Recording Space 20 GByte + Total Recording Space 931.511 GByte
Status Status
* Video Allocated Space 20 GByte + Remaining Space 793.481 GByte
| Video Used Space 0 GByte
m It Description
. ) You can change the path to save a video file.

Video File i ) L

1 Path It is recommended to use a separate storage media for saving files
a
securely.

Video

Recording . . .
2 You can set the recording space to store video files.

space

settings

Recording

space o - ' .
3 If there is insufficient storage space, you can set the file processing method.

managemen

t

Recording
4 Space You can view the video storage space status.

Status

3) Click Apply to save the changes.

Daylight Saving Time

Daylight Saving Time (DST) is a function that adjusts the time to better utilize natural daylight.

1) Click Settings > Daylight Saving Time.
2) Click + Add.
3) Edit the necessary items and click Add.
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Add Daylight Saving Time X

+ Name DST

+ Start Date/Time 03 + | Month 1 w |[Week SUN » | Day of Week 01:00

+ End Date/Time 11 + | Month 2 v |[Week SUN » | Day of Week 01:00

-

4) Click Apply to save the settings.

Note

= You cannot edit or delete a daylight saving time that is already in use.

Security
You can set the password level and the maximum password age. You can also set the maximum invalid
attempts and the maximum password change limit.
1) Click Settings > SECURITY.

2) Edit the necessary items.

= Login Password

Login Password

- Password Level ) 0 Medium
~ Maximum Password Age (I tnactive
« Maximum Invalid Attempts (I tnactive

+ Maximum Password Change Limit C) Inactive

Set the policy for the password complexity for BioStar 2 login.

= Low: You can enter up to 32 characters.

password | * Medium: You must combine 8 to 32 alphabetic characters

Level (uppercase or lowercase), and numbers.

= Strong: You must combine 10 to 32 alphabetic characters
(uppercase and lowercase, at least one alphabetic capital),
numbers, and symbols.
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Note

= If Cloud Use set to Use, you can only use Medium or
Strong.

You can set the period for which you want to use the password. If
the Maximum Password Age is exceeded, a password change
request message is displayed at login.

Maximum
Password )
Age Note
= You can set the Maximum Password Age from 1 day to 180
days.
Maximum | You can set the Maximum Invalid Attempts and the time limit. If

Invalid you enter the wrong password more than the set number of times,
Attempts | you will not be able to log in for the time limit.

You can set the Maximum Password Change Limit.

Maximum

Password Note

Change

Limit = You can set the Maximum Password Change Limit up to 10

times.

= Advanced Security Settings

Advanced Security Settings
« Encrypt Personal Data on Database d Use « Personal Data Encryption Key

Change

«+ Secure communication with device - Use « Use external certificates [¢ D Not Use

+ Device Hashkey Management () notuse

When Use is set for Encrypt Personal Data on
Database, all sensitive data including credential data and
personal information will be stored in the database as
encrypted. If this option is set as Not Use, the encrypted
Encrypt Personal | data will be decrypted and the user's personal information

Data on will be stored in an unencrypted state.
Database

Note

= Items to be encrypted when using Encrypt Personal
Data on Database are as follows.
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- Profile image
- User ID
- Name
- Phone number
- User IP
- Email information for sender ans recipients
- Login ID
- Login password
- Face template
- Fingerprint template
- Card ID
- Smart card layout key
- Custom information for user and visitor
- Image log files
= Do not force start the server while encrypting
personal data on the database. Errors such as
failure to log in to BioStar 2 may occur.

Personal Data
Encryption Key

You can set the personal data encryption key. Click Change
and set a new encryption key. If changing the encryption
key, the existing data will be re-encrypted.

Note

= You can enter the encryption key with 32 characters
using letters, numbers, and symbols.

Secure
communication
with device

The communication between BioStar 2 and a device can be
protected using a certificate.

When Use is set for Secure communication with device,
BioStar 2 creates and sends a certificate to the device. The
device can use a secure channel for exchanging data with
BioStar 2 using this certificate. In order to use an external
certificate, Root certificate, Public key certificate, and
Private key files must be uploaded.

If Device Hashkey Management set to Use, you can set
a new data encryption key and administrator password.

Note

= The devices and the firmware versions where the
secure communication can be set are as follows.
- FaceStation 2 FW 1.1.0 or later
- BioStation A2 FW 1.5.0 or later
- BioStation 2 FW 1.6.0 or later
- BioStation L2 FW 1.3.0 or later
- BioLite N2 FW 1.0.0 or later
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- BioEntry P2 FW 1.1.0 or later
- BioEntry W2 FW 1.2.0 or later
- Facelite FW 1.0.0 or later
- XPass 2 FW 1.0.0 or later
- CoreStation FW 1.1.0 or later
- X-Station 2 FW 1.0.0 or later
- BioStation 3 FW 1.0.0 or later

= BioStar 2 creates or deletes a certificate according
to the setting status of Secure communication
with device, and the same certificate as the
previous certificate will not be created. For
example, if the setting of Secure communication
with device is changed in the order of [Use - Not
Use], the created certificate will be deleted
automatically. When the setting is changed in the
order of [Use - Not Use - Use], the operation of
[Create A certificate - Delete A certificate - Create B
certificate] is carried out.

= If the device is disconnected from the network
physically while using the secure communication of
BioStar 2, do not turn off the secure communication
option. In such a case, the certificate of BioStar 2
will be deleted, and the device will not be able to
connect again. To connect it again, the certificate
saved in the device must be deleted or the device
must be reset to factory default. For more details,
refer to the manual of the device.

Note

= The Advanced Security Settings tab is only active when you log in as the initial

administrator.

Session Security

Session Security

+ Simultaneous Connection Allow Active

Simultane You can set whether to allow simultaneous connections using the
ous same account. If you set Simultaneous Connection Allow to
Connectio | Inactive, a previously logged in user will be logged out when

n Allow attempting to connect to the same account simultaneously.
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Unified Gateway Setting

Unified Gateway Setting

+ Unified Gateway 0 ) hctive

You can change the execution port of BioStar 2 to the Unified
Gateway.

Unified Gateway allows efficient processing of requests to the
BioStar 2 server through the reverse proxy method, improves
security vulnerabilities in iframes, and minimizes SSL certificate

. errors.
Unified

Gateway

Note

= When you activate Unified Gateway, the server restarts
and automatically directed to the login page.

= If the port is in use, a pop-up message will appear. Enter a
different port number and activate it again.

3) Click Apply to save the settings.
Active Directory

You can synchronize user data stored in Microsoft Windows Active Directory to BioStar 2.

Note

= The Active Directory setting will appear when the AC Advanced license is activated.

= The Active Directory is available for a system environment with Windows Server 2008 R2 or
later.

= To use the Active Directory, set the User ID Type to Alphanumeric by referring to User/
Device Management.

1) Click Settings > ACTIVE DIRECTORY.
2) Edit the necessary items.
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12

Active Directory Server

I E——
R —
—_—

Secure transfer 0 ) Active
o Inactive o

Use for BioStar 2 Login

Keystore password

« Server Address

+ User Name

-

User Group

_ 1.
—_—.
 —

+ Base DN

Apply

User Group Filter B ) Active
User Group Base DN Pull User Group

User Group None v Update

Field Configuration

Synchronize

H

. . B Add
User Field Mapping BloStar2 User Field AD Server Field Z

sAMAccountName

Update

Status Not yet executed

Sync Now

o Trm—Joworgen

You can use the encryption when communicating with a Windows Active
1 Secure Directory server.
transfer Install Active Directory Certificate Services and set the keystore password by
referring to Active Directory Encryption.
Use for Enable logging into BioStar 2 using the Windows Active Directory account.
2 BioStar 2 When this option is activated, the value of the sAMAccountName field in the
Login Windows Active Directory server is mapped to the BioStar 2 login ID.
3 Keystore Enter the Windows Active Directory server encryption key store password.
password This can be only used when activating the Secure transfer.
4 Server Enter the server address for Windows Active Directory.
Address
5 User Name Enter the user name used by Windows Active Directory.
6 Password Enter the password used by Windows Active Directory.
Enter the base domain name for Windows Active Directory.
. You can find the base domain name in the following way.
Base DN a) Run the Active Directory Administrative Center.
b) Right-click on the node where user data is stored, and then click
Property.
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¢) In the property window, click Expand and then click Attribute Editor.
d) View the value of distributedName.

8 g_slter Group You can enable or disable synchronization by user group.
ilter
9 User Group Enter the base domain name of the user group for Windows Active Directory.
Base DN This can be only used when activating the User Group Filter.
Select the user group to synchronize. This can be only used when activating
10 User Group
the User Group Filter.
You can map data fields in Windows Active Directory to user fields in BioStar
2.
The user fields to be mapped can be set as shown below.
11 User I_:ield
Mapping
a) Click + Add to add a user field slot.
b) Set the BioStar 2 User Field and AD Server Field to map the correct data
to the user field in BioStar 2.
¢) Click Update to apply user field mapping settings.
Note
= The User ID field is a static item and cannot be deleted.
Click Sync Now to synchronize the user data. The last synchronization time
12 Status

and date are displayed.

Active Directory Encryption

You can use the encryption when communicating with a Windows Active Directory server.

Set according to the following order when using the encryption for the first time.

Step 1. Installing Active Directory Certificate Services

To use Windows Active Directory server encryption communication, you must install the Active Directory

Certificate Services.

The Active Directory Certificate Services can be installed as follows:

1) On the PC where the Windows Active Directory server is installed, run Server Manager, and then
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2)
3)

4)

5)
6)
7
8)

9)

10)
11)
12)
13)

14)
15)

16)

click Manage > Add Roles and Features.

On Before You Begin, click Next.

On Select Installation Type, select Role-Based or feature-based installation and then click
Next.

On Select destination server, select Select a server from the server pool, check the server,
and click Next.

On Select Server Roles, select Active Directory Certificate Services and click Next.

When a pop-up window appears, view the details and click Add Features > Next.

View the details of Active Directory Certificate Services and click Next.

On Confirm installation selections, click Install. When installation is complete, click Configure
Active Directory Certificate Services on the destination server.

When AD CS Configuration wizard appears, view the details and click Next.

On Role Services, click Certification Authority > Next.

On the Setup Type page, select Enterprise CA and click Next.

On the Specify the type of the CA page, select Root CA and click Next.

On the Specify the type of the private key page, select Create a new private key and click
Next.

Set the Cryptography for CA, CA Name, and Validity Period, and then click Next.

On the CA Database page, set the folder location for the certificate database and the
certificate database log and then click Next.

On Confirmation page, view the details of Active Directory Certificate Services and click

Configure.

Step 2. Connecting LDAPS (LDAP over SSL/TLS)

1)
2)
3)
4)

Click Start > Run.

Enter Idp in the input field.

When the Ldp-disconnected window appears, click Connect.
Fill in Server and Port fields and select SSL. And then click OK.

Step 3. Copying the root certificate

1)
2)
3)

4)

Visitor
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Run Command Prompt on the PC where the Windows Active Directory server is installed.
Enter certutil -ca.cert client.crt command to copy the root certificate.

Enter keytool -import -keystore ad.jks -file client.crt command to convert the server
certificate to .jks format.

Save the .jks-formatted server certificate to the BioStar 2 installation path.

You can configure visiting sites and PCs. You can also set the terms and conditions for visitors.
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And You can create the information fields that you want to know from the visitors by using the Custom

Visitor Field.

Note

= The VISITOR setting will appear when the Visitor license is activated.

= Activate the Automatic User Synchronization or Use Server Matching option to use the
VISITOR.

1) Click Settings > VISITOR.

2) Set the necessary items.

Site Settings

Site Settings

You can set the access group to use in the visiting PC and managing

Site

w
5
°
>
o
B
-t

Suprema 02 Acces. Wiegand 26 bit

-t

PC of each site.

You can also set whether or not to use cards. If you are using a card,

you can also set Card Type and Card Data Format.

« Name: You can set the name of site.

» Access Group: You can select the access group to assign to the
visitor.

« Card Use: You can set whether or not to use a card.

» Card Type: You can select the type of card to use in the site. The
card type is activated only when you select Card Use.

« Card Data Format: You can configure the format for reading card
data. The Card Data Format is activated only when you set the

Card Type to Wiegand.

Note

= Up to 48 characters may be entered for a site name.

Click Apply to save the setting of the site.
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Visit PC Settings

Visit PC Settings

e —M =
Aosly
Management PC jo... v io... v a v

+ Visit application page hitps://192.168.14.25/# register_welcome

Drag and drop links from your visiting PC to create shortcuts on your desktop

Description

You can set the visiting PC and managing PC.

= Name: You can set the name of the visiting PC and
managing PC.

= Fingerprint Device Name: Select a device to enroll visitors'
fingerprints when visitors access the site using the
fingerprint authentication.

= Card Device Name: Select a device to issue the card to
visitors when visitors access the site using the card

authentication.

Visit PC
Setting = Site: Select a site to manage the visit on the visiting PC.

Note

= Up to 48 characters may be entered for a name of the
visiting PC.

= You can use the fingerprint and card device at the
same time. You can select only one for each.

= You can only select one site per PC.

Click Apply to save the setting of the Visit PC Setting.

Visit You can create a shortcut icon of Visit application page on
2 applicati | the desktop of the visiting PC. Drag and drop the link to the
on page desktop of the visiting PC.

== Visit PC Select
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Visit PC Select

+ Visit PC Select Visiting PC - Apply

You can select the PC set in Visit PC Setting and assign it to the
Visit PC

Select

current PC.

Click Apply to save the setting.

Terms & Visitor Settings

Terms & Visitor Settings

Accept Terms and Conditions Settings

, Apply

rd

* Allowed period for credential rd 3 Day(s)

Visitor Settings

* Guide to Completion of Visit rd
4
Y

+ Default access period for visitor 2| 1 Day(s)

Description

You can set the terms and conditions for visitors.

Click d to activate the input field and enter the

contents of terms and conditions.

1 Term_s,_ and Note
Conditions

» Up to 65,535 characters may be entered for the
sentence of terms and conditions.
= Up to 64 characters may be entered for the

sentence of accept terms and conditions.

You can set the privacy policy for visitors.

. P . . .
2 Privacy Policy Click to activate the input field and enter the

privacy policy.
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Note

» Up to 65,535 characters may be entered for the
sentence of privacy policy.
= Up to 64 characters may be entered for the

sentence of accept privacy policy.

You can set the period for keeping personal data that
visitors provide when they visit.

Click o to activate the input field and enter the

number of days to keep personal data.
Allowed period

for credential Note
= You can delete the visitors that have
the personal data expired in
VISITOR menu.
You can set the guide to appear on the screen as a
pop-up when a visitor completes an application for a
visit.
Click o to activate the input field and enter the guide
for visitors.
Guide to
4 Completion of Note
Visit

= Up to 65,535 characters may be entered for the
sentence of guide.

= |f you do not enter the sentence of a guide,
nothing will be displayed on the screen when

visitors complete their visit application.

You can set the access period for visitors.
5 Default access

Y . . i
period for visitor Click to activate the input field and enter the

default access period for visitors.

Custom Visitor Feld

Custom Visitor Field

* Custom Visitor Field Settings

1 purpose of visit Text Input Box
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You can add custom visitor fields for extra visitor information

and these fields appear on the visit application page.

= Order: You can set the order of the Custom Visitor Field.

= Name: You can set the name of the Custom Visitor Field.

= Type: You can choose the Text Input Box, Number Input Box or
Combo Box.

= Data: Enter the options to appear in the combo boxes. Each
item is separated by a semicolon (). Data is only activated

when Type is set to Combo Box.

Note

= Fora Text Input Box, characters and numbers are

allowed.
Custom N
.. . * Purpose of visit
Visitor Field
Settings = For a Number Input Box, numbers are allowed and

characters are not allowed.
* Number of visitors

= Fora Combo Box, the items that have been set to the
field are displayed as item. If you want to configure a
combo box field as shown in the screenshot below, you
need to enter Option 1;0ption 2;0ption 3;0ption 4 in the
data field.

* Option I Mone ‘

Mone

Option1
Option2
Option3

Optiond

Click Apply to save the setting of the Custom Visitor Field.

Mobile Access
By linking BioStar 2 and Airfob Portal, you can issue the mobile access cards to users in BioStar 2.

Users can be issued mobile access cards through a link received by email or SMS without signing up for

Airfob Portal or registering mobile access cards separately.
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Note

Mobile access cards can only use either the CSN Mobile card or Template on Mobile.
The devices and the firmware versions that can use the CSN Mobile card are as follows.
- XPass 2 FW 1.1.0 or later

- XPass D2(Rev 2) FW 1.4.0 or later

- BioLite N2 FW 1.3.0 or later

- BioEntry W2(Rev 2) FW 1.6.0 or later

- FaceStation 2 FW 1.4.0 or later

- FaceStation F2 FW 1.0.0 or later

- BioStation 2 FW 1.9.0 or later (Only models with NFC features are compatible.)

- BioStation A2 FW 1.8.0 or later (Only models with NFC features are compatible.)

- Facelite FW 1.2.0 or later

- X-Station 2 FW 1.0.0 or later

- BioStation 3 FW 1.0.0 or later

The devices and the firmware versions that can use the Template on Mobile are as follows.
- BioStation 3 FW 1.2.0 or later

You can set up Suprema Mobile Access as shown below.

Step 1. Join Airfob Portal and open site

credits.

In Airfob Portal, you can set up mobile access cards and registration devices, and manage sites and

& Related information

Step 2. Configure the Mobile Access in BioStar 2

You can set whether to use the mobile access and manage settings related to Airfob Portal.

You can also register devices to use mobile access cards.

Related information

Step 3. Registering Devices
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You can register devices to use mobile access directly from the Airfob Pass application or BioStar 2.

Related information

Step 4. Issuing Mobile Access Card

You can issue mobile access cards to users registered with BioStar 2.
To issue a mobile access card to a user, you must enter user information based on the messaging
option.

Related information

Airfob Portal

In Airfob Portal, you can set up mobile access cards and registration devices, and manage sites and
credits.

1) Access the Airfob Portal( ).

2) Click Get Started to sign up and create a site.

3) Enter the Airfob Portal administrator's email address in the Email input field and click Get Started.
The authentication code will be sent to the email address you entered.

4) Enter the authentication code you received in the authentication code field and click Confirm.

Note

= The authentication code is a 6 digit number.

5) Check the Privacy and Terms and click Agree.

6) Set the password and nickname to use in the Airfob Portal and click Create Account. Creating the
account will be completed.

7) Click Sign In.

8) Enter the email and password, then click Sign In.

9) Click Create Site to open the site.

Note

= Site means an organization or company that uses the mobile access.
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10) Set the name and country of the site, and then click Next.
11) Select the site type.

Note

= You can select types either Dynamic or Regular depending on the type of sites or situations.
- Dynamic: This type allows you to reissue, revoke, or stop mobile access cards or specify
the expiration date of it. It deducts credits according to the period of use or devices. Dynamic
can be used in gyms, libraries, or shared facilities where it provides membership services.
- Regular: This type can be used permanently until an administrator deletes the access
authority. It deducts credits according to the number of issuances. Regular can be used in
companies as employee ID cards or access cards.

= BioStar 2 only supports regular card sites. Dynamic cards will be supported in the future.

12) Click Create. Creating the site will be completed.
13) Click the site name to access the Airfob Portal of the site.

Note

= For more information on using the Airfob Portal, see the Airfob Portal(https://

portal.airfob.com/en).

Configuring Mobile Access

You can set whether to use the mobile access and manage settings related to Airfob Portal.
You can also register devices to use mobile access cards.

1) Click Settings > MOBILE ACCESS.
2) Edit the necessary items.
General
+ Mobile Access Setting T Use + Site Type
+ Domain + Port

+ SiteID 1318 + Email test@suprema.co.kr

+ Password | sesssssssss Connect

= Mobile Access Setting: You can set whether to use the mobile access. If you set
the Mobile Access Setting to Use, you can issue mobile access cards to users.

General Note

= To use Mobile Access with BioStar 2, complete the Airfob Portal sign-up and
initial setup first.
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= Site Type: You can see the site type.

Note

= You can select types either Dynamic or Regular depending on the type of
sites or situations.
- Dynamic: This type allows you to reissue, revoke, or stop mobile access
cards or specify the expiration date of it. It deducts credits according to the
period of use or devices. Dynamic can be used in gyms, libraries, or shared
facilities where it provides membership services.
- Regular: This type can be used permanently until an administrator deletes
the access authority. It deducts credits according to the number of issuances.
Regular can be used in companies as employee ID cards or access cards.

= Domain: You can see the domain address of the Airfob Portal.

= Port: You can see the port number of the Airfob Portal.

= Site ID: Enter the site ID that you created in the Airfob Portal. You can find the site
ID in Settings > Site menu of the Airfob Portal.

= Email: Enter the email address of the mobile access administrator.

= Password: Enter the password of the mobile access administrator.

= Device Registration: You can register devices to use the mobile access. Device
Registration appears when you complete entering the Domain, Port, Site ID,
Email, and Password, and then click Connect to successfully connect to the
Airfob Portal.

+ Device Registration +hdd

Not found

Click + Add to add devices to use the mobile access. The list of devices registered
in BioStar 2 is displayed.

Enrollment Device X

[ ] Device ID Name Group IP Address

[[]  sars32mi2 Facelite 547832712 (192.168.14.240) All Devices 192.168.14.240

[[] 547833190 Xpass2 Keypad 547833190 (192.168.14.233) All Devices 192.168.14.233

Close
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Select the device and click Add.

+ Device Registration +Add

547833190 Xpass2 Keypad 547833190 (192.168.14.233) All Devices 192.168.14.233 oW

The devices that have been added to the list of devices are displayed. Click < to
resend the mobile access certificate. Click ¥ to delete the registered device.

Note

= The devices and the firmware versions that can use the mobile access are as
follows.
- XPass 2 FW 1.1.0 or later
- XPass D2(Rev 2) FW 1.4.0 or later
- BioLite N2 FW 1.3.0 or later
- BioEntry W2(Rev 2) FW 1.6.0 or later
- FaceStation 2 FW 1.4.0 or later
- FaceStation F2 FW 1.0.0 or later
- BioStation 2 FW 1.9.0 or later (Only models with NFC features are
compatible.)
- BioStation A2 FW 1.8.0 or later (Only models with NFC features are
compatible.)
- Facelite FW 1.2.0 or later
- X-Station 2 FW 1.0.0 or later
- BioStation 3 FW 1.0.0 or later
= You can also register devices using the Airfob Pass application.
= If you delete the registered device, the mobile access certificate sent to the
device will be deleted.

Ema
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il Setting

You can set contents such as title, company name, company logo, and contact of email that will send

users a visual face mobile enrollment link or issue a QR/barcode.

Note

= Before setting an email contents, activate the Cloud. The Cloud will be available when the
Standard or higher license is activated.

= Enter user's email address in the user information to use visual face mobile enroliment or
Secure QR.

= The devices that can use Visual Face are as follows.
- FaceStation F2, BioStation 3

= The devices that can use Use QR/Barcode through Scanner are as follows.
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- X-Station 2 (XS2-QDPB, XS2-QAPB)
= The devices that can use Use QR/Barcode through Camera are as follows.
- X-Station 2 (XS2-ODPB, XS2-OAPB, XS2-DPB, XS2-APB) firmware 1.2.0 or higher
- BioStation 3 (BS3-DB, BS3-APWB) firmware 1.1.0 or higher
- Using Use QR/Barcode through Camera requires a separate device license. For more

information, refer to Device License.

1) Click Settings > EMAIL SETTING.

2) Edit the necessary items.

Email Contents Setting

Email Contents Setting

“

Set the SMTP(Simple Mail Transfer Protocol) for sending
emails.

SMTP Option X

Sender Information

+ SMTP Server Name

« Description

« Server Address

« Port(default:25) 25
+ User Name

+ Password

1 | SMTP Setting

« Security Type SSL v

+ Sender

E{” E | Cancel

= SMTP Server Name: Enter the SMTP server name.

= Description: Enter the description.

= Server Address: Enter the SMTP server address.
SMTP server address is the same form as 'smtp. Email
Service Provider.com', and you can check it on the
settings screen of email to use as an SMTP .

= Port(default:25): Enter the port number of the
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SMTP server. you can check it on the settings screen
of email to use as an SMTP.
= User Name: Enter the account of the SMTP service.
» Password: Enter the password of the SMTP service.
= Security Type: Select security type.
= Sender: Enter the email address of the sender.

Note

= For more information on SMTP information,
contact your system administrator.

= When using the SMTP server as an email
account with two-factor authentication and
change the password of the account, note the
following: Once you set up two-factor
authentication, the SMTP password is the same
as the app password generated using two-factor
authentication, not the password of the email
account. At this time, if the password of the
email account is changed, the app password is
automatically deleted, and the SMTP password is
no longer available. When changing the
password for the email account, regenerate the
app password and then set the SMTP password
again.

Test Mail
2 | Recipient
Address

Enter an email address to receive the test email and
click Send Email.

Visual Face Mobile Enrollment
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Visual Face Mobile Enrollment

1 ————————————{ « Visual Face Mobile Enroliment Use
22—+ EmailTitle Visual Face Enrollment

3———— [ . Compan

4 ——————{ . Compan

5 ———————{ + Contact
6 ————————————— + Footer

1 Visual Face

y Name Suprema
y Logo Upload Logo Image

0123456789

To use the visual face mobile enroliment set it as Use. If
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Mobile
Enrollment

you set it as Not Use, it will be unable to send the visual
face mobile enrollment link to users.

2 Email Title

Enter the title of the email.

3 Company
Name

Enter the company name.

4 Company Logo

Upload the company logo image.

Note

= Supported image file formats are GIF, JPG,
JPEG, JPE, JFIF, PNG.
= Supported image file size is up to 5MB.

5 Contact Enter the contact information of the person in charge.
Enter the content to notify the user who is enrolling the
visual face, such as a legal notice. It appears at the
bottom of the email.

6 Footer

Note

= Footer can be up to 5,000 characters in length.

QR

QR

...........

woewoe o
H

Upload Logo Image

“

1 QR

To use the QR/Barcode set it as Use. If you set it as Not
Use, it will be unable to issue the QR/Barcode to users
via email.

2 Email Title

Enter the title of the email.

3 Company
Name

Enter the company name.

4 Company Logo

Upload the company logo image.

Note
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= Supported image file formats are GIF, JPG,
JPEG, JPE, JFIF, PNG.
= Supported image file size is up to 5MB.

5 Contact Enter the contact information of the person in charge.

3) Click Apply to save the settings.

License
Activate BioStar 2 License and Device License.
BioStar 2 License

1) Click Setting > LICENSE.

BioStar 2 License

Access Control
+ Applied License Advanced

« lssued to BioStar2ADV + Expiry date 2023/04/18

Time Attendance
+ Activate License Online Name Activation Key Activate

+ Activate License Offline Request offline key Activate

Video
« Activate License Online Name Activation Key Activate

« Activate License Offline Request offline key Activate

Visitor
+ Activate License Online Name Activation Key Activate

« Activate License Offline | Request offline key Activate

You can activate the purchased BioStar 2 license.

To activate the BioStar 2 license online, click Activate after
entering your name and the activation key that you've received
from Suprema.

To activate the BioStar 2 license offline, click Request offline
key, then the Activate License Offline dialog will appear. Follow
the instructions on the dialog.

BioStar 2
License

Device License
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Activating a device license issued by Suprema allows using specific features
corresponding to the license.
Contact the place of purchase to issue a device license.

Device license can be activated on the device using BioStar 2 and USB memory.

Note

= One feature is available per device license.

= You can include multiple device licenses in one device license file.
(Supports up to 100)

= The device license file is an encrypted file and cannot be modified
arbitrarily.

= Device licenses are issued based on device ID. If the device ID is
changed in an unusual way, the warranty service for the license is not
provided.

1) Click Setting > LICENSE.

Device License

1 ——— - License File Browse | * Device Count ]7 3
2 —— - License Type « License Count ]— a
5 ————{ + Device List

432073370 CoreStation 40 432073370 (192.168.40.164) Cs-40 Normal Not Activated 4/8

Activate

escription

Click Browse to load the device license file from the path
1 where the device license is saved, and License Type,

License

File
Device Count, and Device List are displayed.

Check the type of license included in the device license file.

= Camera QR

Note
2 License = Devices that can use Camera QR are as follows.
Type - X-Station 2 (XS2-ODPB, XS2-OAPB, XS2-DPB,

XS2-APB) firmware 1.2.0 or higher
- BioStation 3 (BS3-DB, BS3-APWB) firmware 1.1.0
or higher

= U&Z Wireless Door Lock
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Note

= You can issue a device license for up to 8 devices
equal to the number of U&Z wireless door locks you
want to connect.

= The maximum number of U&Z wireless door locks
that can be connected with a device license is 8.
Even if you activate multiple device licenses, you
cannot exceed 8 devices.

Device Check the number of devices included in the device license
Count file.

Check the number of U&Z Wireless Door Locks that can be
activated with a device license.

4 License _
Count Note

= This item only appears when a U&Z Wireless Door
Lock device license is activated.

= Device ID: Displays the unique ID of the device.

= Device Name: Displays the device name.

= Product Name: Displays the model name of the device.

= Device Status: Check the device status. Only devices in
Normal state can activate licenses.
- Normal, Disconnected, Not Supported,
Unregistered

= License Status: Displays whether the license is

Device
S List activated. Only Not Activated devices can activate
licenses.
- Not Activated, Activated, N\VA
= Activated Count: Check the connection current situation

of U&Z Wireless Door Locks.
Note

= This item only appears when a U&Z Wireless Door
Lock device license is activated.

2) After checking the device list, click Activated to activate the device license. If
the license activation fails, an activation failed message is displayed and you

can try to activate the license again.
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Card Printer

In the CARD PRINTER menu, BioStar 2 and cardPresso can be linked to print a card with a design the

user wants from BioStar 2.

Note

= To use the card printer feature, you must activate the license issued by cardPresso.

- License type: cardPresso XXL edition

= Install cardPresso on the PC where BioStar 2 is installed.

1) Click Settings > CARD PRINTER.
2) Edit the necessary items.

< | Card Printer

General

+ cardPresso Setting & ) Use + IP Address 127.0.0.1
-
- Ip ADMIN + Port 632
«Password | esess + Printer Name DTC1250e Card Printer [ ]

+ Card Template

+Add

1 C:\template\example.card

C:\template\example2.card ®

+ Card Template Print Test C:\templatel\example.card A 4 Test Print

[ Apply J ‘ Cancel ‘

cardPresso .

. Set whether to use a card printer.
Setting
ID Enter your cardPresso login ID. The default ID is ‘ADMIN'.
Password Enter your cardPresso login password. The default password is 'admin'.
IP Address Enter the IP address of the PC that runs the cardPresso web print server.
Port Enter the port number used by cardPresso to receive print operations.
Printer Enter the name of the printer to be used as a card printer. It can be found in the
Name Windows Control Panel > Devices and printers.
card Click + Add to add a card template. For Name, enter the full path including the card

ar i .
template file name and extension.

Template
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Note

= The file name of the card template can be entered using alphanumeric, and
special characters.

= Up to 20 card templates are supported.

= Example path: C:W template example.card

= For details on how to create a card template, refer to the cardpresso

manual.
Card
Template Test print the card template.
Print Test

3) Click Apply to save the settings.

System Backup

The SYSTEM BACKUP menu backs up important information such as BioStar 2's database, various
settings, key values, etc.

Note

= If the MSSQL database and BioStar 2 are installed on different PCs, BioStar 2 System Backup
and Restore cannot be used.

General Backup
Set the necessary items for system backup.

1) Click Settings > SYSTEM BACKUP.
2) Edit the necessary items.

General

+ Backup File Path C:\Program Files\BioStar 2(x64)\.

+ Number of Backup
Files to Keep

The latest backup was completed on March 03, 2023 at 10:36

Backup Now

Set the path to save the backup file.
Backup

File Path Note
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= The save path must be set to a directory that has already
been created.
Set the maximum number of backup files.
Number ;
Note
of
Backup » If the maximum number of backups are exceeded, the
Files to oldest backup files are automatically deleted.
Kee
P = Number of Backup Files to Keep, only numbers between

1 and 100 are entered.
Back .
N up To back up manually, click Backup Now.

ow

3) Click Apply to save the settings.

Automatic System Backup
Set the system to back up automatically.

1) Click Settings > SYSTEM BACKUP.
2) Edit the necessary items.

Automatic System Backup

+ Frequency Not Use v

+ Day - Time [i ]

Frequenc | Select the automatic system backup frequency as Daily / Weekly /

y Monthly.

Day When Frequency is set to Weekly, set the day of the week to
automatically system backup.
When Frequency is set to Monthly, set the date of the month to
automatically system backup.

Date

Note

= When set to the 29th, 30th, or 31st, automatic system
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backup will not run for months without the corresponding

date.

Time

Set the time to automatically system backup.

Note

= Based on the time zone set in BioStar 2.

3) Click Apply to save the settings.

(® Related Information

System Restore

System Restore

If BioStar 2 does not operate normally, it can use the BioStar 2 Restore program to restore backed up

files by selecting a restore point.

Note

= If the MSSQL database and BioStar 2 are installed on different PCs, BioStar 2 System Backup

and Restore cannot be used.

1) Run ] Start > BioStar 2 > BioStar 2 Restore.
- Program path: C:W Program FilesW BioStar 2(x64)W biostar-restore.exe
2) Click Select File to select the saved backup file and then click Restore to start restoring.

BioStar 2 Restore — 0O X

Load Restore File | C:\Program Files\BioStar 2(x64)\Backup\BioStar_2_ | | SelectFile |
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3) Starting Biostar services...Done messages displayed and restoration is completed.
4) Reconnect to BioStar 2.

Note

= If the BioStar 2 version at the time of backup is different from the current version, the

restoration will not proceed.

For any inquires or technical support concerning BioStar 2, please contact the Suprema Technical
Support Team ( ).

For efficient technical support, please provide the following information.

= Company name, your name and job title, country information (regional information), contact
information and the best time to reach you

= Current BioStar 2 version and device models (examples: BioStar 2 V1.0.233, BioLite Net)

= Details of the error message

= BioStar 2 system log

= Description of your symptom and problem

This section provides the disclaimers, copyright notice, and software end user license agreement of
Suprema.

Disclaimers
= Information in this document is provided in connection with Suprema products.
= The right to use is acknowledged only for Suprema products included in the terms and
conditions of use or sale for such products guaranteed by Suprema. No license, express or

implied, by estoppel or otherwise, to any intellectual property is granted by this document.

= Except as expressly stated in an agreement between you and Suprema, Suprema assumes no
liability whatsoever, and Suprema disclaims all warranties, express or implied including,
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without limitation, relating to fitness for a particular purpose, merchantability, or

noninfringement.

All warranties are VOID if Suprema products have been: 1) improperly installed or where the
serial numbers, warranty date or quality assurance decals on the hardware are altered or
removed; 2) used in a manner other than as authorized by Suprema; 3) modified, altered or
repaired by a party other than Suprema or a party authorized by Suprema; or 4) operated or
maintained in unsuitable environmental conditions.

Suprema products are not intended for use in medical, lifesaving, life-sustaining applications,
or other applications in which the failure of the Suprema product could create a situation
where personal injury or death may occur. Should you purchase or use Suprema products for
any such unintended or unauthorized application, you shall indemnify and hold Suprema and
its officers, employees, subsidiaries, affiliates, and distributors harmless against all claims,
costs, damages, and expenses, and reasonable attorney fees arising out of, directly or
indirectly, any claim of personal injury or death associated with such unintended or
unauthorized use, even if such claim alleges that Suprema was negligent regarding the design
or manufacture of the part.

Suprema reserves the right to make changes to specifications and product descriptions at any

time without notice to improve reliability, function, or design.

Personal information, in the form of authentication messages and other relative information,
may be stored within Suprema products during usage. Suprema does not take responsibility
for any information, including personal information, stored within Suprema’ products that are
not within Suprema’ direct control or as stated by the relevant terms and conditions. When
any stored information, including personal information, is used, it is the responsibility of the
product users to comply with national legislation (such as GDPR) and to ensure proper

handling and processing.

You must not rely on the absence or characteristics of any features or instructions marked
"reserved" or "undefined." Suprema reserves these for future definition and shall have no

responsibility whatsoever for conflicts or incompatibilities arising from future changes to them.

Except as expressly set forth herein, to the maximum extent permitted by law, the Suprema

products are sold “as is”.

Contact your local Suprema sales office or your distributor to obtain the latest specifications
and before placing your product order.

Copyright Notice
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Copyright of this documentation is reserved by Suprema. All other product names, trademarks,
registered trademarks are the property of their respective owners.

Open-source Software License

This product contains open-source software. To request the source code covered under GPL, LGPL, MPL,
and other open-source licenses which require distribution of the source code, please visit

You may obtain the source code for three years after our last shipment of this product on our website
( )-

If you want to obtain the source code in the physical medium, the cost of performing such distribution
may be charged. This offer is valid to anyone in receipt of this information.

Open-source licenses and the corresponding license terms for open-source software contained in this
product are as follows:

MariaDB LGPL client libraries for C and Java

https://mariadb.com/kb/en/client-libraries/

Copyright (C) 1991, 1999 Free Software Foundation, Inc.
The LGPL license

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free

software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
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specially designated software packages--typically libraries--of the

Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about whether
this license or the ordinary General Public License is the better
strategy to use in any particular case, based on the explanations
below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and charge
for this service if you wish); that you receive source code or can get

it if you want it; that you can change the software and use pieces of

it in new free programs; and that you are informed that you can do
these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender these
rights. These restrictions translate to certain responsibilities for

you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis

or for a fee, you must give the recipients all the rights that we gave
you. You must make sure that they, too, receive or can get the source
code. If you link other code with the library, you must provide
complete object files to the recipients, so that they can relink them
with the library after making changes to the library and recompiling

it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified

by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
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any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those

libraries into non-free programs.

When a program is linked with a library, whether statically or using a
shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with

the library.

We call this license the "Lesser"” General Public License because it

does Less to protect the user's freedom than the ordinary General

Public License. It also provides other free software developers Less

of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain

special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free

software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
operating system, as well as its variant, the GNU/Linux operating

system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
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linked with the Library has the freedom and the wherewithal to run

that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter must
be combined with the library in order to run. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of
this Lesser General Public License (also called "this License™). Each
licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control

compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based
on the Library (independent of the use of the Library in a tool for
writing it). Whether that is true depends on what the Library does and

what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
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complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the

Library.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a
fee.

2. You may modify your copy or copies of the Library or any portion of
it, thus forming a work based on the Library, and copy and distribute
such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

* a) The modified work must itself be a software library.

* b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

* ¢) You must cause the whole of the work to be licensed at no
charge to all third parties under the terms of this License.

* d) If a facility in the modified Library refers to a function or
a table of data to be supplied by an application program that
uses the facility, other than as an argument passed when the
facility is invoked, then you must make a good faith effort to
ensure that, in the event an application does not supply such
function or table, the facility still operates, and performs
whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots
has a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function
must be optional: if the application does not supply it, the

square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
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sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the Library
with the Library (or with a work based on the Library) on a volume of
a storage or distribution medium does not bring the other work under

the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do

this, you must alter all the notices that refer to this License, so

that they refer to the ordinary GNU General Public License, version 2,
instead of to this License. (If a newer version than version 2 of the
ordinary GNU General Public License has appeared, then you can specify
that version instead if you wish.) Do not make any other change in

these notices.

Once this change is made in a given copy, it is irreversible for that
copy, so the ordinary GNU General Public License applies to all

subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the

Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative

of it, under Section 2) in object code or executable form under the

terms of Sections 1 and 2 above provided that you accompany it with

the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange.

If distribution of object code is made by offering access to copy from
a designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
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source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the

Library, but is designed to work with the Library by being compiled or
linked with it, is called a "work that uses the Library". Such a work,
in isolation, is not a derivative work of the Library, and therefore

falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library
creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a "work that uses the
library". The executable is therefore covered by this License. Section
6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file
that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is

not. Whether this is true is especially significant if the work can be
linked without the Library, or if the work is itself a library. The

threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure
layouts and accessors, and small macros and small inline functions
(ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative

work. (Executables containing this object code plus portions of the

Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section
6. Any executables containing that work also fall under Section 6,

whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link
a "work that uses the Library" with the Library to produce a work
containing portions of the Library, and distribute that work under

terms of your choice, provided that the terms permit modification of
the work for the customer's own use and reverse engineering for

debugging such modifications.

You must give prominent notice with each copy of the work that the
Library is used in it and that the Library and its use are covered by
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this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one

of these things:

* a) Accompany the work with the complete corresponding
machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under
Sections 1 and 2 above); and, if the work is an executable
linked with the Library, with the complete machine-readable
"work that uses the Library", as object code and/or source code,
so that the user can modify the Library and then relink to
produce a modified executable containing the modified
Library. (It is understood that the user who changes the
contents of definitions files in the Library will not
necessarily be able to recompile the application to use the
modified definitions.)

* ) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user's computer
system, rather than copying library functions into the
executable, and (2) will operate properly with a modified
version of the library, if the user installs one, as long as the
modified version is interface-compatible with the version that
the work was made with.

* ¢) Accompany the work with a written offer, valid for at least
three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of
performing this distribution.

* d) If distribution of the work is made by offering access to
copy from a designated place, offer equivalent access to copy
the above specified materials from the same place.

* e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
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the executable.

It may happen that this requirement contradicts the license

restrictions of other proprietary libraries that do not normally

accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on
the Library and of the other library facilities is otherwise

permitted, and provided that you do these two things:

* a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the
Sections above.

* b) Give prominent notice with the combined library of the fact
that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under

this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so

long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying

the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
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original licensor to copy, distribute, link with or modify the Library
subject to these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted

herein. You are not responsible for enforcing compliance by third

parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Library at all. For example, if a patent

license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply, and the section as a whole is intended to apply in other

circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing

to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to

be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
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countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and

"any later version", you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Library does not specify a

license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status
of all derivatives of our free software and of promoting the sharing

and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE

LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS
AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME

THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
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RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. END OF TERMS AND CONDITIONS.

MariaDB Server

https://mariadb.com/kb/en/legal-documents-mariadb-license/
Copyright (C) 1989, 1991 Free Software Foundation, Inc.

The GPL license

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public License is
intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users. This

General Public License applies to most of the Free Software

Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to

your programs, too.

When we speak of free software, we are referring to freedom, not price.
Our General Public Licenses are designed to make sure that you have
the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new

free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone

to deny you these rights or to ask you to surrender the rights. These
restrictions translate to certain responsibilities for you if you
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distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis
or for a fee, you must give the recipients all the rights that you

have. You must make sure that they, too, receive or can get the source
code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain

that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so

that any problems introduced by others will not reflect on the original

authors' reputations.

Finally, any free program is threatened constantly by software patents.
We wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program
proprietary. To prevent this, we have made it clear that any patent
must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and

modification follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a

notice placed by the copyright holder saying it may be distributed

under the terms of this General Public License. The "Program",

below, refers to any such program or work, and a "work based on

the Program™ means either the Program or any derivative work under

copyright law: that is to say, a work containing the Program or a

portion of it, either verbatim or with modifications and/or

translated into another language. (Hereinafter, translation is

included without limitation in the term "modification™.) Each

licensee is addressed as "you".

Activities other than copying, distribution and modification are
not covered by this License; they are outside its scope. The act
of running the Program is not restricted, and the output from the
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Program is covered only if its contents constitute a work based on
the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of
this License along with the Program.

You may charge a fee for the physical act of transferring a copy,
and you may at your option offer warranty protection in exchange
for a fee.

2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1

above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b. You must cause any work that you distribute or publish, that
in whole or in part contains or is derived from the Program
or any part thereof, to be licensed as a whole at no charge

to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display
an announcement including an appropriate copyright notice and
a notice that there is no warranty (or else, saying that you
provide a warranty) and that users may redistribute the
program under these conditions, and telling the user how to
view a copy of this License. (Exception: if the Program
itself is interactive but does not normally print such an
announcement, your work based on the Program is not required

to print an announcement.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the
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Program, and can be reasonably considered independent and separate
works in themselves, then this License, and its terms, do not

apply to those sections when you distribute them as separate

works. But when you distribute the same sections as part of a

whole which is a work based on the Program, the distribution of

the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each

and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or
contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of

derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the
Program with the Program (or with a work based on the Program) on
a volume of a storage or distribution medium does not bring the
other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms
of Sections 1 and 2 above provided that you also do one of the
following:

a. Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for
software interchange; or,

b. Accompany it with a written offer, valid for at least three
years, to give any third-party, for a charge no more than your
cost of physically performing source distribution, a complete
machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

¢. Accompany it with the information you received as to the offer
to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you
received the program in object code or executable form with

such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for
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making modifications to it. For an executable work, complete
source code means all the source code for all modules it contains,
plus any associated interface definition files, plus the scripts

used to control compilation and installation of the executable.
However, as a special exception, the source code distributed need
not include anything that is normally distributed (in either

source or binary form) with the major components (compiler,
kernel, and so on) of the operating system on which the executable

runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this
License. However, parties who have received copies, or rights,
from you under this License will not have their licenses

terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify
or distribute the Program or its derivative works. These actions
are prohibited by law if you do not accept this License.
Therefore, by modifying or distributing the Program (or any work
based on the Program), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying,

distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program
subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance
by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent
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issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this
License, they do not excuse you from the conditions of this
License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the
Program at all. For example, if a patent license would not permit
royalty-free redistribution of the Program by all those who
receive copies directly or indirectly through you, then the only
way you could satisfy both it and this License would be to refrain
entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable
under any particular circumstance, the balance of the section is
intended to apply and the section as a whole is intended to apply

in other circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of

any such claims; this section has the sole purpose of protecting
the integrity of the free software distribution system, which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed
to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Program under this
License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of
this License.

9. The Free Software Foundation may publish revised and/or new
versions of the General Public License from time to time. Such

new versions will be similar in spirit to the present version, but
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may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the
Program specifies a version number of this License which applies
to it and "any later version", you have the option of following

the terms and conditions either of that version or of any later
version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose

any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free

programs whose distribution conditions are different, write to the
author to ask for permission. For software which is copyrighted
by the Free Software Foundation, write to the Free Software
Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of

all derivatives of our free software and of promoting the sharing
and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY
OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these

terms.

To do so, attach the following notices to the program. It is safest to
attach them to the start of each source file to most effectively convey
the exclusion of warranty; and each file should have at least the

"copyright" line and a pointer to where the full notice is found.

ONE LINE TO GIVE THE PROGRAM'S NAME AND A BRIEF IDEA OF WHAT IT DOES.
Copyright (C) YYYY NAME OF AUTHOR

This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or

(at your option) any later version.

This program is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this

when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) 19YY NAME OF AUTHOR
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type ~show w'.
This is free software, and you are welcome to redistribute it

under certain conditions; type ~show c' for details.

The hypothetical commands ~show w' and ~show c' should show the
appropriate parts of the General Public License. Of course, the
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commands you use may be called something other than ~show w' and ~show
c¢'; they could even be mouse-clicks or menu items--whatever suits your

program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer"” for the program, if
necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program
“Gnomovision' (which makes passes at compilers) written by James Hacker.

SIGNATURE OF TY COON, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program
into proprietary programs. If your program is a subroutine library,

you may consider it more useful to permit linking proprietary
applications with the library. If this is what you want to do, use the
GNU Library General Public License instead of this License.

Node.js

https://nodejs.org/ko/

Node.js is licensed for use as follows:

i

Copyright Node.js contributors. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software™), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
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LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

o

This license applies to parts of Node.js originating from the
https://github.com/joyent/node repository:

o

Copyright Joyent, Inc. and other Node contributors. All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

o

The Node.js license applies to all parts of Node.js that are not externally

maintained libraries.

The externally maintained libraries used by Node.js are:

- c-ares, located at deps/cares, is licensed as follows:
Copyright 1998 by the Massachusetts Institute of Technology.
Copyright (C) 2007-2013 by Daniel Stenberg

Permission to use, copy, modify, and distribute this

software and its documentation for any purpose and without
fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright
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notice and this permission notice appear in supporting
documentation, and that the name of M.1.T. not be used in
advertising or publicity pertaining to distribution of the
software without specific, written prior permission.

M.L.T. makes no representations about the suitability of
this software for any purpose. It is provided "as is"

without express or implied warranty.

o

- HTTP Parser, located at deps/http_parser, is licensed as follows:
http_parser.c is based on src/http/ngx_http_parse.c from NGINX copyright
Igor Sysoev.

Additional changes are licensed under the same terms as NGINX and
copyright Joyent, Inc. and other Node contributors. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software™), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

i

- ICU, located at deps/icu, is licensed as follows:
ICU License - ICU 1.8.1 and later
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2016 International Business Machines Corporation and others
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All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of
the Software and that both the above copyright notice(s) and this

permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT
OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY

SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder
shall not be used in advertising or otherwise to promote the sale, use
or other dealings in this Software without prior written authorization

of the copyright holder.

All trademarks and registered trademarks mentioned herein are the
property of their respective owners.

Third-Party Software Licenses

This section contains third-party software notices and/or additional
terms for licensed third-party software components included within ICU
libraries.

1. Unicode Data Files and Software

COPYRIGHT AND PERMISSION NOTICE
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Copyright © 1991-2016 Unicode, Inc. All rights reserved.
Distributed under the Terms of Use in
http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining

a copy of the Unicode data files and any associated documentation

(the "Data Files™) or Unicode software and any associated documentation
(the "Software") to deal in the Data Files or Software

without restriction, including without limitation the rights to use,

copy, modify, merge, publish, distribute, and/or sell copies of

the Data Files or Software, and to permit persons to whom the Data Files
or Software are furnished to do so, provided that

(a) this copyright and permission notice appear with all copies

of the Data Files or Software,

(b) this copyright and permission notice appear in associated
documentation, and

(c) there is clear notice in each modified Data File or in the Software

as well as in the documentation associated with the Data File(s) or
Software that the data or software has been modified.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS.

IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,

DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder
shall not be used in advertising or otherwise to promote the sale,
use or other dealings in these Data Files or Software without prior
written authorization of the copyright holder.

2. Chinese/Japanese Word Break Dictionary Data (cjdict.txt)

#  The Google Chrome software developed by Google is licensed under
# the BSD license. Other software included in this distribution is

# provided under other licenses, as set forth below.

#H

# The BSD License
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# http://opensource.org/licenses/bsd-license.php

# Copyright (C) 2006-2008, Google Inc.

#

# All rights reserved.

#

# Redistribution and use in source and binary forms, with or without

# modification, are permitted provided that the following conditions are met:
#

# Redistributions of source code must retain the above copyright notice,

# this list of conditions and the following disclaimer.

# Redistributions in binary form must reproduce the above

# copyright notice, this list of conditions and the following

# disclaimer in the documentation and/or other materials provided with

# the distribution.

# Neither the name of Google Inc. nor the names of its

# contributors may be used to endorse or promote products derived from

# this software without specific prior written permission.

#H

#

# THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND

# CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,

# INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

# MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

# DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
# LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
# CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
# SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
# BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF

# LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
# NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
# SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

#

#

# The word list in cjdict.txt are generated by combining three word lists

# listed below with further processing for compound word breaking. The

# frequency is generated with an iterative training against Google web

# corpora.

#H

# * Libtabe (Chinese)

# - https://sourceforge.net/project/?group_id=1519

# - Its license terms and conditions are shown below.

#H

# * IPADIC (Japanese)
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* #
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- http://chasen.aist-nara.ac.jp/chasen/distribution.html
- Its license terms and conditions are shown below.

J*
* Copyrighy (c) 1999 TaBE Project.

* Copyright (c) 1999 Pai-Hsiang Hsiao.

* All rights reserved.

*

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

*

* . Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* . Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the

* distribution.

* . Neither the name of the TaBE Project nor the names of its

* contributors may be used to endorse or promote products derived

* from this software without specific prior written permission.

*

* THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
* "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

* LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

* FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE

* REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

* (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
* SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.

*/
/*
* Copyright (c) 1999 Computer Systems and Communication Lab,
* Institute of Information Science, Academia
* Sinica. All rights reserved.
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* % O#

#
#
#
#
#
#
#

* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions

* are met:

*

* . Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* . Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the

* distribution.

* . Neither the name of the Computer Systems and Communication Lab
* nor the names of its contributors may be used to endorse or

* promote products derived from this software without specific

*  prior written permission.

*

* THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS

* "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

* LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

* FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE

* REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENT IAL DAMAGES

* (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
* SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.

*/

Copyright 1996 Chih-Hao Tsai @ Beckman Institute,
University of lllinois

c-tsaid@uiuc.edu http://casper.beckman.uiuc.edu/~c-tsai4

Copyright 2000, 2001, 2002, 2003 Nara Institute of Science
and Technology. All Rights Reserved.

Use, reproduction, and distribution of this software is permitted.
Any copy of this software, whether in its original form or modified,
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must include both the above copyright notice and the following

paragraphs.

Nara Institute of Science and Technology (NAIST),

the copyright holders, disclaims all warranties with regard to this
software, including all implied warranties of merchantability and
fitness, in no event shall NAIST be liable for

any special, indirect or consequential damages or any damages
whatsoever resulting from loss of use, data or profits, whether in an
action of contract, negligence or other tortuous action, arising out
of or in connection with the use or performance of this software.

A large portion of the dictionary entries
originate from ICOT Free Software. The following conditions for ICOT
Free Software applies to the current dictionary as well.

Each User may also freely distribute the Program, whether in its
original form or modified, to any third party or parties, PROVIDED

that the provisions of Section 3 ("NO WARRANTY") will ALWAYS appear
on, or be attached to, the Program, which is distributed substantially

in the same form as set out herein and that such intended

distribution, if actually made, will neither violate or otherwise
contravene any of the laws and regulations of the countries having

jurisdiction over the User or the intended distribution itself.

NO WARRANTY

The program was produced on an experimental basis in the course of the
research and development conducted during the project and is provided
to users as so produced on an experimental basis. Accordingly, the
program is provided without any warranty whatsoever, whether express,
implied, statutory or otherwise. The term "warranty" used herein
includes, but is not limited to, any warranty of the quality,

performance, merchantability and fitness for a particular purpose of

the program and the nonexistence of any infringement or violation of

any right of any third party.

Each user of the program will agree and understand, and be deemed to
have agreed and understood, that there is no warranty whatsoever for
the program and, accordingly, the entire risk arising from or

otherwise connected with the program is assumed by the user.

Therefore, neither ICOT, the copyright holder, or any other
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organization that participated in or was otherwise related to the
development of the program and their respective officials, directors,
officers and other employees shall be held liable for any and all
damages, including, without limitation, general, special, incidental

and consequential damages, arising out of or otherwise in connection
with the use or inability to use the program or any product, material
or result produced or otherwise obtained by using the program,
regardless of whether they have been advised of, or otherwise had
knowledge of, the possibility of such damages at any time during the
project or thereafter. Each user will be deemed to have agreed to the
foregoing by his or her commencement of use of the program. The term
"use" as used herein includes, but is not limited to, the use,
modification, copying and distribution of the program and the
production of secondary products from the program.

In the case where the program, whether in its original form or
modified, was distributed or delivered to or received by a user from
any person, organization or entity other than ICOT, unless it makes or
grants independently of ICOT any specific warranty to the user in
writing, such person, organization or entity, will also be exempted
from and not be held liable to the user for any such damages as noted
above as far as the program is concerned.
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3. Lao Word Break Dictionary Data (laodict.txt)

# Copyright (c) 2013 International Business Machines Corporation

# and others. All Rights Reserved.

#H

# Project: http://code.google.com/p/lao-dictionary/

# Dictionary: http://lao-dictionary.googlecode.com/git/Lao-Dictionary.txt

# License: http://lao-dictionary.googlecode.com/git/Lao-Dictionary-LICENSE.txt
# (copied below)

#

# This file is derived from the above dictionary, with slight

# modifications.

*

Copyright (C) 2013 Brian Eugene Wilson, Robert Martin Campbell.

All rights reserved.

Redistribution and use in source and binary forms, with or without

R OHE R OH#

modification,
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# are permitted provided that the following conditions are met:

#H

#

# Redistributions of source code must retain the above copyright notice, this
# list of conditions and the following disclaimer. Redistributions in

# binary form must reproduce the above copyright notice, this list of

# conditions and the following disclaimer in the documentation and/or

# other materials provided with the distribution.
#

#

# THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
# "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

# LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

# FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE

# COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,

# INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

# (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
# SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

# HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
# STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

# ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
# OF THE POSSIBILITY OF SUCH DAMAGE.

4. Burmese Word Break Dictionary Data (burmesedict.txt)

Copyright (c) 2014 International Business Machines Corporation
and others. All Rights Reserved.

This list is part of a project hosted at:
github.com/kanyawtech/myanmar-karen-word-lists

RO R O H

#*

Copyright (c) 2013, LeRoy Benjamin Sharon
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met: Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer. Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the following

R OHEOE R R HE R H

disclaimer in the documentation and/or other materials provided
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#

with the distribution.

Neither the name Myanmar Karen Word Lists, nor the names of its
contributors may be used to endorse or promote products derived

from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,

EXEMPLARY, OR CONSEQUENT IAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

5. Time Zone Database

ICU uses the public domain data and code derived from Time Zone

Database for its time zone support. The ownership of the TZ database

is explained in BCP 175: Procedure for Maintaining the Time Zone

Database section 7.

# 7. Database Ownership

R OHEOE O E R E R E R HEHE R

The TZ database itself is not an IETF Contribution or an IETF
document. Rather it is a pre-existing and regularly updated work
that is in the public domain, and is intended to remain in the

public domain. Therefore, BCPs 78 [RFC5378] and 79 [RFC3979] do
not apply to the TZ Database or contributions that individuals make
to it. Should any claims be made and substantiated against the TZ
Database, the organization that is providing the IANA

Considerations defined in this RFC, under the memorandum of
understanding with the IETF, currently ICANN, may act in accordance
with all competent court orders. No ownership claims will be made
by ICANN or the IETF Trust on the database or the code. Any person
making a contribution to the database or code waives all rights to
future claims in that contribution or in the TZ Database.
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o

- libuv, located at deps/uv, is licensed as follows:
libuv is part of the Node project: http://nodejs.org/
libuv may be distributed alone under Node's license:

Copyright Joyent, Inc. and other Node contributors. All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

This license applies to all parts of libuv that are not externally

maintained libraries.
The externally maintained libraries used by libuv are:
- tree.h (from FreeBSD), copyright Niels Provos. Two clause BSD license.
- inet_pton and inet_ntop implementations, contained in src/inet.c, are
copyright the Internet Systems Consortium, Inc., and licensed under the ISC

license.

- stdint-msvc2008.h (from msinttypes), copyright Alexander Chemeris. Three
clause BSD license.
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- pthread-fixes.h, pthread-fixes.c, copyright Google Inc. and Sony Mobile
Communications AB. Three clause BSD license.

- android-ifaddrs.h, android-ifaddrs.c, copyright Berkeley Software Design
Inc, Kenneth MacKay and Emergya (Cloud4all, FP7/2007-2013, grant agreement
n° 289016). Three clause BSD license.

o

- OpenSSL, located at deps/openssil, is licensed as follows:

i

Copyright (c) 1998-2016 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the

distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to
endorse or promote products derived from this software without
prior written permission. For written permission, please contact

openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ~~AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjih@cryptsoft.com).

o

- Punycode.js, located at lib/punycode.js, is licensed as follows:

i

Copyright Mathias Bynens <https://mathiasbynens.be/>

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND

NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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o

- V8, located at deps/v8, is licensed as follows:
This license applies to all parts of V8 that are not externally
maintained libraries. The externally maintained libraries used by V8
are:

- PCRE test suite, located in
test/mjsunit/third_party/regexp-pcre/regexp-pcre.js. This is based on the
test suite from PCRE-7.3, which is copyrighted by the University
of Cambridge and Google, Inc. The copyright notice and license

are embedded in regexp-pcre.js.

- Layout tests, located in test/mjsunit/third_party/object-keys. These are
based on layout tests from webkit.org which are copyrighted by

Apple Computer, Inc. and released under a 3-clause BSD license.

- Strongtalk assembler, the basis of the files assembler-arm-inl.h,
assembler-arm.cc, assembler-arm.h, assembler-ia32-inl.h,
assembler-ia32.cc, assembler-ia32.h, assembler-x64-inl.h,
assembler-x64.cc, assembler-x64.h, assembler-mips-inl.h,
assembler-mips.cc, assembler-mips.h, assembler.cc and assembler.h.
This code is copyrighted by Sun Microsystems Inc. and released

under a 3-clause BSD license.

- Valgrind client API header, located at third_party/valgrind/valgrind.h
This is release under the BSD license.

These libraries have their own licenses; we recommend you read them,

as their terms may differ from the terms below.

Further license information can be found in LICENSE files located in

sub-directories.

Copyright 2014, the V8 project authors. All rights reserved.
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
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copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided
with the distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENT IAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

i

- zlib, located at deps/zlib, is licensed as follows:
zlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.8, April 28th, 2013

Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software

in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.
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Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

i

- npm, located at deps/npm, is licensed as follows:

i

The npm application
Copyright (c) npm, Inc. and Contributors

Licensed on the terms of The Artistic License 2.0

Node package dependencies of the npm application
Copyright (c) their respective copyright owners

Licensed on their respective license terms

The npm public registry at https://registry.npmjs.org

and the npm website at https://www.npmjs.com

Operated by npm, Inc.

Use governed by terms published on https://www.npmjs.com

"Node.js"
Trademark Joyent, Inc., https://joyent.com

Neither npm nor npm, Inc. are affiliated with Joyent, Inc.

The Node.js application
Project of Node Foundation, https://nodejs.org

The npm Logo

Copyright (c) Mathias Pettersson and Brian Hammond
"Gubblebum Blocky" typeface

Copyright (c) Tjarda Koster, https://jelloween.deviantart.com
Used with permission

The Artistic License 2.0

Copyright (c) 2000-2006, The Perl Foundation.

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

Preamble
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This license establishes the terms under which a given free software
Package may be copied, modified, distributed, and/or redistributed.
The intent is that the Copyright Holder maintains some artistic
control over the development of that Package while still keeping the
Package available as open source and free software.

You are always permitted to make arrangements wholly outside of this
license directly with the Copyright Holder of a given Package. If the
terms of this license do not permit the full use that you propose to
make of the Package, you should contact the Copyright Holder and seek
a different licensing arrangement.

Definitions

"Copyright Holder" means the individual(s) or organization(s)

named in the copyright notice for the entire Package.

"Contributor” means any party that has contributed code or other
material to the Package, in accordance with the Copyright Holder's

procedures.

"You" and "your" means any person who would like to copy,
distribute, or modify the Package.

"Package" means the collection of files distributed by the
Copyright Holder, and derivatives of that collection and/or of
those files. A given Package may consist of either the Standard

Version, or a Modified Version.

"Distribute” means providing a copy of the Package or making it
accessible to anyone else, or in the case of a company or

organization, to others outside of your company or organization.

"Distributor Fee" means any fee that you charge for Distributing
this Package or providing support for this Package to another

party. It does not mean licensing fees.
"Standard Version" refers to the Package if it has not been
modified, or has been modified only in ways explicitly requested

by the Copyright Holder.

"Modified Version" means the Package, if it has been changed, and
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such changes were not explicitly requested by the Copyright
Holder.

"Original License" means this Artistic License as Distributed with
the Standard Version of the Package, in its current version or as
it may be modified by The Perl Foundation in the future.

"Source" form means the source code, documentation source, and

configuration files for the Package.

"Compiled" form means the compiled bytecode, object code, binary,
or any other form resulting from mechanical transformation or

translation of the Source form.

Permission for Use and Modification Without Distribution

(1) You are permitted to use the Standard Version and create and use
Modified Versions for any purpose without restriction, provided that
you do not Distribute the Modified Version.

Permissions for Redistribution of the Standard Version

(2) You may Distribute verbatim copies of the Source form of the
Standard Version of this Package in any medium without restriction,
either gratis or for a Distributor Fee, provided that you duplicate

all of the original copyright notices and associated disclaimers. At
your discretion, such verbatim copies may or may not include a

Compiled form of the Package.

(3) You may apply any bug fixes, portability changes, and other
modifications made available from the Copyright Holder. The resulting
Package will still be considered the Standard Version, and as such

will be subject to the Original License.

Distribution of Modified Versions of the Package as Source

(4) You may Distribute your Modified Version as Source (either gratis
or for a Distributor Fee, and with or without a Compiled form of the
Modified Version) provided that you clearly document how it differs
from the Standard Version, including, but not limited to, documenting
any non-standard features, executables, or modules, and provided that
you do at least ONE of the following:
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(a) make the Modified Version available to the Copyright Holder
of the Standard Version, under the Original License, so that the
Copyright Holder may include your modifications in the Standard

Version.

(b) ensure that installation of your Modified Version does not
prevent the user installing or running the Standard Version. In
addition, the Modified Version must bear a name that is different

from the name of the Standard Version.

(c) allow anyone who receives a copy of the Modified Version to
make the Source form of the Modified Version available to others

under

(i) the Original License or

(i) a license that permits the licensee to freely copy,
modify and redistribute the Modified Version using the same
licensing terms that apply to the copy that the licensee
received, and requires that the Source form of the Modified
Version, and of any works derived from it, be made freely
available in that license fees are prohibited but Distributor
Fees are allowed.

Distribution of Compiled Forms of the Standard Version
or Modified Versions without the Source

(5) You may Distribute Compiled forms of the Standard Version without
the Source, provided that you include complete instructions on how to
get the Source of the Standard Version. Such instructions must be
valid at the time of your distribution. If these instructions, at any

time while you are carrying out such distribution, become invalid, you
must provide new instructions on demand or cease further distribution.
If you provide valid instructions or cease distribution within thirty

days after you become aware that the instructions are invalid, then

you do not forfeit any of your rights under this license.
(6) You may Distribute a Modified Version in Compiled form without
the Source, provided that you comply with Section 4 with respect to

the Source of the Modified Version.

Aggregating or Linking the Package
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(7) You may aggregate the Package (either the Standard Version or
Modified Version) with other packages and Distribute the resulting
aggregation provided that you do not charge a licensing fee for the
Package. Distributor Fees are permitted, and licensing fees for other
components in the aggregation are permitted. The terms of this license
apply to the use and Distribution of the Standard or Modified Versions
as included in the aggregation.

(8) You are permitted to link Modified and Standard Versions with
other works, to embed the Package in a larger work of your own, or to
build stand-alone binary or bytecode versions of applications that
include the Package, and Distribute the result without restriction,

provided the result does not expose a direct interface to the Package.

Items That are Not Considered Part of a Modified Version

(9) Works (including, but not limited to, modules and scripts) that
merely extend or make use of the Package, do not, by themselves, cause
the Package to be a Modified Version. In addition, such works are not
considered parts of the Package itself, and are not subject to the

terms of this license.

General Provisions

(10) Any use, modification, and distribution of the Standard or
Modified Versions is governed by this Artistic License. By using,
modifying or distributing the Package, you accept this license. Do not
use, modify, or distribute the Package, if you do not accept this

license.

(11) If your Modified Version has been derived from a Modified
Version made by someone other than you, you are nevertheless required
to ensure that your Modified Version complies with the requirements of

this license.

(12) This license does not grant you the right to use any trademark,

service mark, tradename, or logo of the Copyright Holder.

(13) This license includes the non-exclusive, worldwide,
free-of-charge patent license to make, have made, use, offer to sell,
sell, import and otherwise transfer the Package with respect to any
patent claims licensable by the Copyright Holder that are necessarily
infringed by the Package. If you institute patent litigation
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(including a cross-claim or counterclaim) against any party alleging
that the Package constitutes direct or contributory patent
infringement, then this Artistic License to you shall terminate on the
date that such litigation is filed.

(14) Disclaimer of Warranty:

THE PACKAGE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS
IS' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES. THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR
NON-INFRINGEMENT ARE DISCLAIMED TO THE EXTENT PERMITTED BY YOUR LOCAL
LAW. UNLESS REQUIRED BY LAW, NO COPYRIGHT HOLDER OR CONTRIBUTOR WILL
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENT IAL
DAMAGES ARISING IN ANY WAY OUT OF THE USE OF THE PACKAGE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

o

- GYP, located at tools/gyp, is licensed as follows:

o

Copyright (c) 2009 Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are

met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
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DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

o

- marked, located at tools/doc/node_modules/marked, is licensed as follows:

o

Copyright (c) 2011-2014, Christopher Jeffrey (https://github.com/chjj/)

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

o

- cpplint.py, located at tools/cpplint.py, is licensed as follows:

i

Copyright (c) 2009 Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are

met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.
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* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from

this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

o

- ESLint, located at tools/eslint, is licensed as follows:
ESLint
Copyright jQuery Foundation and other contributors, https://jquery.org/

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

o

- gtest, located at deps/gtest, is licensed as follows:

i
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Copyright 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are

met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS 1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

o

- node-weak, located at test/gc/node_modules/weak, is licensed as follows:

o

Copyright (c) 2011, Ben Noordhuis <info@bnoordhuis.nl>

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above

copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS 1S" AND THE AUTHOR DISCLAIMS ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR
ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN
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ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

i

Boost

https://www.boost.org/

Copyright Joe Coder 2004 - 2006.

Distributed under the Boost Software License, Version 1.0.
Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization
obtaining a copy of the software and accompanying documentation covered by
this license (the "Software™) to use, reproduce, display, distribute,

execute, and transmit the Software, and to prepare derivative works of the
Software, and to permit third-parties to whom the Software is furnished to

do so, all subject to the following:

The copyright notices in the Software and this entire statement, including

the above license grant, this restriction and the following disclaimer,

must be included in all copies of the Software, in whole or in part, and

all derivative works of the Software, unless such copies or derivative

works are solely in the form of machine-executable object code generated by

a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

glog

https://github.com/google/glog

Copyright (c) 2008, Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the

following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

gtest

https://github.com/google/googletest

Copyright 2008, Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS 1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
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OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Ilconv

http://www.gnu.org/licenses/Igpl.html

Copyright © 2007 Free Software Foundation, Inc. https://fsf.org/

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is

not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3
of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public License, and the “GNU
GPL” refers to version 3 of the GNU General Public License.

“The Library” refers to a covered work governed by this License, other than an Application or a
Combined Work as defined below.

An “Application” is any work that makes use of an interface provided by the Library, but which is not
otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode
of using an interface provided by the Library.

A “Combined Work” is a work produced by combining or linking an Application with the Library. The
particular version of the Library with which the Combined Work was made is also called the “Linked
Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding Source for the
Combined Work, excluding any source code for portions of the Combined Work that, considered in
isolation, are based on the Application, and not on the Linked Version.

The “Corresponding Application Code” for a Combined Work means the object code and/or source code
for the Application, including any data and utility programs needed for reproducing the Combined Work
from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3
of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be
supplied by an Application that uses the facility (other than as an argument passed when the facility is
invoked), then you may convey a copy of the modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the event an
Application does not supply the function or data, the facility still operates, and performs whatever part of
its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the
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Library. You may convey such object code under terms of your choice, provided that, if the incorporated
material is not limited to numerical parameters, data structure layouts and accessors, or small macros,
inline functions and templates (ten or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and that the
Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not
restrict modification of the portions of the Library contained in the Combined Work and reverse
engineering for debugging such modifications, if you also do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used in it and that the
Library and its use are covered by this License.

b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

¢) For a Combined Work that displays copyright notices during execution, include the copyright notice for
the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL
and this license document.

d) Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding
Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the
Application with a modified version of the Linked Version to produce a modified Combined Work, in the
manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that
(a) uses at run time a copy of the Library already present on the user's computer system, and (b) will
operate properly with a modified version of the Library that is interface-compatible with the Linked
Version.

e) Provide Installation Information, but only if you would otherwise be required to provide such
information under section 6 of the GNU GPL, and only to the extent that such information is necessary to
install and execute a modified version of the Combined Work produced by recombining or relinking the
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation
Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If
you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of
the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library
together with other library facilities that are not Applications and are not covered by this License, and
convey such a combined library under terms of your choice, if you do both of the following:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined
with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General

Public License from time to time. Such new versions will be similar in spirit to the present version, but
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may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a
certain numbered version of the GNU Lesser General Public License “or any later version” applies to it,
you have the option of following the terms and conditions either of that published version or of any later
version published by the Free Software Foundation. If the Library as you received it does not specify a
version number of the GNU Lesser General Public License, you may choose any version of the GNU
Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU
Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is
permanent authorization for you to choose that version for the Library.

libfcgi

https://directory.fsf.org/wiki/Libfcgi
Copyright © 1996 Open Market, Inc.
This FastCGlI application library source and object code (the

"Software™) and its documentation (the "Documentation™) are

copyrighted by Open Market, Inc ("Open Market™). The following terms

apply to all files associated with the Software and Documentation

unless explicitly disclaimed in individual files.

Open Market permits you to use, copy, modify, distribute, and license

this Software and the Documentation for any purpose, provided that

existing copyright notices are retained in all copies and that this

notice is included verbatim in any distributions. No written

agreement, license, or royalty fee is required for any of the

authorized uses. Modifications to this Software and Documentation may

be copyrighted by their authors and need not follow the licensing

terms described here. If modifications to this Software and

Documentation have new licensing terms, the new terms must be clearly

indicated on the first page of each file where they apply.

OPEN MARKET MAKES NO EXPRESS OR IMPLIED WARRANTY WITH RESPECT TO THE
SOFTWARE OR THE DOCUMENTATION, INCLUDING WITHOUT LIMITATION ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN
NO EVENT SHALL OPEN MARKET BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY
DAMAGES ARISING FROM OR RELATING TO THIS SOFTWARE OR THE
DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, ANY INDIRECT, SPECIAL OR
CONSEQUENTIAL DAMAGES OR SIMILAR DAMAGES, INCLUDING LOST PROFITS OR
LOST DATA, EVEN IF OPEN MARKET HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS".
OPEN MARKET HAS NO LIABILITY IN CONTRACT, TORT, NEGLIGENCE OR
OTHERWISE ARISING OUT OF THIS SOFTWARE OR THE DOCUMENTATION.
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libjpeg

http://libjpeg.sourceforge.net/

This package contains C software to implement JPEG image encoding, decoding,and transcoding. JPEG
is a standardized compression method for full-color and gray-scale images.

The distributed programs provide conversion between JPEG "JFIF" format and image files in PBMPLUS
PPM/PGM, GIF, BMP, and Targa file formats.

The core compression and decompression library can easily be reused in other programs, such as
image viewers. The package is highly portable C code;

we have tested it on many machines ranging from PCs to Crays.

We are releasing this software for both noncommercial and commercial use.

Companies are welcome to use it as the basis for JPEG-related products.

We do not ask a royalty, although we do ask for an acknowledgement in product literature (see the
README file in the distribution for details).

We hope to make this software industrial-quality --- although, as with anything that's free, we offer no

warranty and accept no liability.

For more information, contact jpeg-info@jpegclub.org.

microzip

http://www.gnu.org/licenses/Igpl-3.0.html

Copyright © 2007 Free Software Foundation, Inc. <https://fsf.org/>

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is
not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3
of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public License, and the “GNU
GPL” refers to version 3 of the GNU General Public License.

“The Library” refers to a covered work governed by this License, other than an Application or a
Combined Work as defined below.

An “Application” is any work that makes use of an interface provided by the Library, but which is not
otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode
of using an interface provided by the Library.

A “Combined Work™ is a work produced by combining or linking an Application with the Library. The
particular version of the Library with which the Combined Work was made is also called the “Linked
Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding Source for the
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Combined Work, excluding any source code for portions of the Combined Work that, considered in
isolation, are based on the Application, and not on the Linked Version.

The *“Corresponding Application Code” for a Combined Work means the object code and/or source code
for the Application, including any data and utility programs needed for reproducing the Combined Work
from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3
of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be
supplied by an Application that uses the facility (other than as an argument passed when the facility is
invoked), then you may convey a copy of the modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the event an
Application does not supply the function or data, the facility still operates, and performs whatever part of
its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the
Library. You may convey such object code under terms of your choice, provided that, if the incorporated
material is not limited to numerical parameters, data structure layouts and accessors, or small macros,
inline functions and templates (ten or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and that the
Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not
restrict modification of the portions of the Library contained in the Combined Work and reverse
engineering for debugging such modifications, if you also do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used in it and that the
Library and its use are covered by this License.

b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

c¢) For a Combined Work that displays copyright notices during execution, include the copyright notice for
the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL
and this license document.

d) Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding
Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the
Application with a modified version of the Linked Version to produce a modified Combined Work, in the
manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that
(a) uses at run time a copy of the Library already present on the user's computer system, and (b) will
operate properly with a modified version of the Library that is interface-compatible with the Linked

Version.
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e) Provide Installation Information, but only if you would otherwise be required to provide such
information under section 6 of the GNU GPL, and only to the extent that such information is necessary to
install and execute a modified version of the Combined Work produced by recombining or relinking the
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation
Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If
you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of
the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library
together with other library facilities that are not Applications and are not covered by this License, and
convey such a combined library under terms of your choice, if you do both of the following:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined
with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General
Public License from time to time. Such new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a
certain numbered version of the GNU Lesser General Public License “or any later version” applies to it,
you have the option of following the terms and conditions either of that published version or of any later
version published by the Free Software Foundation. If the Library as you received it does not specify a
version number of the GNU Lesser General Public License, you may choose any version of the GNU
Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU
Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is

permanent authorization for you to choose that version for the Library.

minizip
https://github.com/danieleggert/minizip
MiniZip - Copyright (c) 1998-2010 - by Gilles Vollant - version 1.1 64 bits from Mathias Svensson

Credits
Gilles Vollant - Original MiniZip author

Even Rouault - ZIP64 unzip Support

Daniel Borca - BZip Compression method support in unzip
Mathias Svensson - ZIP64 zip support

Mathias Svensson - BZip Compression method support in zip
License

Condition of use and distribution are the same than zlib :
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This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,

including commercial applications, and to alter it and redistribute it

freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

nginx

https://www.nginx.com/

Copyright (C) 2002-2014 Igor Sysoev
Copyright (C) 2011-2014 Nginx, Inc.
All rights reserved.

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

*  notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

*  notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

*

* THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS ~"AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*/
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OpenSSL

https://www.openssl.org/
Copyright (c) 1998-2011 The OpenSSL Project
Copyright (c) 1995-1998 Eric Young

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of

the OpenSSL License and the original SSLeay license apply to the toolkit.
See below for the actual license texts. Actually both licenses are BSD-style
Open Source licenses. In case of any license issues related to OpenSSL
please contact openssl-core@openssl.org.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

OpenSSL License

* Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

*  notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

*  notice, this list of conditions and the following disclaimer in

*  the documentation and/or other materials provided with the

*  distribution.

* 3. All advertising materials mentioning features or use of this

*  software must display the following acknowledgment:

*  "This product includes software developed by the OpenSSL Project

*  for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

* 4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to
* endorse or promote products derived from this software without

*  prior written permission. For written permission, please contact

*  openssl-core@openssl.org.

* 5. Products derived from this software may not be called "OpenSSL"

*  nor may "OpenSSL" appear in their names without prior written

*  permission of the OpenSSL Project.

* 6. Redistributions of any form whatsoever must retain the following

* acknowledgment:

*  "This product includes software developed by the OpenSSL Project

*  for use in the OpenSSL Toolkit (http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ~~AS IS AND ANY
* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
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* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

* ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim

* Hudson (tjh@cryptsoft.com).

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

* All rights reserved.

* This package is an SSL implementation written

* by Eric Young (eay@cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
*

* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* |hash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).

* Copyright remains Eric Young's, and as such any Copyright notices in

* the code are not to be removed.

* |If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or

* in documentation (online or textual) provided with the package.

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

*  notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright
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*  notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. All advertising materials mentioning features or use of this software

*  must display the following acknowledgement:

*  "This product includes cryptographic software written by

*  Eric Young (eay@cryptsoft.com)"

*  The word ‘cryptographic’ can be left out if the rouines from the library

*  being used are not cryptographic related :-).

* 4. If you include any Windows specific code (or a derivative thereof) from

*  the apps directory (application code) you must include an acknowledgement:

*  "This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

*

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ~"AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* [including the GNU Public Licence.]

*/

PCRE

https://www.pcre.org/
PCRE LICENSE
PCRE is a library of functions to support regular expressions whose syntax

and semantics are as close as possible to those of the Perl 5 language.
Release 8 of PCRE is distributed under the terms of the "BSD" licence, as
specified below. The documentation for PCRE, supplied in the "doc"

directory, is distributed under the same terms as the software itself.

The basic library functions are written in C and are freestanding. Also
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included in the distribution is a set of C++ wrapper functions, and a
just-in-time compiler that can be used to optimize pattern matching. These
are both optional features that can be omitted when the library is built.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel
Email local part: ph10

Email domain:  cam.ac.uk

University of Cambridge Computing Service,
Cambridge, England.

Copyright (c) 1997-2014 University of Cambridge
All rights reserved.

PCRE JUST-IN-TIME COMPILATION SUPPORT

Written by: Zoltan Herczeg
Email local part: hzmester

Emain domain:  freemail.hu

Copyright(c) 2010-2014 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

Written by: Zoltan Herczeg
Email local part: hzmester
Emain domain:  freemail.hu

Copyright(c) 2009-2014 Zoltan Herczeg

All rights reserved.
THE C++ WRAPPER FUNCTIONS

Contributed by: Google Inc.

Copyright (c) 2007-2012, Google Inc.
All rights reserved.

THE "BSD" LICENCE
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Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS*"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

End

Sqlcipher

https://www.zetetic.net/sqlcipher/
Copyright (c) 2008, ZETETIC LLC All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the ZETETIC LLC nor the
names of its contributors may be used to endorse or promote products

derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY ZETETIC LLC "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL ZETETIC LLC BE LIABLE FOR ANY

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

sglite

https://www.sqlite.org/index.html

Anyone is free to copy, modify, publish, use, compile, sell, or distribute the original SQLite code, either
in source code form or as a compiled binary, for any purpose, commercial or non-commercial, and by

any means.

TiddlyWiki

https://tiddlywiki.com/

Copyright (c) UnaMesa Association 2004-2007

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILIT

Websocketpp

https://www.zaphoyd.com/projects/websocketpp/

WebSocket++ is an open source (BSD license)
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided

that the following conditions are met:
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1. Redistributions of source code must retain the above copyright notice, this list of conditions and the

following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and

the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED.

IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

zlib
https://zlib.net/zlib_license.html

(C) 1995-2013 Jean-loup Gailly and Mark Adler
This software is provided 'as-is', without any express or implied

warranty. In no event will the authors be held liable for any damages

arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler

jloup@gzip.org madler@alumni.caltech.edu
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SIL

http://www.sil.org
Copyright (c) 1994-2008, SIL International (http://www.sil.org/).

This Font Software is licensed under the SIL Open Font License, Version 1.1,

with Reserved Font Names "Lateef" and "SIL".
This license is copied below, and is also available with an FAQ at:
http://scripts.sil.org/OFL

PREAMBLE

The goals of the Open Font License (OFL) are to stimulate worldwide
development of collaborative font projects, to support the font creation
efforts of academic and linguistic communities, and to provide a free and
open framework in which fonts may be shared and improved in partnership
with others.

The OFL allows the licensed fonts to be used, studied, modified and
redistributed freely as long as they are not sold by themselves. The
fonts, including any derivative works, can be bundled, embedded,
redistributed and/or sold with any software provided that any reserved
names are not used by derivative works. The fonts and derivatives,
however, cannot be released under any other type of license. The
requirement for fonts to remain under this license does not apply

to any document created using the fonts or their derivatives.

DEFINITIONS

"Font Software" refers to the set of files released by the Copyright
Holder(s) under this license and clearly marked as such. This may

include source files, build scripts and documentation.

"Reserved Font Name" refers to any names specified as such after the
copyright statement(s).

"Original Version" refers to the collection of Font Software components as
distributed by the Copyright Holder(s).

"Modified Version" refers to any derivative made by adding to, deleting,
or substituting -- in part or in whole -- any of the components of the
Original Version, by changing formats or by porting the Font Software to a
new environment.

"Author" refers to any designer, engineer, programmer, technical

writer or other person who contributed to the Font Software.
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PERMISSION & CONDITIONS

Permission is hereby granted, free of charge, to any person obtaining

a copy of the Font Software, to use, study, copy, merge, embed, modify,
redistribute, and sell modified and unmodified copies of the Font

Software, subject to the following conditions:

1) Neither the Font Software nor any of its individual components,

in Original or Modified Versions, may be sold by itself.

2) Original or Modified Versions of the Font Software may be bundled,
redistributed and/or sold with any software, provided that each copy

contains the above copyright notice and this license. These can be

included either as stand-alone text files, human-readable headers or

in the appropriate machine-readable metadata fields within text or

binary files as long as those fields can be easily viewed by the user.

3) No Modified Version of the Font Software may use the Reserved Font

Name(s) unless explicit written permission is granted by the corresponding
Copyright Holder. This restriction only applies to the primary font name as
presented to the users.

4) The name(s) of the Copyright Holder(s) or the Author(s) of the Font

Software shall not be used to promote, endorse or advertise any

Modified Version, except to acknowledge the contribution(s) of the

Copyright Holder(s) and the Author(s) or with their explicit written

permission.

5) The Font Software, modified or unmodified, in part or in whole,

must be distributed entirely under this license, and must not be

distributed under any other license. The requirement for fonts to

remain under this license does not apply to any document created

using the Font Software.

TERMINATION

This license becomes null and void if any of the above conditions are

not met.

DISCLAIMER

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT
OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL THE
COPYRIGHT HOLDER BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM
OTHER DEALINGS IN THE FONT SOFTWARE.
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Font Awesome Free License

https://fontawesome.com/

Font Awesome Free is free, open source, and GPL friendly. You can use it for
commercial projects, open source projects, or really almost whatever you want.
Full Font Awesome Free license: https://fontawesome.com/license/free.

# Icons: CC BY 4.0 License (https://creativecommons.org/licenses/by/4.0/)
In the Font Awesome Free download, the CC BY 4.0 license applies to all icons
packaged as SVG and JS file types.

# Fonts: SIL OFL 1.1 License (https://scripts.sil.org/OFL)
In the Font Awesome Free download, the SIL OFL license applies to all icons

packaged as web and desktop font files.

# Code: MIT License (https://opensource.org/licenses/MIT)
In the Font Awesome Free download, the MIT license applies to all non-font and

non-icon files.

# Attribution

Attribution is required by MIT, SIL OFL, and CC BY licenses. Downloaded Font
Awesome Free files already contain embedded comments with sufficient
attribution, so you shouldn't need to do anything additional when using these

files normally.

We've kept attribution comments terse, so we ask that you do not actively work
to remove them from files, especially code. They're a great way for folks to
learn about Font Awesome.

# Brand Icons

All brand icons are trademarks of their respective owners. The use of these
trademarks does not indicate endorsement of the trademark holder by Font
Awesome, nor vice versa. **Please do not use brand logos for any purpose except
to represent the company, product, or service to which they refer.**

material-ui

https://material-ui.com/
The MIT License (MIT)
Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
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to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Redux Toolkit

https://redux-toolkit.js.org/
Copyright (c) 2018 Mark Erikson
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software™), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Autoprefixer

https://github.com/postcss/autoprefixer

Copyright 2013 Andrey Sitnik andrey@sitnik.ru

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy of

this software and associated documentation files (the "Software™), to deal in
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the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so,

subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

AXIOS

https://xn--xylbk56a.run/axios/guide/api.html
Copyright (c) 2014-present Matt Zabriskie

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in

all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Classnames

https://www.npmjs.com/package/classnames

Copyright (c) 2017 Jed Watson

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy
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of this software and associated documentation files (the "Software™), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Day.js

https://day.js.org/

Copyright (c) 2018-present, iamkun

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

118next

https://www.i18next.com/
Copyright (c) 2017 i18next
The MIT License (MIT)
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Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

118next-http-backend

https://www.npmjs.com/package/i18next-http-backend
Copyright (c) 2020 i18next
Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in

all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Immer

https://immerjs.github.io/immer/
Copyright (c) 2017 Michel Weststrate
MIT License
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Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

prop-types

https://www.npmjs.com/package/prop-types

Copyright (c) 2013-present, Facebook, Inc.

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

React Hook Form

https://react-hook-form.com/
Copyright (c) 2019-present Beier(Bill) Luo
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MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

React

https://ko.reactjs.org/

Copyright (c) Facebook, Inc. and its affiliates.

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software™), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

React-dom

https://ko.reactjs.org/
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Copyright (c) Facebook, Inc. and its affiliates.

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

REACT ROUTER

https://reactrouter.com/
Copyright (c) React Training 2016-2018
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software™), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

REACT ROUTER-dom
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https://reactrouter.com/
Copyright (c) React Training 2016-2018
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software™), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

react-il8next

https://react.il8next.com/

Copyright (c) 2015 i18next

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
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react-number-format

https://www.npmjs.com/package/react-number-format
Copyright (c) 2020 Sudhanshu Yadav
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

React Redux

https://react-redux.js.org/

Copyright (c) 2015-present Dan Abramov

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software™), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
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redux-persist

https://github.com/rt2zz/redux-persist
Copyright (c) 2017 Zack Story
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"), to deal

in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Opencv

https://opencv.org/

Copyright (C) 2000-2020, Intel Corporation, all rights reserved.

Copyright (C) 2009-2011, Willow Garage Inc., all rights reserved.
Copyright (C) 2009-2016, NVIDIA Corporation, all rights reserved.
Copyright (C) 2010-2013, Advanced Micro Devices, Inc., all rights reserved.
Copyright (C) 2015-2016, OpenCV Foundation, all rights reserved.
Copyright (C) 2015-2016, Itseez Inc., all rights reserved.

Copyright (C) 2019-2020, Xperience Al, all rights reserved.

Third party copyrights are property of their respective owners.

License Agreement

For Open Source Computer Vision Library

(3-clause BSD License)

By downloading, copying, installing or using the software you agree to this license.
If you do not agree to this license, do not download, install,

copy or use the software.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:
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* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither the names of the copyright holders nor the names of the contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

This software is provided by the copyright holders and contributors "as is" and
any express or implied warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose are disclaimed.
In no event shall copyright holders or contributors be liable for any direct,
indirect, incidental, special, exemplary, or consequential damages

(including, but not limited to, procurement of substitute goods or services;

loss of use, data, or profits; or business interruption) however caused

and on any theory of liability, whether in contract, strict liability,

or tort (including negligence or otherwise) arising in any way out of

the use of this software, even if advised of the possibility of such damage.

jquery

https://jquery.org

Copyright OpenJS Foundation and other contributors, https://openjsf.org/

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS 1IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND

NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
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LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

angular.js

https://angularjs.org

Copyright (c) 2020 Google LLC. https://angularjs.org
The MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software™), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in

all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

ngStorage

https://github.com/gsklee/ngStorage
Copyright (c) 2015 Gias Kay Lee
The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software™), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
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all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

moment.js

https://github.com/moment/moment

Copyright (c) JS Foundation and other contributors

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use,

copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following

conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS 1IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

async.min.js

https://github.com/caolan/async

Copyright © 2010 Elijah Grey, who also goes by Eli Grey.
This software is licensed under the MIT license.
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MIT license

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software™), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

ngDraggable.js
https://github.com/fatlinesofcode/ngDraggable
Copyright (c) 2014 philippd

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
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konva.js

https://konvajs.org
Original work Copyright (C) 2011 - 2013 by Eric Rowell (KineticJS)
Modified work Copyright (C) 2014 - present by Anton Lavrenov (Konva)

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

springBoot

https://spring.io/projects/spring-boot

Apache License

Version 2.0, January 2004

https://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction,

and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by

409


https://konvajs.org
https://spring.io/projects/spring-boot

19 Appendix

the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all
other entities that control, are controlled by, or are under common
control with that entity. For the purposes of this definition,
"control" means (i) the power, direct or indirect, to cause the
direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the

outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your™) shall mean an individual or Legal Entity

exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation

source, and configuration files.

"Object" form shall mean any form resulting from mechanical
transformation or translation of a Source form, including but
not limited to compiled object code, generated documentation,

and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by a
copyright notice that is included in or attached to the work

(an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object
form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes
of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including

the original version of the Work and any modifications or additions

to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner
or by an individual or Legal Entity authorized to submit on behalf of
the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent

to the Licensor or its representatives, including but not limited to
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communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the
Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise

designated in writing by the copyright owner as "Not a Contribution."

"Contributor” shall mean Licensor and any individual or Legal Entity
on behalf of whom a Contribution has been received by Licensor and

subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of,

publicly display, publicly perform, sublicense, and distribute the

Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
(except as stated in this section) patent license to make, have made,
use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You
institute patent litigation against any entity (including a
cross-claim or counterclaim in a lawsuit) alleging that the Work
or a Contribution incorporated within the Work constitutes direct
or contributory patent infringement, then any patent licenses
granted to You under this License for that Work shall terminate

as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the
Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You

meet the following conditions:

(a) You must give any other recipients of the Work or

Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices

stating that You changed the files; and
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(c) You must retain, in the Source form of any Derivative Works
that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work,

excluding those notices that do not pertain to any part of

the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its
distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained
within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one

of the following places: within a NOTICE text file distributed

as part of the Derivative Works; within the Source form or
documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents
of the NOTICE file are for informational purposes only and

do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside

or as an addendum to the NOTICE text from the Work, provided
that such additional attribution notices cannot be construed

as modifying the License.

You may add Your own copyright statement to Your modifications and
may provide additional or different license terms and conditions

for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use,
reproduction, and distribution of the Work otherwise complies with
the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise,
any Contribution intentionally submitted for inclusion in the Work

by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions.
Notwithstanding the above, nothing herein shall supersede or modify
the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade
names, trademarks, service marks, or product names of the Licensor,
except as required for reasonable and customary use in describing the

origin of the Work and reproducing the content of the NOTICE file.
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7. Disclaimer of Warranty. Unless required by applicable law or

agreed to in writing, Licensor provides the Work (and each

Contributor provides its Contributions) on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied, including, without limitation, any warranties or conditions

of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any

risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory,
whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly
negligent acts) or agreed to in writing, shall any Contributor be
liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a
result of this License or out of the use or inability to use the
Work (including but not limited to damages for loss of goodwiill,
work stoppage, computer failure or malfunction, or any and all
other commercial damages or losses), even if such Contributor
has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing
the Work or Derivative Works thereof, You may choose to offer,
and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this
License. However, in accepting such obligations, You may act only
on Your own behalf and on Your sole responsibility, not on behalf
of any other Contributor, and only if You agree to indemnify,
defend, and hold each Contributor harmless for any liability
incurred by, or claims asserted against, such Contributor by reason

of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following
boilerplate notice, with the fields enclosed by brackets "{}"
replaced with your own identifying information. (Don't include
the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a
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file or class name and description of purpose be included on the
same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright {yyyy} {name of copyright owner}

Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License.

You may obtain a copy of the License at
https://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software

distributed under the License is distributed on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and

limitations under the License.

log4j

https://logging.apache.org/log4j

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction,

and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by

the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all
other entities that control, are controlled by, or are under common
control with that entity. For the purposes of this definition,
"control" means (i) the power, direct or indirect, to cause the
direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the
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outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your™) shall mean an individual or Legal Entity

exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation

source, and configuration files.

"Object" form shall mean any form resulting from mechanical
transformation or translation of a Source form, including but
not limited to compiled object code, generated documentation,

and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by a
copyright notice that is included in or attached to the work

(an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object
form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes
of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including

the original version of the Work and any modifications or additions

to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner
or by an individual or Legal Entity authorized to submit on behalf of
the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent
to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the
Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise

designated in writing by the copyright owner as "Not a Contribution."

"Contributor"” shall mean Licensor and any individual or Legal Entity
on behalf of whom a Contribution has been received by Licensor and
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subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of,

publicly display, publicly perform, sublicense, and distribute the
Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
(except as stated in this section) patent license to make, have made,
use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You
institute patent litigation against any entity (including a
cross-claim or counterclaim in a lawsuit) alleging that the Work
or a Contribution incorporated within the Work constitutes direct
or contributory patent infringement, then any patent licenses
granted to You under this License for that Work shall terminate

as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the
Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You

meet the following conditions:

(a) You must give any other recipients of the Work or

Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices
stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works
that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work,

excluding those notices that do not pertain to any part of

the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its
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distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained
within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one

of the following places: within a NOTICE text file distributed

as part of the Derivative Works; within the Source form or
documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents
of the NOTICE file are for informational purposes only and

do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside

or as an addendum to the NOTICE text from the Work, provided
that such additional attribution notices cannot be construed

as modifying the License.

You may add Your own copyright statement to Your modifications and
may provide additional or different license terms and conditions

for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use,
reproduction, and distribution of the Work otherwise complies with
the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise,
any Contribution intentionally submitted for inclusion in the Work

by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions.
Notwithstanding the above, nothing herein shall supersede or modify
the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade
names, trademarks, service marks, or product names of the Licensor,
except as required for reasonable and customary use in describing the

origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or

agreed to in writing, Licensor provides the Work (and each

Contributor provides its Contributions) on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied, including, without limitation, any warranties or conditions

of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the
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appropriateness of using or redistributing the Work and assume any

risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory,
whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly
negligent acts) or agreed to in writing, shall any Contributor be
liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a
result of this License or out of the use or inability to use the
Work (including but not limited to damages for loss of goodwiill,
work stoppage, computer failure or malfunction, or any and all
other commercial damages or losses), even if such Contributor
has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing
the Work or Derivative Works thereof, You may choose to offer,
and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this
License. However, in accepting such obligations, You may act only
on Your own behalf and on Your sole responsibility, not on behalf
of any other Contributor, and only if You agree to indemnify,
defend, and hold each Contributor harmless for any liability
incurred by, or claims asserted against, such Contributor by reason

of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following
boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include
the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a
file or class name and description of purpose be included on the
same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright 1999-2005 The Apache Software Foundation

Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License.
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You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software

distributed under the License is distributed on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and

limitations under the License.

mssqlidbc

https://github.com/microsoft/mssgl-jdbc

Copyright(c) 2020 Microsoft Corporation

All rights reserved.

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files(the "Software"),

to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense,

and / or sell copies of the Software, and to permit persons to whom the Software is furnished to do so,

subject to the following conditions :

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED *AS IS*, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER

LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS

IN THE SOFTWARE.

hibernate

https://hibernate.org
LGPL 2.1
Most Hibernate projects are released under LGPL v2.1.
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The maintainers of Hibernate have consistently understood the LGPL to simply allow Hibernate to be
used by both open source and proprietary code without any impact on the licensing or distribution of
such independent code. This interpretation applies regardless of whether a binary that includes
Hibernate code is designed to run on the JVM or is a native image generated through use of tools and

frameworks like GraalVM and Quarkus.

More detailed explanation

The original version of the LGPL was written in 1991 with embedded C programming in mind, before
Java existed. This has sometimes led to questions about how to interpret LGPL in a Java context. The “L”
in LGPL originally stood for “library”; LGPL was designed to enable libraries to be used by proprietary
applications in situations that might be impermissible under the ordinary GPL. For this reason, the LGPL
is classified as a “weak copyleft” license, in contrast to the GPL which is considered a “strong copyleft”.
The “L” in LGPL was later reinterpreted to mean “lesser”, to communicate the fact that it has more
limited scope than the GPL and is not meant exclusively for libraries.

By the 2000s, the LGPL had become one of the most widely used and best known open source licenses.
At this time, some Java developers naturally began to adopt the LGPL for their projects as a more
permissive and flexible alternative to the GPL. For projects like Hibernate, the LGPL had a simple

interpretation in the Java setting, which can be summarized as follows:

LGPL requirements are triggered only if there is distribution; internal use is not restricted.

Distributors of binaries built from LGPL-licensed source code must comply with the LGPL by providing
source code corresponding only to the LGPL-covered parts of the binary.

There is no requirement to publish independent code that, for example, merely imports LGPL-covered
packages or classes. Such independent code can be under different licensing terms, including
proprietary licensing terms or other open source licenses.

Modifications of LGPL-licensed source code, if distributed, must be licensed under the LGPL.

This has been the consistent interpretation of the LGPL by the maintainers of Hibernate ever since the

project adopted LGPL.

Use in GraalVM native images

Recently there has been interest in native compilation for Java using tools like GraalVM, such as
commonly used in frameworks like Quarkus. The view of the Hibernate maintainers is that native
compilation is a technical detail that does not fundamentally change how LGPL works for Java code. In a
native image that includes LGPL-licensed code from Hibernate, the Hibernate code remains under the
terms of the LGPL, but the other code in the generated binary is not affected by the licensing of the
Hibernate code.

ASL 2.0
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Some Hibernate projects are released under ASL 2.0.

This is mostly due to our work with the Java Community Process: implementing a reference
implementation in practice requires such a liberal license (or a fully proprietary one strangely enough).

lombok

https://projectlombok.org
Copyright (C) 2009-2021 The Project Lombok Authors.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software™), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Licenses for included components:

org.ow2.asm:asm

org.ow2.asm:asm-analysis

0rg.ow2.asm:asm-commons

org.ow2.asm:asm-tree

org.ow2.asm:asm-util

ASM: a very small and fast Java bytecode manipulation framework
Copyright (c) 2000-2011 INRIA, France Telecom

All rights reserved.

Redistribution and use in source and binary forms, with or without
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modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holders nor the names of its
contributors may be used to endorse or promote products derived from

this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS*"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF

THE POSSIBILITY OF SUCH DAMAGE.

rzwitserloot/com.zwitserloot.cmdreader

Copyright © 2010 Reinier Zwitserloot.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in

all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
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OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

projectlombok/lombok.patcher
Copyright (C) 2009-2021 The Project Lombok Authors.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS 1IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

annotationApi

https://github.com/javaee/javax.annotation
COMMON DEVELOPMENT AND DISTRIBUTION LICENSE (CDDL) Version 1.1

1. Definitions.

1.1. "Contributor" means each individual or entity that creates or
contributes to the creation of Modifications.

1.2. "Contributor Version" means the combination of the Original

Software, prior Modifications used by a Contributor (if any), and
the Modifications made by that particular Contributor.
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1.3. "Covered Software" means (a) the Original Software, or (b)
Modifications, or (c) the combination of files containing Original
Software with files containing Modifications, in each case including

portions thereof.

1.4. "Executable” means the Covered Software in any form other than
Source Code.

1.5. "Initial Developer" means the individual or entity that first
makes Original Software available under this License.

1.6. "Larger Work" means a work which combines Covered Software or

portions thereof with code not governed by the terms of this License.

1.7. "License" means this document.

1.8. "Licensable" means having the right to grant, to the maximum
extent possible, whether at the time of the initial grant or
subsequently acquired, any and all of the rights conveyed herein.

1.9. "Modifications" means the Source Code and Executable form of

any of the following:

A. Any file that results from an addition to, deletion from or
modification of the contents of a file containing Original Software
or previous Modifications;

B. Any new file that contains any part of the Original Software or

previous Modification; or

C. Any new file that is contributed or otherwise made available
under the terms of this License.

1.10. "Original Software" means the Source Code and Executable form
of computer software code that is originally released under this
License.

1.11. "Patent Claims" means any patent claim(s), now owned or
hereafter acquired, including without limitation, method, process,

and apparatus claims, in any patent Licensable by grantor.

1.12. "Source Code" means (a) the common form of computer software
code in which modifications are made and (b) associated
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documentation included in or with such code.

1.13. "You" (or "Your™) means an individual or a legal entity
exercising rights under, and complying with all of the terms of,

this License. For legal entities, "You" includes any entity which
controls, is controlled by, or is under common control with You. For
purposes of this definition, "control” means (a) the power, direct
or indirect, to cause the direction or management of such entity,
whether by contract or otherwise, or (b) ownership of more than
fifty percent (50%) of the outstanding shares or beneficial
ownership of such entity.

2. License Grants.

2.1. The Initial Developer Grant.

Conditioned upon Your compliance with Section 3.1 below and subject
to third party intellectual property claims, the Initial Developer
hereby grants You a world-wide, royalty-free, non-exclusive license:

(a) under intellectual property rights (other than patent or
trademark) Licensable by Initial Developer, to use, reproduce,
modify, display, perform, sublicense and distribute the Original
Software (or portions thereof), with or without Modifications,

and/or as part of a Larger Work; and

(b) under Patent Claims infringed by the making, using or selling of
Original Software, to make, have made, use, practice, sell, and
offer for sale, and/or otherwise dispose of the Original Software
(or portions thereof).

(c) The licenses granted in Sections 2.1(a) and (b) are effective on
the date Initial Developer first distributes or otherwise makes the
Original Software available to a third party under the terms of this

License.

(d) Notwithstanding Section 2.1(b) above, no patent license is
granted: (1) for code that You delete from the Original Software, or
(2) for infringements caused by: (i) the modification of the

Original Software, or (ii) the combination of the Original Software
with other software or devices.

2.2. Contributor Grant.
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Conditioned upon Your compliance with Section 3.1 below and subject
to third party intellectual property claims, each Contributor hereby

grants You a world-wide, royalty-free, non-exclusive license:

(a) under intellectual property rights (other than patent or
trademark) Licensable by Contributor to use, reproduce, modify,
display, perform, sublicense and distribute the Modifications
created by such Contributor (or portions thereof), either on an
unmodified basis, with other Modifications, as Covered Software
and/or as part of a Larger Work; and

(b) under Patent Claims infringed by the making, using, or selling

of Modifications made by that Contributor either alone and/or in
combination with its Contributor Version (or portions of such
combination), to make, use, sell, offer for sale, have made, and/or
otherwise dispose of: (1) Modifications made by that Contributor (or
portions thereof); and (2) the combination of Modifications made by
that Contributor with its Contributor Version (or portions of such

combination).

(c) The licenses granted in Sections 2.2(a) and 2.2(b) are effective
on the date Contributor first distributes or otherwise makes the

Modifications available to a third party.

(d) Notwithstanding Section 2.2(b) above, no patent license is
granted: (1) for any code that Contributor has deleted from the
Contributor Version; (2) for infringements caused by: (i) third

party modifications of Contributor Version, or (ii) the combination

of Modifications made by that Contributor with other software
(except as part of the Contributor Version) or other devices; or (3)
under Patent Claims infringed by Covered Software in the absence of

Modifications made by that Contributor.

. Distribution Obligations.

3.1. Availability of Source Code.

Any Covered Software that You distribute or otherwise make available
in Executable form must also be made available in Source Code form
and that Source Code form must be distributed only under the terms
of this License. You must include a copy of this License with every
copy of the Source Code form of the Covered Software You distribute
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or otherwise make available. You must inform recipients of any such
Covered Software in Executable form as to how they can obtain such
Covered Software in Source Code form in a reasonable manner on or

through a medium customarily used for software exchange.

3.2. Modifications.

The Modifications that You create or to which You contribute are
governed by the terms of this License. You represent that You
believe Your Modifications are Your original creation(s) and/or You
have sufficient rights to grant the rights conveyed by this License.

3.3. Required Notices.

You must include a notice in each of Your Modifications that
identifies You as the Contributor of the Modification. You may not
remove or alter any copyright, patent or trademark notices contained
within the Covered Software, or any notices of licensing or any
descriptive text giving attribution to any Contributor or the

Initial Developer.

3.4. Application of Additional Terms.

You may not offer or impose any terms on any Covered Software in
Source Code form that alters or restricts the applicable version of
this License or the recipients' rights hereunder. You may choose to
offer, and to charge a fee for, warranty, support, indemnity or
liability obligations to one or more recipients of Covered Software.
However, you may do so only on Your own behalf, and not on behalf of
the Initial Developer or any Contributor. You must make it
absolutely clear that any such warranty, support, indemnity or
liability obligation is offered by You alone, and You hereby agree

to indemnify the Initial Developer and every Contributor for any
liability incurred by the Initial Developer or such Contributor as a
result of warranty, support, indemnity or liability terms You offer.

3.5. Distribution of Executable Versions.

You may distribute the Executable form of the Covered Software under
the terms of this License or under the terms of a license of Your
choice, which may contain terms different from this License,

provided that You are in compliance with the terms of this License

and that the license for the Executable form does not attempt to

427



19 Appendix

limit or alter the recipient's rights in the Source Code form from

the rights set forth in this License. If You distribute the Covered
Software in Executable form under a different license, You must make
it absolutely clear that any terms which differ from this License

are offered by You alone, not by the Initial Developer or

Contributor. You hereby agree to indemnify the Initial Developer and
every Contributor for any liability incurred by the Initial

Developer or such Contributor as a result of any such terms You offer.

3.6. Larger Works.

You may create a Larger Work by combining Covered Software with
other code not governed by the terms of this License and distribute
the Larger Work as a single product. In such a case, You must make
sure the requirements of this License are fulfilled for the Covered
Software.

4. Versions of the License.

428

4.1. New Versions.

Oracle is the initial license steward and may publish revised and/or
new versions of this License from time to time. Each version will be
given a distinguishing version number. Except as provided in Section
4.3, no one other than the license steward has the right to modify
this License.

4.2. Effect of New Versions.

You may always continue to use, distribute or otherwise make the
Covered Software available under the terms of the version of the
License under which You originally received the Covered Software. If
the Initial Developer includes a notice in the Original Software
prohibiting it from being distributed or otherwise made available

under any subsequent version of the License, You must distribute and
make the Covered Software available under the terms of the version

of the License under which You originally received the Covered
Software. Otherwise, You may also choose to use, distribute or
otherwise make the Covered Software available under the terms of any

subsequent version of the License published by the license steward.

4.3. Modified Versions.
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When You are an Initial Developer and You want to create a new
license for Your Original Software, You may create and use a
modified version of this License if You: (a) rename the license and
remove any references to the name of the license steward (except to
note that the license differs from this License); and (b) otherwise
make it clear that the license contains terms which differ from this

License.

5. DISCLAIMER OF WARRANTY.

COVERED SOFTWARE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS,
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,

INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED SOFTWARE
IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR
NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF
THE COVERED SOFTWARE IS WITH YOU. SHOULD ANY COVERED SOFTWARE PROVE
DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY

OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING,
REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN
ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY COVERED SOFTWARE IS
AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER.

6. TERMINATION.

6.1. This License and the rights granted hereunder will terminate
automatically if You fail to comply with terms herein and fail to
cure such breach within 30 days of becoming aware of the breach.
Provisions which, by their nature, must remain in effect beyond the

termination of this License shall survive.

6.2. If You assert a patent infringement claim (excluding
declaratory judgment actions) against Initial Developer or a
Contributor (the Initial Developer or Contributor against whom You
assert such claim is referred to as "Participant”) alleging that the
Participant Software (meaning the Contributor Version where the
Participant is a Contributor or the Original Software where the
Participant is the Initial Developer) directly or indirectly

infringes any patent, then any and all rights granted directly or
indirectly to You by such Participant, the Initial Developer (if the
Initial Developer is not the Participant) and all Contributors under
Sections 2.1 and/or 2.2 of this License shall, upon 60 days notice
from Participant terminate prospectively and automatically at the
expiration of such 60 day notice period, unless if within such 60
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day period You withdraw Your claim with respect to the Participant
Software against such Participant either unilaterally or pursuant to

a written agreement with Participant.

6.3. If You assert a patent infringement claim against Participant
alleging that the Participant Software directly or indirectly

infringes any patent where such claim is resolved (such as by
license or settlement) prior to the initiation of patent

infringement litigation, then the reasonable value of the licenses
granted by such Participant under Sections 2.1 or 2.2 shall be taken
into account in determining the amount or value of any payment or

license.

6.4. In the event of termination under Sections 6.1 or 6.2 above,
all end user licenses that have been validly granted by You or any
distributor hereunder prior to termination (excluding licenses

granted to You by any distributor) shall survive termination.

. LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT
(INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL YOU, THE
INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF
COVERED SOFTWARE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE
TO ANY PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR
LOSSES, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE
POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF LIABILITY SHALL NOT
APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING FROM SUCH
PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH
LIMITATION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS EXCLUSION
AND LIMITATION MAY NOT APPLY TO YOU.

. U.S. GOVERNMENT END USERS.

The Covered Software is a "commercial item," as that term is defined

in 48 C.F.R. 2.101 (Oct. 1995), consisting of "commercial computer
software" (as that term is defined at 48 C.F.R. §

252.227-7014(a)(1)) and "commercial computer software documentation
as such terms are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent
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with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4
(June 1995), all U.S. Government End Users acquire Covered Software
with only those rights set forth herein. This U.S. Government Rights
clause is in lieu of, and supersedes, any other FAR, DFAR, or other
clause or provision that addresses Government rights in computer
software under this License.

9. MISCELLANEOUS.

This License represents the complete agreement concerning subject
matter hereof. If any provision of this License is held to be
unenforceable, such provision shall be reformed only to the extent
necessary to make it enforceable. This License shall be governed by
the law of the jurisdiction specified in a notice contained within

the Original Software (except to the extent applicable law, if any,
provides otherwise), excluding such jurisdiction's conflict-of-law
provisions. Any litigation relating to this License shall be subject

to the jurisdiction of the courts located in the jurisdiction and

venue specified in a notice contained within the Original Software,
with the losing party responsible for costs, including, without
limitation, court costs and reasonable attorneys' fees and expenses.
The application of the United Nations Convention on Contracts for
the International Sale of Goods is expressly excluded. Any law or
regulation which provides that the language of a contract shall be
construed against the drafter shall not apply to this License. You
agree that You alone are responsible for compliance with the United
States export administration regulations (and the export control
laws and regulation of any other countries) when You use, distribute

or otherwise make available any Covered Software.

10. RESPONSIBILITY FOR CLAIMS.

As between Initial Developer and the Contributors, each party is
responsible for claims and damages arising, directly or indirectly,
out of its utilization of rights under this License and You agree to
work with Initial Developer and Contributors to distribute such
responsibility on an equitable basis. Nothing herein is intended or
shall be deemed to constitute any admission of liability.

NOTICE PURSUANT TO SECTION 9 OF THE COMMON DEVELOPMENT AND DISTRIBUTION
LICENSE (CDDL)
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The code released under the CDDL shall be governed by the laws of the
State of California (excluding conflict-of-law provisions). Any

litigation relating to this License shall be subject to the jurisdiction

of the Federal Courts of the Northern District of California and the

state courts of the State of California, with venue lying in Santa Clara
County, California.

The GNU General Public License (GPL) Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor

Boston, MA 02110-1335

USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to
share and change it. By contrast, the GNU General Public License is
intended to guarantee your freedom to share and change free software--to
make sure the software is free for all its users. This General Public

License applies to most of the Free Software Foundation's software and

to any other program whose authors commit to using it. (Some other Free
Software Foundation software is covered by the GNU Library General

Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price.
Our General Public Licenses are designed to make sure that you have the
freedom to distribute copies of free software (and charge for this

service if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new

free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone
to deny you these rights or to ask you to surrender the rights. These
restrictions translate to certain responsibilities for you if you

distribute copies of the software, or if you modify it.
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For example, if you distribute copies of such a program, whether gratis
or for a fee, you must give the recipients all the rights that you have.
You must make sure that they, too, receive or can get the source code.
And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.

Finally, any free program is threatened constantly by software patents.
We wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program
proprietary. To prevent this, we have made it clear that any patent must

be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and
modification follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a
notice placed by the copyright holder saying it may be distributed under
the terms of this General Public License. The "Program", below, refers

to any such program or work, and a "work based on the Program™” means
either the Program or any derivative work under copyright law: that is

to say, a work containing the Program or a portion of it, either

verbatim or with modifications and/or translated into another language.
(Hereinafter, translation is included without limitation in the term
"modification”.) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not

covered by this License; they are outside its scope. The act of running

the Program is not restricted, and the output from the Program is

covered only if its contents constitute a work based on the Program
(independent of having been made by running the Program). Whether that
is true depends on what the Program does.
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1. You may copy and distribute verbatim copies of the Program's source
code as you receive it, in any medium, provided that you conspicuously
and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to

this License and to the absence of any warranty; and give any other
recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of
it, thus forming a work based on the Program, and copy and distribute
such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in
whole or in part contains or is derived from the Program or any part
thereof, to be licensed as a whole at no charge to all third parties
under the terms of this License.

c¢) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice
that there is no warranty (or else, saying that you provide a
warranty) and that users may redistribute the program under these
conditions, and telling the user how to view a copy of this License.
(Exception: if the Program itself is interactive but does not

normally print such an announcement, your work based on the Program

is not required to print an announcement.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Program, and
can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based on
the Program, the distribution of the whole must be on the terms of this
License, whose permissions for other licensees extend to the entire
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whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Program.

In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of a
storage or distribution medium does not bring the other work under the
scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections 1
and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three

years, to give any third party, for a charge no more than your cost
of physically performing source distribution, a complete
machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a medium

customarily used for software interchange; or,

¢) Accompany it with the information you received as to the offer to
distribute corresponding source code. (This alternative is allowed
only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in

accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete source code
means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control
compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the
executable.
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If distribution of executable or object code is made by offering access

to copy from a designated place, then offering equivalent access to copy
the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source
along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License. Any attempt otherwise
to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties
who have received copies, or rights, from you under this License will
not have their licenses terminated so long as such parties remain in

full compliance.

5. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all
its terms and conditions for copying, distributing or modifying the
Program or works based on it.

6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions. You may not impose any further restrictions
on the recipients' exercise of the rights granted herein. You are not
responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot distribute
so as to satisfy simultaneously your obligations under this License and
any other pertinent obligations, then as a consequence you may not
distribute the Program at all. For example, if a patent license would
not permit royalty-free redistribution of the Program by all those who
receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from
distribution of the Program.
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If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other

circumstances.

It is not the purpose of this section to induce you to infringe any

patents or other property right claims or to contest validity of any

such claims; this section has the sole purpose of protecting the

integrity of the free software distribution system, which is implemented

by public license practices. Many people have made generous

contributions to the wide range of software distributed through that

system in reliance on consistent application of that system; it is up to

the author/donor to decide if he or she is willing to distribute

software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be
a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in

certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License may
add an explicit geographical distribution limitation excluding those
countries, so that distribution is permitted only in or among countries

not thus excluded. In such case, this License incorporates the

limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new
versions of the General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and "any
later version”, you have the option of following the terms and

conditions either of that version or of any later version published by

the Free Software Foundation. If the Program does not specify a version
number of this License, you may choose any version ever published by the
Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the
author to ask for permission. For software which is copyrighted by the
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Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the
two goals of preserving the free status of all derivatives of our free

software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM

(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to
attach them to the start of each source file to most effectively convey
the exclusion of warranty; and each file should have at least the
"copyright" line and a pointer to where the full notice is found.
One line to give the program's name and a brief idea of what it does.

Copyright (C) <year> <name of author>
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This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful, but

WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1335 USA

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this
when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type
“show w'. This is free software, and you are welcome to redistribute
it under certain conditions; type ~show c' for details.

The hypothetical commands ~“show w' and ~show c' should show the

appropriate parts of the General Public License. Of course, the commands
you use may be called something other than “show w' and ~show c'; they
could even be mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer” for the program, if
necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
program ~Gnomovision' (which makes passes at compilers) written by
James Hacker.

signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program
into proprietary programs. If your program is a subroutine library, you

may consider it more useful to permit linking proprietary applications
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with the library. If this is what you want to do, use the GNU Library
General Public License instead of this License.

#

Certain source files distributed by Oracle America, Inc. and/or its
affiliates are subject to the following clarification and special
exception to the GPLv2, based on the GNU Project exception for its
Classpath libraries, known as the GNU Classpath Exception, but only
where Oracle has expressly included in the particular source file's
header the words "Oracle designates this particular file as subject to
the "Classpath" exception as provided by Oracle in the LICENSE file

that accompanied this code."

You should also note that Oracle includes multiple, independent

programs in this software package. Some of those programs are provided
under licenses deemed incompatible with the GPLv2 by the Free Software
Foundation and others. For example, the package includes programs
licensed under the Apache License, Version 2.0. Such programs are
licensed to you under their original licenses.

Oracle facilitates your further distribution of this package by adding
the Classpath Exception to the necessary parts of its GPLv2 code, which
permits you to use that code in combination with other independent
modules not licensed under the GPLv2. However, note that this would
not permit you to commingle code under an incompatible license with
Oracle's GPLv2 licensed code by, for example, cutting and pasting such
code into a file also containing Oracle's GPLv2 licensed code and then
distributing the result. Additionally, if you were to remove the
Classpath Exception from any of the files to which it applies and
distribute the result, you would likely be required to license some or
all of the other code in that distribution under the GPLv2 as well, and
since the GPLv2 is incompatible with the license terms of some items
included in the distribution by Oracle, removing the Classpath
Exception could therefore effectively compromise your ability to
further distribute the package.

Proceed with caution and we recommend that you obtain the advice of a
lawyer skilled in open source matters before removing the Classpath
Exception or making modifications to this package which may
subsequently be redistributed and/or involve the use of third party
software.
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CLASSPATH EXCEPTION

Linking this library statically or dynamically with other modules is
making a combined work based on this library. Thus, the terms and
conditions of the GNU General Public License version 2 cover the whole

combination.

As a special exception, the copyright holders of this library give you
permission to link this library with independent modules to produce an
executable, regardless of the license terms of these independent
modules, and to copy and distribute the resulting executable under

terms of your choice, provided that you also meet, for each linked
independent module, the terms and conditions of the license of that
module. An independent module is a module which is not derived from or
based on this library. If you modify this library, you may extend this
exception to your version of the library, but you are not obligated to

do so. If you do not wish to do so, delete this exception statement

from your version.

thrift

https://thrift.apache.org

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction,

and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by
the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all
other entities that control, are controlled by, or are under common
control with that entity. For the purposes of this definition,
"control" means (i) the power, direct or indirect, to cause the
direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the
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outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your™) shall mean an individual or Legal Entity

exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation

source, and configuration files.

"Object" form shall mean any form resulting from mechanical
transformation or translation of a Source form, including but
not limited to compiled object code, generated documentation,

and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by a
copyright notice that is included in or attached to the work

(an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object
form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes
of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including

the original version of the Work and any modifications or additions

to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner
or by an individual or Legal Entity authorized to submit on behalf of
the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent
to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the
Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise

designated in writing by the copyright owner as "Not a Contribution."

"Contributor"” shall mean Licensor and any individual or Legal Entity
on behalf of whom a Contribution has been received by Licensor and
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subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of,
publicly display, publicly perform, sublicense, and distribute the
Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
(except as stated in this section) patent license to make, have made,
use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You
institute patent litigation against any entity (including a
cross-claim or counterclaim in a lawsuit) alleging that the Work
or a Contribution incorporated within the Work constitutes direct
or contributory patent infringement, then any patent licenses
granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the
Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You

meet the following conditions:

(a) You must give any other recipients of the Work or
Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices
stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works
that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work,
excluding those notices that do not pertain to any part of

the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its
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distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained
within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one

of the following places: within a NOTICE text file distributed

as part of the Derivative Works; within the Source form or
documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents
of the NOTICE file are for informational purposes only and

do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside

or as an addendum to the NOTICE text from the Work, provided
that such additional attribution notices cannot be construed

as modifying the License.

You may add Your own copyright statement to Your modifications and
may provide additional or different license terms and conditions

for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use,
reproduction, and distribution of the Work otherwise complies with

the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise,
any Contribution intentionally submitted for inclusion in the Work
by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions.
Notwithstanding the above, nothing herein shall supersede or modify
the terms of any separate license agreement you may have executed

with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade
names, trademarks, service marks, or product names of the Licensor,
except as required for reasonable and customary use in describing the
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or
agreed to in writing, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied, including, without limitation, any warranties or conditions
of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the
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appropriateness of using or redistributing the Work and assume any

risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory,
whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly
negligent acts) or agreed to in writing, shall any Contributor be
liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a
result of this License or out of the use or inability to use the
Work (including but not limited to damages for loss of goodwiill,
work stoppage, computer failure or malfunction, or any and all
other commercial damages or losses), even if such Contributor
has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing
the Work or Derivative Works thereof, You may choose to offer,
and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this
License. However, in accepting such obligations, You may act only
on Your own behalf and on Your sole responsibility, not on behalf
of any other Contributor, and only if You agree to indemnify,
defend, and hold each Contributor harmless for any liability
incurred by, or claims asserted against, such Contributor by reason

of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following
boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include
the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a
file or class name and description of purpose be included on the
same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License.
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You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software

distributed under the License is distributed on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and

limitations under the License.

SOFTWARE DISTRIBUTED WITH THRIFT:
The Apache Thrift software includes a number of subcomponents with
separate copyright notices and license terms. Your use of the source

code for the these subcomponents is subject to the terms and

conditions of the following licenses.

Portions of the following files are licensed under the MIT License:

lib/erl/src/Makefile.am

Please see doc/otp-base-license.txt for the full terms of this license.

For the aclocal/ax_boost_base.m4 and contrib/fb303/aclocal/ax_boost_base.m4 components:

Copyright (c) 2007 Thomas Porschberg <thomas@randspringer.de>

Copying and distribution of this file, with or without

modification, are permitted in any medium without royalty provided

* OH O# OEF OH#*

the copyright notice and this notice are preserved.

For the lib/nodejs/lib/thrift/json_parse.js:

/*
json_parse.js
2015-05-02
Public Domain.
NO WARRANTY EXPRESSED OR IMPLIED. USE AT YOUR OWN RISK.
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*/
(By Douglas Crockford <douglas@crockford.com>)

For lib/cpp/src/thrift/windows/SocketPair.cpp

/* socketpair.c

* Copyright 2007 by Nathan C. Myers <ncm@cantrip.org>; some rights reserved.
* This code is Free Software. It may be copied freely, in original or

* modified form, subject only to the restrictions that (1) the author is

* relieved from all responsibilities for any use for any purpose, and (2)

* this copyright notice must be retained, unchanged, in its entirety. If

* for any reason the author might be held responsible for any consequences

* of copying or use, license is withheld.

*/

For lib/py/compat/win32/stdint.h

// 1SO C9x compliant stdint.h for Microsoft Visual Studio

// Based on ISO/IEC 9899:TC2 Committee draft (May 6, 2005) WG14/N1124

//

/! Copyright (c) 2006-2008 Alexander Chemeris

//

/1 Redistribution and use in source and binary forms, with or without

// maodification, are permitted provided that the following conditions are met:

//

// 1. Redistributions of source code must retain the above copyright notice,

// this list of conditions and the following disclaimer.

//

// 2. Redistributions in binary form must reproduce the above copyright

/! notice, this list of conditions and the following disclaimer in the

/! documentation and/or other materials provided with the distribution.

//

// 3. The name of the author may be used to endorse or promote products

/! derived from this software without specific prior written permission.

//

// THIS SOFTWARE IS PROVIDED BY THE AUTHOR ~~AS IS" AND ANY EXPRESS OR IMPLIED
// WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

// MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
// EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

/1 SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
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// PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
// OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

// WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR

// OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF

// ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

/!

i

Codegen template in t_html_generator.h

* Bootstrap v2.0.3

*

* Copyright 2012 Twitter, Inc
* Licensed under the Apache License v2.0
* http://www.apache.org/licenses/LICENSE-2.0

*

* Designed and built with all the love in the world @twitter by @mdo and @fat.

For t_cl_generator.cc

* Copyright (c) 2008- Patrick Collison <patrick@collison.ie>
* Copyright (c) 2006- Facebook

queryDsl

http://querydsl.com

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction,
and distribution as defined by Sections 1 through 9 of this document.
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"Licensor" shall mean the copyright owner or entity authorized by
the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all
other entities that control, are controlled by, or are under common
control with that entity. For the purposes of this definition,
"control” means (i) the power, direct or indirect, to cause the
direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the
outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity

exercising permissions granted by this License.

"Source"” form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation

source, and configuration files.

"Object" form shall mean any form resulting from mechanical
transformation or translation of a Source form, including but
not limited to compiled object code, generated documentation,

and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by a
copyright notice that is included in or attached to the work

(an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object
form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes
of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including

the original version of the Work and any modifications or additions

to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner
or by an individual or Legal Entity authorized to submit on behalf of
the copyright owner. For the purposes of this definition, "submitted"

means any form of electronic, verbal, or written communication sent
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to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the
Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise

designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity
on behalf of whom a Contribution has been received by Licensor and
subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of,
publicly display, publicly perform, sublicense, and distribute the

Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
(except as stated in this section) patent license to make, have made,
use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You
institute patent litigation against any entity (including a
cross-claim or counterclaim in a lawsuit) alleging that the Work
or a Contribution incorporated within the Work constitutes direct
or contributory patent infringement, then any patent licenses
granted to You under this License for that Work shall terminate

as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the
Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You
meet the following conditions:

(a) You must give any other recipients of the Work or

Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices
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stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works
that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work,
excluding those notices that do not pertain to any part of
the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its
distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained
within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one
of the following places: within a NOTICE text file distributed
as part of the Derivative Works; within the Source form or
documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents
of the NOTICE file are for informational purposes only and
do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside
or as an addendum to the NOTICE text from the Work, provided
that such additional attribution notices cannot be construed

as modifying the License.

You may add Your own copyright statement to Your modifications and
may provide additional or different license terms and conditions

for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use,
reproduction, and distribution of the Work otherwise complies with
the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise,
any Contribution intentionally submitted for inclusion in the Work
by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions.
Notwithstanding the above, nothing herein shall supersede or modify
the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade
names, trademarks, service marks, or product names of the Licensor,

except as required for reasonable and customary use in describing the
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origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or
agreed to in writing, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied, including, without limitation, any warranties or conditions
of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any

risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory,
whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly
negligent acts) or agreed to in writing, shall any Contributor be
liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a
result of this License or out of the use or inability to use the
Work (including but not limited to damages for loss of goodwill,
work stoppage, computer failure or malfunction, or any and all
other commercial damages or losses), even if such Contributor

has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing
the Work or Derivative Works thereof, You may choose to offer,
and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this
License. However, in accepting such obligations, You may act only
on Your own behalf and on Your sole responsibility, not on behalf
of any other Contributor, and only if You agree to indemnify,
defend, and hold each Contributor harmless for any liability
incurred by, or claims asserted against, such Contributor by reason
of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following
boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include
the brackets!) The text should be enclosed in the appropriate
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comment syntax for the file format. We also recommend that a
file or class name and description of purpose be included on the
same "printed page" as the copyright notice for easier

identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software

distributed under the License is distributed on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and

limitations under the License.

libevent

https://libevent.org

Copyright (c) 2000-2007 Niels Provos <provos@citi.umich.edu>
Copyright (c) 2007-2010 Niels Provos and Nick Mathewson

Libevent is available for use under the following license, commonly known

as the 3-clause (or "modified") BSD license:

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ~"AS IS" AND ANY EXPRESS OR

IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
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IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Portions of Libevent are based on works by others, also made available by
them under the three-clause BSD license above. The copyright notices are
available in the corresponding source files; the license is as above. Here's

a list:

log.c:
Copyright (¢) 2000 Dug Song <dugsong@monkey.org=>
Copyright (c) 1993 The Regents of the University of California.

stricpy.c:
Copyright (c) 1998 Todd C. Miller <Todd.Miller@courtesan.com>

win32select.c:
Copyright (c) 2003 Michael A. Davis <mike@datanerds.net>

evport.c:
Copyright (c) 2007 Sun Microsystems

ht-internal.h:
Copyright (c) 2002 Christopher Clark

minheap-internal.h:
Copyright (c) 2006 Maxim Yegorushkin <maxim.yegorushkin@gmail.com>

The arc4module is available under the following, sometimes called the

"OpenBSD" license:

Copyright (c) 1996, David Mazieres <dm@uun.org=>
Copyright (c) 2008, Damien Miller <djm@openbsd.org>

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
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copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANT IES
WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR
ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

rapidjson

https://rapidjson.org

Tencent is pleased to support the open source community by making RapidJSON available.
Copyright (C) 2015 THL A29 Limited, a Tencent company, and Milo Yip. All rights reserved.

If you have downloaded a copy of the RapidJSON binary from Tencent, please note that the RapidJSON
binary is licensed under the MIT License.

If you have downloaded a copy of the RapidJSON source code from Tencent, please note that
RapidJSON source code is licensed under the MIT License, except for the third-party components listed
below which are subject to different license terms. Your integration of RapidJSON into your own
projects may require compliance with the MIT License, as well as the other licenses applicable to the
third-party components included within RapidJSON. To avoid the problematic JSON license in your own
projects, it's sufficient to exclude the bin/jsonchecker/ directory, as it's the only code under the JSON
license.

A copy of the MIT License is included in this file.

Other dependencies and licenses:

Open Source Software Licensed Under the BSD License:

The msinttypes r29
Copyright (c) 2006-2013 Alexander Chemeris

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the

following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
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following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of copyright holder nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ~"AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE REGENTS AND CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Open Source Software Licensed Under the JSON License:

json.org
Copyright (c) 2002 JSON.org
All Rights Reserved.

JSON_checker
Copyright (c) 2002 JSON.org
All Rights Reserved.

Terms of the JSON License:

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software™), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

The Software shall be used for Good, not Evil.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
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HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Terms of the MIT License:

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software™), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Software End User License Agreement(EULA)

SUPREMA INC.
SOFTWARE LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY BEFORE INSTALLING OR
USING THE SOFTWARE OR ANY ACCOMPANY ING DOCUMENTATION (COLLECTIVELY, THE
“SOFTWARE”).

THE TERMS AND CONDITIONS OF THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) GOVERN
YOUR USE OF THE SOFTWARE UNLESS YOU AND SUPREMA INC (“COMPANY””) HAVE EXECUTED A
SEPARATE AGREEMENT GOVERNING THE USE OF THE SOFTWARE.

Company is willing to license the Software to you only upon the condition that you accept all the terms
contained in this Agreement. By clicking “l accept the agreement” or by installing or using the Software,
you indicate that you understand this Agreement and agree to be bound by all of its terms. If you are
accepting the terms of this Agreement on behalf of a company or other legal entity, you represent and
warrant that you have the authority to bind that company or other legal entity to the terms of this
Agreement, and, in such event, “you” and “your” will refer to that company or other legal entity. If you
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do not accept all the terms of this Agreement, Company is unwilling to license the Software to you, you
must click “l do not accept the agreement” or otherwise may not install or use the Software, and you

must ask your local authorized distributor (“Local Distributor”) for a full refund of the license fee paid (if
any) within 30 days after the date of purchase. If you click “l accept the agreement” or otherwise install

or use the Software, any license fee paid will not be refundable.

1. Grant of License.

Conditioned upon your compliance with the terms and conditions of this Agreement, Company grants
you a non-exclusive, non-transferable, revocable license to Execute (as defined herein) one copy of the
Software on a computer (“Computer”) in connection with your compatible hardware products
(“Hardware Product™), solely for your internal business purposes. Company reserves all rights in the
Software not expressly granted to you in this Agreement. For purposes of this Agreement, “Execute”
and “Execution” means to load, install, and run the Software in order to benefit from its functionality as
designed by Company.

2. Restrictions.

Without prior written approval from Company, you may not: (a) copy (except in the course of loading or
installing) or modify the Software, including but not limited to adding new features or otherwise making
adaptations that alter the functioning of the Software; (b) transfer, sublicense, lease, lend, rent or
otherwise distribute the Software to any third party; (c) make the functionality of the Software available
to multiple users through any means, including but not limited to by uploading the Software to a network
or file-sharing service or through any hosting, application services provider, service bureau, software-
as-a-service (SaaS) or any other type of services; or (d) disassemble, decompile or reverse engineer
the Software, in whole or in part, or permit or authorize a third party to do so, except to the extent such

a restriction is unenforceable by law.

3. Open Source.

You acknowledge that the Software may include Open Source Software (“OSS”) that is subject to OSS
licenses of third parties. Nothing in this Agreement limits your rights under, or grants you rights that
supersede, the terms and conditions of any applicable license for the OSS. After completion of the
installation, please click “HELP” link that points to the page including the OSS list and the terms and
conditions thereof. Any listed OSS is listed only for your convenience and solely for information
purposes, and, if licensed, is licensed to you only under the terms set forth in the corresponding Open
Source License.

4. Ownership.

The Software is licensed, not sold. Company retains ownership of all proprietary rights in the Software,
including all intellectual property rights therein. The Software is protected by copyright and other
intellectual property laws and international treaties. You will not delete or in any manner alter the
copyright, trademark, and other proprietary rights notices or markings appearing on the Software as

delivered to you.

5. Data Collection and Privacy.
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For the purpose of initial validation of the license, the Software connects to the internet to contact the
Software licensing servers. During the validation process, the Software reads MAC address of your
Computer and Company stores this data in the Software licensing server. By installing and using the
Software, you agree that MAC address of your Computer can be processed when required for licensing
purposes. The Software may include features that enable it to process certain personal data such as
user names, contact information and biometric data of binary fingerprint/facial templates, facial images,
and log data. (“Personal Data”).

YOU AGREE THAT YOU ARE SOLELY RESPONSIBLE FOR: (I) USE OF THE SOFTWARE, INCLUDING
ENSURING THE SECURITY OF YOUR COMPUTER AND HARDWARE PRODUCT SO THEY ARE SAFE FROM
UNAUTHORIZED ACCESS; (Il) USE OF THE SOFTWARE IN COMPLIANCE WITH ALL APPLICABLE LAWS;
AND (11I) PROVIDING ADEQUATE NOTICE AND OBTAINING AND MAINTAINING VALID CONSENTS FROM
ALL OF YOUR (AS A SITE ADMIN) END USERS, AS MAY BE NECESSARY UNDER APPLICABLE LAW TO
PROCESS THEIR PERSONAL DATA USING THE SOFTWARE FOR YOUR INTENDED PURPOSES.

6. Term.

The license granted under this Agreement remains in effect indefinitely, unless earlier terminated in
accordance with this Agreement. You may terminate the license at any time by destroying the Software
in your possession or control. The license granted under this Agreement will automatically terminate,
with or without notice from Company, if you breach any term of this Agreement. Upon termination, you
must immediately cease using the Software and destroy the Software in your possession or control.
Either party’ rights and obligations under this Agreement that by their nature are intended to survive

termination of this Agreement shall do so.

7. Limited Warranty.

Company warrants that, for one (1) year following the date of purchase, the Software will be free from
material defects in materials and workmanship, and will perform in all material respects in accordance
with any accompanying documentation. As your sole and exclusive remedy and Company entire liability
for any breach of this limited warranty, Company will at its option and expense promptly correct or
replace the Software so that it conforms to this limited warranty. Company does not warrant that the
Software will meet your requirements, that the Software will operate in the combinations that you may
select for Execution, that the operation of the Software will be error-free or uninterrupted, or that all
Software errors will be corrected. The warranty set forth in this Section 7 does not apply to the extent
that Company provides you with the Software free of charge. This warranty is VOID if failure of the
Software is due to accident, negligence, abuse, improper installation or misuse of the Software.

8. DISCLAIMER.

THE SOFTWARE IS PROVIDED “AS 1S.” THE LIMITED WARRANTY SET FORTH IN SECTION 7 IS IN LIEU
OF AND COMPANY EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT, AND ANY
WARRANTIES AND CONDITIONS ARISING OUT OF COURSE OF DEALING OR USAGE OF TRADE. NO
ADVICE OR INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED FROM COMPANY OR ELSEWHERE
WILL CREATE ANY WARRANTY OR CONDITION NOT EXPRESSLY STATED IN THIS AGREEMENT.
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THE SOFTWARE MAY COLLECT PERSONAL DATA OF YOUR COMPANY'S EMPLOYEES WITHIN YOUR
HARDWARE. THESE PERSONAL DATA IS NOT COLLECTED OR STORED BY COMPANY, AND IT SHALL BE
YOUR SOLE RESPONSIBILITY TO PROCESS THESE INFORMATION IN ACCORDANCE WITH THE LAWS OF
YOUR JURISDICTION.

9. Limitation of Liability.

NOTWITHSTANDING ANYTHING TO THE CONTRARY CONTAINED IN THIS AGREEMENT, COMPANY'S
TOTAL LIABILITY TO YOU FROM ALL CAUSES OF ACTION AND UNDER ALL THEORIES OF LIABILITY WILL
BE LIMITED TO ANY REFUND THE LOCAL DISTRIBUTOR MAY PROVIDE TO YOU IN REGARDS TO THE
DIRECT DAMAGES UP TO THE AMOUNT PAID BY YOU TO THE LOCAL DISTRIBUTOR FOR THE
SOFTWARE.

IN NO EVENT WILL COMPANY BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE
OR CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF DATA,
LOSS OF BUSINESS PROFITS OR ANY OTHER PECUNIARY LOSS) OR FOR THE COST OF PROCURING
SUBSTITUTE PRODUCTS ARISING OUT OF OR IN CONNECTION WITH THIS AGREEMENT OR THE
EXECUTION OF OR INABILITY TO EXECUTE THE SOFTWARE, WHETHER SUCH LIABILITY ARISES FROM
ANY CLAIM BASED UPON CONTRACT, WARRANTY, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY
OR OTHERWISE, AND WHETHER OR NOT COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
LOSS OR DAMAGE. THE FOREGOING LIMITATIONS WILL SURVIVE AND APPLY EVEN IF ANY LIMITED
REMEDY SPECIFIED IN THIS AGREEMENT IS FOUND TO HAVE FAILED OF ITS ESSENTIAL PURPOSE.

10. Refund Policy.

Your Local Distributor has the obligation and responsibility to refund the license fee paid (if any) and the
fee will be refundable in accordance with the refund policy of your Local Distributor. If you are unwilling
to install or use the Software, you must click “I do not accept” or otherwise may not install or use the
Software and you must ask your Local Distributor for a full refund of the fee within 30 days after the
date of purchase. Once you click “l Accept” and enter the serial number of the Software, it will be
deemed to have been used, and thus, you will not, under any circumstances, be entitled to any license

fee paid.

11. Indemnities.

You shall indemnify, defend and hold Company and its affiliates and subsidiaries harmless from and
against any and all claims, including, but not limited to, the claim in relation to: (a) your infringement of
any intellectual property, privacy or other rights of any third party; (b) injury to or death of any
person(s) or damage to or loss of property; (c) your breach of any term in this Agreement; and/or (d)
your violation of applicable law. In such a case, Company will provide you with written notice of such

claim, suit or action.

12. Export Law.

You agree to comply fully with all export or import controls imposed by the country of origin, destination
or use, including regulations under such laws. You agree not to export or re-export (directly or
indirectly) to ensure that neither the Software nor any technical data related thereto nor any direct
product thereof are exported or re-exported directly or indirectly in violation of, or used for any purposes
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prohibited by, such laws and regulations.

13. Governing Law.

This Agreement will be governed by and construed in accordance with the laws of the Republic of Korea,
without regard to or application of conflict of laws rules or principles. The United Nations Convention on
Contracts for the International Sale of Goods will not apply.

14. Arbitration.

In the event of any dispute controversy or claim arising out of, or in connection with, or relating to this
Agreement, or the breach, termination or invalidity of this Agreement, all attempts shall be made to
solve it through mutual consultation in a spirit of confidence and integrity. If all attempts so made
through mutual consultations have proved to be of no help within a reasonable time, arbitration rather
than legal proceedings shall solve it. The matter shall be finally settled by arbitration in Seoul, Korea in
accordance with the Domestic(International) Arbitration Rules of the Korean Commercial Arbitration
Board and under the Law of Korea.

15. General.

You may not assign or transfer this Agreement or any rights granted hereunder, by operation of law or
otherwise, without Company’ prior written consent, and any attempt by you to do so, without such
consent, will be void. Except as expressly set forth in this Agreement, the exercise by either party of any
of its remedies under this Agreement will be without prejudice to its other remedies under this
Agreement or otherwise. All notices or approvals required or permitted under this Agreement will be in
writing and delivered by electronic mail, confirmed facsimile transmission, by overnight delivery service,
or by certified mail, and in each instance will be deemed given upon receipt. All notices or approvals
will be sent to the addresses set forth in the applicable ordering document or invoice or to such other
address as may be specified by either party to the other in accordance with this section. The failure by
either party to enforce any provision of this Agreement will not constitute a waiver of future enforcement
of that or any other provision. Any waiver, modification or amendment of any provision of this
Agreement will be effective only if in writing and signed by authorized representatives of both parties. If
any provision of this Agreement is held to be unenforceable or invalid, that provision will be enforced to
the maximum extent possible, and the other provisions will remain in full force and effect. This
Agreement is the complete and exclusive understanding and agreement between the parties regarding
its subject matter, and supersedes all proposals, understandings or communications between the
parties, oral or written, regarding its subject matter, unless you and Company have executed a separate
agreement. Any terms or conditions contained in your purchase order or other ordering document that
are inconsistent with or in addition to the terms and conditions of this Agreement are hereby rejected by

Company and will be deemed null.

16. Contact Information.

If you have any questions regarding this Agreement, please visit
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